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Introduction

aptop owners are special people.

You see, a laptop owner demands everything from a computer that a desktop
owner does: reliability, performance, expandability, and ease of use. Owners of
Mac Pro, Mac mini, and iMac desktop computers can draw the line right there,
because their computers are designed for a stationary existence. But you and I are
laptop owners. We also need that same computer to be an inch thick (or less). We
demand that it run for hours on a single battery charge. We require that it be light
as a feather. We want to conquer the coffee shop, the library, and even a lecture
hall or two!

Today’s Apple laptops deliver all that and more. If you’ve bought one of these
modern masterpieces — or you’re thinking about it — I applaud your good taste,
common sense, and discerning eye. Apple laptops have everything: super perfor-
mance, a top-shelf LED screen, rugged reliability, and a trouble-free, powerful
operating system. Heck, your Intel-based Apple laptop can even run — wait for
it — Windows 10. (If you absolutely have to, the option is there.)

I wrote this book for myself — and for every other Apple laptop owner who wants
to become a laptop techno-wizard. In these pages, you find a guide to both your
laptop’s hardware and macOS High Sierra, the latest version of Apple’s superb
operating system. After I cover the basics that every laptop owner should know,
you find out how to accomplish all sorts of cutting-edge audio, visual, and Inter-
net projects. (Oh, and if you already have another of my books, you know that I
don’t skimp on the power-user tips and tricks that save you time, effort, and
money.)

Foolish Assumptions

So who is the target audience for this book? As in past editions, I make no assump-
tions about your previous knowledge of computers and software. I figure you’ve
either just bought a MacBook or you’re considering buying one. Perhaps you’ve
found a bargain on a gently used older MacBook, and you need guidance as you
learn the ropes. Those are the only assumptions I make. And unlike other books
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TIP

©

REMEMBER

that require a lot of technical expertise to understand, this book’s only require-
ment is your desire to become a Mac laptop power user (someone who produces the
best work in the least amount of time and has the most fun doing it)!

By the way, if your friends and family predicted that you’ll spend half your life
savings on software — or that no “decent” software is available for Mac
computers — just smile quietly to yourself! The MacBook comes complete with
more productivity software than any Windows box, and they’re better than
anything available on a PC!

This book was written using one of the latest Intel quad-core MacBook models —
because of changing hardware, owners of older Mac laptops might not be able to
follow along with every feature I cover. However, if you’ve upgraded an older
MacBook to macOS High Sierra, you should be able to use most of this book with
no problem.

About This Book

2

In writing about the MacBook, I’ve kept one precept firmly in mind: macOS High
Sierra, the operating system you’ll run, is just as important as the laptop itself.
Therefore, you’ll find that MacBook For Dummies is just as much about familiariz-
ing you with all the software you get as it is with introducing you to hardware
features like the Touch Bar, the keyboard, and the trackpad. After all, it’s rela-
tively easy to connect a power cable and turn on any new computer. What comes
next is the challenging part!

As in my other For Dummies titles, I respect and use the same everyday language
you do, avoiding jargon, ridiculous computer acronyms, and confusing techno-
babble whenever possible.

If you’re upgrading from a PC running the Windows operating system, I’ve got
tips, tricks, and entire sections devoted to those hardy pioneers called Switchers.
You discover both the similarities and differences between your MacBook running
High Sierra and a PC running Windows. I also show you how to make the switch
as easily and quickly as possible.

A word about the conventions I use: Even with an absolute minimum of techno-
speak, this book needs to cover the keys you have to press or menu commands you
have to choose to make things work. Therefore, please keep in mind this short list
of conventions as you read:

MacBook For Dummies
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¥ Stuff you type: If | ask you to type (or enter) something, such as in a text box
or field, that text appears in bold, like this:

Type me.
You usually have to press Return before anything happens.

3 Menu commands: | list menu paths and commands using another format.
For example, this instruction indicates that you should click the Edit menu and
then choose the Copy menu item:

Edit=> Copy

3 Web addresses: No up-to-date book on a computer would be complete
without a bag full of web addresses for you to check out. When you see these
in the text, they look like this: www.mlcbooks . com. (By the way, that website
does exist. You're always welcome to check out my little acre of Internet
spacel)

3 For the technically curious: Your MacBook is an elegant and sophisticated
machine, and as easy to use as a computer can be. But from time to time, you
may be curious about the technical details that surround your hardware and
software. (Perhaps you disassembled alarm clocks as a kid, like | did.) Techie
stuff is denoted with a margin icon, as discussed in the next section. You don't
have to read the technical notes unless you want to know what makes things
tick. (Pun by sheer accident.)

Icons Used in This Book

TIP

o
T
TECHNICAL
STUFF

WARNING

Like other technology authors, I firmly believe that important nuggets of wisdom
should stand out on the page! With that in mind, this For Dummies book includes a
number of margin icons for certain situations:

This is the most popular icon in the book. You find it parked next to suggestions I

make to save you time and effort (and even cash!).

You don’t have to know this information, but the technologically curious love
high-tech details. (Of course, we’re great fun at parties, too.)

Always read this information before you take action! I’m discussing something
that could actually harm your hardware or throw a plumber’s helper into your
software.
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MARK'S
MAXIMS

Consider these nuggets to be highlighter stuff — not quite as universally accepted
(or as important to the author) as a Mark’s Maxim (described next), but good
reminders nonetheless. I use this icon to reinforce what you should remember.

These gold-plated, cream-of-the-crop truisms are MFRs (short for My Favorite
Recommendations). In fact, I'll bet just about any MacBook power user would tell
you the same. Follow my Maxims to avoid the quicksand and pitfalls I’ve encoun-
tered with all sorts of Macs for three decades.™

Beyond the Book

Thanks to my hard-working good friends at Wiley, a ton of extra content accom-
panies this book. Fire up your Safari browser, go to www.dummies.com, and search
for MacBook For Dummies to find the following:

3 Cheat Sheet: I've created a number of Cheat Sheet pages that cover things
like common keystrokes and maintenance procedures that every MacBook
owner should follow on a regular basis.

3 Bonus chapters: If you're dying to find out how to share data among wireless
devices via Bluetooth technology, check out the handy Bluetooth bonus
chapter at www . dummies. com or at my website (www . m1cbooks . com).

3 Updates to this book, if we have any.

Where to Go from Here

MARK'S
MAXIMS

Each chapter is a reference for a specific hardware or software topic. As fruit of the
hard work of my editors, you can begin reading anywhere you like, because each
chapter is self-contained. However, if you want to get the most out of this tome
(and your MacBook experience), there’s nothing wrong with reading this book
from front to back. I warn you, however, that J. K. Rowling and Stephen King have
nothing to fear from my no-frills prose!

Time for the first Mark’s Maxim in this book:
Take your time. After all, learning how to use your MacBook isn’t a race. And

don’t worry if you’re not a graphic artist, professional photographer, or video
editor. With your Mac laptop and its software, you don’t have to be!™
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Tie Myself Down
with a Desktop?
Preposterous!



IN THIS PART ...

Tour the features of your MacBook and macOS High
Sierra.

Compare the different MacBook models.
Unpack and set up your MacBook.
Maintain your laptop's battery the right way.

Familiarize yourself with the basics of macOS.



IN THIS CHAPTER

» ldentifying the important parts of
your Mac laptop

» Comparing the different MacBook
models

» Finding the best location for your
computer

» Unpacking, plugging in stuff, and
getting hooked up

» Playing with your bundled software

» Buying additional stuff you might
need

Chapter 1

Hey, It Really Does
Have Everything
| Need

ost action films have one scene in common: I call it “gearing up,”

because the good guys strap on their equipment in preparation for battle.

(The era doesn’t matter: You see “gearing up” scenes in Gladiator, Aliens,
and virtually every movie Arnold has made.) You're sure to see lots of clicking
straps and equipping of offensive weapons (and sometimes even a dash of war
paint). The process usually takes a minute or so, all told with whiplash camera
work and stirring martial music in the background.
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Well, fellow Mac road warrior, it takes only two seconds and one move — closing
the lid — for you to gear up. That’s because your MacBook is a self-contained
world, providing virtually all the essentials you’ll find on a desktop iMac or Mac
mini. This is indeed the second “decade of the laptop,” meshing nicely with your
smartphone and that wireless connection at your local coffee shop. You have
selected the right companion for the open road.

Unlike Apple’s other designs, such as the Mac mini, the Mac Pro and the iMac,
your MacBook looks like a PC laptop running Windows. (In fact, an Intel-based
Mac laptop can run Windows if you absolutely must.) But your laptop holds a
number of pleasant surprises that no PC laptop or tablet can offer — and, with the
MacBook, MacBook Air, and MacBook Pro, you’ll lose pounds and inches from
your chassis! In this chapter, I introduce you to the hardware and all the major
parts of the machine. You even find out how to unpack and connect your com-
puter. And, as frosting on the cake, I preview the software of which Apple is so
proud, as well as the accessories you should buy now rather than later.

Welcome to your Mac laptop, good reader. Gear up!

An Overview of Your Mac Laptop

8

Sure, your MacBook Pro might be about half an inch thin (a MacBook is even more
svelte than that — I get to that later in the chapter), but a lot of superb design
lives inside. You encounter the same parts you’d find in a desktop machine. In the
following sections, I discuss those important parts — both the stuff you can see
and the stuff shoehorned within.

The parts you probably recognize

Every laptop requires some of the same gizmos. Figure 1-1 helps you track them
down. Of course, as you’d expect, a computer has a body of sorts in which all the
innards and brains are stored, a display screen, a keyboard, a trackpad or other
pointing device, and ports for powering and exchanging data with outside toys.

That magnificent screen

What a view you have! Today’s Mac laptops feature a 12-, 13-, or 15-inch LED
display. LED screens use far less electricity than their antique CRT ancestors, and
they emit practically no radiation.

PART 1 Tie Myself Down with a Desktop? Preposterous!
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FEELING OUTDATED? NEVER!

Are you using an older MacBook? It seems that Apple’s product line changes every time
you tear a page from your 12-month calendar. In addition, every new generation of lap-
tops includes new whiz-bang features. Sometimes you can add those features sepa-
rately to your older machine, such as an external video camera, but you can't update
some things, such as your MacBook's motherboard. Sigh.

Here's my take on this situation: If your older laptop does what you need at a pace you
can accept, there’s no need to upgrade it.

Skeptical? Here's the proof: Before my upgrade to a MacBook Air, yours truly was lug-
ging around a pristine iBook G3, which booted macOS Tiger and did absolutely every-
thing | demanded. (A little more patience was required, certainly, but technology
authors are simply brimming with patience.) The moral: Avoid upgrade fever unless you
really need a new companion.

If you're the proud owner of an older MacBook, as long as it can run macOSmacOS High
Sierra you can still enjoy this book and discover new tips and tricks from it. Unless the
current breed of Intel-based Mac laptops has a feature you absolutely can’t use on

your mature MacBook (such as Thunderbolt 3 support), you can sail on with your cur-
rent computer, fiercely proud of The Bitten Apple that appears on the cover. (In fact,
older MacBooks have features that no longer appear on some current models, such as
Firewire ports, optical drives, and built-in Ethernet ports.) Although this book was writ-
ten with the current MacBook, MacBook Pro, and MacBook Air lines in mind, virtually
everything you read here still applies to your older laptop. Unless it's steam-powered,
of course.

Apple’s laptop screens offer a widescreen aspect ratio (the screen is considerably
wider than it is tall), which augurs well for those who enjoy watching movies. (A
favorite editor of mine loves it when I use the antique word augur, meaning to
predict or foretell.)

That reminds me: Throw away your printed dictionary! You won’t need it, because
macOS High Sierra includes the fantastic Dictionary widget. It uses the Internet to
retrieve definitions from the online Oxford American Dictionary site (and, yes, it
does contain augur). More on widgets in general in Chapter 3.
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FIGURE 1-1:
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FaceTime HD camera

LED screen

Keyboard Trackpad

The keyboard and trackpad

Hey, here’s something novel for your laptop. Unlike the external input devices on
a standard desktop computer, your MacBook has a built-in keyboard and trackpad
(which does the job of a mouse). The illuminated keyboard is a particular favorite
of mine, offering special keys for activing all sorts of features within macOS High
Sierra (as well as keys for adjusting brightness and volume).

The latest crop of Mac laptops feature a great trackpad design as well. The Force
Touch trackpad can sense the amount of pressure you apply with your fingers,
activating features in macOS High Sierra that used to require a right-click (like
displaying the definition of a word in a Pages document, or displaying a map of an
address in Contacts). The Force Touch trackpad can even provide tactile feedback
to your fingertips while you’re using some applications!

The MacBook, MacBook Air, and the MacBook Pro do not have an internal optical
drive (more on all three models later in this chapter). You can use the CD & DVD
Sharing feature in High Sierra to read discs remotely (from another Mac or PC on
your network), or you can pick up an external optical drive from Apple for about
$80. (Such is the price you pay for super-thin and super-light.)

Food for your ears

A machine this nice had better have great sound, and the Mac doesn’t disappoint.
You have a couple of options for Mac laptop audio:
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3 All Mac laptops sport built-in stereo speakers and two microphones to boot
(the 13-inch MacBook Pro with Touch Bar even has three microphones).

¥ Use the built-in headphone jack to connect your Mac's audio to a pair of
headphones, a more powerful (and expensive) external speaker system, or a
home stereo system. (There are also portable USB and Bluetooth speaker
systems that can provide better-quality audio.)

The power cable

Sorry, you can’t get a wireless power system — yet. (Apple’s working hard on this
one.) However, the MacBook Pro was the first major release of a laptop with a
magnetic power connector; the MacBook Air followed suit soon after. The MagSafe
2 connector on the MacBook Air reduces the chances of your pride and joy being
yanked off a desk when someone trips over the power cord, because the magnetic
closure pops off under significant strain. Now that’s sassy.

When you connect your power cable, an amber light on the cable connector indicates
that your battery is charging; a green light indicates that the battery is fully charged.

The MacBook Pro and MacBook use a different connector, called a USB-C, as a
power cable. The USB-C cable also does double-duty as a port for Thunderbolt and
USB-C compatible devices.

Many MacBook owners ask me whether they should disconnect the power after
the battery is fully charged or leave it connected. I leave the cable connected. It
won’t cause any damage to your MacBook, and you can continue to use your lap-
top while it’s charging. (Oh, and road warriors prefer a laptop battery that’s
always topped off when it’s time to go mobile!)

The power button

The latest MacBook Pro with Touch Bar actually turns on whenever you open it —
to turn this model off, you press and hold the Touch ID button at the far right side
of the Touch Bar.

Owners of the MacBook and MacBook Air, you still have a power button. It’s at the
upper-right corner of the keyboard, bearing the familiar “circle with a vertical
line” logo.

The FaceTime HD camera

Check out that tiny square lens above your screen. That’s a built-in FaceTime HD
camera, which allows you to chat with others in a videoconferencing environment
by using the Messages and FaceTime applications that come with High Sierra.
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You can even take photos with the camera, using the Photo Booth software that
comes with your laptop, or set up a travelin’ webcam. (If you need a higher-
resolution camera — or one that can be easily turned or tilted — check out the
discussion of a favorite of mine later in this chapter.)

information that could prevent visual embarrassment! As my Technical Editor
points out, you can also cover the lens for guaranteed privacy. (Some companies
TIP even offer plastic clips especially designed for covering the lens.)

‘ Note that a green light appears next to the lens when the camera is on — handy

The battery

All of Apple’s current laptop computers do not include user-replaceable batteries.
The battery is sealed inside the case and can be replaced only by an Apple techni-
cian. However, you should get several years of trouble-free operation from your
MacBook’s battery.

The holes called ports

The next stop on your tour of Planet Laptop is Port Central — those rows of holes
on the sides of your computer. Each port connects a different type of cable or
device, allowing you to easily add all sorts of functionality to your computer.

Each of these stellar holes has an icon to help you identify it. Here’s a list of what
you’ll find and a quick rundown of what these ports do.

The following connections are used for external devices and networking:

3 Thunderbolt/Thunderbolt 2/Thunderbolt 3 port: The Thunderbolt port
(and its faster descendents, Thunderbolt 2 and Thunderbolt 3) is the expan-
sion racehorse of today’s MacBooks. It offers the fastest data transfer rates
and the ability to add all sorts of peripherals, from external hard drives to
monitors to wired Ethernet connections. (A peripheral is another silly techno-
nerd term that means a separate device you connect to your computer.)
Thunderbolt 3 devices are somewhat more expensive than their Thunderbolt
2 and USB cousins, but prices are dropping as more Thunderbolt 3 peripher-
als arrive on the market.

Although Thunderbolt-compatible monitors are available, they're significantly
more expensive than a standard display. Luckily, you can also buy an adapter
for this port that allows you to send the video signal from your laptop to
TIP another VGA, DVI, or HDMI monitor.

3 USB port(s): Short for universal serial bus, the familiar USB port is the jack-of-
all-trades in today's world of computer add-ons. Most external devices you
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want to connect to your laptop (such as portable hard drives, scanners, and
digital cameras) use a USB port, including the iPod. (Today's PCs also include
USB ports, allowing you to share external USB peripherals like optical drives
and scanners between your MacBook and your desktop PC.) USB 3.0 connec-
tions are much faster than the old USB 2.0 standard, but they still accept USB
2.0 devices running at the slower speed.

Get the lowdown on Thunderbolt, Thunderbolt 2 and 3, and USB ports in
Chapter 21.

The MacBook and the MacBook Pro with Touch Bar use a unique USB-C port
that allows you to charge the laptop, connect a Thunderbolt 3 or USB 3.0
device, or connect an external monitor or projector — all from one port!
However, to make the USB 3.0 connection you'll need a USB-C to USB adapter
(about $20), and a USB-C AV Multiport adapter (about $70) to connect an
external display.

3 Ethernet port: Older MacBook Pro laptops include a standard gigabit
(10/100/1000) Ethernet port, so the laptop is ready to join your existing wired
Ethernet network. (Alternatively, you can go wireless for your network
connection; more on that in the next section and in Chapter 12.) Because
today’s MacBook, MacBook Air, and MacBook Pro are designed to be com-
pletely wireless, they don't have a built-in wired Ethernet port. If a wired
connection is a necessity, you can add a Thunderbolt-to-Gigabit-Ethernet (or
USB-to-Gigabit Ethernet) adapter to add a wired network port to your laptop.
(Apple sells one for about $35.) Or you can invest in a laptop dock with a wired
Ethernet port (which | discuss at the end of this chapter).

3 SD/SDXC card slot: The MacBook Air includes an SD (Secure Digital) or SDXC
(Secure Digital Extended Capacity) card slot, allowing you to plug SD or SDXC
memory cards from digital cameras, cellphones, and portable devices directly
into your laptop.

3 Headphone/optical output port: Last (but certainly not least), you can send
the high-quality audio from your rectangular beast to a set of standard
headphones or an optical digital audio device such as a high-end home
theater system.

Don’t forget the parts you can't see

When you bought your new digital pride and joy, you probably noticed a number
of subtle differences between the MacBook, MacBook Air and the pricier MacBook
Pro models. I call these differences the Important Hidden Stuff (or IHS, if you’re
addicted to acronyms). They’re just as important as the parts and ports you
can see.
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Internal storage devices are as follows:

3 CPU: Today's Mac laptops feature the latest Intel Core i5 and i7 processors. Of
course, the faster the processor, the better. (Definitely not rocket science.)

¥ Storage: Today's MacBook models are equipped with solid-state drives that
use memory chips. The drive capacities are different across the entire
MacBook product line.

Solid-state drives have a number of advantages over traditional magnetic
hard drives: You'll find no moving parts in a solid-state drive, and it offers
better performance than a standard hard drive. Think of the solid-state drive
as an internal USB flash drive that uses RAM chips rather than magnetic
platters to hold your data.

Wireless communications devices include the following:

3 Wireless Ethernet: “Look, Ma, no wires!” As mentioned earlier, you can
connect your laptop to an existing wireless Ethernet network. All current Mac
laptops have built-in AirPort Extreme hardware. With wireless connectivity,
you can share documents with another computer in another room, share a
single high-speed Internet connection between several computers, or enjoy
wireless printing. Truly sassy!

Although Apple would want you to build your wireless wonderland with an

@ Apple AirPort Extreme Base Station or an AirPort Time Capsule unit — go
figure — you can use your Mac with any standard 802.11b/g/n/ac wireless
TIP network. And, yes, PCs and Macs can intermingle on the same wireless

network without a hitch. (Scandalous, ain't it?)

3 Bluetooth: Let's get the old “digital pirate” joke out of the way: “Arrgh, matey, |
needs me a wireless parrot.” (Engineers again . . . sheesh.) Although strangely
named, Bluetooth is another form of wireless connectivity. This time, how-
ever, the standard was designed for accessories such as your keyboard and
mouse and devices like wireless headphones and your smartphone. (The
latest Macs support version 4.2 Bluetooth hardware.)

Here’s the hidden display device:

¥ Video card: The standard Intel video hardware that's built in to today’s
MacBooks is fine for typical home and business laptop applications. However,
if your applications rely heavily on high-speed 3D graphics or digital video,
you'll be pleased as punch to discover that today’s 15-inch MacBook Pro
model can be ordered with the muscle-bound AMD Radeon Pro 560. This card
is well suited to high-end mobile 3D modeling, video editing on the road, and,
well, honestly, blasting the latest video game enemies into small smoking
pieces with aplomb.
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Meet the MacBooks

FIGURE 1-2:
Behold the
MacBook Air.

So far in this chapter, I’ve discussed the common hardware shared by today’s
MacBook models. Now it’s time to compare the MacBook, MacBook Air, and Mac-
Book Pro with an eye toward selecting the right one for you. (Unless you decide to
pick up one of each. Certainly an elegant choice, but not everyone has that option!)

For example, consider the least expensive MacBook: The MacBook Air, shown in
Figure 1-2, is unique for both its size and weight. And yet the Air is just like the
MacBook and MacBook Pro. Well, mostly.

“Hold on, Mark. How can it be so singular and yet share so much with its road
warrior siblings?” I answer that question in the following sections, which discuss
the many similarities and the handful of striking differences between the three
laptop models in the MacBook line. If you’re considering buying an Apple laptop,
these sections can help you decide whether you’d like to go ultra-thin or stick
with the more traditional (and slightly thicker) laptop crowd.

One thing’s for sure: Apple never creates a mundane design!

Comparing the MacBooks

Do you remember when Apple introduced the first iMacs? Although they shared
the same basic components as any computer — a monitor, keyboard, ports,
speakers, and cables — the iMac was revolutionary because it was completely
self-contained. And it came in colors. And it didn’t have a floppy drive. In fact,
Apple had redesigned the common computer with the focus on style and ease of use
and had scrapped the floppy drive (and rightly so, seeing as how floppies had
become practically useless and were unreliable to boot).

I consider the MacBook, MacBook Air, and the MacBook Pro to be extensions of
the iMac revolution. With these designs, Apple has focused this time on physical
dimensions and weight and has tossed out anything that isn’t absolutely necessary
for the lecture hall, boardroom, or city park. However, I’'m happy to note that
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these ultra-light MacBooks are neither toys nor bare-bones netbooks. In fact,
both the MacBook and the MacBook Air share some of the features of the high-end
MacBook Pro.

What are the similarities?

Consider the similarities between the different models:

»

»

»

»

»

»

»

Widescreen display: Each model sports a widescreen LED backlit display. The
MacBook sports a 12-inch display, the MacBook Air offers a 13-inch display,
and the MacBook Pro is the star of the show, with the highest resolution
available on any Apple laptop. (It's available in a 13-inch or 15-inch display.)

Intel processor power: All three models can be ordered from Apple with
Core i5 or i7 power, while the MacBook also offers a lower-cost Intel Core m3
processor option.

Keyboard and trackpad: All three MacBook models offer a backlit keyboard.
The MacBook and MacBook Pro offer the Force Touch trackpad, while the
MacBook Air features the older Multi-Touch trackpad. The new Touch Bar
available on the MacBook Pro offers a number of nifty features within your
favorite applications. (Read more about Multi-Touch and the Touch Bar in
Chapter 3.)

High Sierra: All current laptops from Apple naturally run the latest version of
macOS with aplomb.

FaceTime: Every MacBook is video ready, using a built-in FaceTime camera.
You can record audio with the built-in microphones as well.

Sealed battery: You can't swap batteries with any of Apple's current MacBook
line, because the battery is sealed inside. (Think iPad and iPhone.)

Wireless support: The MacBook, MacBook Air, and MacBook Pro each have
built in the latest AirPort Extreme hardware (802.11ac). All three models
feature built-in Bluetooth hardware. (Read more about AirPort Extreme in
Chapter 11.)

I think most Apple laptop owners would agree that these major MacBook features
show there’s no underpowered pushover in the lineup!

So what's so flippin’ radical?

I’m glad you asked! Here’s the checklist of striking differences that set the Mac-
Book and MacBook Air apart from the MacBook Pro:

»

Physical dimensions: You need a thin laptop? You've come to the right place!
The current Air laptop measures a mere 0.68 inches in height (at its tallest
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point) when closed. (If you think that's mind-blowing, the MacBook is even
thinner, measuring just 0.52 inches in height when closed!) Oh, and hold

on to your chair for this one: The MacBook is also the lightweight champ at
2.03 pounds! (That's a couple of pounds you won't be carrying around all day
at that convention expo. Take it from this traveler: You will feel the refreshing
difference in just an hour or two.) By comparison, the 13-inch MacBook Pro
weighs 3.02 pounds, and the 15-inch MacBook Pro is a (comparatively) hefty
4.02 pounds.

¥ Cost: At the time of this writing, an entry-level 13-inch MacBook Air will set
you back $999. The 12-inch MacBook is slightly more expensive at $1299. By
comparison, the 13-inch MacBook Pro is $1499, while the 15-inch MacBook
Pro model starts pricier at $2399.

3 Ports: As | mentioned earlier in this chapter, the MacBook offers only two
ports, the USB-C (which requires adapters for use as a USB 3.0 and external
video port) and a headphone jack. The MacBook Air offers two conventional
USB 3.0 ports, a headphone jack, a SDXC card slot, and a Thunderbolt 2 port
for connecting an external monitor or high-speed drive. The MacBook Pro
includes either two or four USB-C/Thunderbolt 3 ports and a headphone jack.

As | mentioned earlier, all current MacBooks lack a wired Ethernet port. The latter
two models can use a Thunderbolt-to-Gigabit Ethernet adapter from Apple, while

the MacBook will require a USB-C to Gigabit Ethernet adapter. (Rats.)
REMEMBER

¥ Sealed case: You can't add or replace RAM modules on the MacBook,
MacBook Air, or the MacBook Pro. If you haven't ordered your laptop yet, it's a
very good idea to configure your MacBook with the maximum RAM it can
carry, because you won't be able to add more in the future.

3 No built-in optical drive: Whoa, Nellie! This difference is a big one, and it
applies to all current MacBook models. Apple decided that owners of these
slimmer, trimmer laptops are likely to use a wireless connection for transfer-
ring files and media. But what if you have to reinstall applications available
only on disc? If you need to read or burn discs, you can buy a separate
external USB SuperDrive for about $80, or you can use the Remote Disc
feature and share the drive on another computer. (More on Remote Disc in
the later section “Sharing a CD or DVD drive."”)

As you can see, these striking differences make the choice between a MacBook,
MacBook Air, and a MacBook Pro easy indeed. To wit:

¥ The MacBook and MacBook Air models are designed for the traveler who
appreciates minimum weight and size. These folks see a laptop as a race car:
nimble, with reduced weight and no unnecessary frills. (Think of a typical
NASCAR entry: Who needs an expensive stereo or air conditioning?)
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3 The MacBook Pro is all about the brilliant Retina display, of course, and it's
considerably faster than either the MacBook or the MacBook Air. The
MacBook Pro appeals to presenters, graphics professionals, and video editors,
who appreciate the higher-resolution display and the better performance.

Look, Ma, no moving parts!

You’re probably familiar with the common species of usbius flashimus, more com-
monly called the USB Flash drive. With one of these tiny devices, you get the
equivalent of a 4—512GB hard drive that plugs into a USB 2.0 or 3.0 port, allowing
you to carry your data with you as you jet across the continents. But have you ever
asked yourself, “Self, why don’t they make internal drives that use this same
technology?”

Actually, dear reader, solid-state drives have been around for a number of years
(think iPod shuffle and iPod nano). Unfortunately, however, the solid-state mem-
ory used in today’s flash drives gets pretty expensive as capacity increases. In fact,
cost has been the limiting factor, because a solid-state drive offers a number of
advantages that set it apart from a conventional magnetic hard drive:

3 No moving parts: Unlike a typical magnetic hard drive, you find no read-write
heads and no magnetic platter — just gobs of happy silicon memory chips. In
effect, a solid-state drive works along the same lines as your MacBook's
system RAM. Unlike your Mac's RAM, though, a solid-state drive doesn't lose
the data it stores when you turn off your laptop. As you can imagine, no
moving parts on a computer in motion is superior on two levels:

The solid-state drive never wears out or needs replacing.

If your laptop is accidentally abused (gets knocked off your desk), it's far
less likely that you'll lose a hard drive's worth of priceless data when it hits
the ground.

3 Speed: Oh my goodness, is this thing fast! Your MacBook will boot, restart, or
awaken in far less time, and everything you do on your laptop will benefit
from the speed boost. A solid-state drive can read data far faster than a
conventional magnetic hard drive.

3 Power usage: Forget your hard drive spinning up from sleep mode. The
solid-state drive uses far less power than a conventional hard drive, resulting
in significantly longer battery life.

¥ Blessed silence: The solid-state drive is completely silent. (No more of that
gargling noise while the disk is accessed. Sweet.)
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WARNING

What if | need that pesky optical drive?

Can a laptop survive in the jungle that is Real Life without a DVD drive? The terse
answer is no. I’ll be honest: Ripping an audio CD or watching a DVD movie without
an optical drive is impossible. (Rather like a cheap sports car.) And the wonders of
digital media are a big part of the iWorld. So what was Apple thinking?

First, a bit of explanation. Today’s DVD drives are thin, but not MacBook thin. To
create these stunning designs with truly revolutionary dimensions, Apple engi-
neers had to leave out the drive. However, if you own a current Mac laptop, you
have two choices when it comes to reading the contents of a CD or DVD: Go exter-
nal, or find out how to share.

The external USB route

I have no problem toting around an external USB DVD burner with a MacBook Air.
Heck, half the time you’re likely to leave it at home, because you don’t install
software every day. The folks at Cupertino want you to download your movies
from the iTunes Store and your software from the App Store, so if you follow the
Apple Path, you still don’t need an optical drive!

A USB SuperDrive from Apple costs a mere $80, and it can read and write DVDs as
well as any built-in drive.

You can also use any third-party USB DVD drive that’s compatible with Apple’s
laptops and macOS High Sierra.

Sharing a CD or DVD drive

The other option for installing software or reading a DVD on your MacBook is the
CD/DVD Sharing feature within High Sierra. Sharing is an option if you have a
wired or wireless network (see Chapter 11) with at least one of the following com-
puters available:

3 A Mac running OS X Tiger or later

3 A PC running Windows 7 through Windows 10 (and a Windows application
supplied by Apple with your MacBook)

You can only read from a shared optical drive. You can’t write data to the remote
drive, even if that drive is a DVD recorder.

On the Mac computer with the optical drive, open System Preferences, click the
Sharing icon, and select the DVD or CD Sharing check box. Note that you can set
whether the Mac will request your permission when another computer attempts
to share the drive.
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On a PC, display the Control Panel, click the DVD or CD Sharing icon, and then
select the Enable DVD or CD Sharing check box. Again, you can specify that per-
mission is required if security is a concern.

After you set up the shared drive, just load the disc and select the Remote Disc
item in any Finder sidebar. (Remote Disc appears under the Devices heading in the
sidebar.) Now you can access the drive as if it were directly connected to your
MacBook, MacBook Air, or MacBook Pro. Ah, technology!

Location, Location, Location!

If you choose the wrong spot to park your new laptop, I guarantee you’ll regret it.
Some domiciles and office cubicles don’t offer a choice. You have one desk at
work, for example, and nobody will hand over another one. But if you can select a
home for your MacBook, consider the important placement points in this
section:

3> Keep things cool. Your new laptop is silent, but that super-fast Intel processor
generates heat. Make sure that the location you choose is far from heating
vents and shielded from direct sunlight. | also recommend a laptop cooling pad,
which elevates the base of your laptop to allow air to circulate underneath
(some are even equipped with their own fans). Although you can stow your
MacBook in the close confines of a bag or backpack while it's in Sleep mode,
avoid putting that laptop away while it's hot! Let your MacBook Pro cool off first.

3 Outlets are key! Your computer needs at least one nearby outlet, and
perhaps as many as two:

A standard AC outlet (using a current adapter if you're traveling abroad, if
necessary)

A nearby Ethernet jack (if you use a built-in Ethernet port for connecting to
a wired Ethernet network, or an Ethernet adapter)

If you prefer to send your data over the airwaves, consider wireless
@ networking for your Mac. | discuss everything you need to know in
Chapter 11.
TIP
3 Don't forget the lighting. Let me act as your mom. (I know that's a stretch, but
bear with me.) She'd say, “You can’t possibly expect to work without decent
lighting! You'll go blind!” She's right, you know. You need a desk lamp or floor lamp
at a minimum if you need to refer to books or documents often in your work.

3 Plan to expand. If your laptop hangs out on a desk, allow an additional foot of
space on each side. That way, you have room for external peripherals, more
powerful speakers, and an external keyboard and mouse if you need one.
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If you want to keep an external keyboard handy, consider using a laptop shelf.
These Plexiglas or metal stands elevate your laptop several inches above the
desk, putting the screen at a better ergonomic position and allowing you to
TIP park your keyboard and external mouse underneath.

Unpacking and Connecting Your Laptop

You'll love the following sections. They’re short and sweet because configuring a
laptop on your desktop is a piece of cake. (Sorry about the cliché overload, but this
really is easy.)

Unpacking for the road warrior

Follow these guidelines when unpacking your system:

3 Check for damage. I've never had a box arrive from Apple with shipping
damage, but I've heard horror stories from others (who claim that King Kong
must have been working for That Shipping Company).

Check all sides of the box before you open it. If you find significant damage,
take a photograph (just in case).

TP ¥ Search for all the parts. When you're removing those chunks o’ foam, make
certain that you've checked all sides of each foam block for parts snuggled
therein or taped for shipment.

3 Keep all packing materials. Do not put the box and packing materials in the
trash. Keep the box and all packing materials for at least a year, until the
standard Apple warranty runs out. If you have to ship your laptop to an Apple
service center, the box and the original packing are the only way for your
machine to fly.

And now, a dramatic Mark’'s Maxim about cardboard containers:

Smart computer owners keep their boxes far longer than a year. If you
sell your laptop or move across the country, for example, you'll want

MARK'S that box. Trust me on this one.™
MAXIMS
¥ Store the invoice for safekeeping. Your invoice is a valuable piece of paper.

Save your original invoice in a plastic bag, along with your computer’s
manuals, original software, and other assorted hoo-hah. Keep the bag on a

shelf or stored safely in your desk, and enjoy a little peace of mind.
REMEMBER
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3 Read the Mac’s manual. “Hey, wait a minute, Mark. Why do | have to read
the manual from Apple along with this tome?” Good question, and here’s the
answer: The documentation from Apple might contain new and updated
instructions that override what | tell you here. (For example, “Never cut the red
wire. Cut the blue wire instead.” Or something to that effect.) Besides, Apple
manuals are rarely thicker than a restaurant menu.

You can always download the latest updated manuals for Apple computers in
electronic format from Apple’s website. (Adobe’s PDF format is the standard
for reading documents on your computer. You can open and display any PDF
document in High Sierra by using the Preview application or the Quick Look
feature.) | always keep a copy of the PDF manual for my MacBook Air on my
drive, justin case.

Connecting Cables 101

Your laptop makes all its connections simple, but your computer depends on you
to get the outside wires and thingamabobs where they go.

The absolutely essential connection

After your new Mac is resting comfortably in its assigned spot (I assume that’s a
desktop), you need to make just one required connection: the power cable. First
plug the cable into the corresponding MagSafe 2 or USB-C port on the MacBook,
and then plug ’er into that handy AC outlet. After your battery is completely
charged, you can go mobile at a moment’s notice.

Adding the Internet to the mix

If you have high-speed Internet service, or if you’re in an office or school with a
local computer network, you can probably connect through your older MacBook’s
built-in Ethernet port (or by using an adapter with your Thunderbolt or USB-C
port). You make two connections:

1. Plug one end of the Ethernet cable into the Ethernet port (or the adapter
on a current MacBook, MacBook Air, or MacBook Pro).

2. Plug the other end of the Ethernet cable into the Ethernet port from your
network.

Your network port is probably one of the following: an Ethernet wall jack, an

Ethernet hub or switch, or a cable or DSL Internet router (or sharing device).

Will you be joining a wireless network? If so, you can find the information you
need about configuring High Sierra for wireless networking in Chapter 11.
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Great, a Lecture about
Handling My Laptop

Proper handling of your laptop is important, so take a moment to read the Rules
of Proper Laptop Deportment. Okay, perhaps I’m lecturing a bit, but a little com-
mon sense goes a long way when handling any computer equipment, and your
laptop is no different. (Scolding mode off.)

Keep these rules in mind while opening and carrying your laptop:

3 The cover is your friend. Open your laptop's cover slowly, without jerking or
bending it.

3 Close it before you move it. By closing your laptop, you put your macOS
operating system into sleep mode, and (if your older MacBook uses a
magnetic hard drive for storage) the hard drive automatically spins down,
making it safer to move. The laptop is still on; it will spring back to life after
you open the cover.

3 Don't stack stuff on your laptop. You'd be surprised how many horror
stories I've heard about laptop owners piling a stack of books or other heavy
stuff on their computers. Remember that LED display? Made of glass?

3 Be nice to your keyboard. Don't press those keys too hard! Use the same
amount of pressure you use with a desktop computer keyboard.

3 Keep food and drinks far away. Care to turn your laptop into an expensive
doorstop? Go ahead and park your soda next to it. (Oh, and crumbs are
perfect if you're interested in buying replacement keyboards.)

3 Keep your laptop as level as possible. Using your older Mac laptop while it's
tilted too far in any direction can eventually cause problems with your
magnetic hard drive. | kid you not. (If your MacBook uses a solid-state hard
drive, of course, this rule does not apply.)

An Overview of Mac Software Goodness

The following sections answer the most common novice computer question:
“What the heck will I do with this thing?” You find additional details and exciting
factoids about the software you get for free, software you’ll want to buy, and stuff
you can do on the Internet.
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What comes with my laptop?

Currently, Apple laptops ship with the following major software applications
installed and ready to use:

3 macOS High Sierra: Naturally, your MacBook comes preloaded with
High Sierra.

3 Apple’s digital lifestyle suite: You know you want these applications! They
turn your Mac into a digital hub for practically every kind of high-tech device,
including camcorders, digital cameras, tablets, portable music players, and
even smartphones.

Chapters 12 through 15 focus on the major applications that will appeal to
MacBook owners: iTunes, Photos, iMovie, and GarageBand.

3 Apple’s digital productivity suite: Owners of new MacBooks can download
all three of Apple’s great productivity applications — Pages, Numbers, and
Keynote — for free, using the App Store. Pages is a desktop publishing jewel,
Numbers is a great spreadsheet tool, and Keynote is a superb slideshow/
presentation application. Chapters 16 through 18 are your guides to the basic
functions of all three applications. ‘Nuff said.

The installed software on your MacBook might change as new programs become
available.

REMEMBER

Connecting to the Internet from your lap

What is a modern computer without the Internet? Apple gives you great tools to
take full advantage of every road sign and off-ramp on the Information Super-
highway right out of the box:

3 Web surfing: | use Apple's Safari web browser every day. It's fast and
well-designed, with features such as tabbed browsing and Facebook and
Twitter sharing.

If tabbed browsing sounds like ancient Aztec to you, don't worry. Chapter 8 is
devoted to Safari.

¥ Quick information: Dashboard widgets can search the entire Internet for
stocks, movie listings, airline schedules, dictionaries, and foreign language
translations. | explain the Dashboard in Chapter 3.

¥ Instant messaging: Messages lets you use your MacBook to chat with others
around the world for free on the Internet — by keyboard, voice, or full-color
video. This is awesome stuff straight out of Dick Tracy and Buck Rogers. If
you've never seen a video chat, you'll be surprised just how good your friends
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REMEMBER

TIP

and family look! You can also use the FaceTime application to video chat with
folks who have an iPhone, iPad, or iPod touch, as well as another Mac.

Always wear a shirt when videoconferencing.

3 Email: Soldier, Apple has you covered. The Apple Mail application is a
full-featured email system, complete with defenses against the torrent of junk
mail awaiting you. (Imagine a hungry digital predator with an appetite for
spam.) Send pictures and attached files to everyone on the planet, and look
doggone good doing it.

Applications that rock

Dozens of small applications are also supplied with macOS High Sierra. I mention
many of them in later chapters, but here are three good examples to whet your
appetite:

3 DVD Player: If your MacBook has an internal or external DVD drive, put all
that widescreen beauty to work and watch your favorite DVD movies with
DVD Player! You have all the features of today’s most expensive stand-alone
DVD players, including a spiffy onscreen control that looks like a remote.

3 Contacts: Throw away that well-thumbed collection of fading addresses on
paper. Use the High Sierra Contacts application to store, search, and recall just
about any piece of information on your friends, family, and acquaintances.

3 Chess: This isn't the chessboard your dad used! Play the game of kings against
a tough (and configurable) opponent — your MacBook — on a beautiful 3D
board. Heck, your Mac even narrates the game by speaking the moves!

You can use the data you store in your Contacts in other Apple applications
included with High Sierra, such as Apple Mail and Messages.

Boot Camp For Dummies

macOS High Sierra includes one particularly exciting feature for Windows switch-
ers: You can use the Apple Boot Camp utility and your licensed copy of Windows 8
or 10 to install and boot Windows on your Intel-based Mac laptop!

Boot Camp creates a Windows-specific partition (or section) on your drive, where
all your Windows files are stored. Other than the slightly strange key assignments
you have to remember, Boot Camp is reliable and easy to use. However, I strongly
urge you to back up your laptop on a regular basis; inviting Windows onto your
Mac laptop invites potential viruses as well.
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Apple’s Boot Camp Assistant provides step-by-step instructions, making it easy
to configure your laptop for Windows. To run the Boot Camp Assistant, click the
Launchpad icon in the Dock, click the Utilities folder icon, and then click the Boot
Camp Assistant application icon. You’ll find more detailed information on using
Boot Camp in Chapter 19.

Other Stuff That Nearly Everyone Wants

26

No man is an island, and no computer is either. I always recommend the same set
of stuff for new PC and Mac laptop owners. These extras help keep your new com-
puter clean and healthy (and some make sure you’re happy as well):

3 Alaptop sleeve or case: Most laptop owners eschew the traditional bulky
laptop bag because a bag broadcasts the fact that you're carrying a valuable
MacBook (and adds yet another item to carry on your trip). On the other
hand, if you pack your MacBook in a briefcase, book bag, or backpack, you
need to provide protection from bumps and scratches (make sure that any
sleeve or case you buy provides padding around the entire computer, and
not just on the top surface). That's where a laptop sleeve or thin case comes
in. | use the very cool BookBook hardback leather case from Twelve South
(www . twelvesouth . com), which looks — you guessed it — like an old-
fashioned leather-bound book. (I think it makes me appear scholarly while
disguising my MacBook.) The BookBook (shown in Figure 1-3) is available for
all sizes of MacBooks, costs about $80, and provides long-lasting, cushioned
protection for your expensive road warrior computer.

3 An external camera: Your MacBook has a built-in FaceTime camera, but
many folks prefer a stand-alone external camera they can pan, tilt, and point
where they like (especially moviemakers who need high-resolution video clips
of whatever's happening around them). | carry the stylish steel aGent V6 HD
webcam from Liquid Digital Solutions (www . liquiddigital.com.au), shown
in Figure 1-4, with my MacBook Air. It provides full 1080p high-definition
recording in iMovie and connects to a USB port. You can choose to clip the
webcam to your MacBook or use the desktop stand on any flat surface. The
video quality is excellent, with auto exposure and low-light compensation for
environments with less-than-perfect illumination. The aGent V6 HD webcam
costs about $100.

3 Surge suppressor: Even an all-in-one computer like your laptop can fall prey
to a power surge. | recommend using one of these:

A basic surge suppressor with a fuse can help protect your MacBook from an
overload.
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LD,
TECHNICAL
STUFF

A UPS (uninterruptible power supply) costs a little more but does a better job
of filtering your AC line voltage to prevent brownouts or line interference
from reaching your computer.

Of course, your laptop's battery immediately kicks in if you experience a
blackout, so a UPS is less important for your MacBook. However, any
computer tech will tell you that filtered AC current is far better for your
laptop, and your UPS can also provide backup power for external devices
that don't have a battery.

3 Alaptop docking station: Will your MacBook often do double duty as both a

»

WARNING »

»

»

desktop computer and a mobile powerhouse? If so, a laptop docking station
will prevent you from disconnecting a bird’s nest of USB and Thunderbolt
cables each time you hit the road. In essence, you need to unplug only one
connection between your MacBook and the docking station, and all your
external desktop peripherals — monitor, backup hard drive, USB trackball, and
such — remain blissfully in place. When your MacBook returns to the desktop,
you simply reconnect that one Thunderbolt cable, and you're back in business.

My docking station of choice is the excellent Thunderbolt Express Dock from
Belkin (www .belkin.com), shown in Figure 1-5. It requires only one
Thunderbolt cable connection to your MacBook. In turn, it provides two
Thunderbolt ports, three USB 3.0 ports, a wired Ethernet jack (perfect for
MacBooks), a FireWire 800 port, and even microphone and headphone/
speaker jacks! The Thunderbolt Express Dock is about $200 online. As a
MacBook owner who likes to “grab and go,” | say it's worth every penny.

Screen wipes: Invest in a box of premoistened screen wipes to keep your
screen pristine. Your MacBook’s screen can pick up dirt, fingerprints, and
other unmentionables faster than you think.

Make sure your wipes are especially meant for LED, LCD, or laptop computer
screens.

Blank CDs and DVDs: If you're using a MacBook with an internal or external
optical drive, you'll want blank discs. Your choices are

CD-R (record once) and CD-RW (record multiple times)
DVD-R (record once) and DVD+RW (record multiple times)

Cables: Depending on the external devices and wired network connectivity
you'll be using, these are

A standard Ethernet cable (for wired networks or high-speed Internet)
Thunderbolt or USB 3/USB-C cables for devices you already have

Wrist rest: You might have many reasons to buy a new Mac laptop, but |
know a bad case of carpal tunnel syndrome is not one of them. Take care of
your wrists by carrying a keyboard wrist rest in your laptop bag.
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FIGURE 1-3:
The BookBook
case provides
protection and
camouflage for
your MacBook.

FIGURE 1-4:
Break out your
aGent V6 HD
webcam for
on-the-spot
moviemaking.

FIGURE 1-5:

A plethora of
ports provided
by Belkin's
Thunderbolt
Express Dock.
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Chapter 2

Turning On Your
Portable Powerhouse

n Chapter 1, you got as far as unpacking your Mac laptop and connecting a few

cables to it. But unless you bought this computer solely as a work of modern art,

it’s time to turn on your MacBook and begin living The Good Life. (Plus, you
still get to admire the design of your Apple laptop while using iTunes.) After you
get your new beauty powered on, I show you how to run an initial checkup of your
laptop’s health. Then I wax enthusiastic about maintaining (and even augment-
ing) your laptop battery.

I also familiarize you with the initial chores you need to complete before settling
in with your favorite applications. These tasks include setting up macOS and mov-
ing the data and settings from your existing computer to your MacBook, MacBook
Pro, or MacBook Air.
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In this chapter, I assume that either macOS High Sierra was preinstalled on your
Mac, or you just completed an upgrade to High Sierra from macOS Sierra.

Tales of the On Button

30

TIP

The power switch on current MacBook and MacBook Air models is located on the
right side of the keyboard. To turn on your laptop, simply press the button. If
you’re the proud owner of a new MacBook Pro or MacBook, all you have to do is
open your laptop!

You hear the pleasant start-up tone that’s been a hallmark of Apple computers for
many years. Don’t be alarmed if you don’t immediately see anything onscreen; it
takes a second or two for the initial Apple logo to appear.

In my experience, sometimes a quick press of the power button on some Mac lap-
top models just doesn’t do it. Rather, you must hold down the button for a couple
seconds before the computer turns on.

If your Mac laptop ever locks up tight, and you can’t quit an application (I discuss
quitting in Chapter 3), the power button gives you another option: Hold it down
for five seconds or so, and your MacBook shuts off completely, even if your laptop
is locked up tight. If you’re using a MacBook Pro with a Touch Bar, press the
Touch ID sensor and hold it to turn your laptop off, then press the Touch ID sensor
again to turn your laptop back on.

As the Apple logo appears, you see a familiar progress bar indicator — that indica-
tor is the sign that your MacBook is loading High Sierra and checking the internal
hardware for problems. Sometimes the progress bar can take a bit longer to disap-
pear. As long as it’s moving, though, something good is happening: Your laptop is
busy loading certain file-sharing, networking, and printing components (and so
on). This process won’t take long.

At last, your patience is rewarded, and your MacBook presents you with the initial
High Sierra setup screen, shown in Figure 2-1.
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% Install macOS High Sierra  Edit  Window

Install macOS High Sierra

macQOS High Sierra
FIGURE 2-1: To set up the installation of macOS High Sierra, click Continue.
The macOS High
Sierra setup
screen — good
things are
happening!

Mark’s Favorite Signs of a Healthy Laptop

Before you jump into the fun stuff, don’t forget an important step — a quick pre-
liminary check of the signs that your new mobile Mac survived shipment intact
and happy.

If you can answer “yes” to each of these questions, your MacBook likely made the
trip without serious damage:

1. Doesthe laptop’s chassis appear undamaged?

It's pretty easy to spot damage to your MacBook’s svelte design. Look for
scratches, dents, and puncture marks.

2. Does the LED screen work, and is it undamaged?

Does the cover open smoothly? Are any individual dots (or pixels) on the LED
screen obviously malfunctioning? Bad pixels appear black or in a different color
than everything surrounding them. (Techs call these irritating anarchists dead
pixels.) A 13-inch MacBook Pro screen has well over two million pixels, and,
unfortunately, some new LED screens include one or two dead ones.
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3.

Do the keyboard and trackpad work?

Check your MacBook's built-in trackpad by moving your finger across its surface;
the cursor should move on the screen. To check the keyboard, press the Caps
Lock key on the left and observe whether the Caps Lock light turns on and off.

If you do notice a problem with your laptop (and you can use your Safari browser
and reach the web), you can connect with an Apple support technician at www.
apple.com. If your MacBook remains dead — like an expensive paperweight —
and you can’t get to the Internet, you can check your phone book for a local Apple
service center, or call the AppleCare toll-free number at 1-800-275-2273.
Chapter 19 also offers troubleshooting information.

You Won't Lecture Me about
Batteries, Will You?

32

No, this isn’t a lecture. In fact, the only lecture I put you through in this book
concerns backing up (which, naturally, you should do). Instead, consider these tips
as your rules of the road for monitoring and charging your battery:

»

»

TIP

Recharge your laptop in sleep mode or when powered off. The battery
recharges faster when your laptop is off or in sleep mode. (I go into more
detail on sleep mode in Chapter 5.)

Keep your laptop plugged into an AC socket (or a car inverter, which
plugs into your car’s power outlet) when possible. | take every opportunity
to top off my laptop's battery, and so should you.

If you don't have much time to charge your battery before you're away from
an AC socket — say, half an hour — don't use your MacBook while it's plugged
in and charging. That way, your battery will gain the maximum benefit from
the charge time. (When you're using your MacBook while it's charging, the
charging process takes much longer.)

3 Save your juice. To get the most juice you can scavenge, here are some easy tricks:

Turn off your laptop, or close it to enter sleep mode.

Turn off unnecessary hardware. To conserve battery power as much as
possible, disconnect any unnecessary USB or Thunderbolt devices. Also
turn off your Wi-Fi and Bluetooth wireless hardware if you're not con-
nected to a network. (I cover Wi-Fi wireless networking in Chapter 11.)
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Reduce the brightness of the display from your laptop’s keyboard by pressing
the F1 key.

Avoid using processor-intensive applications (for example, Photoshop or iMovie).

3 Monitor your battery level from the Finder menu. | love the battery-monitoring
system built into High Sierra. Your laptop's battery life can be displayed in the Finder
menu as either a simple battery icon or — my favorite — as a percentage of power
remaining (with a fully charged battery registering at 100%). To display the percent-
age, click the battery icon on the Finder menu, and choose Show Percentage.

Keep in mind that the percentage shown is estimated by using your current
System Preferences settings and power usage. So if you change your Energy
Saver settings or remove a USB device that draws power from your laptop,
you see that change reflected in the battery meter. Figure 2-2 shows the
battery meter in Percentage view.

3 Calibrate your battery. You can “train” your battery to provide the maximum
charge by calibrating it, which Apple recommends doing monthly. The process
is a snap:

1. Charge your battery until the Finder menu battery meter indicates that the unit is
fully charged, at 100%.

2. Keep your laptop connected to an AC socket for another two hours to ensure a
maximum charge.

3. Disconnect the power cord and use your laptop on battery power until it is fully
discharged and automatically switches to sleep mode.

& Make sure you close all your applications when you see the low battery
warning dialog box so that you don't lose anything.
WARNING 1. Allow your laptop to sleep (or turn it off) for a full five hours.

2. Reconnect the AC cord and fully charge your battery.

3 Invest in an external battery. If you often find yourself running out of
battery power on the road without an AC socket handy, consider buying an
external battery. These handy units are specially designed to charge your
MacBook and other USB-powered devices when no other power source is
available. A rechargeable battery can power and charge your MacBook, as
well as an iPhone and other USB devices.

39% @ Thu9:25 PM Mark Chambers

FIGURE 2-2: =
Monitor

your MacBook’s
juice from the
Finder menu.
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HOT PATOOTIE! IS MY LAPTOP STEAM-
POWERED?

Laptops generate heat. Today's super-fast multicore processors can work up a head of
steam (pun intended) while you're using them. Some of that heat radiates from the
bottom of the computer, even though many current MacBook models have a fan.

What you might not realize, however, is just how much heat your MacBook can produce.
You won't get burned if you shift your MacBook from a desk to your lap (Apple dislikes
lawsuits as much as the next company), but that laptop will be uncomfortably hot if
you've been using it for hours!

To avoid that burning sensation, buy a laptop stand or cooling pad for your desk. These
nifty metal or Plexiglas pedestals raise your laptop off your desk, allowing air to flow
under the bottom of the computer for better cooling. Also, a laptop stand elevates the
screen to a more ergonomic position. Some stands even include a built-in fan powered
by one of your USB ports. (The keyboard might suddenly be harder to use, naturally, but
that's yet another reason why | recommend an external keyboard when you're using
your Mac laptop at a semi-permanent desk location. The other reasons are that an
external keyboard saves wear and tear on your laptop keyboard, and you get the ease
of using a full-size keyboard.)

If your battery is no longer holding a charge — in other words, if you fully charge
it and unplug the AC adapter, only to discover that you have only a few minutes of
battery life — it’s time to invest in a replacement battery. If you use an older Mac
laptop with a replaceable battery, you can buy a new battery (from Apple or an
online vendor) and install it yourself. Unfortunately, owners of current MacBook
models must take their computers in for servicing. Today’s Mac laptop is a sealed
unit, and you can’t replace the battery yourself.

Setting Up and Registering Your Laptop

34

After your MacBook is running and you give it the once-over for obvious shipping
damage, your next chore is to set up your laptop. I won’t cover the setup process
step by step, unlike other tasks in this book. Apple tweaks the questions you see
during setup on a regular basis, and they are very easy to answer. Everything is
explained onscreen, complete with onscreen Help if you need it.
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However, I do want you to know what to expect, as well as what information you
need to have at hand. I also want you to know about support opportunities and
neat features like Apple’s iCloud. Hence this section. Consider it a study guide for
whatever your MacBook’s setup procedure throws at you.

Your iCloud account is your friend

Remember when you were offered the chance to create an iCloud account (also
known as an Apple ID) during the initial setup of High Sierra? (If you already had
an iCloud account from an earlier version of macOS, or you created an Apple ID
while using your iPad or iPhone, you skipped ahead without a second thought.) If
you’re careful about your online travels and you decided not to supply your per-
sonal data, however, you may have passed up the chance to immediately create
your iCloud account during High Sierra setup, most likely thinking that you could
take care of it later.

Unfortunately, you’ve probably realized by now that all sorts of macOS features
and applications hinge on your iCloud account, including the App Store, Messages,
the iTunes Store, and FaceTime. If you haven’t created your iCloud account yet,
take care of that chore now. It’s free and painless and makes you one of the “in
crowd.”

When you’re prompted for an iCloud password by one of the aforementioned
applications, click the Create Apple ID/iCloud Account button to start the ball roll-
ing. The application leads you through the process step by step. You can also cre-
ate your ID through the App Store or the iTunes Store. Click the Account link in
either of these applications, and you’re prompted to create your iCloud account.

Note that Apple now uses what it calls 2 Factor Authentication for your Apple ID —
this provides much tighter security for safeguarding your Apple ID. However, if
you share your Apple ID among multiple Macs or between iOS devices (like an
iPhone or iPad), 2 Factor Authentication does involve entering a code on each of
those computers and devices. The code entry isn’t a huge hassle, but if you’re
switching from a Windows PC it may seem a little strange!

Setting up macOS High Sierra

After you start your computer for the first time — or if you just upgraded from
macOS Sierra — your laptop will launch High Sierra setup automatically. The
setup process takes care of a number of tasks:

3 Setup provides High Sierra with your personal information. As | mention
in Chapter 1, your Mac ships with a bathtub full of applications. Many of them
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use your personal data (such as your address and telephone number) to
automatically fill out your documents.

If that stored personal information starts you worrying about identity theft, |
congratulate you. If you're using common sense, sharing your personal data
at any time should make you uneasy. In this case, however, you're fine. Apple
doesn't disseminate this information anywhere else, and the applications that
use your personal data won't send it anywhere, either. And Safari, the Apple
web browser, fills out forms on a web page automatically only if you give your
permission.

Setup creates your user account. You're prompted for a username and
password, which Setup uses to create your administrator-level account.

Setup configures your language and keyboard choices. macOS is a truly
international operating system, so you are offered a chance to configure your
laptop to use a specific language and keyboard layout.

Setup configures your email accounts in Apple Mail. If you already have an
email account set up with your ISP, keep handy the email account information
that the ISP provided to answer these questions. The info should include your
email address and your login name and password. High Sierra can even
automatically configure your email account for you (including many web-
based email services such as Google Mail, Yahoo! Mail, and Outlook) if you
supply your account ID and password. Sweet.

Setup allows you to open an iCloud account. Apple’s iCloud service just
plain rocks — especially the free storage. Take my word for it: Join up, trooper,
and create your iCloud account during setup. The standard iCloud service is
free, and upgrading to additional space is a breeze if you decide you like the
service benefits. | go into these benefits in detail in Chapter 9, but for now, just
sign up (or sign in, if you already have an existing iCloud account) and take the
opportunity to feel smug about owning an Apple computer.

Setup sends your registration information to Apple. As a proud owner of a
MacBook, take advantage of the year of hardware warranty support and the
free 90 days of telephone support. All you have to do is register to use 'em.
Rest assured that all this info is confidential.

Setup offers to launch Migration Assistant. This assistant guides you
through the process of migrating (an engineer’s term for moving) your existing
user data from your old Mac or PC to your laptop. Naturally, if your MacBook
is your first Macintosh computer, you can skip this step with a song in your
heart! (Read more on Migration Assistant in the later section, “Importing Stuff
from Another Mac.”)
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Registering your MacBook

I’ll be honest: Many people, myself included, don’t register every piece of com-
puter hardware they buy. For example, I didn’t register the wireless Bluetooth
adapter I bought for my older iBook because the expenditure was only around $40,
the gizmo has no moving parts, and I’'m never likely to need technical support to
use it or get it fixed.

However, your MacBook is a different kettle of fish, so I strongly recommend that
you register your purchase with Apple during the setup process. You spent a fair
amount on your computer, and your investment has a significant number of very
expensive parts. In fact, I heartily advocate the purchase of an AppleCare Protec-
tion Plan extended warranty with your new MacBook for the ultimate in peace of
mind — if you can invest a couple of hundred dollars more, you’ll have a full three
years of service coverage from the purchase date.

Even the hardiest of techno-wizards would agree with this important Mark’s Maxim:
If you don’t register your new laptop, you can’t receive support.™

MARK'S And rest assured that Apple is not one of those companies that constantly pesters
you with email advertisements and near-spam. I've registered every Apple com-
puter I’ve owned, and I’ve never felt pestered. (And I have an extremely low toler-
ance for pester.)

Importing Stuff from Another Mac

If you’re upgrading from an older Mac running macOS to your new Mac laptop, I
have great news: Apple includes Migration Assistant. This utility application can
help you copy (whoops — I mean migrate) all sorts of data from your old Mac to
your new machine. It does so via your laptop’s wired or wireless Ethernet network
connection or an existing Time Machine backup on an external hard drive.

As mentioned earlier, Setup launches Migration Assistant automatically if you
indicate that you want to transfer stuff during the setup process, but you can
always launch Migration Assistant manually at any time. Simply click the Spot-
light search icon (which looks like a magnifying glass) in the Finder menu bar,
then type Migration Assistant and press Return.
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The list of stuff that gets copied includes the following:

3 User accounts: If you set up multiple user accounts (so that more than one
person can share the computer), the utility ports them all to your new Mac.

3 Network settings: Boy, howdy, this is a real treat for those with manual
network settings provided by an ISP or network administrator! Migration
Assistant can re-create the entire network environment of your old Mac on
your new laptop.

¥ System Preferences settings: If you're a fan of tweaking and customizing
macOS so that it fits like a glove, rejoice. Migration Assistant copies all the
changes you've made in System Preferences on your old Mac! (Insert sound of
angelic chorus: Hallelujah!)

3 Documents: The files in your Documents folder(s) are copied to your new
MacBook.

3 Applications: Migration Assistant tries its best to copy over third-party applica-
tions you've installed in your Applications folder on the older Mac. | say “tries its
best” because you might have to reinstall some applications. Some developers
create applications that spread all sorts of files across your hard drive, and
Migration Assistant just can't keep track of those nomadic files. Other applications
make the trek just fine, but you might have to reenter their serial numbers.

By far, the easiest method of using Migration Assistant is over a wired or wireless
Ethernet network. Both computers should be connected to the same network.
(Because today’s MacBook models don’t have an on-board Ethernet port, you may
require a Thunderbolt-to-Ethernet or USB-to-Ethernet adapter if you decide to
use a wired Ethernet connection.) Typically, you also have to run Migration Assis-
tant on the source computer. Or, if you’re migrating data from a PC, you must
download and install the free Windows Migration Assistant (www.apple.com/
migrate-to-mac).

If you’ve connected an external hard drive containing the Time Machine backup
files from your older Mac, just connect the drive to your new laptop.

After the two computers are connected (or you have connected the Time Machine
backup), simply follow the onscreen instructions displayed in the Migration
Assistant window. The application leads you through the process step by step. If
you need to return to the previous step at any time, click the Back button that
appears at the bottom of the screen. Migration Assistant may take an hour (over a
wired connection) or even several hours (over a wireless connection) to complete,
depending on the amount of data to be moved.
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Importing Stuff from Windows
(If You Must)

If you’re a Windows-to-Mac Switcher, you made a wise choice, especially if you’re
interested in the creative applications in Apple’s digital lifestyle suite! Although
you could choose to start your Apple computing life anew, you probably want to
migrate some of your existing documents and files from that tired PC to your
bright, shiny new MacBook.

As mentioned in the preceding section, the Windows Migration Assistant provided
by Apple can transfer much of the Windows data you want to take with you. If you
find that some files were left behind, you can move stuff manually as well. You can
copy your files to a USB flash drive or over a network. To make this manual move
more manageable, Table 2-1 covers a number of typical Windows file locations in
Windows 7, 8, and 10, their High Sierra counterparts, and the Mac applications
you’ll use to open them.

TABLE 21 Moving Media and Documents betwixt Computers
File Type Windows Location macOS Location Mac Application
Music files Music folder Music folder iTunes
Video and movie files Videos folder Movies folder QuickTime, DVD Player, iTunes
Digital photos Pictures folder Pictures folder Photos
Office documents Documents folder Documents folder Mac Office, OpenOffice, Pages,

Numbers, and Keynote

TIP

The macOS Help system contains an entire subsection on specific tricks you can
use when switching from Windows to Mac, including how to connect to a Win-
dows network and how to directly connect the two computers.
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SWITCHING FROMAPCTO...AN
APPLE PC?

With the High Sierra Boot Camp feature, you can actually create a full Windows 8 or 10
system on your Intel-based Mac laptop. Yup, Windows and High Sierra coexist peace-
fully on the same computer. However, you have to reboot your computer to use your
MacBook as a Windows system.

This possibility brings a whole new meaning to the term Switcher. Some Mac owners are
moving their stuff from Windows (running on their old PC) to . . . well, Windows (running
on their new MacBook) rather than High Sierra. If you decide to create a Windows
system on your MacBook with Boot Camp, the files and folders on your existing PC can
be copied directly by using the Windows Easy Transfer utility (in Windows 8). Windows
8.1 and 10 users will need a third-party application to move files and folders, such as
PCmover Home from Laplink (www. laplink.com). In effect, you're copying your set-
tings and data between your old PC and your new Apple-based PC! (That sounds a little
skewed, but die-hard Apple apostles will have to forgive me.)

Manually moving existing Windows applications (such as PaintShop Pro X9) to your lap-
top's drive usually doesn’t work even with Boot Camp — Apple’s dual-boot feature that
allows you to run both High Sierra and Windows 8, 8.1 or 10 on your MacBook. Most
Windows software installs all sorts of necessary files in several folders across your drive,
and manually moving applications doesn't put those files where they should go. Instead,
you have to install Windows 8, 8.1 or 10 on your Mac laptop (using Boot Camp) and then
reinstall your Windows applications. You'll find complete details on Boot Camp later in
Chapter 19.
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IN THIS CHAPTER

» Introducing macOS High Sierra Desktop

» Coping with those missing trackpad
buttons

» Launching and quitting applications

» Mastering Finder windows and
shortcuts

» Identifying and selecting items

» Manipulating your Desktop with
Mission Control and Dashboard

» Storing everything in your Home folder
» Customizing the Dock and Desktop

» Taking care of the Trash (and
rescuing precious stuff from it)

» Printing your documents

» Getting help while learning about
High Sierra

Chapter 3

The MacBook Owner’s
Introduction to macOS
High Sierra

h, the Finder. Many admire its scenic beauty. But don’t ignore its unsur-
passed power or its many moods. And send a postcard while you’re there.
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Okay, so the High Sierra Finder might not be quite as majestic as the mighty region
it’s named after, but it’s the basic toolbox you use every day while piloting your
MacBook. The Finder includes the most common elements of macOS: window
controls, common menu commands, icon fun (everything from launching appli-
cations to copying files), keyboard shortcuts, and even emptying the Trash. In
fact, you could say that if you master the Finder and learn how to use it efficiently,
you’re on your way to becoming a power user!

This chapter is your Finder tour guide, and we’re ready to roll. I satisfy your curios-
ity about your new playground and introduce you to the basic elements of the High
Sierra Desktop, and I outline the resources available if you need help with macOS.

Oh, and I promise to use honest-to-goodness English in my explanations, with a
minimum of engineer-speak and indecipherable acronyms. (In return, promise
that you will boast about High Sierra to your family and friends. Aunt Harriet
might not be as technologically savvy as we are.)

Your Own Personal Operating System

42

TIP

High Sierra is a special type of software called an operating system (or OS, as in
mac0S). This means that High Sierra essentially runs your MacBook and allows
you to run all your other applications, such as iTunes and Photoshop. It’s the most
important computer application — or software — that you run.

Think of a pyramid, with High Sierra as the foundation and other applications
running on top.

You're using the OS when you aren’t running a specific application, such as these
actions:

¥ Copying files from a USB flash drive to your laptop’s internal drive
¥ Navigating through files and folders on your drive

¥ Choosing a different screen saver

Sometimes, High Sierra even peeks through an application while it’s running. For
example, macOS controls application actions such as these:

¥ The Open, Save, and Save As dialogs you see when working with files
in Photoshop

3 The Print dialog that appears when you print a document in Pages (Apple's
desktop publishing application)
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FIGURE 3-1:
Everything High
Sierra starts
here — the
macOS Desktop.

In the following sections, I escort you around the most important hotspots in High
Sierra, and you meet the most interesting onscreen thingamabobs you use to con-
trol your laptop. (I told you I wouldn’t talk like an engineer!)

The High Sierra Desktop

The High Sierra Desktop isn’t made of wood, and you can’t stick your gum under-
neath. However, this particular desktop does work much like the surface of a tra-
ditional desk. You can store things there, organize things into folders, and take
care of important tasks such as writing and drawing (using tools called applica-
tions). Heck, you even have a clock and a trash can.

Gaze upon Figure 3-1 and follow along as you venture to your Desktop and beyond.
I discuss each of these Desktop elements in more detail later in this chapter.
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Meet me at the Dock

The Dock is a versatile combination: one part organizer, one part application
launcher, and one part system monitor. From the Dock, you can launch
applications — for example, the postage stamp icon represents the Apple Mail
application, and clicking the spiffy compass icon launches your Safari web
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browser. Icons in the Dock also allow you to see what’s running, and display or
hide the windows shown by your applications.

Each icon in the Dock represents one of the following (many of which are proudly
displayed in Figure 3-2):

3 An application you can run (or that is running)

3 An application window that's minimized (shrunk)

3 Aweb page URL link

3 Adocument or folder on your system

¥ A network server, shared document, or shared folder

¥ Your Trash

FIGURE 3-2:

The Dock can
contain all sorts
of exotic icons.

The Dock is highly configurable:

TP ¥ It can appear at different edges of the screen.

900 wBBRBO o % @@ 5 il Hiemy

¥ It can disappear until you move the pointer to the edge to call it forth.

¥ You canresizeiit.

Dig those crazy icons
By default, High Sierra always displays at least one icon on your Desktop: your
Mac’s internal drive. To open a drive and view or use the contents, you double-
click the icon. Each icon is a shortcut of sorts that represents something,
including

3 CDs and DVDs (if you have an optical drive).

¥ External hard drives, solid-state drives, and USB flash drives.

¥ Applications and documents.

¥ Files and folders.

» Network servers you access.
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FIGURE 3-3:
Clicking a menu
displays a list of

menu commands.

REMEMBER

Note that an icon can represent applications you run and documents you create.
Sometimes you single-click an icon to watch it do its thing (as in the Dock), but
usually you double-click an icon to make something happen.

There's no food on this menu

The menu bar isn’t found in a restaurant. You find it at the top of the Desktop,
where you can use it to control your applications. Virtually every application you
run on your laptop has a menu bar.

To use a menu command, follow these steps:

1 . Click the menu title (such as File or Edit).

2. Choose the desired command from the list that appears, as shown in
Figure 3-3.
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When you click a menu, it extends down so that you can see the commands it
includes. While the menu is extended, you can choose any enabled menu item
(just click it) to perform that action. You can tell that an item is enabled if its name
appears in black or white. Conversely, a menu command is disabled if it appears
grayed out. Clicking it does nothing.

When you see a menu path printed in this book (such as File=>Save), it’s just a
visual shortcut that tells you to click the File menu and then choose Save from the
drop-down menu that appears.
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Virtually every Mac application has some menus, such as File, Edit, and Window.
You’re likely to find similar commands within these menus. However, only two
menus are in every macOS application:

¥ The Apple menu, which is identified with that jaunty Apple Corporation icon.
This is a special menu because it appears in both the Finder menu bar and the
menu bar in every application you run. It doesn’t matter whether you're in
iTunes or Photoshop or Word. If you can see a menu bar, the Apple menu is
there. The Apple menu contains common commands to use no matter where
you are in High Sierra, such as Restart, Shut Down, and System Preferences.
Figure 3-3 proudly displays the Apple icon at the upper left.

3 The Application menu, which always bears the name of the active application.
For instance, the DVD Player menu group appears when you run the High
Sierra DVD Player, and the Word menu group appears when you launch
Microsoft Word.

call a right-click menu — by right-clicking the High Sierra Desktop, an application,
a folder, or a file icon. (Because your MacBook is equipped with a trackpad, you

TIP can right-click by tapping the trackpad with two fingertips. I’ll explain more on
tapping later in this chapter.)

‘ You can also display a context or shortcut menu — which regular human beings

The Finder menu bar is your friend

Whenever the Finder itself is ready to be used (or, in Mac-speak, whenever the
Finder is the active application), the Finder menu bar appears at the top of the
screen. You know the Finder is active and ready when the word Finder appears at
the left of the menu bar.

There's always room for one more window
You’re probably already familiar with the ubiquitous window itself. Both High
Sierra and the applications you run use windows to display things such as

3 The documents you create

3 The contents of your drive

For example, the window shown in Figure 3-1 is a Finder window, where High
Sierra gives you access to the applications, documents, and folders on your sys-
tem. You use Finder windows to launch applications, to perform disk chores such
as copying and moving files, and to navigate your hard drive.
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T
TECHNICAL
STUFF

IT'S APPLE TO THE RESCUE!

UNIX is the established, super-reliable OS that powers most of the high-performance
servers that make up the Internet. UNIX has built-in support for virtually every hardware
device ever wrought by the Hand of Man (including all the cool stuff that comes with
your MacBook). It's also well designed and highly efficient.

Unfortunately, standard UNIX looks as hideous as old-fashioned character-based DOS,
complete with a confusing command line. So ease of use for normal human beings like
you and me goes out the window. Enter the genius types at Apple, who understood
over 15 years ago that all UNIX needed was a state-of-the-art, novice-friendly interface.
To wit: macOS was developed with a UNIX foundation (or core), so it shares the same
reliability and performance as UNIX. However, the software engineers at Apple (who
know a thing or two about ease of use) made it good-looking and easy to use.

Wait a Second: Where the Heck
Are the Mouse Buttons?

WARNING

High Sierra takes a visual approach to everything. What you see in Figure 3-1is
designed for point-and-click convenience, because the trackpad is your primary
navigational tool while you’re using your Mac laptop. You move your finger over
the surface of the trackpad, and the pointer follows like an obedient pup. The
faster you move your finger, the farther the pointer goes. When your pointer is
over the desired item, you tap it (or click it, if you prefer the more familiar term),
it opens, you do your thing, and life is good.

Never use any object other than your finger on the trackpad! That means no pencils (no,
not even the eraser end), pens, or chopsticks; they can damage your trackpad in
no time.

If you’ve grazed on the other side of the fence — if you’re one of Those Who Were
Once Windows Users — you’re probably accustomed to using a mouse with at
least two buttons. This brings up the nagging question: “Hey, Mark! Where the
heck are the buttons?”

In a nutshell, the buttons simply ain’t there if you’re using your Mac laptop’s
trackpad. The entire surface of the trackpad can act as both buttons. To customize
how the trackpad operates, click the Apple menu in the Finder menu bar, then
click System Preferences, and then click the Trackpad icon. From the Point & Click
pane, for example, you can
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3 Select the Tap to Click check box: Now, when you tap once quickly any-
where on the trackpad, your Mac laptop counts that as a click. Tap twice
quickly, and your MacBook recognizes that as a double-click.

¥ Select the Secondary Click check box: A single tap with two fingers displays
the right-click menu (which | cover in more detail in a page or two).

3 Select the Look Up & Data Detectors check box: If your Mac laptop is
equipped with a Force Touch Trackpad, you can choose how Force Click
operates (along with the Force Click and Haptic Feedback check box, which
provides physical feedback from the trackpad). Note that these two check
boxes will not appear if your Macbook has an older trackpad.

3 Enable the Look Up check box: Tap the trackpad with three fingers to look
up a selected word in the Dictionary.

3 Enable the Three Finger Drag check box: (Sounds like a dance from the '60s,
doesn't it?) By using three fingers, you can drag around windows on your
Desktop to reposition them.

3 Adjust your tracking speed and Force Click pressure: Click and drag the
Tracking speed slider to speed up or slow down the rate at which the pointer
moves. The Click pressure slider controls how hard you must press to activate
Force Click.

Apple has done a great job of illustrating each gesture available from the Trackpad
pane in System Preferences. A short video clip shows you both the gesture itself
and the effect of that gesture within macOS.

DOING THE MULTI-TOUCH AND FORCE
CLICK THINGS

Today’s crop of MacBooks has the smartest trackpads on the planet! That's because Apple's
latest mice and trackpads include two features. Multi-Touch allows you to control the view
of a document by using specific finger motions on the trackpad surface, while Force Click
activates specific features if your fingers press down harder on the trackpad surface. (Your
Macbook must be equipped with a Force Touch trackpad to use a Force Click).

At the time of this writing, here's the rundown:
® Two-finger scrolling: Move two fingers over the surface of the trackpad at once to
scroll the contents of the active Finder window or application in the same direction. For

example, you can use the scroll function to move up and down through the pages of a
document or to move up and down through a long web page. Who needs scroll bars?
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® Two-finger zooming: Pinching your thumb and forefinger toward each other on
the trackpad zooms in on a document or image. The reverse (moving your finger-
tips away from each other) zooms out.

® Two-finger Smart Zoom: Tap twice with two fingers to zoom in, and double-tap
again with two fingers to zoom back out.

® Two-finger rotating: Move your thumb and forefinger in a circle on the trackpad
to rotate an image or document in the corresponding direction.

® Two-finger paging: Swipe your thumb and forefinger to the left or right across the
trackpad to page through a document or to move to the next or previous image in
aset.

® Three-finger full-screen switching: Swipe your thumb and first two fingertips to
the left or right across the trackpad to move between open applications in full-
screen mode.

® Two-finger Notification Center display: Swipe to the left with two fingers from
the right edge of the trackpad, and High Sierra displays the Notification Center. To
hide the panel, reverse the gesture and swipe from the left edge to the right using
two fingers.

® Perform actions in Mission Control, Launchpad, and your Desktop: Using the
combination of thumb and fingers you specify, you can configure the display and
operation of these features within High Sierra.

® Force Click data on your screen to display additional information: You can
Force Click on a text or links in documents, web pages, and email messages to dis-
play related data, or Force Click on a document icon to display its contents without
opening it. Other Force Click functions vary by application, but you can check the
Help system within any application to see if it offers Force Click commands.

Note that not all Multi-Touch gestures work with older MacBook trackpads, and you'll
only find Force Touch on the latest Mac laptops.

I’ll be honest: When my laptop is on my desk at home, I plug in a Logitech optical
trackball. This neat device has two buttons and a scroll wheel, saving me wear and
tear on my trackpad and offering even finer control in my applications. In fact, a
new industry is springing up for tiny USB mousing devices made especially for
laptops. Some devices are smaller than a business card, but they still carry a full
complement of two buttons and a scroll wheel.

In this book I refer to the pointer whether you’re using the trackpad or a mouse. So

here’s a Mark’s Maxim I think you’ll appreciate more and more as you use your
laptop.
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If you can afford a USB or wireless Bluetooth mouse, trackpad or trackball for
your laptop, buy it. You can thank me later with an email message sent to mark@
MARK'S mlcbooks.com.™
MAXIMS
If you tap the trackpad with two fingertips (or click the right mouse button on a
USB mouse), High Sierra performs the same default function that a right-click
does in Windows. Namely, with a right-click on most items — icons, documents,
even your Desktop — you get a shortcut menu of commands specific to that item.

Figure 3-4 shows a typical convenient right-click menu in a Finder window. I
have all sorts of cool items at my disposal on this menu because of the applica-
tions I've installed that make use of a right-click menu.
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If you’re using a USB mouse, don’t forget to visit the Mouse pane in System Pref-
erences to configure it.

TIP

Launching and Quitting Applications
with Aplomb

Now it’s time to pair your newly found trackpad acumen with the High Sierra
Finder window. Follow along with this simple exercise. Move the pointer over the
iTunes icon in the Dock. (This icon looks like a circle with a musical note on it.)
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FIGURE 3-5:
Click a Dock icon
to launch that
application.

Q

TIP

Then tap the trackpad once (see the preceding section for how to set this prefer-
ence). Whoosh! High Sierra launches (or starts, or runs) the iTunes application,
and you see a window much like the one shown in Figure 3-5.
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iTunes Application Window iTunes Dock Icon

If an application icon is already selected (which I discuss later in the chapter),
you can simply press 38+0 to launch it. The same key shortcut works with docu-
ments, too.

Besides the Dock, you have a plethora of other ways to launch an application or
open a document in High Sierra:

» From the Apple menu (8): You can launch a number of applications from
anywhere in High Sierra using the Apple menu. Click System Preferences to
change all sorts of settings, such as your display background and how icons
appear. Click App Store to launch the macOS App Store and display software
that you can download for your laptop. (Most are commercial applications
that you have to pay for, but many great free applications are available as
well.) You can also use the App Store to see whether update patches are
available for your Apple software.

3 From the Launchpad: Arrange all your application icons in a full-screen
display. (The Launchpad icon in the Dock bears a spiffy rocket.) If you have
more than one screen (or page) worth of applications, press the arrow keys to
move between Launchpad pages. Using the trackpad, swipe two fingers to the
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TIP

»

left or right. To launch an application, just click the icon. (If you're the proud
owner of an iPhone, iPad, or iPod touch, the Launchpad is familiar, because it
corresponds directly to the iOS Home screen on those devices.)

From the Desktop: If you have a document you created or an application
icon on your Desktop, you can launch or open it from the Desktop by
double-clicking that icon (tapping the trackpad twice with one finger in rapid
succession when the pointer is on top of the icon).

Double-clicking a device or network connection on your Desktop opens the
contents in a Finder window. This method works for CDs and DVDs you've
loaded, as well as external drives and USB flash drives. Just double-click ‘'em to
open them and display their contents in a Finder window. Applications and
documents typically launch from a CD, a DVD, or an external drive just like
they launch from your internal drive (the one that's typically named Macintosh
HD). So you don't have to copy stuff from the external drive just to use it. Note,
however, that running an application directly from your optical or external
drive usually causes the application to run significantly slower. (Oh, and don't
forget that you can’t change the contents of most CDs and DVDs; they're
read-only, so you can't write to them.)

DIG THAT CRAZY LAUNCHPAD!

You can customize your Launchpad display by dragging icons to arrange them in the
order you prefer. (For example, | have all the applications | use the most on the first

Launchpad page.) Drag an application icon to the right or left side of the screen to move

it to another page.

Launchpad, like a Finder window, allows you to create folders to help organize your
applications. To create a folder in Launchpad, drag one application icon on top of

another, and then add other icons by dragging them to the folder (or remove them by

dragging them out of the folder). To run an application within a folder, click the folder
icon to display the icons within it, and then click the desired application. To change a
folder name, click the folder to open it, click the folder name to display a text-editing
box, type the new moniker for the folder, and press Return.

If you want to remove an application from Launchpad — which also deletes the applica-
tion from your MacBook entirely — click the icon and continue pressing the trackpad until

the icons start to wiggle. (Yes, you read that correctly; | wrote wiggle. iPhone and iPad

owners know what | mean.) Click the tiny delete (X) button that appears next to the icon
whose application you want to delete, and the icon — and its application — disappear.
Press Esc to stop all that wiggling. (Note that applications supplied with High Sierra can’'t

be deleted this way.)
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TIP

»

»

»

From the Recent Items selection: When you click the Apple menu and hover
the pointer over the Recent Items menu item, the Finder displays all the
applications and documents you used over the past few computing sessions.
Click an item in this list to launch or open it.

From the Login Items list: Login items are applications that High Sierra
launches automatically each time you log in to your user account. | cover login
items in detail in Chapter 10.

From the Finder window: You can also double-click an icon within the
confines of a Finder window to open it (for documents), launch it (for applica-
tions), or display the contents (for a folder).

The macOS Quick Look feature can display the contents of just about any docu-
ment or file — but without actually opening the corresponding application! Sweet.
To use Quick Look from a Finder window, click a file to select it, and then press

the

spacebar.

After you finish using an application, you can quit that application to close its
window and return to the Desktop. Here are a number of different ways to quit an

app

»

»

lication:

Press 38+Q. This keyboard shortcut quits virtually every Macintosh applica-
tion. Just make sure that the application you want to quit is currently active
first (the application name should appear immediately to the right of the
Apple [€] menu).

Choose the Quit command from the application’s menu. To display the
Quit command, click the application’s named menu from the menu bar. As |
just mentioned, this menu is always to the immediate right of the Apple (&)
menu. For example, Safari displays a Safari menu, and that same spot in the
menu bar is taken up by Calendar when Calendar is the active application.
Refer to Figure 3-5, and look for the iTunes menu, right next to & at the very
top of the figure.

¥ Choose Quit from the Dock. You can right-click an application’s icon in the

Dock and then choose Quit from the menu that appears.

A running application displays a small dot under its icon in the Dock.

3 Click the Close button in the application window. Some applications quit

entirely when you close their window, such as the System Preferences window
or the Apple DVD Player. Other applications might continue running without
any window, such as Safari or iTunes; to close these applications, you have to
use another method in this list. (More on window controls like Close in the
next section.)
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TOUCHING BASE WITH THE TOUCH BAR

Three current MacBook Pro models sport yet another important advancement in Apple
computing design: the new Touch Bar, which runs across the top of the keyboard. This
strip of real estate is actually a touch-sensitive LED display (on a much smaller scale than
your MacBook Pro’s main screen, of course), and it changes according to the application
you're running. If you're familiar with the function keys that have appeared on personal
computer keyboards for decades, you'll understand the idea — but unlike the static F1
through F12 keys of previous Macs, the Touch Bar offers application-specific icons. Heck,
in some applications, the Touch Bar acts as a slider control for photo editing, or an emoji
selector in a mail message, or even a theme display in a presentation! As time passes,
more and more applications will offer support for the Touch Bar (hence my enthusiasm).
In fact, two of the big guns in the software world have already signed on: both Microsoft
Office and Photoshop support the Touch Bar.

You can also customize the display of controls offered by the Touch Bar within many appli-
cations, so you can specify exactly what functions appear. Or, in a bow to older software
that doesn't use the Touch Bar, you can even display the standard set of 12 function keys.

Integrated into the Touch Bar is the same fingerprint-reading Touch ID sensor that's fea-
tured on iPhones and iPads, allowing you to unlock your laptop, use Apple Pay and iden-
tify yourself to secured applications — all with the touch of your finger.

3 Choose Force Quit from the Apple menu. This is a last-resort measure! Use
this method only if an application has frozen and you can't use another
method in this list to quit. Force-quitting an application doesn't save any
changes to any open documents in that application!

Performing Tricks with Finder Windows

54

In the following sections of your introduction to macOS, I describe basic windows
management in High Sierra: how to move things around, how to close windows,

and how to make windows disappear and reappear like magic.

Scrolling in and resizing windows

Can you imagine what life would be like if you couldn’t see more than a single
window’s worth of stuff? Shopping would be curtailed quite a bit — and so would

the contents of the folders on your MacBook’s drives!
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That’s why High Sierra includes scroll bars that you can click and drag to move
through the window’s contents. (By default, scroll bars don’t appear in High
Sierra until you move the pointer close to them.) You can

¥ Click the scroll box and drag it. For the uninitiated, that means clicking the
darker portion of the bar and holding down your finger on the trackpad while
you move your finger in the desired direction.

¥ Click anywhere in the empty area above or below the scroll box to scroll pages
one at a time.

3 Hold down the Option key and click anywhere in the empty area above or
below the bar to scroll to that spot in the document.

dow’s contents (both vertically and horizontally). To control trackpad behavior,
open System Preferences and click the Trackpad pane. You can read all about con-

TIP figuring trackpad settings in the earlier section “Wait a Second: Where the Heck
Are the Mouse Buttons?”

‘ Of course, you can also drag two fingertips across the trackpad to scroll a win-

Figure 3-6 shows two vertical scroll bars in a typical Finder window, as well as the
Sidebar and three Finder Tabs.

Minimize Button

Zoom/Full Screen Button

Close Button Finder Tabs New Finder Tab Button
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TIP

Often, pressing the Page Up and Page Down keys moves you through a document
one page at a time. Also, pressing the arrow keys moves the insertion pointer one
line or one character in the four compass directions.

You can also resize most Finder and application windows by enlarging or reducing
the window frame itself. Move the pointer over any corner or edge of a window
and then drag the edge in any direction until the window is the precise size you
need. (More information on dragging pops up later in this chapter.)

Minimizing and restoring windows

Resizing a window is indeed helpful, but maybe you simply want to banish the
doggone thing until you need it again. That’s a situation for the Minimize button,
which also appears earlier, in Figure 3-6. A minimized window disappears from
the Desktop but isn’t closed; it simply reappears in the Dock as a miniature icon.
Minimizing a window is easy: Move the pointer over the Minimize button (the
second of the three buttons at the upper-left corner of the window) — a minus
sign appears in the button to tell you you’re on target — and then click. Here’s a
good shortcut: Double-clicking the window’s title bar (the top frame of the
window, which usually includes a document or application name) minimizes the
window.

To restore the window to its full size (and its original position on the Desktop),
just click its window icon in the Dock.

Moving and zooming windows

Perhaps you want to move a window to another location on the Desktop so that
you can see the contents of multiple windows at the same time. Click the window’s
title bar and drag the window anywhere you like. Then release the button. (Don’t
click the icon in the center of the title bar, though. You’ll move just the icon itself,
not the window.)

Many applications can automatically arrange multiple windows for you (examples
include Microsoft Word and PowerPoint). Choose Window=> Arrange All (if this
option appears).

To see everything a window can show you, use the Zoom feature to expand any
Finder or application window to its maximum practical size. (Zooming a Finder
window is different from zooming with the Multi-Touch feature, because you’re
expanding only the size of the Finder window, not an image or document.) Note
that a zoomed window can fill the entire screen, or, if that extra space isn’t appli-
cable for the application, the window might expand to only a larger part of the
Desktop.
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To zoom a window, move your pointer over the third button at the top-left corner
of the window. Again, refer to Figure 3-6, which struts its stuff and illustrates the
position. (Man, that is one versatile figure.) A double-arrow icon appears on the
Zoom/Full-Screen button. Click to expand your horizons to full-screen, or hold
down the Option key while clicking to zoom the window to maximum size.

Speaking of full-screen operation, it comes in very handy on a smaller laptop
display — that’s where a single application fills the entire screen, without
displaying a window frame or traditional Finder menu bar. The method you use to
switch to full-screen mode varies depending on the application, so there’s no one
menu command or one keyboard shortcut that will always do the deed. Most of the
applications included with macOS High Sierra use View+> Enter Full Screen, and
many applications have a button you can click in the window to switch back and
forth. A click on the Zoom/Full-Screen button switches most Apple applications
into full-screen. Finder windows can also be switched to full-screen mode in High
Sierra! To exit full-screen mode, just press Esc.

So how do you switch between applications if they’re all in full-screen mode?

3> Move your pointer to the bottom of the screen to display the Dock, where you
can click another application to switch to it.

¥ Invoke Mission Control and choose another application from there. (More
about Mission Control later in this chapter.)

¥ Swipe three fingers to the left or right across the trackpad surface.

3 From the keyboard, use the §8+Tab shortcut to cycle through the applications
you have running.

TOGGLING TOOLBARS THE HIGH SIERRA WAY

It's time to define a window control that's actually inside the window for a change. A tool-
bar is a strip of icons that generally appears under the window's title bar (although tool-
bars can appear in other locations as well). These icons typically perform the most
common actions in an application; the effect is the same as if you used a menu com-
mand or pressed a keyboard shortcut. Toolbars are popular these days. You see 'em in
everything from the Finder window to most application windows.

You can usually banish a window's toolbar to make extra room for icons, documents, or
whatever the window happens to be holding. Just choose View => Hide Toolbar. To
restore the toolbar to its original position, choose View = Show Toolbar. Nete: If you
toggle the Finder window toolbar off, you also lose the Finder window sidebar.
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ONLY ONE CAN BE ACTIVE AT ONCE

Here's a very special Mark's Maxim in the macOS universe:
MARK'S
MAXIMS

Only one application window can be active in High Sierra at any time.™
You can always tell which window is active:

® The active window is on top of other windows. (You can still use a window's Close,
Minimize, and Zoom buttons when the window is inactive.)

® Any input you make by typing or by moving your finger on the trackpad appears in
the active window.

® macOS dims the title bars of inactive windows you haven't minimized.

Closing windows

When you’re finished with an application or you no longer need to have a window
open, move the pointer over the Close button at the upper-left corner of the win-
dow (it’s the first of the three circular buttons). When the X appears in the button,
click it. And yes, I can make one more reference to Figure 3-6, which I’m thinking
of nominating as Figure of the Year.

Perhaps you have more than one window open in the same application, and you
want to close ’em all in one fell swoop. Hold down the Option key while you click

the Close button in any of the windows.
TIP

application gets downright surly and prompts you for confirmation. “Hey, human,
you don't really want to do this, do you?” If you answer in the affirmative — “Why,

rememeer V€S, machine. Yes, indeed, I do want to throw this away and not save it.” — the
application discards the document you were working on. If you decide to keep your
document (thereby saving your posterior from harm), you can cancel the action and
then save the document within the application.

@ If you haven’t saved a document, and you try to close that application’s window, the

Juggling Folders and Icons

Finder windows aren’t just for launching applications and opening the files and
documents you create. You can also use the icons in a Finder window to select one
or more specific items or to copy and move items from place to place within your
system.
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A field observer’s guide to icons

Not all icons are created equal. Earlier in this chapter, I introduced you to your
MacBook’s drive icon on the Desktop. Here’s a little background on the other types
of icons you might encounter during your mobile Mac travels:

»

»

»

»

»

Hardware: These icons are your internal storage devices (such as your hard
drive and optical drive, if you have one) as well as external peripherals — like
an external hard drive or a USB flash drive.

Applications: These icons represent the applications (or programs) you can
launch. Most applications have a custom icon that incorporates the company’s
logo or the specific application logo. Double-clicking an application usually
doesn't load a document automatically; you typically get a new blank docu-
ment or an Open dialog box from which you can choose the existing file you
want to open.

Documents: Many of the files on your hard drive are documents that can be
opened in the corresponding application; the icon usually looks similar to the
application’s icon so they're easy to recognize, as you can see in Figure 3-7.
Double-clicking a document automatically launches the associated application
(that is, as long as macOS recognizes the file type).

Files: Most of the file icons on your system are mundane things such as
preferences and settings files, text files, log files, and miscellaneous data files.
Yet most are identified with at least some type of recognizable icon that lets
you guess what purpose the file serves. You'll also come across generic file
icons that look like a blank sheet of paper (used when High Sierra has no
earthly idea what the file type is).

Aliases: An alias acts as a link to another item elsewhere on your system. For
example, to launch Adobe Acrobat, you can click an Adobe Acrobat alias icon
that you can create on your Desktop instead of clicking the actual Acrobat
application icon. The alias essentially acts the same way as the original icon,
but it doesn't take up the same amount of space — only a few bytes for the
icon itself, compared with the size of the actual application. Plus, you don't
have to go digging through folders galore to find the original application icon.
(Windows switchers know an alias as a shortcut. The idea is the same,
although Macs had it first. Harrumph.) You can always identify an alias by the
small curved arrow at the base of the icon, and the icon might also sport the
tagalias at the end of its name.

You have two ways to create an alias. Here's one:
1. Select the item. (More on selecting items in the next section.)

2. Choose File => Make Alias, or press 38+L.
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TIP

Figure 3-8 shows three aliases for macOS applications, complete with that
fashionable alias arrow.

Here's another way to create an alias:
1. Hold down $8+QOption.
2. Drag the original icon to the location where you want the alias.

Note that this funky method doesn't add the alias tag to the end of the alias
icon name unless you drag the icon to another spot in the same folder.
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So why bother to use an alias? Two good reasons:

»

»
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You can launch an application or open a document from anywhere on
your drive. For example, if you occasionally need to use another application
while working on a Pages project, you can add an alias and launch the other
application directly from the folder where you store those Pages documents.
Speed, organization, and convenience. Life is good.

You can send an alias to the Trash without affecting the original item.
When that school project is finished, you can safely delete the entire folder
without worrying about whether Pages will run the next time you double-click
the application icon!
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Selecting items

Often, the menu or keyboard commands you perform in the Finder need to be
performed on something. Perhaps you’re moving an item to the Trash, getting
more information on the item, or creating an alias for that item. To identify the
target of your action to the Finder, you need to select one or more items on your
Desktop or in a Finder window. In the following sections, I show you just how to
do that.

Selecting one thing

High Sierra gives you a couple of options when selecting just one item for an
upcoming action:

3 Move the pointer over the item and click. A dark border (or highlight)
appears around the icon, indicating that it's selected.

¥ If aniconis already highlighted on your Desktop or in a window, move
the selection highlight to another icon in the same location by using the
arrow keys. To shift the selection highlight alphabetically, press Tab (to move
in order) or press Shift+Tab (to move in reverse order).

Selecting items in the Finder doesn’t actually do anything to them by itself. You
have to perform an action on the selected items to make something happen.

REMEMBER

Selecting a whole bunch of things

You can also select multiple items with aplomb by using one of these methods:

3 Adjacent items:

Drag a box around them. If that sounds like ancient Sumerian, here’s the
explanation: Click a spot above and to the left of the first item. Keep
holding down your finger on the trackpad surface, and drag down and to
the right. (This is called dragging in Mac-speak.) A box outline like the one
shown in Figure 3-9 appears, indicating what you're selecting. Any icons
that touch or appear within the box outline are selected when you release
the button.

Click the first item to select it, and then hold down the Shift key while you click
the last item. High Sierra selects both items and everything between them.

¥ Nonadjacent items: Select these by holding down the §8 key while you click
each item.
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Check out the status bar (which can appear at the top or bottom of a Finder
window, depending on whether the toolbar is hidden). It tells you how much space
is available on the drive you’re working in, as well as how many items are displayed
in the current Finder window. When you select items, it shows you how many you
highlighted. (If you don’t see a status bar, choose View+> Show Status Bar.)

Copying items

Want to copy items from one Finder window to another, or from one location (like
a flash drive) to another (like your Desktop)? Trés easy. Just use one of these
methods:

¥ On the same drive

® To copy one item to another location: Hold down the Option key (you don't
have to select the icon first), and then click and drag the item from its
current home to the new location.

To put a copy of an item in a folder, just drop the item on top of the
receiving folder. If you hold the item you're dragging over the destination
folder for a second or two, High Sierra opens a new window so that you
can see the target's contents. (This is called a spring-loaded folder. Really.)

® To copy multiple items to another location: Select them all (see the preceding
section), hold down the Option key, and then drag-and-drop one of the
selected items where you want it. All the items you selected follow the item
you drag. (Rather like lemmings. Nice touch, don't you think?)

To help indicate your target when you're copying files, High Sierra high-
lights the location to show you where the items will end up. (This works
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REMEMBER

whether the target location is a folder or a drive icon.) If the target location
is a window, High Sierra adds a highlight to the window border.

¥ On a different drive

To copy one or multiple items: Click and drag the icon (or the selected items
if you have more than one) from the original window to a window you
open on the target drive. (No need to hold down the Option key while
copying to a different drive.) You can also drag one item (or a selected
group of items) and simply drop the items on top of the drive icon on your
Desktop.

The items are copied to the top level, or root, of the target drive.

If you try to move or copy something to a location that already has an item
with the same name, you see a dialog that prompts you to decide whether
to replace the file or to stop the copy/move procedure and leave the
existing file alone. (Heck, you can even keep both — macOS performs the
copy or move, but also appends the word copy to the item being copied.)
Good insurance, indeed.

MY, WHAT AN ATTRACTIVE
SIDEBAR ... AND SO USEFUL!

Have you noticed the sidebar that typically occupies the left side of a Finder window? It's
a pane of links to common locations and devices that you can use to jump like a flash to
a specific spot on your hard drive. For example, you can click the Applications link under
the Favorites heading, and you're transported to your Applications folder in an instant.

Here's a great example of sidebar magic: | like as few icons on my Desktop as possible,
so each book I'm working on gets its own folder. All the items for that project that might
otherwise end up on my Desktop are saved to that folder instead. In fact, | make a point
of adding my current book project folder to my Finder window sidebar so that it's avail-
able immediately from any Finder window. To do this, just drag the folder into the
column at the left side of the Finder window and drop it on top of the Favorites heading
in the sidebar’s list.

You can configure the items that will appear in your sidebar: Choose Finder =

Preferences, and then click the Sidebar tab to display the list. From here, you can
select and deselect check boxes to configure your sidebar to your liking.
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Moving things from place to place

Moving things from one location to another location on the same drive is the easi-
est action you can take. Just drag the selected item or items to the new location.
The item disappears from the original spot and reappears in the new spot.

Duplicating in a jiffy

If you need more than one copy of the same item in a folder, use the High Sierra
Duplicate command. I use Duplicate often when I want to edit a document but
want to ensure that the original document stays pristine, no matter what. I just
create a duplicate and edit that file instead.

To use Duplicate, you can

¥ Click an item to select it and then choose File => Duplicate.
¥ Right-click the item and choose Duplicate from the menu.

3 Hold down the Option key and drag the original item to another spot in the
same window. When you release the trackpad button, the duplicate file
appears like magic!

The duplicate item has the word copy appended to its name. A second copy is
named copy?2, a third is copy3, and so on.

Duplicating a folder also duplicates all the contents of that folder. Therefore, cre-
ating a duplicate folder can take some time if the original folder was stuffed full
(or contained files several hundred megabytes or larger in size). The duplicate
folder has copy appended to its name, but the contents of the duplicate folder keep
their original names.

Using Finder Tabs

High Sierra includes a powerful feature you can use to display multiple locations
in the same window. Finder Tabs work just like the tabs in Safari (as well as other
popular browsers for both Macs and PCs), allowing you to switch between multi-
ple locations on your Mac instantly by clicking a tab to switch to that location. You
can even drag files and folders from tab to tab!
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To open a new tab in a Finder window, you have a wealth of choices:

¥ Click the desired location and press $8+T.
¥ Right-click the location and choose Open in New Tab.

¥ Select the location and click the New Tab button (which bears a plus sign) at
the right side of the window.

¥ Click the Action icon (which bears a gear icon) in any Finder window toolbar,
and choose Open in New Tab.

For example, suppose that you’re working on an iMovie project. You might create
tabs using the Applications item in the Finder window sidebar and a folder (or
even a DVD or shared drive) named Work that contains your video clips. The loca-
tion appears as a new tab immediately under the toolbar. You can open as many
tabs as you like, and you can also drag the Finder Tabs themselves to reorder
them. To close a tab, hover the pointer over it and click the X button that appears.
That hardworking Figure 3-6 (shown earlier in the chapter) shows three Finder
Tabs at work.

You can also set new folders to open in tabs instead of windows. Just click the
Finder menu at the top of the Desktop, choose Preferences, and then click the
Open Folders in Tabs Instead of New Windows check box to enable it.

TIP

Keys and Keyboard Shortcuts
to Fame and Fortune

Your MacBook’s keyboard might not be as glamorous as the trackpad, but any
Macintosh power user will tell you that using keyboard shortcuts is usually the
fastest method of performing certain tasks in the Finder, such as saving or closing
a file. I recommend committing these shortcuts to memory and putting them to
work as soon as you begin using your laptop so that they become second nature to
you as quickly as possible.

Special keys on the keyboard

The Apple standard keyboard has a number of special keys that you might not
recognize — especially if you’ve made the smart move and decided to migrate
from the chaos that is Windows to macOS! Table 3-1 lists the keys that bear
strange hieroglyphics on the Apple keyboard and describes what they do.
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TABLE 3-1 Too-Cool Function Keys

Action/Key Name Symbol Purpose

Audio Mute Mutes (and restores) all sound produced by your MacBook

Keyboard Illumination Increases, decreases, or turns off the brightness of your keyboard
backlighting

Volume Up Increases the sound volume

Volume Down Decreases the sound volume

Ctrl Ctrl Displays the right-click/Control+click menu with the trackpad

Command 38 Primary modifier for menus and keyboard shortcuts

Delete Delete Deletes selected text

Option Option Modifier for shortcuts

Using the Finder and application
keyboard shortcuts

The Finder is chock-full of keyboard shortcuts that you can use to take care of
common tasks. Some of the handiest shortcuts are listed in Table 3-2.

TABLE 3-2 High Sierra Keyboard Shortcuts of Distinction
Key Combination  Location Action
3B+A Edit menu Selects all items (works in the Finder, too)
38+C Edit menu Copies the selected items to the Clipboard
$8+H Application menu  Hides the current application window
98+M Window menu Minimizes the active window to the Dock (also works in
the Finder)
38+0 File menu Opens or launches an existing document, file, or folder (also

works in the Finder)

38+P File menu Prints the current document

3%+Q Application menu  Exits (quits) the application, and prompts you to save any changes
B+T File menu Opens a new Finder tab with the currently selected location

3B+V Edit menu Pastes the contents of the Clipboard at the current

pointer position

38+X Edit menu Cuts the highlighted item to the Clipboard
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Key Combination  Location Action

B+Z Edit menu Reverses (undoes) the effect of the last action you took
8+? Help menu Displays the Help system (works in the Finder, too)
38+Tab Finder Switches between open applications

36+Option+M Finder Minimizes all Finder windows to the Dock
38+Option+W Finder Closes all Finder windows

But wait; there’s more! Most of your applications also provide their own set of key-
board shortcuts. While you’re working with a new application, display the applica-

— tion’s Help file and print a copy of the keyboard shortcuts as a handy cheat sheet.
If you’ve used a PC before, you’re certainly familiar with three-key shortcuts. The
most infamous is Ctrl+Alt+Delete, the beloved reboot/Task Manager shortcut
nicknamed the Windows three-finger salute. Three-key shortcuts work the same
way in High Sierra (but you’ll be thrilled to know you don’t need to reboot by
using that notorious Windows shortcut!). If you’re new to computing, to use a
three-key shortcut, hold down the first two keys and then press the third key.

visit the Keyboard pane and then click the Shortcuts tab to change an existing

You’re not limited to the keyboard shortcuts I’ve listed. In System Preferences,
shortcut or add a shortcut.

TIP

Home, Sweet Home Folder

Each user account you create in High Sierra is actually a self-contained universe.
For example, each user has a number of unique characteristics and folders devoted
to just that person, and High Sierra keeps track of everything that user changes or
creates. (In Chapter 10, I describe the innate loveliness of multiple users living in
peace and harmony on your laptop.)

This unique universe includes a different system of folders for each user account
on your system. The top-level folder uses the short username High Sierra assigns
when that user account is created. Naturally, the actual folder name is different
for each person. Mac techno types typically call this folder your Home folder. (On
the sidebar, look for the teeny house icon under the Favorites heading, marked
with your account name.)

When you’re on the hunt for your Home folder, don’t look for a folder that’s actu-
ally named Home. Instead, look for the short username that was assigned when

you created the user account.
REMEMBER
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Each account’s Home folder contains a set of subfolders, including

¥ Movies
¥ Music
¥ Pictures

¥ Downloads (for files you download by using Safari or through Apple Mail
attachments)

¥ Public (for files you want to share with others on your network)
¥ Sites (for web pages created by the user)

¥ Documents (for files created by the user)

Although you can store your stuff at the root (top level) of your drive — or even on
your Desktop — that gaggle of files, folders, and aliases can get crowded and con-
fusing quickly. Here’s a Mark’s Maxim to live by:

Your Home folder is where you hang out and where you store your stuff. Use it to
make your computing life much easier!™

MARK’S

maxims  Create subfolders within your Documents folder to organize your files and folders
even further. For example, I create a subfolder in my Documents folder for every
book I write so that I can quickly and easily locate all the documents and files
associated with that book project.

I discuss security in your Home folder and what gets stored where in Chapter 10.
For now, remember you can reach your Home folder easily, because it appears in
the Finder window sidebar. One click on the sidebar entry for your Home folder,
and all your stuff is within easy reach. (If your Home folder doesn’t appear in the
sidebar, that’s easy to fix: Choose Finder=> Preferences, click the Sidebar tab, and
then select the check box to display your Home folder.)

In addition to using the Finder window sidebar, you can reach your Home folder
in other convenient ways:

3 From the Go menu: Choose Go =>Home to display your Home folder
immediately from the Finder window. Alternatively, you can press $8+Shift+H
to accomplish the same thing.

3 From the Open dialog: The High Sierra standard File Open dialog also includes
the same Home folder (and subfolder) icons as the Finder window sidebar.

3 In any new Finder window you open: If you like, you can set every Finder
window you open to automatically display your Home folder:
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1. Choose Finder = Preferences and click the General tab.

2. Click the arrow button at the right side of the New Finder Windows Show pop-up
menu.

A menu pops up (hence the name).
3. Click the Home entry (with the house icon and your short username) in the menu.
4. Click the Close button at the upper-left corner of the dialog.

You're set to go. From now on, every Finder window you open displays your
Home folder as the starting location!

High Sierra expects your stuff to be there when you migrate your files from an
older Mac to a new MacBook, and all Apple applications can use your Home folder
TIP when loading and saving projects.

‘ Here’s another reason to use your Home folder to store your stuff: default locations!

Working with Mission Control,
Spaces, and Dashboard

For those power users that often work with a passel of applications, allow me to
turn your attention to one of the sassiest features in High Sierra: Mission Control.
Figure 3-10 shows off the Mission Control screen:

3 Press F3 (or Control+T, depending on your keyboard) to show all open
windows using Mission Control, grouped by application; then click the one you
want. Figure 3-10 illustrates the tiled All Windows display on my MacBook Air
after | press F3. Move the pointer on top of the window you want to activate —
the window turns blue when it's selected — and click once to switch to that
window. You can specify which keys you want to use in the Mission Control
pane in System Preferences.

3 Press Ctrl+F3 (or Control+!, depending on your keyboard) to show all
open windows from the application that you're currently using; click the one
you want to activate. This Mission Control function is great for choosing from
all the images you've opened in Photoshop or all the Safari web pages
populating your Desktop!

Astute observers will notice that the application menu bar also changes to match
the now-active application.

CHAPTER 3 The MacBook Owner’s Introduction to macOS High Sierra 69



FIGURE 3-10:

Mission Control is

70

the desktop
manager in
High Sierra.

TIP

TIP

Welcome to MLE Books Online!

9-M00 sBRABO o O®A i B

Besides the F3 and Control+F3 hot keys that I just discussed, Mission Control pro-
vides one more nifty function: Press 38+F3, and all your open windows scurry to
the side of the screen. Now you can work with drives, files, and aliases on your
Desktop — and when you’re ready to confront those dozen application windows
again, just press the keyboard shortcut a second time.

Naturally, these key combinations can be viewed and customized — visit the com-
fortable confines of System Preferences and click on the Mission Control icon to
choose what key sequence does what.

Although the Mission Control screen appears automatically when necessary, you
can launch it at any time from your MacBook’s Launchpad display or by pressing
the Mission Control key on your keyboard. From the trackpad, display the Mission
Control screen by swiping up with three fingers.

Switching Desktops with Spaces

Ah, but what if you want to switch to a different set of applications? For example,
suppose that you’re slaving away at your pixel-pushing job — say, designing a
magazine cover with Pages. Your page design Desktop also includes Adobe’s Pho-
toshop and InDesign, which you switch between often using one of the techniques
I just described. Suddenly, however, you realize you need to schedule a meeting
with others in your office, using Calendar, and you want to check your email in
Apple Mail. What to do?

Well, you could certainly open Launchpad and launch those two applications on
top of your graphics applications and then minimize or close them. But with Mis-
sion Control’s Spaces feature, you can press the Control+« or Control+— sequences
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to switch to a different “communications” Desktop, with Calendar and Apple Mail
windows already open and in your favorite positions. (I’ve also created a custom
“music” Desktop for GarageBand and iTunes.) Figure 3-10 illustrates multiple
Spaces Desktops at the top of the Mission Control screen.

After you set up your meeting and answer any important email, simply press
Control+« or Control+— again to switch back to your “graphics” Desktop, where
all your work is exactly as you left it. (And yes, Virginia, Spaces does indeed work
with full-screen applications.)

To create a new Desktop for use in Spaces, click the Launchpad icon on the Dock
and then click the Mission Control icon. Now you can set up new Spaces Desktops.
Move your pointer to the top right of the Mission Control screen, and click the Add
button (with the plus sign) that appears. (If you relocated your Dock to the right
side of the screen, the Add button shows up in the upper-left corner instead.)
Spaces creates a new empty Desktop thumbnail. Switch to the new Desktop by
clicking the label at the top of the Mission Control screen, and then open those
applications you want to include. (Alternatively, you can drag the applications
from Mission Control onto the desired Spaces label.) That’s all there is to it!

To switch an application window between Spaces Desktops, drag the window to
the edge of the Desktop and hold it there. Spaces automatically moves the window
to the next Desktop. (Applications can also be dragged between Desktops within
the Mission Control screen.) You can also delete a Desktop from the Mission Con-
trol screen. Just hover your pointer over the offending Spaces label to display the
thumbnail, and click the Delete button (with the X) that appears.

You can jump directly to a specific Spaces Desktop by clicking its thumbnail in
your Mission Control screen or by holding down the Control key and pressing the
number corresponding to that desktop. Finally, you can always use the Control+«
or Control+— shortcuts to move between Desktops and full-screen applications.

Stick it on the Dashboard

Dashboard is a favorite feature of mine within High Sierra — I use it to hold wid-
gets and display them with the press of a button. (Okay, I know that sounds a little
wacky, but bear with me.) Widgets are small applications — dubbed by some as
‘“applets” — that typically provide only one function. For example, Dashboard
comes complete with a calculator, dictionary, clock, weather display, and quick-
and-simple calendar.

By default, Dashboard is turned off in High Sierra. To enable Dashboard, open the

Mission Control pane in System Preferences, click the Dashboard pop-up menu
and select As Space (which displays your widgets as a separate Space in Mission
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Control). You can also choose overlay mode if you prefer your widgets to “float”
over your Desktop instead.

You can display and use these widgets at any time by pressing the Dashboard
shortcut; by default, that’s Function-F12 on current Apple laptop keyboard mod-
els (hold down the FN key and press F12), or press the Function Keys display on
your Touch Bar and press F12. You can modify the Dashboard key on the Mission
Control pane in System Preferences. Dashboard also appears as a Desktop in the
Spaces strip on the Mission Control screen and as an icon in Launchpad, and you
can add it to your Dock from the Applications folder.

You can add widgets to your Dashboard by clicking the Add button (which bears a
plus sign, naturally) at the lower-left corner of the Dashboard screen. Then Dash-
board displays your entire collection of widgets, and you can click a widget to add
it directly onto your Dashboard.

While you’re adding widgets, rearranging the widgets that are already populating
Dashboard is easy: Drag them to the desired spot. When it’s time to go back to
work (or play), you can return to your High Sierra Desktop by pressing the Dash-
board key again, or by clicking anywhere on the Dashboard background.

Most widgets have an option button that allows you to change things, such as
borders, zip codes, display columns, and the like; look for a tiny circle with a low-
ercase letter i. Click this information icon, and you can then tweak whatever
options are available for that widget.

To remove a widget from the Dashboard display, just click the Delete button
(which bears a minus sign) and you’ll notice that a tiny X button appears next to
each widget on your Dashboard. Click the X button next to the widget you want to
remove, and it vanishes from the display. Note, however, that deleting a widget
doesn’t remove it from your Mac entirely! You can add that deleted widget back
again at any time by clicking the Add button. To return to your Dashboard, click
the Delete button again.

Personalizing Your Desktop

72

Many folks put all their documents, pictures, and videos on their High Sierra
Desktop because the file icons are easy to locate! Your computing stuff is right in
front of you . . . or is it?

Call me a finicky, stubborn techno-oldster — go ahead, it’s true — but I prefer a
clean macOS Desktop without all the iconic clutter. In fact, my Desktop usually has
just three or four icons even though I use my MacBook several hours every day,
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often on multiple book projects. It’s an organizational thing; I work with literally
hundreds of applications, documents, and assorted knickknacks daily. Sooner or
later, you’ll find that you’re using that many, too. When you keep your stuff
crammed on your Desktop, you end up having to scan your screen for a particular
file, alias, or type of icon. You end up taking more time to locate it on your Desktop
than in your Documents folder! And don’t forget, open windows hang out on your
Desktop too. To find anything, you have to close or move those windows!

Plus, you’ll likely find yourself looking at old icons that no longer mean anything
to you or stuff that’s covered in cobwebs that you haven’t used in years. Stale
icons — yuck.

I recommend that you arrange your Desktop so that you see only a few icons for
the files or documents you use the most. Leave the rest of the Desktop for that cool
image of your favorite actor or actress.

Besides keeping things clean, I can recommend a number of other favorite tweaks
that you can make to your Desktop:

3 Keep Desktop icons arranged as you like.
1. From the Finder menu, choose View ©> Show View Options.

2. From the Sort By pop-up menu, choose the criteria that High Sierra uses to
automatically arrange your Desktop icons, including the item name, the last
modification date, or the size of the items.

| personally like things organized by name, but many MacBook owners
prefer to see things organized by date (putting the most recently modified
item at the top, for example).

3 Choose a favorite background.

1. Right-click any open spot on your Desktop and choose Change Desktop
Background.

The Desktop & Screen Saver pane appears, as shown in Figure 3-11.

2. Browse through the various folders of background images that Apple provides,
open a folder of your own images, or use an image from your Photos library.

3 Display all the peripherals and network connections on your system.
1. Choose Finder > Preferences.

2. Make sure that all four of the top check boxes are selected: Hard Disks; External
Disks; CDs, DVDs, and iPods; and Connected Servers.

If you're connected to an external network, or if you've loaded an external hard
drive or device, these external storage locations show up on your Desktop. You
can double-click that Desktop icon to view your external stuff.
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Customizing the Dock

In terms of importance, the Dock — the quick-access strip for applications and
documents that appears on your Desktop — ranks right up there with the com-
mand center of a modern nuclear submarine. As such, it had better be easy to
customize, and naturally, macOS doesn’t let you down.

Adding applications and extras to the Dock

Why be satisfied with just the icons that Apple places on the Dock? You can add
your own applications, files, and folders to the Dock as well:

¥ Adding applications: You can add any application to your Dock by dragging
its icon into the area to the /eft side of the Dock (that's to the left side of the
vertical line on the Dock). You'll know when you're in the proper territory
because the existing Dock icons obligingly move aside to make a space for it.

Attempting to place an application directly on the right side of the Dock sends
it to the Trash (if the Trash icon is highlighted when you release the button), so

beware. Note, however, that you can drop an application icon inside a Stack
WARNING (more on that in a bit) or a folder that already exists at the right side of the

Dock. (If you've repositioned the Dock to the left or right side of the screen,
consider the top of the Dock as the “left side” and the bottom of the Dock as
the “right side.”)
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¥ Adding individual files and volumes: Individual files and volume icons can
be added to the Dock by dragging the icon into the area to the right side of the
Dock. (Attempting to place these to the left side of the Dock opens the
application associated with the contents, which typically isn't what you
intended.) Again, the existing Dock icons move aside to create a space when
you're in the right area.

To open the Dock item you've added in a Finder window, right-click the icon to
display a Dock menu, where you can open documents, run applications, and
have other assorted fun, depending on the item you choose.

¥ Adding several files or a folder: High Sierra uses a feature called Stacks,
which | discuss in the next section, “Keeping track with Stacks,” to handle
multiple files or add an entire folder to the Dock.

¥ Adding websites: You can drag any URL from Safari directly into the area at
the right of the Dock. Clicking that Dock icon automatically opens your
browser and displays that page.

To remove an icon from the Dock, just click and drag it off the Dock. Note, how-
ever, that the original application, folder, or volume is not deleted — just the Dock
icon itself is permanently excused. If you like, you can delete almost any of the
default icons that macOS installs on the Dock; only the Finder and Trash icons
must remain on the Dock.

Keeping track with Stacks

High Sierra offers Stacks, which are groups of items (documents, applications, and
folders) that you want to place on the Dock for convenience — perhaps the files
needed for a project you’re working on, or your favorite game applications. For
example, I have a Stack named Wiley on my Dock that holds all the project files I
need for the book I’m currently writing.

To create a Stack, just select a folder containing the items and drag the folder to
the right side of the Dock. As always, the Dock opens a spot on the right side of the
Dock to indicate you’re in the zone.

To display the items in a Stack, just click it:

¥ If the Stack holds relatively few items, they're displayed in a really cool-
looking arc that Apple calls a fan, and you can click the item you want to open
or launch. Figure 3-12 illustrates a typical Stack unfurled as a fan.

¥ If the Stack is stuffed full of many items, the Stack opens in a grid display,
allowing you to scroll through the contents to find what you need.
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High Sierra provides a number of display and sorting options for a Stack. Right-
click the Stack icon, and you can choose to sort the contents by name, date created
or added, date modified, or file type. If you’d prefer a grid display (no matter how
many items the Stack contains), you can choose Grid mode. Choose List to display
the Stack’s contents in much the same way as List view mode in a Finder window.
List view mode also allows you to view folders in a Stack as nested menu items.
Choose Automatic to return to the default view mode.

When set to Display as Stacks, the Stack icon is displayed using icon images from
the contents of the folder; if security is an issue, however, choose Display as Folder
from the right-click menu to display the Stack as a plain folder icon instead.

You can remove a Stack from the Dock by right-clicking the Stack icon and choos-
ing Options from the menu that appears. Choose Remove from Dock from the
submenu that appears. Alternatively, just drag that sucker right off the Dock.

You can also display the contents of a Stack in a Finder window. Right-click the
Stack icon, and choose the Open item at the bottom of the pop-up menu.

If you add a folder full of items, the Stack is named after the folder; otherwise,
High Sierra does the best job it can in figuring out what to name the Stack.
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Apple provides a Stack already set up for you: The Downloads folder, situated next
to the Trash, is the default location for any new files that you download using
Safari or receive in your email. High Sierra bounces the Download Stack icon to
indicate that you’ve received a new item.

Resizing the Dock

You can change the size of the Dock from the Dock settings in System Preferences —
but here’s a simpler way to resize the Dock, right from the Desktop.

Move your pointer over the vertical solid line that separates the left side of the
Dock from the right side; the pointer turns into a funky vertical line with arrows
pointing up and down. This is your cue to click and drag while moving up and
down, which expands and shrinks the Dock, respectively.

You can also right-click when the funky line pointer is visible to display a menu
of Dock preferences. This allows you to change your Dock preferences without the
hassle of opening System Preferences and displaying the Dock settings.

What's with the Trash?

©

REMEMBER

Another sign of a Mac laptop power user is a well-maintained Trash can. It’s a
breeze to empty the discarded items you no longer need, and you can even rescue
something you suddenly discover you still need!

The translucent High Sierra Trash icon resides in the Dock, and it works just like
the Trash has always worked in macOS: Simply drag selected items to the Trash to
delete them.

Note one very important exception: If you drag a Desktop icon for an external
device or a removable media drive to the Trash (such as an iPod, DVD, or external
hard drive), the Trash icon turns into a giant Eject icon, and the removable device
or medium is ejected or shut down — not erased. Repeat, not erased. (That’s why
the Trash icon changes to the Eject icon — to remind you that you’re not doing
anything destructive.)

Here are other ways to chuck items you select to go to the wastebasket:

¥ Choose File > Move to Trash.

¥ Click the Action button on the Finder toolbar, and choose Move to Trash from
the list that appears.
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¥ Press §8+Delete.

¥ Right-click the item and choose Move to Trash from the menu that appears.

You can always tell when the Trash contains at least one item, because the basket
icon is full of crumpled paper. However, you don’t have to unfold a wad of paper
to see what the Trash holds. Just click the Trash icon in the Dock to display the
contents of the Trash. To rescue something from the Trash, drag the item(s) from
the Trash folder to the Desktop or any other folder in a Finder window. (If you’re
doing this for someone who’s unfamiliar with High Sierra, remember to act like it
was a lot of work, and you’ll earn big-time DRP, or Data Rescue Points.)

When you’re sure that you want to permanently delete the contents of the Trash,
use one of these methods to empty the Trash:

¥ Choose Finder = Empty Trash.

¥ Press 38+Shift+Delete.

¥ Right-click the Trash icon in the Dock and choose Empty Trash from the menu
that appears.

All You Really Need to Know
about Printing

78

TIP

Since we’re near the end of this chapter, I turn now to a task that most MacBook
owners need to tackle soon after buying their laptop or installing High Sierra:
printing documents. Because basic printing is so important (and in most cases, so
simple), allow me to demonstrate how to print a document.

Most of us have a Universal Serial Bus (USB) printer — the USB being the favored
hardware connection in macOS. As long as your printer is supported by macOS,
setting it up is as easy as plugging it into one of your MacBook’s USB ports.

Before you print, preview! Would you jump from an airplane without a parachute?
Then why would you print a document without double-checking it first? Most
applications now have their own built-in Preview thumbnails in the Print sheet,
as shown in Figure 3-13 — this is definitely A Good Thing, since you see what the
printed document will look like, possibly saving you both paper and some of that
hideously expensive ink or toner.
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FIGURE 3-13:
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To print from any application using the default page characteristics — standard
814 x 11"” paper, portrait mode, no scaling — follow these steps:

1.

In your application, choose File = Print or press the 35+P keyboard

shortcut.

In most applications, macOS displays the simple version of the Print sheet. (To
display all the fields you see in Figure 3-13, click the Show Details button at the
bottom of the sheet.) Some applications use their own custom Print dialogs,

but you should see the same general settings.

Click in the Copies field, and enter the number of copies you need.

You can also enable or disable collation, just as you can with those oh-so-fancy

copiers.

Decide what you want to print.

® The whole shootin” match: To print the entire document, use the default
Pages radio button setting of All.

® Anything less: To print a range of selected pages, select the From radio
button and enter the starting and ending pages (or, if the application
allows it, a selection of individual pages).
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4.

5.

(Optional) Choose application-specific printing parameters.

Each macOS application provides different panes so you can configure settings
specific to that application. You don't have to display any of these extra settings
to print a default document, but the power is there to change the look
dramatically when necessary. To display these settings, open the Layout
pop-up menu in the center of the Print sheet and choose one of these panes.
For example, if you're printing from Contacts, you can choose the Contacts
entry from the pop-up menu and elect to print a phone list, an envelope,
mailing labels, or an email list.

When everything is go for launch, click the Print button.

Of course, there are more settings and more functionality to the printing
system in macOS. However, | can tell you from my experiences as a consultant
and hardware technician that this short introduction to printing will likely
suffice for 90 percent of the Mac owners on Earth. 'Nuff said.

And Just in Case You Need Help.. ..

TIP

You can call on the resources described in this section if you need additional help
while you’re discovering how to tame High Sierra.

Some of the help resources are located on the Internet, so your Safari web browser
will come in handy when you search for answers.

The High Sierra built-in Help system

Sometimes the help you need is as close as the Help menu on the Finder menu bar.
You can get help for either of the following:

»

»

A specific application: From the application, just click Help. Then click in the
Search box and type a short phrase that sums up your query (such as startup
keys). You see a list of help topics on the menu. Just click a topic to display
more information.

General topics: Click a Finder window and then click Help on the menu bar.
Again, you see the Search box, and you can enter a word or phrase to find in
the Help system. To display the Help Center window, click the Help Center
item under the Search box.

80 PART 1 Tie Myself Down with a Desktop? Preposterous!



TIP

The Apple web-based support center

Apple has online product support areas for every hardware and software product
it manufactures. Visit www.apple.com and click the Support link at the top of the
web page.

The Search box works just like the macOS Help system, but the knowledge base
that Apple provides online has a lot more answers.

Magazines

Many magazines and publications (both in print and online) offer tips and tricks
on using and maintaining macOS High Sierra.

My personal online favorites are Macworld (www . macwor1d.com) and the Wiley For
Dummies website (www . dummies.com).

Local Mac user groups

I'd be remiss if I didn’t mention your local Mac user group. Often, a user group
maintains its own website and discussion forum. If you can wait until the next
meeting, you can even ask your question and receive a reply from a real live human
being. This is quite a thrill in today’s web-centric world!

To locate a local user group using your Internet connection, launch Safari, click in
the Address box, and type

Mac User Group location
Instead of location, type the desired spot on the map, like
Mac User Group Columbia Missouri

Don’t forget to press Return!

CHAPTER 3 The MacBook Owner’s Introduction to macOS High Sierra 81


http://www.apple.com/
http://www.macworld.com/
http://www.dummies.com/




Shaking Hands
with macOS
High Sierra



IN THIS PART ...

Learn more about the new features within macOS
High Sierra.

Use System Preferences to fine-tune how High Sierra
works.

Keep track of practically everything using Notes, Maps,
and Reminders.

Use Spotlight to search your entire system in seconds.



IN THIS CHAPTER

» Using the new Apple File System

» Reducing the size of video files

» Enhancing Mac graphics and virtual
reality

» Improving editing and organization in
Photos

» Building on the success of Siri

» Banishing ads and autoplay videos
from the Web

» Sharing files using iCloud Drive

Chapter 4

What's New in macOS
High Sierra?

ave you upgraded to High Sierra from the previous version of macOS,

Sierra? (Nothing like a subtle name change to avoid confusion, I always

say.) If so, you’ve opened the door to a number of new features, and this
chapter was written especially for you. (And if you’re not rubbing your hands
together with gleeful anticipation, you should be — I know I am.) Here you’ll find
descriptions of my favorite new features that ship with the latest version of
macOS.

Note that a number of other new High Sierra features appear elsewhere in the
book — for example, the discussion of customizing settings for individual web-
sites appears within the Safari chapter. The new features you find here, however,

are what I consider the real standouts, so they’re showcased separately.

Let the fun begin!
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Under the Hood: The New Apple
File System

Many of the most important new features in High Sierra work behind the scenes -
thus the moniker “Under the Hood.” To illustrate: You won’t run a new applica-
tion or choose a new menu item to take advantage of the new Apple File System (or
APFS) featured in High Sierra, because it’s truly the foundation of your MacBook’s
storage, and it all works automatically and invisibly.

Forgive me while I wax technical for a few seconds: Your MacBook’s solid-state
06“ f:'lrive (or SSD for short) saves and reads every filfe and fold‘er on your laptop, and
it does so at speeds far faster than older magnetic hard drives. However, today’s
tecunicar  SSD drives were actually running less efficiently under previous versions of macOS
STUFF than they could be, as they were hobbled by the original Mac OS X file system,
which dated back to 2001 and the days of floppy disks. (We’re talking antiquity

here.)

To address the issue, Apple’s engineers redesigned the APFS especially for SSD
technology. If that sounds less than heroic, consider the benefits you’ll enjoy with
every application and macOS function:

3 APFS can instantly display file and folder information (like the total size of an
overstuffed folder). No more waiting for those pesky calculations!

¥ Data encryption and security has been improved over the old file system.
¥ Copying and moving files and folders takes significantly less time.

¥ Your files and folders are safer in the event of a system crash or sudden loss
of power.

“But Mark, my older MacBook still uses a magnetic hard drive! Does this mean I
can’t run High Sierra?” Never fear, good reader: APFS is backwards-compatible
with older hard drives and will run just fine. Naturally, you won’t notice much of
a speed improvement, since you’re not using solid-state technology, but you’ll
still benefit from the upgrade. Note, however, that an older application that dates
back several years might be incompatible with the new file system — contact the
developer to see if there’s an update to the application that will allow it to run
under High Sierra.
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Under the Hood: Better Video

Our next “hidden” new feature in macOS High Sierra is the arrival of High Effi-
ciency Video Coding, better known by the far less intimidating acronym HEVC. HEVC
video files offer up to 40 percent better compression than older video formats,
which results in far smaller file sizes. In plain English, movies that you rent and
buy from the iTunes Store will take up less space, and streaming sites that feature
HEVC video will require less buffering (even on slower broadband connections).

Oh, and here’s the payoff: HEVC offers the same quality as the older formats, so
your video will look just as good!

Under the Hood: Improved Graphics
and Virtual Reality

I'll include one last stowaway within macOS High Sierra: the new graphics engine
named Metal 2, which will be an amazing boon to gamers, video professionals and
virtual reality developers. With Metal 2, you can not only take full advantage of
your Mac’s built-in graphics hardware (providing mind-blowing visual effects),
you can even add an external GPU (short for Graphics Processing Unit) to super-
charge your video. Virtual reality fans will thrill to the new support for SteamVR
software and the HTC Vive VR headset, finally bringing us closer to a truly seam-
less VR world!

Adding Functionality to Photos

Although High Sierra’s Photos application contains the common image editing
functions that most MacBook owners will use the most — such as cropping, rotat-
ing, and applying filters — amateur and professional photographers will find that
the new version of Photos that accompanies High Sierra adds several powerful
features that make it easier to edit and organize a large photo library. For exam-
ple, the new search, filter, and batch controls allow you to perform the same oper-
ation on an entire folder of files. (Can you say, “Rotate every one of these 100
images once clockwise” automatically, instead of manually? Oh, I knew you could.)
The improved Photos sidebar allows you easy access to every album — even
hidden images are now just a click away.

As for editing mode, you're going to appreciate the new advanced tools that
Photos provides (shown in Figure 4-1); these controls remind me of other
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professional-level image applications, such as Aperture and Adobe Photoshop. And
you can still choose to edit images within Photos using a third-party application
like Photoshop, but now the process is far more seamless and much easier to use.

® ®® [ mO | ReverttoOriginal FTIE & Fiies | 3 Crop

FIGURE 4-1:
Photos offers
new advanced
editing controls in
High Sierra.

[ Noise Reduction

Improved Siri to the Rescue

Are you on an intimate basis with Siri, Apple’s voice assistant? There’s no shame
in admitting it. If so, you’re going to love the improvements to Siri:

¥ Within iTunes, Siri can now recommend music, create playlists and provide
you with information about albums or artists.

¥ If you're in a meeting or want to ask Siri a question without speaking, you can
use the new Type to Siri feature. Note, however, that Siri will still speak the
results normally.

3 Siri now sounds more....well... human! The intonation and expressiveness
of your favorite voice is greatly improved.
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Banish Scams and Advertisements!

Personally, I find our next standout new feature to be a downright sanity saver:
Safari now uses Reader mode automatically if a web page supports it! As you can
see in Figure 4-2, the Reader display is far easier on the eyes, and Reader removes
all extraneous advertising, images and assorted hoo-hah; in fact, for those of us
who date back to the beginning of the World Wide Web, Safari Reader paints the
web as it used to look before the arrival of the Commercial Scourge.
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Shortly after Pan American Airways started flying from New
York to London in 1959, a round trip ticket cost what would be
$3,800 today — in economy class.

. More than a half-century later, Pan Am is long gone and newcomer Norwegian Air
FIGURE 4-2: Shuttle ran a special promotion with $65 one-way tickets on 10 new routes from
Bless you, Safari the northeast U.S. to Ireland and Scotland.
Reader — the Those fares sold out in less than a day. They're also a signal that, with new low-
a dve I’ti sements cost carriers spreading their wings across the U.S., the Atlantic and Pacific, we're
heading into a new golden age of affordable air travel.
are gone!

Oh, and you needn’t fear losing the content you do want to see: Reader provides
you with everything on the page, just not the extraneous crud. (More on this trea-
sure in Chapter 8.)

Sharing the Joy of iCloud Drive

If you want to store and share files online using the iCloud Drive provided by
macOS, it’s time to celebrate: iCloud Drive users can now share files and folders
with others using email links! The recipients you select each receive an email with
a direct link to the shared file, turning iCloud Drive into a collaboration tool on the
order of Dropbox. Best of all, using a shared file is convenient, with no download-
ing necessary.
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Away with Autoplay Videos!

Okay, I know I said that automatic Reader mode was the best thing to hit Safari
earlier, but I almost forgot the other killer new feature: Say goodbye to those irri-
tating autoplay videos! How many times have you found yourself grinding your
teeth in frustration while your Mac automatically loads some mindless advertis-
ing video on a web page? The Apple macOS designers heard your cries, and Safari
now prevents videos from starting up by themselves. (If you’re on a site where you
actually want autoplay videos — such as YouTube — you can enable autoplay for
that specific site using the new custom website controls in Safari.)
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» Navigating System Preferences

» Locating specific controls

» Customizing High Sierra from System
Preferences

Chapter 5

A Nerd’'s Guide to System
Preferences

emember the old TV series Voyage to the Bottom of the Sea? You always knew

you were on the bridge of the submarine Seaview because it had an entire

wall made up of randomly blinking lights, crewmen darting about with
clipboards, and all sorts of strange and exotic-looking controls on every available
surface. You could fix just about anything by looking into the camera with grim
determination and barking an order. After all, you were On the Bridge. That’s why
virtually all the dialog and action inside the sub took place on that one (expensive)
set: It was the nerve center of the ship, and a truly happenin’ place to be. Just like
the bridge of your favorite starship from an entire host of TV shows and movies.

In the same vein, I devote this chapter to the System Preferences window and the
most commonly used settings within it. After all, if you want to change how High
Sierra works or customize the features in our favorite operating system, you
should head toward System Preferences. This one window is the nerve center of
macOS and a truly happenin’ place to be. Sorry, no built-in wall of randomly
blinking lights — but you do find exotic controls just about everywhere.
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An Explanation — without Jargon, No Less

The System Preferences window, shown in Figure 5-1, is a self-contained beast.
You can reach it in the following ways:

¥ Click the Apple menu (), and choose System Preferences.

¥ Click the Time and Date display in the menu bar and then choose Open Date
and Time Preferences. In fact, you can also click most of the other menu
status icons — including Bluetooth and Wi-Fi — and then choose Open
Preferences.

¥ Right-click any uninhabited area of your Desktop, and choose Change Desktop
Background.

¥ Last, but not least, click the Launchpad icon in the Dock and then click the
System Preferences icon (it looks like a collection of gears).

o0 4 i System Preferences Q
Fa— . 5 = PY
i @ - g o @
General Desktop & Dock Mission Language Security Spotlight  Notifications
Screen Saver Control & Region & Privacy
—_— =
. wm N =
Displays Energy Keyboard Mouse Trackpad Printers & Sound Startup
Saver Scanners Disk
A - b L
» @ @ @ 0 v =
iCloud Internet App Store Network Bluetooth Extensions Sharing

Accounts

n

@

B © W

Users & Parental Siri Date & Time Time Accessibility
Groups Controls Machine
FIGURE 5-1:
The powerhouse
of settings and
switches: System Flash Player
Preferences.

When the System Preferences window is open, you can click any of the icons to
switch to that pane. The entire window morphs to display the settings for the
selected pane. For example, Figure 5-2 shows the Sound pane, which allows you
to set a system alert sound, configure your MacBook’s built-in microphone, and
choose from several different output options.
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FIGURE 5-2:

The Sound pane,
proudly showing
off the Sound
Effects panel.

TIP

e < HEH Sound Q

Qutput  Input
Select an alert sound:

Name Type

Basso Built-in

Blow Built-in

Bottle Built-in

Frog Built-in

Funk Built-in

Glass Built-in

Play sound effects through: | Internal Speakers | <]
Alert volume: uf *)))

./ Play user interface sound effects

Play feedback when volume is changed

Output volume: ) o ))) Mute

24 Show volume in menu bar

Many panes also include a number of tabbed buttons at the top — in this case,
Sound Effects, Output, and Input. You can click these tabs to switch to another
section in the same pane. Many panes in System Preferences have multiple sec-
tions. This design allows our friends at Apple to group a large number of related
settings in the same pane (without things getting too confusing).

To return to the top-level System Preferences pane from any other pane, just click
the Show All button (located in the upper-left corner of the pane) or press
s8+L. You can also click the familiar Previous and Next buttons to move backward
through the panes you’ve already visited and then forward again, in sequence.
(Yep, these buttons work just like the browser controls in Safari. Sometimes life is
funny that way.)

Although the System Preferences panes are arranged by category when you first
install High Sierra, you can also display the panes in alphabetical order. To arrange
the panes in this way, choose View=> Organize Alphabetically. Note that you can
also select any pane directly from the View menu. Choose View=> Customize, and
you can hide specific icons from the System Preferences window. Just deselect the
check box next to each icon you want hidden, and then click Done. You can still
reach hidden icons from the System Preferences View menu, so they’re not ban-
ished forever.

You can right-click the System Preferences icon in the Dock to jump to any pane
from the shortcut menu. Wowzers!
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REMEMBER

HEY, | HAVE BONUS ICONS IN MY WINDOW!

Some third-party applications and media plug-ins can actually install their own panes in
your once-pristine System Preferences window. You see them arranged at the bottom
of the window (for example, the Flash Player icon shown in Figure 5-1). Naturally, | can't
document these invited guests in this chapter, but they work the same way as any other
pane in System Preferences. Click the icon, adjust any settings as necessary, and then
close the System Preferences window to save your changes.

You won’t find an OK button that you have to click to apply any System Prefer-
ences changes. Apple’s developers do things the right way. Your changes to the
settings in a pane are automatically saved when you click Show All or when you
click the Close button in the System Preferences window. You can also press $8+Q_
to exit the window and save all your changes automatically. This is one of my
favorite shortcuts.

If you see an Apply button in a pane, you can click it to immediately apply any
changes you made, without exiting the pane. This is perfect for settings you might
want to try before you accept them, like many of the controls in the Network pane.
However, if you’re sure about what you changed and how those changes will affect
your system, you don’t have to click Apply. Just exit the System Preferences win-
dow or click Show All as you normally would.

Locating That Certain Special Setting

94

Wouldn't it be great if you could search through all the different panes in System
Preferences — with those countless radio buttons, check boxes, and slider controls —
from one place, even when you’re not quite sure what you’re looking for?

Figure 5-3 shows exactly that kind of activity taking place. Just click in the System
Preferences Spotlight Search box (located in the upper-right corner of the pane,
with the magnifying glass icon), and type just about anything. For example, if you
know part of the name of a particular setting you need to change, type that. High
Sierra highlights the System Preferences panes that might contain matching set-
tings. And if you’re a switcher from the Windows world, you can even type what
you might have called the same setting in Windows.

The System Preferences window dims, and the icons that might contain what
you’re looking for stay highlighted. Slick.
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FIGURE 5-3:
Searching for
specific settings is
a breeze with the
Search box.

TIP

System Preferences

Desktop picture

Desktop & Screen Saver

Set up Spaces

Button, menu, and window look
Dashboard shortcuts

Exposé shortcuts

Trackpad gestures

Dock settings

You can also search for System Preferences controls by using the Spotlight box
from the Finder menu. Find more on this cool feature in Chapter 6.

If you need to reset the Search box to try again, click the X icon that appears at the
right side of the box to clear it.

Popular Preferences Panes Explained

It’s time to get down to brass tacks: Let’s open the most often-used panes in Sys-
tem Preferences to see what magic you can perform. I won’t discuss every pane,
because I cover many of them in other chapters. In fact, you might never need to
open some System Preferences panes, such as the Language & Region pane. This
chapter covers just about all the settings you’re likely to use on a regular basis.

The Displays pane

If you’re a heavy-duty gamer, or you work with applications such as Keynote or
Photoshop, you probably switch your monitor’s characteristics regularly. To
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TIP

TIP

switch easily, visit the Displays pane, shown in Figure 5-4. It includes three

sections:

3 Display: To allow High Sierra to choose the best resolution for your display,
select the Default for Display radio button. To manually select a resolution,
select the Scaled radio button and then click the resolution you want to use
from the Resolutions list that appears. In most cases, you want to use the
highest resolution.

Move the Brightness slider to adjust the brightness level of your MacBook's
display. If you like, you can enable the Automatically Adjust Brightness check
box to allow your MacBook to select a brightness level.

To automatically adjust the brightness to match the ambient light around you,
enable the Ambient Light Compensation check box.

Ready to stream content to your TV directly from your MacBook — without
cables? You can use High Sierra's wireless AirPlay Display feature to send the
display from your MacBook to your HD-TV. AirPlay requires an Apple TV unit
that supports this feature. You can also send the audio from your MacBook
directly to an AirPlay-enabled receiver or speaker system. To make it easier to
control AirPlay, select the Show Mirroring Options in the Menu Bar When
Available check box. (Note that the icon will only appear in your menu bar
when you have an Apple TV unit within range.)

¥ Color: Click a display color profile to control the colors on your screen. To load
a profile, click the Open Profile button. To create a custom ColorSync profile
and calibrate the colors that you see, click the Calibrate button to launch the
Display Calibrator. This easy-to-use assistant walks you step by step through
creating a ColorSync profile matched to your MacBook’s gamma and white-
point values.

3 Night Shift: If your MacBook was built in 2012 or later, the Night Shift feature
allows High Sierra to automatically adjust your display to provide warmer
colors during nighttime operation. Click Schedule to choose either Sunset to
Sunrise operation or create your own custom schedule. You can also turn on
Night Shift manually using the Turn On Until Tomorrow check box. Finally,
adjust the Color Temperature slider to increase or decrease the warmth of
colors on your display.

If you connect your MacBook to an external monitor, don't be surprised to see
the Arrangement section appear as well. You can drag the output to a
different monitor, or drag the menu bar to another screen, or you can choose
to mirror the same output to all displays connected to your MacBook.
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[ N J < it Built-in Display Q
Color  Night Shift
= Resolution: Default for display
) Scaled
1440 = 900
1280 = 800
= — 1152 = 720
1024 = 640
Brightness:
% Automatically adjust brightness
FIGURE 5-4:
The Display pane
makes it easy to AirPlay Display: = Off | <]
change your _ _
. 2 Show mirroring options in the menu bar when available ?
screen resolution.

The Desktop & Screen Saver pane

No offense to the awesome High Sierra “sunlit peaks” background, but who
doesn’t want to choose his or her own background? And what about that nifty
screen saver you just downloaded from the Apple website? You can change both
the background and screen saver by using these options in the Desktop & Screen
Saver pane.

The settings on the Desktop panel, shown in Figure 5-5, are

3 Current Desktop picture: You can click a picture in the thumbnail list at the
right half of the screen to use it as your Desktop background. The Desktop is
immediately updated, and the thumbnail appears in the well (the upper-left
box in Figure 5-5). To display a different image collection or open a folder of
your own images, click the Add Folder button at the lower left of the window
(a plus sign) and browse for your heart's desire; then click Choose to select a
folder and display the images it contains.

¥ Layout: You can tile your background image, center it, fill the screen with it
(cropping the edges if necessary), and stretch it to fill the screen (without
cropping). Note that filling the screen in either case may distort the image. The
layout pop-up menu appears only when you're using your own pictures, so
you don't see it if you're using a Desktop image supplied by Apple.

¥ Change Picture: Change the Desktop background automatically after the
delay period that you set, including each time you log in and each time your
Mac wakes up from sleep mode.
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3 Random Order: To display screens randomly, enable the Random Order
check box. Otherwise, the backgrounds are displayed in the sequence in
which they appear in the thumbnail list.

[ N ] < HH Deskiop & Screen Saver Q

| De p Screen Saver

v Apple
|| Desktop Pictures
«' Solid Colors

¥ Photos
» O] Moments -
» [ Collections
» [T Years
» [C] Places “
¥[] Albums
[T London...y 07/21 —
=] Camera Card -“
[E London...y 07/20
[T London...y 07/19

FIGURE 5-5: =
B + Change picture: | Every 30 minutes &
Pick your own Random order »
Desktop :
background.

The settings on the Screen Saver tab are

¥ Screen Saver: In the Screen Saver list at the left, click any screen saver to
preview (on the right). To try out the screen saver in full-screen mode, hover
your pointer over the display on the right and click the Preview button that
appears. (You can end the test by moving the cursor.) If the screen saver
module you select has any configurable settings, click the Screen Saver
Options button to display them. (A screen saver is not configurable if the
Screen Saver Options button doesn't appear.) Choose the Random screen
saver to display a different screen saver module each time the screen saver is
activated.

¥ Start After: Specify the period of inactivity that triggers the screen saver. To
disable the screen saver, choose the Never setting at the top of the list. (Your
Start After delay should be a shorter time than the Display Sleep delay you set
in the System Preferences Energy Saver pane. Otherwise, you won't see the
great screen saver at all. | describe the Energy Saver pane later in this
chapter.)

3 Show with Clock: If you want your selected screen saver to display the time
as well, select this check box.
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TIP

FIGURE 5-6:

Set your

Mission Control
preferences here.

3 Hot Corners: Click the Hot Corners button, and then click any of the four
pop-up menus at the four corners of the screen. Doing so designates that
corner as an activation hot corner (immediately activates the screen saver) or
as a disabling hot corner (prevents the screen saver from activating). As long as
the cursor stays in the disabling hot corner, the screen saver doesn't kick in,
no matter how long a period of inactivity passes. Note that you can also set
the Sleep, Mission Control, Launchpad, Notification Center, and Dashboard
activation corners from here. For the scoop on these features, see the next
section.

For additional security, check out the Security & Privacy pane in System
Preferences, where you find the Require Password After Sleep or Screen Saver
Begins check box. When you select this check box, High Sierra requires your
user account password before allowing anyone to turn off the screen saver (a
great idea when traveling, as you can imagine).

Mission Control preferences

Figure 5-6 shows the Mission Control, Spaces, and Dashboard settings you can
configure in this group. You can use Mission Control to view all the application
windows you’re using at one time so that you can select a new active window. Or
you can move all windows aside so that you can see the Desktop. Dashboard
presents a number of mini-applications (or widgets), which you can summon and
hide by pressing a single key.

@@ < & Mission Control Q

Mission Control gives you an overview of all your open windows, thumbnails of your full-
screen applications, and Dashboard, all arranged in a unified view.

o/ Automatically rearrange Spaces based on most recent use

4 When switching to an application, switch to a Space with open windows for the application
Group windows by application

./ Displays have separate Spaces

Dashboard: | As Space | < |

Keyboard and Mouse Shortcuts

With a single keystroke, view all open windows, windows of the current application, or hide windows to locate an
item on the desktop that might be covered up.

Mission Contral: =~
Application windows: ~ 4
Show Desktep: F11

Show Dashboard: = F12

(o] of ol
(ol ofof<

(for additional choices press Shift, Control, Option, or Command)

Hot Corners... ?

CHAPTER 5 A Nerd’s Guide to System Preferences 99



The settings are

3 Automatically Rearrange Spaces Based on Most Recent Use: If this check
box is selected, Mission Control presents your most recently used Spaces first
in the thumbnails at the top of the screen.

3 When Switching to an Application: When selected, this check box allows
you to switch applications between Spaces desktops by using the 38+Tab
shortcut. Yosemite jumps to the Desktop that has an open window for the
application you choose, even if that Desktop is not currently active.

3 Group Windows by Application: When selected, this check box automatically
arranges windows in the Mission Control screen by the application that
created them.

3 Displays Have Separate Spaces: If you have multiple monitors connected to
your Mac, you can select this check box to create a separate Spaces display for
each monitor.

To display your Dashboard as a Space (a virtual desktop) in the Mission
Control screen, click the Dashboard pop-up menu and choose the As Space
option. If you prefer your Dashboard widgets to appear as an overlay over
TIP your Desktop, select the As Overlay option from the pop-up menu.

3 Keyboard and Mouse Shortcuts: From each pop-up menu, set the key
sequences (and mouse button settings) for Mission Control, Application
Windows, Show Desktop, and Show Dashboard.

Press the Shift, Control, Option, and 38 keys while a pop-up menu is open, and
you see these modifiers appear as menu choices! (Heck, you can even
REMEMBER combine modifiers, such as 38+Shift+F9 instead of just F9.)

@ You're not limited to keyboard and mouse shortcuts in the pop-up menus.

3 Hot Corners: Click the button at the lower-left corner of the pane to specify
your hot corner settings. These four pop-up menus operate just like hot
corners and active screen corners in the Desktop & Screen Savers pane,
allowing you to control the operation of the screen management features
within High Sierra. Click one to designate that corner as one of the following:

A Mission Control corner displays the Mission Control screen.

An Application Windows corner displays only the windows from the active
application.

A Desktop corner moves all windows to the outside of the screen to uncover
your Desktop.

A Dashboard corner displays your Dashboard widgets.
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A Launchpad corner activates the Launchpad screen.

A Notification Center corner displays the Notification Center strip at the right
side of your Desktop.

Note that you can also set the Screen Saver Start and Disable corners from
here, as well as put your display to sleep.

The General pane

The talented General pane, shown in Figure 5-7, determines the look and opera-
tion of the controls that appear in application windows and Finder windows. It
looks complex, but I cover each option here.

ee < i General Q

Appearance: Craphite || For Buttons, Menus, and Windows

2 Use dark menu bar and Dock
Automatically hide and show the menu bar

Highlight color: Green | < |
Sidebar icon size:  Medium | < |
Show scroll bars: Automatically based on mouse or trackpad
When scrolling
) Always
Click in the scroll bar to: ) Jump to the next page

Jump to the spot that's clicked

Default web browser: @ Safari |7 ]

[ Ask to keep changes when closing documents
Close windows when guitting an app
When selected, open documents and windows will not be restored

FIGURE 5-7; when you re-open an app.
Appearances Recent items: 30 % Documents, Apps, and Servers
might not be _ , ) )
. 4 Allow Handoff between this Mac and your iCloud devices
everything, but
y
they re easy to 2 Use LCD font smoothing when available ?
find here.

The settings are

3 Appearance: Choose a color to use for buttons, menus, and windows. Click
the Use Dark Menu Bar and Dock check box to switch to a dark scheme for
your Finder menu bar and Dock. You can also choose to hide the Finder menu
bar — to display it, move your pointer to the top of the screen.

3 Highlight Color: Choose a color to highlight selected text in fields and pop-up
menus.
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Sidebar Icon Size: Select the size of the icons in the Finder window Sidebar.
It's the strip to the left of the Finder window that displays your devices and
favorite locations on your system. If you have a large number of hard drives,
or if you've added several folders to the Sidebar, reducing the size of the icons
allows you to display more of them without scrolling.

Show Scroll Bars: Specify when High Sierra should display scroll bars in a
window. By default, they're placed automatically when necessary, but you can
choose to display scroll bars always or only when you're actually scrolling
through a document.

Click in the Scroll Bar To: By default, macOS jumps to the next or previous
page when you click in an empty portion of the scroll bar. Select the Jump to
the Spot That's Clicked radio button to scroll the document to the approxi-
mate position in relation to where you click.

Default Web Browser: Click this pop-up menu to specify which application
Yosemite should use to display web pages. By default, macOS uses the Safari
web browser.

Ask to Keep Changes When Closing Documents: If you select this check
box, High Sierra prompts you for confirmation if you attempt to close a
document with unsaved changes. If the check box is deselected, High Sierra
allows the unsaved document to be closed without saving a new version.

Close Windows When Quitting an App: If this check box is deselected, the
macOS Resume feature automatically saves the state of an application when
you quit. When you relaunch the application again, High Sierra restores all
application windows and opens the documents you were working on when
you quit. In effect, you can continue using the application just as if you had
never quit. If you select the check box, High Sierra does not restore your work,
and you have to reload your document.

Recent Items: The default number of recent applications, documents, and
servers (available from the Recent Items item in the Apple menu [&]) is 10. To
change the default, open the pop-up menus here and choose up to 50. (I like
20 or 30.)

Allow Handoff Between this Mac and Your iCloud Devices: If this check
box appears within the General pane, you can enable it to turn on Handoff
functionality within High Sierra. (I discuss Handoff within the confines of
Chapter 9.) Note that this check box will not appear on older MacBooks
without compatible Bluetooth hardware.

Use LCD Font Smoothing When Available: By default, this check box is
enabled, making the text on your MacBook’s display appear more like the
printed page. You can turn off this feature to speed up text display slightly.
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FIGURE 5-8:
Reduce your
MacBook power
consumption
from the Energy
Saver pane.

TIP

The Energy Saver pane

I’'m an environmentalist — it’s surprising how many techno types are colored
green — so the two sections on this pane are pretty doggone important. When you
use them correctly, you not only conserve battery power but also invoke the Power of
High Sierra to automatically start up and shut down your laptop whenever you like!

Move the Computer Sleep slider, shown in Figure 5-8, to specify when High Sierra
should switch to sleep mode. The Never setting disables sleep mode. To choose a
separate delay period for blanking your screen, drag the Display Sleep slider to the
desired period. You can also power down the drive to conserve energy and prevent
wear and tear (an especially good feature for laptops with magnetic hard drives).

[ N ] < 22 Energy Saver Q
| Power Adapter
Computer sleep:
1 min 18 min 1hr 3hrs Mever

Display sleep:

1 min 15 min 1hr 3hrs Never

4 Put hard disks to sleep when possible
./ Slightly dim the display while on battery power

Enable Power Nap while on battery power
While sleeping, your Mac can periodically check for new email, calendar, and other iCloud updates

Current battery charge: 80% Restore Defaults

4 Show battery status in menu bar Schedule...

Enable the Slightly Dim the Display While on Battery Power check box to save
additional power by reducing the brightness of your MacBook’s screen. (I can
hardly notice the difference, but your laptop’s battery will thank you!)

If you want to start up or shut down your laptop at a scheduled time, click the
Schedule button. Select the desired schedules (the Start Up or Wake check box and
the Shut Down/Sleep check box) to enable them. Then click the up and down
arrows next to the time display to set the trigger time. Click OK to return to the
Energy Saver pane.

Mac laptop owners can set two separate Energy Saver configurations by clicking
one of the two tabs at the top of the pane:

3 Battery: Applies when the MacBook is running on battery power

3 Power Adapter: Kicks in when the laptop is connected to an AC outlet
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Your MacBook automatically switches to the proper configuration when you plug
in or unplug your laptop.

Some of the settings can toggle events that control sleep mode in High Sierra,
including a Wi-Fi network connection (the Wake for Wi-Fi Network Access check
box, which appears on the Power Adapter section). You can also set macOS to
automatically update iCloud data while in sleep mode, using the Enable Power Nap
feature (supported only on all current MacBook models).

Naturally, MacBook owners will want to click the Show Battery Status in Menu Bar
check box to select it.

The Dock pane

I'll come clean: I think the Dock is the best thing since sliced bread. (I wonder
what people referred to before sliced bread was invented?) You can use the set-
tings shown in Figure 5-9 to configure the Dock’s behavior until it fits your per-
sonality like a glove:

¥ Size: Pretty self-explanatory. Just drag the slider to change the Dock’s scale.

¥ Magnification: When you select this check box, each icon in the Dock swells
like a puffer fish when you move the cursor over it. (The Magnification slider
determines just how much it magpnifies.) | really like this feature because |
resize my Dock smaller, and | have a large number of Dock icons.

¥ Position on Screen: Select a radio button here to position the Dock on the
left, bottom, or right edge of the Desktop.

3 Minimize Windows Using: High Sierra includes two cool animations that you
can choose from when shrinking a window to the Dock (and expanding it back
to the Desktop). Click the Minimize Windows Using pop-up menu to specify
the genie-in-a-bottle effect or the scale-up-or-down-incrementally effect.

3 Prefer Tabs when Opening Documents: This setting allows you to specify
when your applications should open documents in a new tab display or within
a new document window. You can choose to use tabs always, only when using
full-screen mode, or only when you actually create a new tab in the applica-
tion itself. (Note that if an application doesn't support tab display, new
documents will open in a window.)

3 Double-Click a Window'’s Title Bar to Minimize/Zoom: Select this check box
to minimize or zoom a Finder or application window by simply double-clicking
the window's title bar.

3 Minimize Windows into Application Icon: If this check box is not enabled,
minimized application windows appear as thumbnail icons on the Dock. To
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FIGURE 5-9:
Customize your
Dock with these

controls.
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TIP

minimize application windows into the application icon on the Dock — which
can save space on your Dock — select this check box. (To restore a window
that's been minimized into the application icon, right-click the icon on the
Dock and choose Restore from the menu that appears.)

3 Animate Opening Applications: Active souls who like animation probably
get a kick out of the bouncing application icons in the Dock, which indicate
that you've launched an application and that it's loading. If you find this
effervescence overly buoyant or distracting, deselect this check box.

3 Automatically Hide and Show the Dock: Select this check box, and the Dock
disappears until you need it. (Depending on the size of your Dock, the Desktop
real estate you gain can be significant.) To display a hidden Dock, move the
cursor over the corresponding edge of the Desktop.

3 Show Indicators for Open Applications: macOS indicates which applications
are running in the Dock with a small gray dot in front of the icon. To disable
these indicators, deselect this check box.

[ N ] < i Dock Q

Size:
small Large
2 Magnification:
Min Max
Position on screen:

Left Bottom Right
Minimize windows using: = Cenie effect |

Prefer tabs when opening documents:  In Full Screen Only | T

¥ Double-click a window's title bar to | minimize [
Minimize windows into application icon

4 Animate opening applications

1 Automatically hide and show the Dock

4 Show indicators for open applications ?

You can also change most of these Dock preferences settings from the Apple menu.

The Sharing pane

So you’re in a neighborly mood, and you want to share your toys with others on
your local wired or wireless network. Perhaps you’d like to start your own website
or protect yourself from the Bad Guys on the Internet. All these fun diversions are
available from the Sharing pane in System Preferences, as shown in Figure 5-10.
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FIGURE 5-10:
Use controls
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Computer Name: | AirDragen

Computers on your local network can access your computer at: Edit
AirDragon.local

On  Service @ Printer Sharing: On
Screen Sharing Printer Sharing allows others on your network to use printers connected to
this computer.
File Sharing
Open Printers & Scanners Preferences...
Remote Login .
Printers: Users:
Remote Management
Remote Apple Events W HP LaserJet 200... B Everyone Can Print &

Internet Sharing
Bluetooth Sharing
Content Caching

Click the Edit button to change the default network name assigned to your Mac-
Book during the installation process. Your current network name is listed in the
Computer Name text field.

Each entry in the services list controls a specific type of sharing, including DVD
and CD Sharing (if you have an optical drive), Screen Sharing, File Sharing (with
other Macs and PCs running Windows), Printer Sharing, Remote Login, Remote
Management (using Apple Remote Desktop), Remote Apple Events, Internet Shar-
ing, Bluetooth Sharing and Content Caching (which stores updates and other con-
tent for later installation). To turn on any of these services, select the On check
box for that service. To turn off a service, click the corresponding On check box to
deselect it.

From a security standpoint, I highly recommend that you enable only the services
you actually use. Each service you enable automatically opens your High Sierra
firewall for that service. Here’s a Mark’s Maxim to remember:

Poking too many holes in your firewall is not A Good Thing.™

When you click one of the services in the list, the right side of the Sharing pane
changes to display the settings you can specify for that particular service.

The Time Machine pane

MacBook users are thrilled with the Time Machine automatic backup feature
that’s built in to High Sierra. It’s saved my stuff numerous times. You can easily
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FIGURE 5-11:

Put Time Machine
to work, and your
data is always
backed up.

TIP

TIP

configure how Time Machine handles your backups from this pane, as shown in
Figure 5-11. Chapter 21 covers how to use Time Machine. Of course, you need an
external drive (or an AirPort Time Capsule wireless backup device) for the best
backup security. Note that Time Machine doesn’t work with a CD or DVD rewrite-
able drive; you must use an external drive or a high-capacity USB flash drive.

e0 < s Time Machine Q

@ Magnum
11.9 GB of 62.9 GB available

Oldest backup: November 27, 2016
Latest backup: November 27, 2016
Select Disk... Next backup: When disk is connected
Time Machine
B4 Back Up Automatically
Time Machine keeps:

« Local snapshots as space permits

« Hourly backups for the past 24 hours

« Daily backups for the past month

« Weekly backups for all previous months

The oldest backups are deleted when your disk becomes full.

2 Show Time Machine in menu bar Options... 2

To enable Time Machine, click the On toggle switch and then select a disk to hold
your Time Machine backup data on the sheet that appears. Click Use Disk to con-
firm your choice. (Your external backup drive should be at least twice the capacity
of your internal drive, thus ensuring that your backup files have the elbow room
they need.) If you have an external Time Capsule wireless unit, click Set Up instead.

By default, Time Machine backs up all the drives on your system; however, you
may not need to back up some folders on your MacBook. To save time and backup
drive space, Time Machine allows you to exclude specific folders from the backup
process. Click Options and then click the Add button (with the plus sign) to select
the drives or folders you want to exclude. They appear in the Exclude These Items
From Backups list.

To remove an exclusion, select it in the list, and click the Delete button (with the
minus sign). Note that the Estimated Size of Full Backup figure increases, and
Time Machine adds the item you deleted from the list to the next backup.

If you enable the Show Time Machine in Menu Bar check box, you can elect to back
up your Mac immediately by clicking the Time Machine icon in the Finder menu

bar and then choosing Back Up Now.

By default, High Sierra warns you when deleting older backup files, but you can
turn this off from the Options sheet as well.
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iCloud preferences

From the High Sierra iCloud Preferences pane, shown in Figure 5-12, you can
specify which types of data are automatically pushed to your MacBook and iOS
devices. If you haven’t created an iCloud account yet — or if you signed out of an
existing account earlier — System Preferences prompts you to enter your Apple ID
and password. Click Sign In to display the contents of the iCloud pane.

ee < % iCloud Q
5 ‘ iCloud Drive Options...
—| 36 Photos Options...
o @ vai
Mark Chambers V] ‘ o

Account Details @ 17| Calendars

Set Up Family
/] u Reminders
FIGURE 5-12:
Control and 0 @ s
configure your .
iCloud activity
with these Sign Out Photos ang Videos | Manage.

settings.

High Sierra allows you to set up Family Sharing, where up to six accounts can
share photos, iTunes media and apps, and a common calendar — group members
can even display the current location of other members who are carrying Mac-
Books or i0S devices! Click the Set Up Family button and then click Continue to
launch the Family Sharing setup assistant.

The check boxes for each category are

3 iCloud Drive: Enable and disable iCloud Drive access for specific applications.

3 Photos: Push the latest photos and video clips you've added in Photos to
other devices, and update your Photos library with photos and video clips
pushed from your iOS devices.

¥ Mail: Synchronize your Mail account settings between devices.

3 Contacts: Push your Contact cards between devices.

¥ Calendars: Push your calendar events to and from your iOS devices.
3 Reminders: Synchronize the reminders you've set between devices.

¥ Safari: Synchronize your Safari bookmarks.
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FIGURE 5-13:
Each application
that uses
notifications can
be individually
configured.

¥ Notes: Synchronize your Notes between devices.
¥ Siri: Synchronize your Siri configuration.

¥ Keychain: Share passwords for applications and websites between your
devices.

3 Back to My Mac: Control file and screen sharing across all the Macs sharing
this iCloud account. Back to My Mac must be enabled on all computers that
will use this feature.

¥ Find My Mac: Locate your MacBook from a web browser or your iOS device.
You can also choose to remotely lock your computer — or even wipe your
laptop’s hard drive completely to prevent someone from stealing your data.

Wiping your MacBook remotely is a drastic step that will prevent you from locat-
ing it in the future.

To display the storage currently being used by your mail, backups, documents,
and application data, click the Manage button at the lower right of the pane. Apple
provides each iCloud account 5GB of space for free, but you can also elect to buy
additional storage from this sheet.

Notifications preferences

The Notifications group is shown in Figure 5-13. Each application that can display
notifications appears in the list at the left of the pane.

e £ B Notifications Q
Motification Center shows your alerts in the upper-right of your sereen, without interrupting what you're
doing. Show and hide Notification Center by clicking its icon in the menu bar.

Do Not Disturb Turn on Do Not Disturb in Notification
Battery Monitor il “ -
-» Banners and a ill be hidden and
notification sou be silenced
Calendar
171 Turn on Do Not Disturb:
c ClamXav From: 10:00 PM || to: 7:00 AM |
2 When the display is sleeping
Dropbox — L -
g P 4 When mirroring to TVs and projectors
'3 Facebook When Do Not Disturb is turned on:
Allow calls from everyone
FaceTime Allow repeated calls
L
When enabled, a second call from the same person within
.; Games three minutes ¥ e silenced
'ﬁ iMovie
Notification Center sort order:  Recents | <] ?
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TIP

TIP

Click the Do Not Disturb entry in the list at the left to set Do Not Disturb mode,
where Notification banners, alerts, and sounds are disabled. You can specify a
time period, turn on Do Not Disturb when your MacBook is in sleep mode, or turn
on Do Not Disturb when you’re mirroring (or sending) the video from your Mac-
Book to a TV or projector. You can also optionally allow FaceTime calls from any-
one while Do Not Disturb is active or just from those you’ve marked as Favorites
in FaceTime. If you select Allow Repeated Calls, a FaceTime caller can call a second
time within three minutes without being disabled.

Click an application in the list at the left to configure its notifications. Different
applications display different options in the settings pane, but the settings can
include the following:

¥ Alert Style: These three buttons specify which type of alert should appear
under the Notification Center icon in the menu bar. You do not need to
display the Notification Center to see alerts, which appear on your Desktop.
Choose None to disable alerts for this application. Choose Banners to display
alert messages that automatically disappear after a delay. Choose Alerts to
display alert messages that remain onscreen until you click the confirmation
button in the Alert dialog.

3 Show Notifications on Lock Screen: If it appears, you can select this check
box to allow notifications even if your MacBook is displaying the Lock screen.

3 Show in Notification Center: To display notification messages from this
application in the Notification Center, select this check box. You can also
specify how many recent messages from this application are displayed.

3 Badge App Icon: This check box toggles on and off the display of this
application’s icon in alert boxes and in the Notification Center. It also activates
the numeric display of pending items on the icon itself (for example, unread
mail and messages).

3 Play Sound for Notifications: To play a sound when alerts appear, enable
this check box.

You can change the order that notifications are sorted in the Notification Center
using the Notification Sort Order drop-down list box at the bottom of the pane.
The default sort is by the most recent, but you can choose Recents by App to sort
recent notifications grouped by applications. For the ultimate in custom notifica-
tions, choose Manually by App from the drop-down list box and drag the applica-
tions in the list at the left to your desired order.
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IN THIS CHAPTER

» Mastering basic Spotlight searching
skills

» Selecting text and keywords for best
results

» Displaying results in the Finder
search window

» Customizing Spotlight within System
Preferences

Chapter 6
Sifting Through
Your Stuff

hat would you say if I told you that you could search your entire system

for all the data connected with a person — and in only the short time it

takes to type that person’s name? And I’'m not just talking about files
and folders that might include that person’s name. I mean every email message
and every Calendar event that references that person — and even that person’s
Contacts card to boot. Heck, how about if that search could dig up every occur-
rence of the person’s name inside your PDF documents? What if it could even
search folders shared on other Macs across your network?

You’d probably say, “That makes for good future tech. I’ll bet I can do that in five
or ten years. It’ll take Apple at least that long to do it — and just in time for me to
buy a new MacBook! (Harrumph.)”

Don’t be so hasty. You can do all this right now. (In fact, this functionality has
been part of macOS for a number of years.) The technology is the macOS feature
named Spotlight, built into High Sierra. In this chapter, I show you how to use it
like a MacBook power guru. I also show you how to take advantage of Internet
search widgets you can display within the Dashboard. (From what I hear, there’s
good stuff on the Internet, too.)
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Doing a Basic Search
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FIGURE 6-1:
Lots of power
rs behind this
ngle Spotlight

Search box.

TIP

Figure 6-1 shows the Spotlight search box, which is always available from the
Finder menu bar. Click the magnifying glass icon once (or press g8+spacebar), and
the Spotlight search box appears on your Desktop, front and center.

# Finder File Edit View Go Window Help ) <7 [ A o) ThuS46PM Mark Chambers

To run a search, simply begin typing. (The words you type that you want to match
are called keywords.) Matching items appear as soon as you type, and the search
results are continually refined while you type the rest of your search keywords.
You don’t need to press Return to begin the search.

After a second or two, the Spotlight search box expands to display the results of
your search, and the list is updated automatically in real time while you continue
to type. The most relevant items are grouped into categories — such as Messages,
Definitions, Documents, Folders, Images, PDFs, and Contacts, right on the Spot-
light search box. Spotlight takes a guess at the item that’s most likely the match
you’re looking for (based on your Search Results list in System Preferences, which
I cover later in the chapter) and presents it first. To open the top item like a true
High Sierra power user, just press Return. (My brothers and sisters, it just doesn’t
get any easier than that.)

Although one or two keywords is typically enough to do the job, you can also type
phrases, such as emails from Mark Chambers or songs with sunshine in the title.
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TIP

Single-click any item in the list, and shazam! — Spotlight uses the Quick Look
technology built in to High Sierra to display the contents (such as a thumbnail
image of a document or an album cover) or information on the item! For example,
if the item is an iTunes playlist, you’ll see the song list in the results pane on the
right, and you can click one of the songs to open iTunes and play it. If the item is
a Mail message, click it once in the list to view the contents of the message —
without leaving the Spotlight box.

When you click an item in the list, Spotlight indicates which application will be
used to open the item by displaying the icon for that application in the upper-
right corner of the Spotlight box — for example, you’ll see the iTunes icon for a
song and the Safari icon for a website.

Literally, any text string is acceptable as a Spotlight search. However, here’s a
short list of the common search criteria I use every day:

> Names and addresses: Because Spotlight has access to the Contacts
application in High Sierra, you can immediately display contact information
using any portion of a name or an address.

¥ Email message text: Need to open a specific email message, but you'd rather
not launch Mail and spend time digging through the message list? Enter the
person’s email address or any text string contained in the message you're
looking for.

¥ File and folder names: A simple item name is the classic search favorite.
Spotlight searches your entire system for that one file or folder in the blink
of an eye.

3 Events and Reminder items: Yep, Spotlight gives you access to your
Calendar events and those all-important Reminders you've created.

¥ Specific songs and playlists: Itching to hear “Rock Me Amadeus” by Falco?
With the power of Spotlight and your iTunes library, you can satisfy your
musical needs in seconds.

3 System Preferences: Now things start to get really interesting. Try typing the
word desktop in the Spotlight field. At least one of the results in the list will be
a System Preference pane. That's right: Every setting in System Preferences is
referenced in Spotlight. For example, the Desktop background setting resides
in the Desktop & Screen Saver pane in System Preferences.

3 Weather, stocks, and sports scores: Put Spotlight to work and you can get
instant displays of current weather and forecasts (type weather followed by a
town name), stock figures (type the desired stock abbreviation), and even
sports scores (type your favorite team name).
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3 Web pages: Whoa. Stand back, Google. You can use Spotlight to search the
web — and, if necessary, the web pages you've recently displayed in Safari.

¥ Metadata: This category is pretty broad, but it fits. If you're not familiar with the
term metadata, think of the information stored by your digital camera each time
you take a photo — exposure setting, time and date, and even the location
where the photo was taken, which are also transferred to iPhoto when you
import. Here's another example: | like to locate Word documents on my system
using the same metadata that's stored in the file, such as the contents of the
Comments field in a Word document. Other supported applications include
Adobe Photoshop images, Microsoft Excel spreadsheets, Keynote presentations,
iTunes media, and other third-party applications that offer a Spotlight plug-in.

¥ Airline flight information: Type in a flight number, and let Spotlight provide
you with information like the flight's status, point of departure and arrival, and
even the gate numbers.

To reset the Spotlight search and try another text string, press 38+A to select the
entire contents and then press Delete.

After you find the item you’re looking for in the list at the bottom of the Spotlight
box, you can double-click the entry in the list to do any of these things:

¥ Launch it (if the item is an application).

¥ Open it in System Preferences (if it's a setting or description on a Preferences
pane).

3 Open it within the associated application (if the item is a document, website,
or data item).

¥ Display itin a Finder window (if the item is a folder).

on your system by using the file type as the keyword. For example, to provide a list
of all images on your system, just use images as your keyword — the same goes
TP for movies and audio, too.

‘ Here’s another favorite timesaver: You can display all the files of a particular type

How Cool Is That? Discovering
What Spotlight Can Do

Don’t get fooled into simply using Spotlight as another file-'n’-folder-name
search tool. Sure, it can do that, but Spotlight can also search inside PDFs, Pages,
Word documents, and HTML files, finding matching text that doesn’t appear in
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the name of the file. To wit: A search for High Sierra on my system pulls up all sorts
of items with High Sierra not only in their names but also files with High Sierra in
them:

3 Apple Store SF.ppt is a PowerPoint presentation with several slides contain-
ing the text High Sierra.

3 bk01ch03.doc is a rather cryptically named Microsoft Word file (a chapter of
this book that mentions High Sierra in several spots).

3 Conference Call with Amy is a Calendar event pointing to a conference call
with my editor about upcoming High Sierra book projects.

Not one of these three examples has the words High Sierra occurring anywhere in
the title or filename, yet Spotlight found them because they all contain the text High
Sierra therein. That, dear reader, is the true power of Spotlight, and how it can liter-
ally guarantee you that you’ll never lose another piece of information that Spotlight
can locate in the hundreds of thousands of files and folders on your hard drive!

Heck, suppose that all you remember about a file is that you received it in your mail
last week or last month. To find it, you can type time periods, such as yesterday, last
week, or last month, to see every item that you saved or received within that period.
(Boy, howdy, I love writing about TGIs — that’s short for Truly Good Ideas.)

IS SPOTLIGHT SECURE?

So how about all those files, folders, contacts, and events that you dont want to appear
in Spotlight? What if you're sharing your Mac as a multiuser computer or accessing
other Macs remotely? Can others search for and access your personal information
through Spotlight?

Definitely not! The results displayed by Spotlight are controlled by file and folder permis-
sions as well as your account login, just as the applications that create and display your
personal data are. For example, you can't access other users' calendars using Calendar,
and they can't see your Mail messages. Only you have access to your data, and only after
you've logged in with your username and password. Spotlight works the same way. If a
user doesn’'t normally have access to an item, the item simply doesn't appear when that
user performs a Spotlight search. In other words, only you get to see your stuff.

However, you can hide certain folders and disks from your own Spotlight searches if

necessary. Check out the final section of this chapter for details on setting private
locations on your system.
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Be careful, however, when you’re considering a search string. Don’t forget that by
default Spotlight matches only those items that have all the words you enter in the
Spotlight box. To return the highest number of possible matches, use the fewest
number of words that will identify the item; for example, use horse rather than
horse image, and you’re certain to be rewarded with more hits. On the other hand,
if you’re looking specifically for a picture of a knight on horseback, using a series
of keywords — such as horse knight image — shortens your search considerably. It
all depends on what you’re looking for and how widely you want to cast your
Spotlight net.

To allow greater flexibility in searches, Apple also includes those helpful Boolean
friends that you may already be familiar with: AND, OR, and NOT. For example,
you can perform Spotlight searches such as these:

3> Horse AND cow: Collects all references to both those barnyard animals into
one search

3 Batman OR Robin: Returns all references to either Batman or Robin

3 Apple NOT PC: Displays all references to Apple that don't include any
information about dastardly PCs

Expanding Your Search Horizons

116

TIP

I can just hear the announcer’s voice now: “But wait, there’s more! If you double-
click the Show All in Finder menu item at the bottom of your search results list,
we’ll expand your Spotlight search box into the Finder search window!” (Fortu-
nately, you don’t have to buy some ridiculous household doodad.)

Keyboard mavens will appreciate the Finder search window shortcut key, and I
show you where to specify this shortcut in the final section of this chapter.

Figure 6-2 illustrates the Finder search window. To further filter the search, click
one of the buttons on the search criteria bar to create your own custom filter. Click
the button with the + (plus) on the search criteria bar and then click the pop-up
menus to choose from criteria, such as the type of file, the text content, or the
location on your system (for example, your hard drive, your Home folder, or a
network server). You can also filter your results listing by the date when the items
were created or last saved. To add or delete criteria, click the + (plus) and — (minus)
buttons at the right side of the search criteria bar. To save a custom filter that
you’ve created, click the Save button.
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FIGURE 6-2:
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Images appear as thumbnail icons, so you can use that most sophisticated search
tool — the human eye — to find the picture you’re looking for. (If you don’t see
thumbnail images, click the Icon view button on the toolbar.) Don’t forget that
you can increase or decrease the size of the icons by dragging the slider at the bot-
tom right of the window.

To display the contents of an item in the list (without leaving the comfortable
confines of the Finder search window), click the item to select it and press the
spacebar for a better view. Note that High Sierra must recognize the format of the
file, and it must be supported by at least one application.

Again, when you’re ready to open an item, just double-click it in the Finder search
window.

As I mention earlier, Spotlight can look for matching items on other Macs on your
network only if those remote Macs are configured correctly. To allow another Mac
to be visible to Spotlight on your system, enable File Sharing on the other Mac. Oh,
and remember that you need an admin level account on that Mac — or access to a
good friend who has an admin level account on that Mac.

Follow these steps to enable file sharing on the other Mac:

1. On the Dock, click the System Preferences icon (it's the one with the
gears).

2. Clickthe Sharing pane.
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REMEMBER

3. Inthe service list on the left side of the Sharing pane, select the On check
box next to the File Sharing item to enable it.

4. Click the Close button in the System Preferences window. Or, if you're a
keyboard power user, simply press the 35+Q shortcut.

You can search only those items for which you have rights and permissions to
view on the remote Mac (such as the contents of the Public folders on that com-
puter). I discussed more about these limitations earlier in this chapter, in the “Is
Spotlight secure?” sidebar.

Customizing Spotlight to Your Taste

FIGURE 6-3:
Fine-tune your
Spotlight menu
and Results
window from
System
Preferences.

You might wonder whether such an awesome macOS feature has its own pane in
System Preferences — and you’d be right again. Figure 6-3 shows off the Spot-
light pane in System Preferences: Click the System Preferences icon on the Dock
and then click the Spotlight icon to display these settings.
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FIGURE 6-4:
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Click the Search Results tab to

3 Determine which categories appear in the Spotlight search box. For
example, if you don't use any presentation software on your Mac, you can
clear the check box next to Presentations to disable this category (thereby
making more room for other categories that you will use).

¥ Specify the Spotlight search box and Finder search window keyboard
shortcuts. You can enable or disable either keyboard shortcut and choose
the key combination from the pop-up menu. By default, the menu keyboard
shortcut is §8+spacebar, and the Finder search window keyboard shortcut is
38+Option+spacebar.

Click the Privacy tab (shown in Figure 6-4) to specify disks and folders that should
never be listed as results in a Spotlight search. I know, I know — I said earlier that
Spotlight respected your security, and it does. However, the disks and folders that
you add to this list won’t appear even if you are the one performing the search — a
great idea for folders and removable drives that you use to store sensitive infor-
mation, such as medical records.

[ N} < i Spotlight

Spotlight helps you quickly find things on your computer and shows suggestions from the
Internet, iTunes, App Store, movie showtimes, locations nearby, and more.

Search Results

Prevent Spotlight from searching these locations:

Click Add (+), or drag a folder or disk into the list below.

Photos to be Checked

Keyboard Shortcuts... About Spotlight Suggestions & Privacy

To add locations that you want to keep private, click the Add button (a plus sign)
and navigate to the desired location. Click the location to select it and then click
Choose. Alternatively, you can drag folders or disks directly from a Finder window
and drop them into the pane.
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IN THIS CHAPTER

» Setting reminders

» Making notes
» Using the Notification Center

» Navigating with Maps

Chapter 7

Using Reminders, Notes,
Notifications, and Maps

s I’ve said many times before in my books, “If it works in one place, it’s

likely to show up in another.” In this case, four popular time-saving (and

headache-preventing) apps have crossed over from the world of iOS
devices — the iPhone, iPad, and iPod touch — and have securely landed on your
High Sierra Desktop. These apps are Reminders, Notes, Notification Center, and
Maps, all taken from the iOS world.

That’s not the only good news, though: These four Mac applications work seam-
lessly with an iCloud account. So if you also use an iOS device (with the same Apple
ID), much of the data you store — such as the notes you take and the reminders
you make — is automatically synchronized between all your Apple computers and
devices.

Because all four of these new applications have a similar goal — keeping you in
touch with the information, daily tasks, locations, and digital events that matter
to you — I decided to cover them in one shiny chapter. Consider this chapter a
guide that demonstrates how you can remind, note, notify, and map like a mobile
power user.
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Remind Me to Use Reminders

FIGURE 7-1:

The main
Reminders
window in action.

TIP

You don’t need to look far to find the Reminders application on your Mac. Just
click the Reminders icon on the Dock to display the main window, as shown in
Figure 7-1.

Reminders Sidebar

Search Box Reminders Add Reminder Button
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Reminders

2dd Sean to Birthday List

Meeting Weanesday witn Merketing

Add List

July 2017
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3 24 25 26 27 28 2

Add List Button Calendar

These are highlights of the Reminders window:

3 Search box: Click here and type a phrase or name to search for it among your
reminders.

3 Reminders Sidebar: You can add as many separate Reminder lists as you like
in the application (one for work, for example, and another for your Mac user
group). In the Sidebar, you can switch quickly between your lists.

You can hide or show the Reminders Sidebar at any time using the View
menu, or by pressing $8+Option+S. You save a significant amount of screen
real estate when the display is hidden.

¥ Calendar: This handy calendar indicates which days of the current month
already have reminders pending: They're displayed with a dot under the date.
You can jump to any date by clicking it. To move forward and backward
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FIGURE 7-2:
Editing a
reminder.

»

»

»

Adding a reminder is straightforward. First, click a date in the calendar display to
jump to that date, and then click the Add Reminder button. Type a few words and
press Return to create a basic reminder. However, if you hover your cursor over
eminder you just created, an Info button (the lowercase i in a circle icon)
appears next to the text. The game is afoot! Click the Info button to display the

the r

through the months, click the Previous and Next buttons next to the month
name. (Note that this calendar does not sync or exchange reminder dates
with the Calendar application.) To display the Calendar, click View = Show
Calendar — to hide the Calendar, click View =>Hide Calendar.

Add List button: Click this button to add a new Reminder list to the Sidebar;
from the keyboard, press 38+L. The list name is highlighted in a text box, so
you can simply type the new name and press Return.

Reminders: These entries are the reminders themselves. Each is prefaced by
a radio button so you can select the radio button when the reminder is
complete, thereby moving that reminder automatically to the Completed list.
And yes, if you click the Show link next to the number of completed reminders
to display them and deselect the radio button for a reminder, it returns (like a
bad penny) to the original list.

Add Reminder button: Click this button to add a new reminder to the
currently selected list; from the keyboard, press 38+N. In its simplest form, a
reminder is just a short phrase or sentence. Press Return afterward to save it
to your list.

settings you see in Figure 7-2.
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These fields are on the Edit sheet:

3 Reminder text: Click this text to edit the reminder text itself.

3 On a Day: Enable this check box if the reminder should appear in Notification
Center on a particular day. By default, the date is the one selected when you
created the reminder. You can click the Date and Time fields to change them.

3 At a Location: This is a powerful feature. Select the At a Location check box,
and a pop-up menu appears below the check box. Now you can type an
address in the Enter a Location field. Reminders monitor your current location
on your MacBook, iPad, or iPhone using Location Services. They notify you
when you're leaving or arriving at that location (and, optionally, on the date
and time you specify in the On a Day field). For example, you could create a
reminder that notifies you on your iPhone when you're arriving at the mall on
September 15 to pick up the watch that's being repaired. Shazam!

3 Repeat: If you select the On a Day check box, you can also set this reminder
to automatically repeat every day, week, month, or year at the same time.

¥ Priority: You can assign one of four priorities to the reminder: Low, Medium,
High, or None. Assigning a priority prefaces the reminder text with one (Low),
two (Medium), or three (High) blue exclamation points so the reminder stands
out from the crowd.

3 Note: Click next to the Note field to enter a free-form text note along with the
reminder.

Click Done on the Edit sheet when you’ve finished making changes. You can edit a
reminder as often as you like. For example, I sometimes need to change the date
on a reminder multiple times as my schedule changes.

To delete a reminder from the list, right-click it and choose Delete from the menu
that appears.

TIP
iCloud connectivity allows Reminders to share information with other Macs and

i0S devices, as well as Microsoft Outlook on both PCs and macOS. To share remind-
ers, click the System Preferences icon on the Dock, click the Internet Accounts
icon and then click one of the accounts at the left of the pane. If an account allows
you to share data from the Reminders application — such as the iCloud account —
you’ll see a Reminders check box at the right side of the pane.
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Taking Notes the High Sierra Way

Imagine a notepad of unlimited pages that’s always available whenever you’re
around your Mac, iPhone, iPod touch, or iPad — that’s the idea behind Notes, and
it’s superbly simple. To open the Mac version of the application, click the Notes
icon on the Dock. The window shown in Figure 7-3 appears.

New Note Button Share Button ~ Search Box

= T

(XX J :m] 88 ] ] fu] =]
Cloud RHPS 40th

All iCloud 9M6  Facade for KD's solo MLC Rodio
Notes

Work

MLC Radio More tracks from Grease the movie
o6

Add dates for songs without togs
Recently Deleted

Newspaper advertissment
Google

Notes

FIGURE 7-3:
The notable
Notes application ) )
window. Folders List Notes List Note Page

@ New Folder

The salient stuff in the Notes window includes these items:

¥ Search box: If you're hunting for a specific note, click in this box and type a
phrase or name to search for it.

¥ Folders list: You can create new folders to hold specific kinds of notes. In
Figure 7-3, for example, | added a Work folder. To add a new folder, choose
File &> New Folder or press §8+Shift+N and type the new folder name. To
switch between folders, display the Folders list and click the desired folder.
You can display or hide the Folders list from the View menu.

3 Notes List: Each Note you create appears as a separate entry in the List. You
can click a Note in the list to switch to it immediately.

¥ New Note button: Click this button to add a new Note. Notes uses the first
line of text you type as the title of the Note, which appears in the list.
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TIP

3 Note Page: This free-form pane is where you type the body of your note. You
can also drag images from a Finder window and include them in the body of
the note, or embed PDF and audio files by dragging them from a Finder
window as well.

3 Share button: Open this pop-up menu to share the contents of the current
note, just like the Share button that appears on the Finder window toolbar.
Sharing options can include a new email message, a new message in the
Messages application, a new Reminder, and new postings to Twitter or
Facebook.

To edit a note, click it to select it in the Notes List, and then simply make your
changes or additions in the Note Page. You can format the text from the Format
menu — everything from different fonts and colors to inserting bulleted and
numbered lists.

To delete a note you no longer need, right-click it in the Notes List and choose
Delete from the menu that appears. The application prompts you for confirmation
before the deed is done.

You can pin a note to the top of the Notes list to make it more visible - it stays
anchored to the top of the list whenever it’s visible. Right-click on the desired
note in the list and choose Pin Note (or Unpin Note to return the note to regular
status).

With the arrival of High Sierra, a note can now include tables to help organize your
data, much like the Pages application! Click the Table button in the Notes toolbar
to create a default table (two columns and three rows), then click in the first field
and begin typing. Press Tab to continue to the next field in the table. To create a
custom table, click Format in the Notes menu bar and choose Table — you can
specify the number of rows and columns there.

Like Reminders, the Notes application can share information with Macs and iOS
devices, as well as Outlook on both Macs and PCs. The process is the same: Open
System Preferences and click the Internet Accounts icon, and then click the desired
account at the left of the pane. Accounts that support sharing data from Notes will
display a Notes check box at the right side of the pane.

Staying Current with Notification Center

126

Unlike Reminders and Notes, Notification Center isn’t an application you launch.
Instead, the Notification Center icon appears at the far right side of the Finder
menu bar, and it’s always running.
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FIGURE 7-4:
Notification
Center muscles
your desktop to
the side.

Q

TIP

Click the icon (or, if you’re using a trackpad, swipe with two fingers from the right
edge to the left) to display your notifications. These notifications can be generated
by a whole host of High Sierra applications and functions, including Calendar,
Mail, FaceTime, Reminders, Game Center, Photo Stream, Messages, Safari, Face-
book, and even the Mac App Store. Third-party applications can also generate
notifications.

You can also click the Today button at the top of the Notification Center to display
all sorts of information that specifically applies to today’s date (as shown in
Figure 7-4), including things like Calendar events, Reminders, the current
weather, the macOS calculator and the latest stock figures. To switch back to the
Notifications view, click the Notifications button at the top of the Notification
Center.
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You can add applets called widgets to the Today view as well, allowing you to cus-
tomize the information you see there. Notification widgets are very similar to
Dashboard widgets — you can download them from the App Store.

I love how Notification Center doesn’t interfere with open applications. It simply
moves the entire desktop to the left so you can see the Center. You can close Noti-
fication Center at any time by clicking anywhere on the Desktop to the left, click-
ing the Notifications icon on the Finder menu bar again, or swiping in the opposite
direction.
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FIGURE 7-5:
An alert
notification

appears on your

128

Desktop.

TIP

Notification entries that appear in the Notification view are grouped under the
application that created them. Many entries can be deleted from Notification Cen-
ter by clicking the Delete button that appears next to the application heading (the
button bears an X symbol). Other entries, such as Calendar alerts, remain in Noti-
fication Center until a certain time has elapsed.

But wait, there’s more to Notification Center than just a strip of happenings —
depending on the settings you choose, notifications can also appear without Noti-
fication Center being open at all. These notifications are displayed as pop-up
banners (which disappear in a few seconds) and alerts (which must be dismissed
by clicking a button). Figure 7-5 illustrates a typical alert notification from iTunes.
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Long Line Of Cars
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High Sierra can also allow actions in notifications. Depending on the application or
function that generates the notification, you may see buttons on a banner or an
alert that allow you to take care of business (without requiring the application to
be running). For example, if a new email message is received in Apple Mail, you
can choose to reply to or delete the message. Websites can display updates as noti-
fications, and you can answer a FaceTime or an iPhone call directly from the
notification.

You can configure the notifications for all your applications from the Notifications
pane in System Preferences, which you can reach easily if Notification Center is
open. Just click the gears icon at the lower right of the Notification Center.
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Introducing the Maps Application

If you own an iPad, iPhone, or iPod touch, prepare yourself for a joyful state: your
beloved Maps application also resides on your Dock! As long as you have a connec-
tion to the Internet, Maps is ready to display locations, provide directions, and
even allow for informal views of important sites worldwide! (Recognize the grand
dame in Figure 7-6?)

@® @ Diections 7 Jl Q. statue of liberty o t Map Transit

Statue of Liberty
Fkrhd 7

FIGURE 7-6:

The Statue of
Liberty shines in
the Maps
application.

Displaying an overhead view of an address is one of the simplest chores in all of
macOS — from the Maps window, just click in the Search box at the top of the
window, type the address, and press Return. Maps displays the address with a red
pushpin to help you locate it.

Depending on the location you’ve chosen, you may also see a tiny Info icon (which
looks like a lowercase i within a circle) next to the name. To view more informa-

tion, click the Info icon.
TIP

If you are in range of a Wi-Fi signal, and have turned Location Services on, you
can quickly map your current location — just click View= Go to Current Location,

or press 38+L.
TIP
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FIGURE 7-7:
Looks like this
pizza joint is
highly rated.

Ah, but why stop with just a simple address? You can also enter the following
types of information:

3 The name of a landmark, monument, or building (for example, Statue
of Liberty).

¥ The name of a business or restaurant (or even a genre of food, such as
Chinese) followed by the city name. Maps displays matching sites with
pushpins (complete with reviews), and you can click any of the pushpins to
find out more information on a location. Figure 7-7 illustrates a search for
pizza in my hometown of Columbia, Missouri — you can see the Info pop-up
that appears when | click the Info icon next to the restaurant name, complete
with a link to their website and reviews a-plenty.

¥ Attractions and services, followed by the city name. You can search for a gas
station, movie theater, or local park.
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If you need to zoom in or zoom out on a Maps display, use the scroll function on
your pointing device, click the plus and minus buttons at the bottom-right corner
of the Maps window, or use the 38+plus and $8+minus shortcuts. To move around
the Maps window, click and drag the map in the desired direction.

Teachers and parents, take note: A virtual “flyby” of a famous site in Maps is a
valuable (and cool) resource.
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Switching Views in Maps

A traditional printed map offers you only one view, which may be perfectly fine for
determining a route but provides no visual interest. (The word banal comes to
mind.) Maps, on the other hand, offers three types of views, each of which offers
certain advantages:

¥ Standard (or Map) mode is a familiar line map, with streets and highways
marked. Standard mode is best for planning a road trip, just like your father's
old-fashioned paper map.

¥ Satellite mode is a photographic overhead view without streets or highways
marked, which is great for panoramic views of your neighborhood or a
location and its surroundings.

¥ Transit mode displays public transportation routes and bus, subway and train
schedules. Note, however, that Transit information is not available in every
location.

To select your view, click one of the buttons at the top of the Maps window: press
38+1 for standard Map, $8+2 for Transit, or $8+3 for Satellite. Figure 7-6 shown
earlier illustrates Satellite view mode, while Figure 7-8 shows off Standard view.
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FIGURE 7-8:
Standard view
reminds me of an
auto GPS unit.

Have you noticed the Show pop-up menu at the lower-left corner of the Maps
window? If you’re using Satellite view, you can click the Show menu and choose
Show Labels to toggle street names on and off. The Show pop-up menu also allows
you to display traffic conditions and toggle the 3D map.
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TIP
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TIP

“Wait, there’s a 3D map option?” Yes indeed, and no special glasses are required!
For additional visual thrills, you can angle the Maps display with a slight 3D
effect — nothing quite as grand as a 3D TV, but it does help add depth to Satellite
view. To toggle 3D on and off, press $8+0, click the Show pop-up menu, or press
the 3D button at the lower-right corner of the window.

By default, Maps is oriented with north at the top of the screen, but if you need to
change the orientation, click the red compass arrow at the bottom-right corner of
the screen and drag in the desired direction. To immediately return to north at the
top of the screen, press $8+T or click View=> Snap to North.

Getting Directions Over Yonder

FIGURE 7-9:

The Directions
panel is ready to
provide directions
to your next
clambake.

My primary use for a map is getting directions from one point to another, and
Maps doesn’t disappoint when it comes to navigation. Click the Directions button
to display the panel you see in Figure 7-9, and you’re ready to plot your course.

IYEY oo | 1 P
srt: Columbia, MO, United Sta

End:  The White House
Walk Transit

14 hr 13 min
936 mi - 1-70E
Tolls required * Fastest route

14 hr 44 min
987 mi - -84 E
Tolls required - Alternate route fHansascity

16 hr 18 min Missoun
1,093 mi- I-81N
Alternate route

nashville

&
16 hr 18 min

33

Follow these steps to get directions between two addresses:

1. Inthestart box, type the starting address.

As you type, Maps provides a pop-up list of suggestions taken from your recent
locations, as well as addresses from your Contacts database and matching
streets from around the globe. To choose one of these suggestions, just click it.
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TIP

To clear the contents of the field, click the X button that appears at the right
side of the box.

2. Press Tab to move to the End box.
3. IntheEnd box, type the destination address.

Note that your destination doesn't have to be a specific address — for
example, Memphis, TN, works just fine.

4.  Click the Drive button for road directions, click the Walk button for
walking directions or display mass transit information by clicking the
Transit button.

5. PressReturnto generate your directions.

Maps usually offers more than one route for your trip — the first route provided
is typically the fastest or shortest, and it appears as a bright blue. To view one of
the other routes, just click a light blue line and it turns bright blue to indicate that
it’s now the selected route. (You can see the approximate mileage and time for the
currently selected route at the top of the turn list.) The turn-by-turn list provides
approximate mileage for each leg of the journey.

You can easily print the route map and directions by choosing File Print (or by
pressing $8+P), and then clicking the Show Details button at the bottom of the
Print sheet to display all the options.

If you’d rather create a PDF document with your map and directions, choose
File=> Export as PDF.

Finally, Maps also allows you to share your maps and directions using Mail, Mes-

sages, Twitter, or Facebook. Click the Share button at the top of the window, and
then select the desired sharing method.
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Communicating



IN THIS PART ...

Surf the web with ease using Apple's Safari browser.
Sync documents and data automatically using iCloud.
Share your laptop with other users safely.

Join or create a wireless network with your MacBook.



IN THIS CHAPTER

» Introducing the Safari window
and controls

» Visiting websites with Safari

» Moving between sites

» Creating and using bookmarks

» Receiving files with Safari

» Surfing with your tabs showing

» Saving web pages to disk

» Protecting your privacy on the web

» Blocking those irritating pop-ups

Chapter S
Let's Go on Safari!

proudly surf the web via a lean, mean — and fast — browser application. That’s

Safari, of course, and it keeps getting better with each new version of

macOS. Safari delivers the web the right way, without the wait. You’ll find that
features have been added to Safari that no other browser offers, like the Reading
List, which allows you to easily select articles and pages for later perusal.

If you need a guide to Safari, this is your chapter. Sure, you can start using Safari
immediately, but wouldn’t you rather read a few pages so that you can surf like a
power user?

Within these pages, I show you how to use those other controls and toolbar but-

tons in Safari — you know, the ones in addition to the Forward and Back buttons.
You’ll discover how to keep track of where you’ve been and where you’d like to go.
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Pretend You've Never Used This Thing

Safari at a glance.

138

Figure 8-1 illustrates the Safari window. You can launch Safari directly from the
Dock, or you can click the Safari icon in Launchpad.
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Welcome to MLC Books Online!
CELEBRATING OUR 20TH ANNIVERSARY - ONLINE SINCE 1997!

The Home of Books Written by Mark L. Chambers

This online library is dedicated to the books I've written and those who read them... thanks for dropping by!
Pull up a virtual chair and browse the titles - and, if you like what you see, you're welcome to buy copies of
my books right from this site. Drop me an email with your comments and questions, and downlaad the bonus
chapters mentioned in my books

What's New?

MacBook For Dummies 7t" Edition is in the works! Are you ready for the new version of macOS and all
the details on the latest Mac laptops? I've begun the 7th Edition of my bestselling guide to our favorite line of
road warriors - stay tuned for more information as it becomes available!

I'm On Video! Thanks to Wiley Publishing, I now have two videos featured on YouTube — one covers the Mac
and macOS, while the other covers today's PCs and Windows. To watch them, click on the Watch My YouTube
Videos link at the left!

Our Regular Attractions...

Jam to MLC RADIO ONLINE! Ready for a heady mixture of classic 70's music? If you're using a broadband
DSL or cable modem connection and you're using Winamp MP3 player, Windaws Media Player or iTunes for
Mac/PC, you can listen ta my streaming Internet radio station. We're talking CD-quality, delivered directly to
your computer commercial-free! (Well, come to think of it, there are commercials, but they're il 30 years
old.) MLC RADIO ONLINE features hundreds of pop, rock, soul and R&B favorites from 1970 to 1979 - I call it

my 70 Time Machine”, and I know you'll love it! To listen, visit the station’s status page at
Macsoek All-in-one For Dummies http://173.26.241,52:8000/. Enjoy!
Visit The BATBOARD BBS onlinel Would you like to experience the text-based online world the way it used
t0 be - you know, before that “Web” thing took off? If so, I'm proud to announce that a character-based
Telnet connection is now available to my classic character-based BBS! The BATBOARD has been online
continuously since 1984, with a selection of great online games, online chatting between members and what

FIGURE 8-1:

Sidebar Content Pane

These are the major sections of the Safari window:

¥ The toolbar: Here are the most often-used commands for tasks such as
navigation, sharing content, and searching Google (or Yahoo!, or DuckDuckGo,
or Bing). Plus, here you can type or paste the address for websites that you'd
like to visit.

¥ The Favorites bar: Consider this a toolbar that allows you to jump directly to
your favorite websites with but a single click or two. | show you later, in the
section “Adding and Using Bookmarks,” how to add and remove sites from
your Favorites bar. For now, remember that you can toggle the display of the
Favorites bar by choosing Viewr>Hide/Show Favorites Bar or by pressing
38 +Shift+B.

3 The Tab bar: This toolbar allows you to quickly switch between multiple web
pages that you've loaded, using what appear to be old-fashioned file folder
tabs. (Something familiar — familiar is good.) To hide or display the Tab bar,
choose Viewr>Hide/Show Tab Bar. You can also pin sites to the Tab bar
permanently (more on this later in the chapter).
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The Sidebar: The Sidebar pane allows you to organize and read your
bookmarks, reading list, and shared links. To hide or display the Sidebar,
press 38+Shift+L or choose Viewr>Hide/Show Sidebar.

The Content pane: Congratulations! At last, you've waded through the
pregame show and reached the area where web pages are displayed. The
Content pane can be scrolled, and when you minimize the Safari window to
the Dock, you get a thumbnail (minimized) image of the Content pane.

The Content pane often contains underlined text and graphics that transport
you to other pages when you click them. These underlined words and icons
are links, and they zip you right from one area of a site to another area (or to a
different site altogether). You can tell when your pointer is resting on a link
because it changes to that reassuring pointing-finger hand. Handy! (Sorry
about that.)

The Status bar: The Status bar displays information about what the pointer is
resting on, such as the address for a link or the name of an image; it also
updates you about what's happening while a page is loading. To hide or
display the Status bar, press 38+/ (forward slash) or choose Viewr>Hide/Show
Status Bar.

Visiting Websites

Here’s the stuff that virtually everyone over the age of five knows howtodo. .. but
I get paid by the word, and some folks might just not be aware of the many ways
to visit a site. You can load a web page using any of these methods:

»

»

Click in the Address box. If you're not viewing your Top Sites display, just
click once on the Address box to display a scrolling thumbnail list of your
Favorites and most frequently visited sites. Click a thumbnail to jump immedi-
ately to that page. That's about as simple as life gets!

Type (or paste) a website address in the Address box on the toolbar, and
press Return. If you're typing an address and Safari recognizes the site as one
that you've visited in the past, it “helps” by autocompleting the address for
you. Press Return if you want to accept the suggested site. If this is a new site,
just keep typing.

The Safari Address box also acts as a smart address field, displaying a new
pop-up menu of sites that match the text you enter. Safari does this by using
sites taken from your History file and your bookmarks, as well as sites
returned from Google, Yahoo!, DuckDuckGo, or Bing. If the site you want to
visit appears in the list, click it to jump there immediately.
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»

»

»

»

»

»

»

WARNING

»

»

Click a Bookmarks or Favorites entry. Bookmarks appear in the Sidebar
and the Bookmarks menu, while Favorites appear in the Favorites bar.

Click a tab for a pinned site. Pinned tabs appear as icons at the left side of
the Tab bar.

If the Home button appears on your toolbar, click the button to go to the
home page that you specify. Read more on this in the upcoming section,
“Setting Up Your Home Page.”

If the Top Sites button appears on the toolbar, click it to open the Top
Sites display. Safari displays a wall of preview thumbnail pages from your
most frequently visited sites, and you can jump to a site just by clicking the
preview. You can anchor a thumbnail to keep it onscreen permanently by
hovering your pointer over the thumbnail and clicking the pin icon that
appears, or you can delete a thumbnail by clicking the X button that appears.

Because each thumbnail is updated with the most current content, the Top
Sites wall makes a great timesaver. Quickly make a visual check of all your
favorite haunts from one screen!

Click an item you saved earlier in the Sidebar’'s Reading List tab. To
display items in your list, click the button bearing the eyeglasses icon at the
top of the Sidebar.

Click a page link in Apple Mail or another Internet-savvy application.
These links are typically highlighted or underlined to make them easier to see.

Never click on a link in an email unless you know and trust the sender!

Click a page link in another web page. By default, Safari opens the new
page in a separate tab.

Select a web address in a document, click the Services menu, and choose
Open Page in Safari. Safari automatically loads and displays the page.

Type a search term in the Address box. By default, Safari uses Google as a
search engine, but you can also use Yahoo!, Bing, or DuckDuckGo if you
prefer. To set the default search engine, choose Safari>Preferences; then on
the Search tab, click the Search Engine drop-down menu. (You can immedi-
ately switch to another engine by clicking the magnifying-glass icon that
appears before you start typing into the Address box.)

Click in the Address box, type the contents that you want to find, and press
Return. Safari presents you with the search results page on Google for the text
you entered. (In case you've been living under the Internet equivalent of a rock
for the last several years, Google (www . google . com) is the preeminent search
site on the web. People use Google to find everything from used auto parts to
ex-spouses.)
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TIP

TIP

»

Click a Safari page icon on the Dock or in a Finder window. Drag a site
from your Favorites bar (or drag the icon from the left side of the Address
box), and drop it on the right side of the Dock. Clicking the icon that you add
launches Safari and automatically loads that site.

This trick works only on the side of the Dock to the right of the vertical line.
More on that all-important divider in a bit.

If you minimize Safari to the Dock, you'll see a thumbnail of the page with the
Safari logo superimposed on it. Click this thumbnail on the Dock to restore the
page to its full glory.

Speaking of full glory, Safari supports the same full-screen mode as many
other High Sierra applications. Click the Zoom/Full Screen button at the
top-left corner of the Safari window to switch to full-screen mode, or press the
Control+38+F shortcut (a good shortcut to memorize because it works with
virtually all High Sierra-compatible applications). To make things convenient
for you, the toolbar and Favorites bar remain. To exit full-screen mode, press
Esc or the Control+38+F shortcut again.

Navigating the Web

TIP

A typical web surfing session is a linear experience. You bop from one page to the
next, absorbing the information you want and discarding the rest. However, after
you visit a few sites, you might find that you need to return to where you’ve been
or head to the familiar ground of your home page. Safari offers these navigational
controls on the toolbar:

»

»

Back: Click the Back button (the left-facing arrow) on the toolbar to return to
the last page you visited. Additional clicks take you to previous pages, in
reverse order. The Back button is disabled if you haven't visited at least

two sites.

Forward: If you've clicked the Back button at least once, clicking the Forward
button (the right-facing arrow) takes you to the next page (or through the pages)
where you originally were, in forward order. The Forward button is disabled if
you haven't used the Back button and haven't navigated to another page.

Safari supports a number of trackpad gestures. For example, you can swipe in
either direction with two fingers to move backward and forward, just as you
would move with the Forward and Back buttons. To zoom in and out on the
Content pane, you can either double-tap the trackpad or pinch with two
fingers — yes, just like an iPhone. (Ever get the notion that someday we'll just
have a single box called “The Device" that does it all?)
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REMEMBER

WARNING

»

»

»

»

»

»

»

Home: Click this button (look for the little house) to return to your home page.

Not all these buttons and controls may appear on your toolbar — you may
not see many of these toolbar controls unless you add them yourself. To
display or hide toolbar controls, choose View=>Customize Toolbar. The sheet
that appears works just like the Customize Toolbar sheet in a Finder window:
Drag the control you want from the sheet to your Safari toolbar, or drag a
control that you don't want from the toolbar to the sheet. As with most
buttons and controls in Mac applications, if you hover your pointer over an
unfamiliar button on the toolbar, Safari will display a tooltip to identify the
button for you.

Show/Exit Tab Overview: A click on this toolbar button displays all the
tabbed sites you've opened, as well as the iCloud Tabs from Safari on your
other Macs, PCs, and iOS devices.

AutoFill: If you fill out lots of forms online — when you're shopping at
websites, for example — you can click the AutoFill button (which looks like a
little text box and a pen) to complete these forms for you. You can set what
information is used for AutoFill by choosing Safari>Preferences and clicking
the AutoFill toolbar button.

To be honest, I'm not a big fan of automatically releasing any of my personal
information to any website, so | don't use AutofFill. If you do decide to use this
feature, make sure the connection is secure (look for the padlock icon in the
Address box) and read the site’s Privacy Agreement page first to see how
your identity data is treated. Never enter credit card numbers or personal
information on a website without a secure connection!

Top Sites: Click this button to display the Top Sites screen | discuss earlier. If
you're having trouble finding it, the button bears a tiny, fashionable grid of
squares.

Zoom: Shrink or expand the size of text on the page, offering smaller, space-
saving characters (for the shrinking crowd) or larger, easier-to-read text (for
the expanding crowd) by clicking one of the Zoom buttons, which are labeled
respectively with a small and large letter A. (From the keyboard, you can press
38+= (equal sign) to expand and 38+- (hyphen) to shrink.)

Favorites bar: Click this button (which carries the Bookmarks symbol
sandwiched between two horizontal lines) to display or hide the Favorites bar.

Stop/Reload: Click Reload (which has a circular arrow in the Address box) to
refresh (reload) the contents of the current page. Although most pages remain
static, some pages change their content at regular intervals or after you fill out
a form or click a button. By clicking Reload (look for the curved arrow in the
Address box), you can see what's changed on these pages. (I use Reload every
hour or so with CNN.com, for example.) While a page is loading, the Reload
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TIP

»

»

»

»

»

»

»

button turns into the Stop button — with a little X mark — and you can click it
to stop the loading of the content from the current page. This feature is a real
boon when a download takes foorrewverr, which can happen when you're
trying to visit a popular or slow website. Using Stop is also handy if a page has
a number of very large graphics that are likely to take a long time to load.

Sidebar: Click this toolbar button at the left side of the Address box to hide or
display the Safari Sidebar. You'll find the complete description of the sidebar
in an upcoming section.

History: Click this button, which bears a clock symbol, to display or hide the
History list, which | discuss later in this chapter.

Downloads: This toolbar button appears only if you're currently downloading
a file or if you've downloaded files that haven't been cleared yet. Click it to
display the files you've downloaded recently, and click the Clear button to
clear the contents of the Download list. Note that clearing the list does not
delete the files you've downloaded; it simply cleans things up. You can also
double-click a completed download in the list to open it immediately. (More
on downloading in the section, “Downloading Files.")

When you're downloading a file, a tiny progress bar appears in the Downloads
button on the toolbar to show you how much you've received. Now that, good
reader, is progress! (Let's see whether my editor allows such a horrible pun to
remain.) Anyway, you can click the Downloads button during the file transfer
to pause or stop the download completely.

Open in Dashboard: Click this button to create a Dashboard widget using the
contents of the currently displayed web page. Safari prompts you to choose
which clickable section of the page to include in the widget's borders, such

as the local radar map on your favorite weather website. Click Add, and
Dashboard loads automatically with your new widget. For more on widgets,
see Chapter 3.

Mail: Click this button (bearing an envelope icon) to send an email message
with a link to the current page, just as if you clicked the Share button and
chose Email This Page. Safari automatically opens Apple Mail (or your default
email application) and creates a new message with the link already in the
body. Shazam!

Print: Click this convenient button to print the contents of the Safari window.
(Dig that crazy printer icon!)

Website Preferences: Click this button to display (or change) the preference
settings you've selected for this specific website. You can elect to use the
Reader whenever possible, enable the content blocker to prevent most
advertisements from appearing (more on both these features later in the
chapter), set the Zoom level, and enable or disable the Auto-Play feature for
videos that contain an audio track.
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¥ Share: If you have an iPhone, iPod touch, or iPad, you're probably already
familiar with this button, which carries a rectangle and arrow symbol. Click the
Share button to send the current page (or a link to it) to a number of different
destinations, including your Reading List, an email message, your Notes,
Messages or Reminders applications, AirDrop, Facebook, LinkedIn, or Twitter.
You can also add a bookmark to the current page using the Share button.
Figure 8-2 illustrates the Share button in action.

O [}l o
oo Add to Reading List \_
0 Add Bookmark
Overview  macos Te ™ Email This Page
@) AirDrop
£2 Twitter
f Fac
[0 Linkedin
.. Notes
& Messages
) Reminders
() More...

FIGURE 8-2:

The Share button
makes it easy to
spread goodness
and light!

Setting Up Your Home Page

Choosing a home page is one of the easiest methods of speeding up your web surf-
ing. However, a large percentage of the MacBook owners whom I've talked with
have never set their own home page; instead, they simply use the default home
page provided by their browser. Declare your independence! With Safari running,
take a moment to follow these steps to declare your freedom to choose your own
home page:
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1. In Safari, display the web page that you want to become your new home

page.
@ I recommend selecting a page with few graphics or a fast-loading popular site.
r 2 Choose Safaric>Preferences, or press 38+, (comma).
3. Click the General tab.
You see the settings shown in Figure 8-3.
4. Click the Set to Current Page button.
5. Cclick the Close button to exit the Preferences dialog.
@ General
o=/ ¢ Qa0 & F O
General Tabs AutoFill Passwords Search Security Privacy Websites Extensions Advanced
Safari opens with: =~ A new window | <]
New windows open with: = Homepage <
New tabs open with: ~ Empty Page | <]
Homepage:  EHINMIICBOGKEEEM]
Set to Current Page
Remove history items:  After one week | <]
Favorites shows: (1] Favorites | < ]
Top Sites shows: 6 sites <
FIGURE 8-3: File download location: [ Downloads 8
Add|ng your own Remove download list items: | Upon successful download |
home page isan % Open "safe" files after downloading
easy change you Qiﬁ&if‘fﬁé”ﬁl‘f&ﬂ Socumante, i
can make. :

Alternatively, click the New Windows Open With pop-up menu and choose Empty
Page if you want Safari to open a new window with a blank page. This choice is the
fastest one for a home page.

Visit your home page at any time by pressing the Home button on the toolbar. If it
doesn’t appear on your toolbar, you can add it by choosing View=>Customize
Toolbar.

TIP

Adding and Using Bookmarks

No doubt about it: Bookmarks make the web a friendly place. As you collect
bookmarks in Safari, you’re able to immediately jump from one site to another
with a single click of the Bookmarks menu or the buttons on the Favorites bar.
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TIP

TIP

To add a bookmark, first navigate to the desired page and then do any of the
following:

»

»

»

Choose Bookmarks-—Add Bookmark.

Safari displays a sheet where you can enter the name for the bookmark, a
description and choose where it appears (on the Favorites bar, Top Sites
display, Bookmarks folder, or Bookmarks menu).

Press the 38+D keyboard shortcut.
Again, you'll see the sheet requesting a name and location.

Drag the icon next to the web address from the Address field to the
Favorites bar.

This trick also works with other applications besides Safari, including in a Mail
message or Messages conversation. Drag the icon from the Safari Address
field to the other application window, and the web page link is added to your
document.

You can also drag a link on the current page to the Favorites bar, but note that
doing this adds a bookmark only for the page corresponding to the link — not the
current page.

To jump to a bookmark, do one of the following:

»

»

»

»

Choose it from the Bookmarks menu. If the bookmark is contained in a
folder, which I discuss later in this section, hover your pointer over the folder
name to show its contents and click the bookmark.

Click the bookmark on the Favorites bar.

If you've added a great number of items to the Favorites bar, click the More
icon on the edge of the Favorites bar to display the rest of the buttons.

Click the Show Sidebar button on the Safari toolbar, click the Bookmarks
button in the Sidebar, and then click the desired bookmark. The Sidebar
(shown in Figure 8-4) displays all your bookmarks, allowing you to review each
collection at your leisure.

Click Bookmarks=>Edit Bookmarks (or press Option+3§+B) to open the
Bookmark list. For those who prefer more information (and more onscreen
elbow room) while selecting or organizing their bookmarks, the Bookmark
listis the cat's meow. It displays both the name and web address for each
bookmark in your collection.
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The more bookmarks you add, the more unwieldy the Bookmarks menu and
the Sidebar can become. To keep things organized, choose Bookmarks=>Add
Bookmark Folder and type a name for the new folder. With folders, you can
organize your bookmarks into collections, which appear in the column at

the left of the Sidebar, as folders in the Bookmark list, and as menus on

the Bookmarks bar. (Collections also appear as separate submenus in the
Bookmarks menu on the Safari menu bar.) You can drag bookmarks into the
new folder to help reduce the clutter.
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easy reach.

To delete a bookmark or a folder from any of these locations, right-click the icon
next to the entry and choose Delete from the contextual menu.

Working with the Reading List

Now that you know all about bookmarks, I’ll introduce you to another method of
loading, saving, and retrieving specific pages in Safari — and it’s hiding in the
now-familiar confines of the Safari sidebar!

The Sidebar’s Reading List tab allows you to save entire pages for later perusal.
From the keyboard, press g8 +Shift+L to display the Sidebar, and click the Reading
List button. Click Bookmarks=>Add to Reading List or press 38 +Shift+D to add the
current page to the list, or hover your pointer over the left side of the Address box
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TIP

and click the circular icon with the plus sign that appears. Oh, and don’t forget
that you can click the Sharing icon in the toolbar and choose Add to Reading List
to achieve the same victory.

When you click one of those entries in the Reading List and then click the Show
Reader View icon (it looks like a paragraph) that appears at the left side of the
Address box, the real magic begins! If you click it, the Reader panel appears to
display text articles free of advertisements and silly pop-ups. And if an article is
continued over multiple web pages, the Reader panel automatically stitches them
together to form a continuous block of text. (Think of an e-book displayed in
iBooks on your MacBook, and you get the idea.)

To delete an item from the Reading List, right-click the item and click Remove
Item, or click the X icon that appears next to the title.

If the Show Reader View icon appears in Safari’s Address box — and you’re not
using the Reading List — don’t panic! Because the page you’re reading contains
text articles, Safari is offering to display it in the Reader panel. (If a page has
nothing to display in the Reader panel, the icon disappears.) To display the page
in the Reader panel, click the Show Reader View button in the Address box. To
return to your mundane browsing experience, click the Reader icon again.

If you’re as big a fan of Reader View as I am, you’ll be thrilled to learn that you can
turn on this feature for every page on a website! With Reader View set on as a
default, every page on a website that’s compatible with the Reader panel will
automatically display in Reader view. (For example, I always set all my news
websites — like CNN and Macworld — to default to Reader view.) When you’ve
navigated to the desired website, click the Website Preferences button on
the toolbar (if you’ve added it), or choose Safaric> Settings for This Website from
the Safari menu. Click the Use Reader When Available check box to enable it, and
you’re good to go!

Downloading Files

148

A huge chunk of the fun you’ll find on the web is the capability to download
images and files. If you’ve visited a site that offers files for downloading, typically
you just click the Download button or the download file link, and Safari takes care
of the rest. While the file is downloading, feel free to continue browsing or even
download additional files; the Downloads status list helps you keep track of what’s
going on and when everything will be finished transferring. To display the
Downloads status list from the keyboard, press $8+Option+L. You can also click
the Download button at the upper-right corner of the window to display the
Download list.
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By default, Safari saves any downloaded files to the Downloads folder on your
Dock, which I like and use. To specify the location where downloaded files are
stored — for example, if you’d like to scan them automatically with an antivirus
program — follow these steps:

. Choose Safaric>Preferences, or press 38+, (comma).

Click the General tab (refer to Figure 8-3), and open the File Download
Location pop-up menu.

Choose Other.

Navigate to the location where you want the files stored.

Click the Select button.

oOUMhAW N=

. Click the Close button to exit Preferences.

To download a specific image that appears on a web page, move your pointer over
the image, right-click, and choose Save Image As from the menu that appears.
Safari prompts you for the location where you want to store the file.

You can choose to automatically open files that Safari considers safe — things like
movies, text files, and PDF files that are very unlikely to store a virus or a damag-
ing macro. By default, the Open “Safe” Files after Downloading check box is
selected on the General pane of the Safari Preferences dialog. However, if you’re
interested in preventing anything you download from running until you’ve manu-
ally checked it with your antivirus application, you can deselect the check box and
breathe easy.

timedia file types that it encounters. However, if you’ve downloaded a multimedia
file and Safari doesn’t seem to be able to play or display it, try loading the file in

TIP QuickTime Player. QuickTime Player is the Swiss Army knife of multimedia players,
and it can recognize a huge number of audio, video, and image formats. To launch
the Player, click the Spotlight search icon and type QuickTime Player.

‘ Luckily, Safari has matured to the point that it can seamlessly handle most mul-

Using History

To keep track of where you’ve been, you can display the History list by clicking the
History menu in Safari. To return to a page in the list, just choose it from the
History menu. Note that Safari also arranges older history items by the date you
visited a site so you can easily jump back a couple of days to that page you forgot
to bookmark!
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Safari also searches the History list automatically, when it fills in an address
you’re typing — that’s the feature I mention in the previous section, “Visiting
Websites.”

To view your Top Sites display, choose Show Top Sites from the History menu. You
can also click the Top Sites button at the far left side of the Favorites bar or on the
Safari toolbar (if you’ve added it).

You can add a site manually to your Top Sites by dragging a bookmark from the
Sidebar to the Top Sites icon in the Favorites bar, or by dragging a link or URL
address from another application to the Top Sites icon in the Favorites bar. (You’ll
see a plus sign appear next to your pointer to indicate the addition.) To rearrange
screens in the Top Sites display, just drag a screen thumbnail to the desired
location. If you prefer that a specific thumbnail remain in the same place, hover
your pointer over the thumbnail and click the gray pushpin icon, which turns blue
to indicate that the thumbnail is pinned in place.

If you’re worried about security and would rather not keep track of where you’ve
been online, find out how to clear the contents of the History file in the upcoming
section, “Handling ancient history.”

Tabs Are Your Browsing Friends

150

Safari also offers tabbed browsing, which many folks use to display (and organize)
multiple web pages at one time. For example, if you’re doing a bit of comparison
shopping for a new piece of hardware among different online stores, tabs are
ideal. Heck, tabbed browsing is so popular that Apple added tabs to Finder windows
with the release of OS X Mavericks!

When you hold down the g8 key and click a link or bookmark using tabs, a tab
representing the new page appears at the top of the Safari window. Just click the
tab to switch to that page. By holding down Shift+3g, the tab is both created and
displayed. (If you don’t hold down g8, things revert to business as usual, and
Safari replaces the contents of the current tab with the new page.)

You can also open a new tab by clicking the plus sign that appears at the upper-
right corner of the Safari window or by pressing $§+T. To move between multiple
tabs, simply click on the desired tab header. If you’re finished with a page, you can
remove a tabbed page by hovering your pointer over the tab and clicking the X
button that appears.
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FIGURE 8-5:
Hang on, Martha;
we've struck tabs!

TIP

Trackpad fans will appreciate Safari’s two gestures that control tabs. With multiple
tabs active, you can do these:

3 Pinch to display them all in the All Tabs view display (as shown in Figure 8-5).

3 With the All Tabs view open, swipe with two fingers to move among tabs.
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To display your tabs in All Tabs view without a trackpad, click the Show All Tabs
button that appears at the right side of the Safari toolbar. From the All Tabs view,
you can click any tab thumbnail to switch immediately to that tab. (Note that the
iCloud Tabs shared from your other Macs and iOS devices appear at the bottom of
the All Tabs view display.) To close a tab in All Tabs view, move your pointer over
the thumbnail and click the X button that appears. To close the All Tabs view dis-
play, click the Hide All Tabs button at the right side of the Safari toolbar.

The All Tabs view also displays the iCloud Tabs you’ve set on your other Macs
(running OS X Lion or later) and iOS devices (running iOS 7 or later).

To fine-tune your tabbed browsing experience, choose Safari=> Preferences to dis-
play the Preferences dialog, and click Tabs. From here, you can specify whether a
new tab or window automatically becomes the active window in Safari, and
whether you want to switch between tabs using 38 +1 through 38 +9.
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POWER USERS PIN SITES

Safari also offers pinned tabs, which allows you to immediately jump to a specific page.
Pinned sites hang out at the left side of the Tab bar, usually sporting a recognizable
symbol (taken from the site itself). Unlike standard tabs that | discuss in this section,
however, pinned tabs are updated automatically in the background from the moment
you launch Safari, which is perfect for sites like your Facebook page or Twitter feed that
are constantly changing.

To set a pinned tab, navigate to the page you want to pin, and click Windowe>Pin Tab.
The pinned tab is added at the far left of the Tab bar, and you can click it at any time to
immediately return to that page.

To remove a pinned tab, click the tab to switch to that page, then click Window=>Unpin Tab.

If you open a page that plays audio — either as background music, or as part of a
video shown on the page — you can click the speaker icon that appears in the tab
header to mute that audio. (Think really, really irritating video advertisements.)
To unmute the audio, click on the speaker icon again. You can also display the
Website Preferences sheet to disable auto-play of videos with sound across all the
pages on a website: Choose Safari= Settings for This Website from the Safari
menu, click the Auto-Play drop-down menu and choose Stop Media with Sound to
banish those irritating videos from the current website.

Printing Web Pages

152

TIP

If you’ve encountered a page that you’d like to print, follow these steps:

1. Display the desired page.
2. Choose Filec>Print, or press 38+P.

3. Select the number of copies, and specify whether you'd like to print the
entire page, only the current page, or a range of pages.

4. Click Print.

A quick word about printing a page in Safari: Some combinations of background
and text colors might conspire to render your printed copy worthless. In a case
like that, use your printer’s grayscale setting (if it has one), or click the Show
Details button at the bottom of the Print sheet and deselect the Print Backgrounds
check box (which can save you quite a bit of ink or toner). Alternatively, you can
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simply click and drag to select the text on the page, press $8+C to copy it, and
paste the text into TextEdit, Word, or Pages, where you can print the page on a
less offensive background (while still keeping the text formatting largely
untouched). You can also save the contents of a page as an electronic PDF file by
clicking Filew> Export as PDF or by clicking the PDF pop-up menu at the bottom of
the Print sheet. Finally, if the page is available in Reader view, you can print it
from there and avoid most color conflicts!

and choose Email This Page. If you’ve added the Mail button to your toolbar, one
click does the job. Mail loads automatically, complete with a prepared email mes-
TIP sage. Just address it to the recipients, and click Send.

If you’d rather mail the contents of a web page to a friend, click the Share button

Protecting Your Privacy

No chapter on Safari would be complete without a discussion of security, against
both outside intrusion from the Internet and prying eyes around your laptop.
Hence this last section, which covers protecting your privacy.

Although diminutive, the padlock icon that appears at the left side of the website
name in the Address box when you’re connected to a secure website means a great
deal! A secure site encrypts the information you send and receive, making it much
harder for those of unscrupulous ideals to obtain private data, such as credit card
numbers and personal information. You can click the padlock icon (next to the site
name) to display the security certificate in use on that particular site. A secure site
web address begins with the prefix https: instead of http:. (The extra s stands
for secure. A Good Thing.)

Yes, there are such things as bad cookies

First, a definition of this ridiculous term: A cookie, a small file that a website auto-
matically saves on your Mac’s drive, contains information that the site uses on
your future visits. For example, a site might save a cookie to preserve your site
preferences for the next time or — like shopping at Amazon.com — to identify
you automatically and help customize the offerings that you see.

In and of themselves, cookies aren’t bad things. Unlike a virus, a cookie file isn’t
going to replicate itself or wreak havoc on your system, and only the original site
can read the cookie that it creates. However, many folks don’t appreciate acting as
a gracious host for a slew of little snippets of personal information. (Not to
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mention that some cookies have highly suggestive names, which can lead to all
sorts of conclusions. End of story.)

You can opt to disable cookies altogether. You can also set Safari to accept cookies
only from the sites you choose to visit. To change your Cookie Acceptance Plan (or
CAP, for those who absolutely crave acronyms), follow these steps:

1 . Choose Safari=>Preferences.
2. Click the Privacy tab.
3. Click Block All Cookies.

If a site’s cookies are blocked, you might have to take care of things manually,
such as by providing a password on the site that used to be read automatically
from the cookie.

Feeling nervous about the data stored by the websites you visit? You can always
delete all that stored information with a single click. From the Privacy pane in the
Safari Preferences dialog, click the Manage Website Data button, then click the
Remove All button. You’ll be asked to confirm your draconian decision.

The Privacy pane also includes the Ask websites not to track me check box, which
works . . . sometimes. Unfortunately, it’s up to a particular website whether to
honor Safari’s request for privacy. Also, some sites — such as Amazon.com — use
tracking legitimately, to keep track of your likes and purchases each time you
return. With the release of High Sierra, Apple has added Intelligent Tracking Pre-
vention to Safari - it’s automatic and works behind the scenes, helping to prevent
unwanted intrusion into your browsing history. However, if you’re especially
worried about leaving a trail of breadcrumbs behind you on the web, I recommend
selecting this check box. You can also choose to block any attempts at cross-site
tracking, where multiple web sites cooperate together and share tracking
information.

Finally, you can also limit the access that websites have to your MacBook’s loca-
tion services, which can pinpoint your current location, from the Websites tab in
Safari Preferences. For example, Facebook’s website uses location services if you
allow it. Access can be set through prompting, or you can deny access to location
services completely for all websites.

Banishing pesky iCloud Keychain
passwords

I am the world’s biggest critic of keychains, which High Sierra uses to automati-
cally provide all sorts of login information throughout the system. In Safari, for
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example, the password information is automatically entered for you whenever a
website you’ve approved requires you to log in.

To be more specific, I'm sure many readers will adopt iCloud Keychain, which
stores password and credit card information for Safari and wirelessly distributes
that information automatically to other Macs and iOS devices using the same
Apple ID. Apple even says that the passwords generated by iCloud Keychain are
more complex and harder to crack, which sounds more secure, right?

I'd rather keep a pet piranha in a cereal bowl than use this feature! Why? When-
ever you’re logged in, anyone using your MacBook gets control of your online
persona (in the form of your passwords to secure websites). Safari, like an obedient
puppy, automatically provides access to sites with stored keychain passwords.

If you’d like to take the far-less-convenient-but-much-safer, old-fashioned
route of remembering your passwords yourself, follow my lead: Visit the iCloud
pane in System Preferences, and deselect the Keychain check box to turn the
iCloud Keychain feature off.

Now that I've warned you thoroughly, I feel better about mentioning the Pass-
words tab in Safari Preferences for those who do decide to use iCloud Keychain.
From the Passwords tab, you can view the iCloud Keychain information that Safari
uses, and either remove a specific password or all passwords from your iCloud
Keychain.

Handling ancient history

As you might imagine, your History file leaves a very clear set of footprints indi-
cating where you’ve been on the web. To delete the contents of the History menu,
choose History= Clear History (at the very bottom of the History menu).

Safari also allows you to specify an amount of time to retain entries in your History
file. Open the Safari Preferences dialog, click the General tab (refer to Figure 8-3),
and then click the Remove History Items pop-up menu to specify the desired
amount of time. Items can be rolled off daily, weekly, biweekly, monthly, or
yearly. You can also turn off automatic removal entirely.

Setting notifications

In High Sierra, Safari can allow websites you’ve approved to send you messages
using Notification Center — you can control which sites have been given this
functionality from the Websites tab in Safari’s Preferences dialog. To prevent a
website from sending notifications, click the Notifications entry in the list on the
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left, then choose Deny from the drop-down menu next to the offending site. You
can also remove a website from the list completely by clicking it and clicking the
Remove button.

Avoiding those @*!"\%$ pop-up ads

I hate pop-up ads, and I’m sure you do, too. To block many of those pop-up
windows with advertisements for everything from low-rate mortgages to “sure-
thing” Internet casinos, open the Safari Preferences dialog, click the Security tab,
and verify that Block Pop-Up Windows is selected. You can also turn on content
blocking for all the pages on the current website by choosing Safari=> Settings for
This Website from the Safari menu and clicking the Enable Content Blockers check
box to enable it.
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» Using your iCloud Drive

» Sharing documents with iOS devices
using Handoff

» Setting iCloud preferences

» Managing iCloud storage

Chapter 9

iCloud Is Made
for MacBooks

eaders often ask me to name my favorite reasons why they should switch

platforms. In other words, why should a Windows user who thinks all is

well move to the Apple universe? I always mention the superior hardware
and that High Sierra is a much better operating system than Windows 10. My
favorite selling point is innovation. Apple comes up with the best ideas first, and
everyone else plays catch-up.

Here’s the perfect example: The folks at Apple got tired of constantly synchroniz-
ing their iOS devices with their computers over a USB cable. Remember those
archaic days? When you took a photo with your iPhone or created a new document
with your iPad, your new additions just sat there in their original locations until
you had a chance to sync your device with your MacBook. But with Apple’s iCloud
functionality, your stuff gets automatically synchronized and backed up across the
Internet — something that the Windows world still doesn’t have, even today!

In this chapter, I save you the trouble of researching all the benefits of iCloud.
Heck, that’s one of the reasons you bought this book, right?
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So How Does iCloud Work, Anyway?

iCloud works by

FIGURE 9-1:

pushing data

among all your

158

iOS devices.

Today’s i0S devices can all display or play the same media: photos, music, books,
TV shows, and such. Heck, iOS devices (your iPhone, iPad, and iPod Touch) can
even share applications. Therefore, it makes sense to effortlessly share all your
digital media across these devices, and that’s what iCloud is all about. Apple calls
this synchronization “pushing.”

Here’s how the pushing process works. Imagine that you just completed a Pages
document on your MacBook (an invitation for your son’s birthday party), but
you’re at the office, and you need to get the document to your family so they can
edit and print it using your son’s iPad.

Before iCloud, you had to attach the document to an email message or upload it
to some type of online storage such as Dropbox or Microsoft’s OneDrive, and
then a family member had to download and save the document to the iPad
before working with it. With iCloud, you simply save the document on your
MacBook to the Pages folder on your iCloud Drive, and macOS automatically
pushes the document to the iPad (using the same Apple ID). Your document
appears on the iPad, ready to be opened, edited, and printed — and it appears
on any other devices using the same Apple ID as well. Figure 9-1 gives you an
idea of what’s happening in the background when one of your devices pushes
data using iCloud.

T @

Anew Pages Uploaded stored in iCloud Pushed to other The Pages

document you've 105 devices such as document

created and saved on your iPhone automatically

your Mac and iPad appears on your
iPad

I'll admit that Windows eventually implemented a similar process using
OneDrive — for example, you can save documents within Office 365 to OneDrive
and access them on other PCs and devices. Ah, but iCloud isn’t limited to just
digital media, though! High Sierra can also automatically synchronize your email
accounts, Calendar, and Contacts entries with other iOS devices across the
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Internet, so staying in touch is much easier (no matter where you are or which
device you happen to be using at the moment).

Apple also throws in 5GB of free online storage that you can use for all sorts of
things — not only digital media files but also documents you’d like to save online
for safekeeping. Items you buy through the iTunes Store, iBooks Store, or App
Store — music, video, podcasts, books, and applications — do not count against
your 5GB limit. (More on how you can expand that 5GB limit later in the
chapter.)

To join the iCloud revolution, you need an Apple ID. If you didn’t create one during
the initial High Sierra setup, you can create an Apple ID from the App Store.

REMEMBER .
You can also access your documents through the web at www. icloud.com. Log in

with your Apple ID and password to send mail, access your contacts and calendar,
edit your notes and reminders, locate your devices, and use online versions of

Pages, Numbers, and Keynote.
TIP

Moving, Saving, and Opening
iCloud Documents

iCloud online storage for your documents is definitely neat; your iCloud Drive
functions much like other popular online storage services like Dropbox and
Microsoft OneDrive, allowing you to save documents, load documents, and move
files to and from your MacBook’s drive with ease, using a Finder window. In fact,
iCloud Drive keeps things tidy for you: If you move a file from your iCloud Drive to
your local drive, it’s also deleted automatically from iCloud Drive on your other
Macs and iOS devices that use the same Apple ID. (High Sierra prompts you for
permission first, of course.)

Figure 9-2 illustrates my iCloud Drive in action; you can access your iCloud
Drive from the Finder window Sidebar. Note that iCloud folders are automati-
cally created for supported applications, such as Pages and Numbers, allowing
you to click the corresponding iCloud folder from the application’s Open dialog.
In other words, both your iCloud Drive and the application-specific iCloud folder
are available within the application’s Open dialog. It’s about as convenient as
you can get.
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FIGURE 9-2:
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Putting Handoff to Work

160

If you’re like me, your favorite moment in a team track event is the all-important
handoff of the baton from one runner to the next — making Handoff the perfect
name for this High Sierra feature, because it actually transfers what you’re doing
on your iOS devices to matching applications on your Mac!

As an example, let’s suppose you’re using Maps on your iPhone, and you realize
you’d rather view the location on your MacBook’s larger screen (as well as print
it from the USB printer connected to the laptop). If you’re within Bluetooth sig-
nal range of your MacBook, Handoff is ready to go: An icon for the macOS version
of Maps automatically appears at the left side of the Dock in High Sierra. One
click on that icon, and your MacBook opens Maps and displays the same
location!

You’re not restricted to just one application, either — each time you open an
application that Handoff supports (like Safari and Mail), High Sierra offers you the
chance to open the matching application on your MacBook and displays the
current data from the iOS app. All this is completely trouble-free: There’s nothing
to configure or set.

Caveats? Only three at the time of this writing:

3 Bluetooth is required: Bluetooth networking must be turned on for both the
iOS device and the MacBook for Handoff to work, and the iOS device must be
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within a 30-foot radius of your laptop. (That's the distance limit that Bluetooth
hardware can broadcast; walls and other obstructions reduce that range.)

3 You'll need the right hardware: In order to use Handoff, you'll need an
iPhone 5 (or later), a fourth-generation iPad (or later), any iPad mini, or a
fifth-generation iPod Touch (or later). On the computer side, you must have
a 2012 model MacBook (or later) that includes Bluetooth LE hardware.

¥ i0S 8 is a must: Handoff is compatible only with iOS devices running iOS 8 or later.

Handoff works in the other direction as well, allowing you to pick up where you
left off on your MacBook application by transferring the active session to your
iPhone, iPad, or iPod touch. Swipe the icon that appears on your iOS device to start
the ball rolling.

Configuring iCloud

FIGURE 9-3:

The iCloud pane
appears in
System
Preferences.

You control all the settings for iCloud from High Sierra’s iCloud pane in System
Preferences (shown in Figure 9-3). Click the System Preferences icon on the Dock
and then click the iCloud icon. At the sign-in prompt, enter your Apple ID and your
password. System Preferences then guides you through basic iCloud configuration.

LN ] < i iCloud Q
] ‘ iCloud Drive Options...
=] & Photos Options
] %‘, Mail
Mark Chambers 7 ‘ e

Account Details

Set Up Family
] u Reminders
0 ﬁ Safari
~ Notes
Sign Out Photes and Videos _. Manage...

Most of the check boxes on the iCloud Preferences pane control whether a
particular type of data — such as a Contacts entry, Keychain password, Mail
message, or calendar in Calendar — is pushed to all your iOS devices. (If an Options
button appears next to an entry, you can click it to specify additional settings.)
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WARNING

Note, however, that you can enable three other unique features from this pane
as well:

»

»

»

Photos: Click the Options button and enable the My Photo Stream check box
to allow your MacBook to automatically receive photos from your iOS devices.
Take a photo with your iPhone, for example, and that image is immediately
pushed to your laptop, iPad, and iPod touch. On the MacBook, however,
Photo Stream goes one step further: The photos appear automatically in
Photos in a special album titled Photo Stream. To store all of your photos

In iCloud, enable the iCloud Photo Library check box. (If you have a large
number of photos, you may have to buy additional iCloud storage space to
use the iCloud Photo Library feature.) You can also enable iCloud Photo
Sharing, which allows you to share photos with others from Photos.

To turn on My Photo Stream or iCloud Photo Sharing in Photos, choose
Photos = Preferences, click the iCloud button, and select the desired check
boxes.

Back to My Mac: If you enable Back to My Mac, you can remotely control your
MacBook from another Mac computer (or vice versa) using High Sierra’s

Screen Sharing feature. You can also transfer files between the two computers.
Back to My Mac works over both a broadband Internet connection and a local
network. Available Mac computers show up in the Shared section of the Finder
window sidebar. Note that you must manually turn on Screen Sharing in the
System Preferences Sharing pane before you can remotely control another Mac.

Find My Mac: Talk about Buck Rogers! Imagine locating a lost or stolen
MacBook from your iPhone or iPad. Now think about this: With Find My

Mac, you can even lock or completely wipe your Mac's hard drive remotely,
preventing unauthorized use and erasing your private data! After you

access your MacBook from another iOS device, you can play a sound, send

a message to be displayed onscreen, remotely lock the machine, or remotely
wipe the drive.

After you wipe the drive, though, you can't locate your MacBook again.

You can also enable Family Sharing from the iCloud pane, which allows you to
share purchased media and apps with as many as six users’ accounts. Participants
can share a special Photo Stream, apps, and media (purchased from the iTunes
Store, iBooks Store, or App Store), common reminders and a common calendar —
and no, they don’t actually need to be members of the same family. To launch the
Family Sharing Setup assistant, click the Set Up Family button and follow the
onscreen instructions.
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Managing Your iCloud Storage

FIGURE 9-4:
Checking on your
iCloud storage.

TIP

Apple knows that you’re curious about how much space you’ve taken up in your
personal iCloud. To monitor your iCloud storage, click the Manage button at the
bottom-right corner of the iCloud System Preferences pane. From the sheet that
appears, shown in Figure 9-4, you can see how much space you’re using for
document and data storage.
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- Your photos and videos are using 4.1 GB.
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iBooks your iCloud storage, you can disable it on all your devices.
bl

You then have 30 days to download your photos and

videos.
"N Other Documents

Disable and Delete
== GarageBand

[EStESsn )

Sign Out Photes and Wideos . Manage..

Click the data type in the left column, and iCloud displays the amount of storage
space that’s being used for that data. For instance, in Figure 9-4, I’'m checking the
amount taken by my iCloud Photo Library. Other items that might appear in this
sheet include Mail and selected iPad and iPhone apps that support iCloud.

If you find yourself running out of iCloud storage space, delete any stored item by
selecting it in the list at the right side of the sheet and click Delete.

And if you need more elbow room than 5GB, Apple is happy to provide 50GB,
200GB, or even a whopping 2TB of additional storage for a monthly subscription
fee of $0.99, $2.99, or $9.99, respectively. Click the Manage button on the iCloud
pane in System Preferences and then click the Buy More Storage button to
subscribe.
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» Enjoying the advantages of a
multiuser MacBook

» Understanding access levels

» Adding, editing, and deleting user
accounts
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accounts
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» Securing your stuff with FileVault

Chapter 10

Your Laptop Goes
Multiuser

verybody wants a piece — of your laptop, that is.

Perhaps you live in a busy household with kids, significant others, grandparents,
and a wide selection of friends, all of them clamoring for a chance to spend time
on the Internet, take care of homework, or enjoy a good game.

On the other hand, your MacBook might occupy a college classroom or boardroom
at your office. Suddenly your classmate or coworker wants his own Private iDaho
on-the-road warrior, complete with a reserved spot on the drive and his own
attractive, handpicked Desktop background. (Even flying at 30,000 feet, your
coworker will be eyeing your MacBook.)
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Before you throw up your hands in defeat, read this chapter and take heart! Here
you find all the step-by-step procedures, explanations, and tips to help you build
a safe multiuser MacBook that’s accessible to everyone with clean hands.

Oh, and you still get to use it, too. And, no, that’s not being selfish.

Once Upon a Time (An Access Fairy Tale)

166

Okay, so you don’t have Cinderella, Snow White, or that porridge-loving kid with
the trespassing problem. Instead, you have your brother Bob.

Every time Bob visits your place, it seems he needs to do “something” on the
Internet, or he needs a moment with your MacBook Air to bang out a quick mes-
sage, using his web-based email application. Unfortunately, Bob’s forays onto
your laptop always end up changing stuff, such as your Desktop settings, Contacts
database, and Safari bookmarks.

What you need, good reader, is a visit from the Account Fairy. Your problem is that
you have but a single user account on your system, and macOS High Sierra thinks
that Bob is you. By turning your MacBook into a multiuser system and giving Bob
his own account, High Sierra can tell the difference between the two of you,
keeping your druthers separate!

With a unique user account, High Sierra can track all sorts of things for Bob, leav-
ing your computing environment blissfully pristine. A user account keeps track of
stuff such as

¥ Contacts cards
¥ Safari bookmarks and settings

¥ Desktop settings (including background images, screen resolutions, and
Finder tweaks)

¥ iTunes Libraries, just in case Bob brings his own music (resigned “sigh”)

Plus, Bob gets his own reserved Home folder on your laptop’s hard drive, so he’ll
quit complaining about how he can’t find his files. Oh, and did I mention how user
accounts keep others from accessing your stuff? And how you can lock Bob out of
where-he-should-not-be, such as certain applications (like Messages and Mail)?
Heck, you can even lock Bob out of specific websites (including that offshore
Internet casino site he’s hooked on)!
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MARK'S
MAXIMS

User accounts affect just about everything you can do in High Sierra and on your
laptop. The moral of my little tale? A Mark’s Maxim to the rescue:

Assign others their own user accounts, and let High Sierra keep track of every-
thing. Then you can share your MacBook with others and still live happily ever
after!™

Big-Shot Administrator Stuff

TIP

Get one thing straight right off the bat: You are the administrator of your Mac-
Book. In network-speak, an administrator (or admin for short) is the one with the
power to Do Unto Others — creating new accounts, deciding who gets access to
what, and generally running the multiuser show. In other words, think of yourself
as the Monarch of macOS. (The king or queen, not the butterfly.)

I always recommend that you have only one (or perhaps two) accounts with
administrator-level access on any computer. In this way, you can be assured that
no one can monkey with your laptop while you’re away from the keyboard. So why
might you want a second admin account? Well, suppose you’re away from your
laptop — think “daughter takes it with her on a trip to Europe.” You might need
to assign a second administrator account to a trusted individual who knows as
much about your road warrior as you do. (Tell ’em to buy a copy of this book.) That
way, if something breaks or an account needs to be tweaked in some way, the
other person can take care of it while you’re absent (but without getting access to
your personal data). If necessary, don’t forget you can always log in to your second
admin account and change the password to guarantee security!

In the following sections, I explain the typical duties of a first-class MacBook
administrator.

Deciding who needs what access

The three most common user account levels are

3 Admin (administrator): See the preceding section.

¥ Standard level: Perfect for most users, these accounts allow access to just
about everything but don't let the user make drastic changes to High Sierra or
create new accounts.

3 Managed with parental controls level: These accounts are standard
accounts with specific limits assigned by you or another admin account.
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Another Mark’s Maxim is in order:

Assign other folks standard-level accounts and then decide whether each new
account needs to be modified to restrict access as a managed account. Never
assign an account admin-level access unless you deem it truly necessary.™

Standard accounts are quick and easy to set up, and I think they provide the per-
fect compromise between access and security. You'll find that standard access
allows your users to do just about anything they need to do, with a minimum of
hassle.

Managed accounts (with parental controls) are highly configurable, so you can
make sure that your kids don’t end up trashing the hard drive, sending junk mail,
or engaging in unmonitored chatting. (Note: Attention, all parents, teachers, and
anyone designing a single public access account for a library or organization: This
means you.)

Adding users

All right, Mark. Enough pregame jabbering. Show this good reader how to set up
new accounts! Your laptop already has one admin-level account set up for you
(created during the initial High Sierra setup process). You need to be logged in to
that account to add a user. To add a new account, follow these steps:

1. Intheusers& Groups pane (from System Preferences), click the New
User button (plus sign) at the bottom of the accounts list to display the
empty user record sheet shown in Figure 10-1.

If the New User button is disabled and you can't click it, click the padlock at the
bottom left of the System Preferences pane, and provide your password to
unlock the Users & Groups pane.

2. select the access level for this user from the New Account pop-up menu.

By default, the user receives a standard-level account. You can also choose an
administrator account, a managed standard account with parental controls
already enabled, or a sharing-only account.

The sharing-only account allows the user to copy or open shared files from
your MacBook remotely (from another computer), but that user can't directly
log in to your laptop.
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have a new user.

3. Inthe Full Name text box, type the name you want to display for this
account (both in the Current User list and on the Login screen). Then
press Tab to move to the next field.

macOS automatically generates an account name in the Account Name field

@ for use as your screen and buddy name in Messages and various network
applications. The account name is also the name of the folder that macOS
TP creates on the computer’s hard drive for this user. You can keep the default

account name or type a new one, but it cannot contain any spaces.
4, Type the password for the new account.

Click the button with the key icon next to the Password field, and High Sierra is
happy to display Password Assistant, complete with a suggestion. Click the
Suggestion pop-up menu to see additional suggestions. You can choose the
password's length and select from among several types: letters and numbers,
numbers only, memorable, completely random, or even FIPS-181 compatible
(government-quality). Password Assistant automatically copies the current
password you're considering into the Password and Verify text boxes.

As always, when you enter or verify a password, macOS displays bullet
characters for security.

n

Press Tab, type the password in the Verify text box, and press Tab again.

6. (Optional) If you decide to use the password hint feature, you can enter a
short sentence or question in the Hint text box.

The hint is displayed after three unsuccessful attempts at entering the account
password.
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From a security standpoint, password hints are taboo. (Personally, | never use
'em. If someone is having a problem logging in to a computer | administer, you
better believe | want to know why.) Therefore, despite the recommendation
that High Sierra shows here, | strongly recommend that you skip this field. If
you decide to offer a hint, keep it vague! Avoid hints like “Your password is the
name of the Wookiee in Star Wars."” And don't embed the password in the hint!

7. Click the Create User button to finish and create the account.

The new account shows up in the Current User list and in the Login screen.

Each user’s Home folder has the same default subfolders, including Movies,
Music, Pictures, Public, and Downloads. A user can create new subfolders within
his or her Home folder at any time.

Here’s one more neat fact about a user’s Home folder: No matter what the account
level, most of the contents of a Home folder can’t be viewed by other users. (Yes,
that includes admin-level users. This way, everyone using your MacBook Pro gets
his or her own little area of privacy.) In the Home folder, only the Public folder can
be accessed by other users — and only in a limited fashion. (Read all about Home
folders in Chapter 5.)

Modifying user accounts

Next, consider the basic modifications you can make to a user account, such as
changing existing information or selecting a new picture to represent that user’s
unique personality.

To edit an existing account, log in with your admin account, display the System
Preferences window, and click Users & Groups to display the account list. Then
follow these steps:

1. Inthelist to the left of the window, click the account you want to change.

If the accounts in the list are disabled and you can't select one, you must
unlock the Users & Groups pane. Click the lock at the bottom left of the System
Preferences pane (and type your password, if prompted).

. Edit the settings you need to change.

Examples include temporarily enabling administrator rights for an account (by
selecting the Allow User to Administer This Computer check box) and changing
the account password (by clicking the Reset Password button).
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FIGURE 10-2:
Choose the
image that best
represents

a user.

3.

Click the round picture well (the circle that displays the image) to specify
the thumbnail image that appears in the Login list next to the account
name.

Apple provides a number of good images in the preview collection. Just click a
thumbnail to select it.

To replace your account image, drag a new image from a Finder window
or the Photos window and drop it into the picture well.

Note that some of these choices are available only when you're using an
Admin-level account:

® To choose an image from the default set of High Sierra icons: Click the picture
well, click the Defaults entry at the left (see Figure 10-2), click the desired
image, and then click Done.

® To choose an image from your Photos collection: Click the Photos entry, click
the desired image, and then click Done.

® To choose an icon image from your iCloud Photo Stream: Click the iCloud
entry, click the desired image, and then click Done.

Alternatively, you can click the picture well and click the Camera entry to grab a
picture from your MacBook's built-in FaceTime HD camera. When you're set to
take the photo, click the camera icon and then click Done to accept it. Most
cool. (You can also use Photo Booth to take an account image.)

After you make your changes, press 38+Q to save them and close the
System Preferences window.

-

ent User Defaults

) Mark Cha Camera

Curre

Other Users

Benjamin )
» Collections

‘m Login Opt.

T

Users & Groups

Current

i1ssword...
Admin | photos

» Moments

GuestUs  » Years
Ot » Places
» Albums
Photo Booth

Click the lock to prevent further changes. ?
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Standard-level users have some control over their accounts — they’re not
helpless, after all. Standard users can log in, open System Preferences, and click
Users & Groups to change the account password or picture as well as the Contacts
Card assigned to them in the High Sierra Contacts application. All standard users
can also set up login items, which I cover later in this chapter. Note, however, that
managed users might not have access to System Preferences, so they can’t make
changes. (Read about this in the upcoming section “Managing an account’s access
settings.”)

| banish thee, mischievous user!

Not all user accounts last forever. Students graduate, coworkers quit, kids move
out of the house (at last!), and Bob might even find a significant other who has a
faster broadband connection. We can only hope.

Anyway, no matter what the reason, you can delete a user account at any time. Log
in with your admin account, display the Users & Groups pane in System Prefer-
ences, and then follow these steps to eradicate an account:

1 . Inthe user list at the left of the window, click the account you want to
delete.

2. Click the Delete User button (which bears the Minus Sign of Doom).
macOS displays the confirmation sheet shown in Figure 10-3.

Note that the contents of the user's Home folder can be saved in a disk image
in the Deleted Users folder (just in case you need to retrieve something).
Alternatively, you can choose to leave the deleted user's Home folder as is,
without removing it (but naturally you won't regain any space, even though the
user account is deleted).

If you're absolutely sure you won't be dating that person again, select the
Delete the Home Folder radio button (which doesn't save anything in the
Deleted Users folder). You regain all the drive space that was being occupied
by the contents of the deleted user's Home folder.

3. To delete the account, click Delete User. If you're not sure, click the
Cancel button to abort and return to the Accounts list.

Time once again for a Mark’s Maxim:

Always delete unnecessary user accounts. Otherwise, you’re leaving holes in your
laptop’s security.™
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FIGURE 10-3:
This is your last
chance to save
the stuff from a
deleted user
account.

[ ] Users & Groups

1 Are you sure you want to delete the user account
Current Us “Benjamin Franklin"?
Marl ird...
o) To delete this user account, select what you want to do with the home

Admi folder for this account, and then click "Delete User"

Other User
. Save the home folder in a disk image
Man: The disk image is saved in the Deleted Users folder {in the
Gue Users folder).

off
Don't change the home folder
The home folder remains in the Users folder.
Delete the home folder

Cancel |

Allow user to administer this computer
m Login Options

+]—

.4 Enable parental controls Open Parental Controls...

[l Click the lock to prevent further changes.

WORKING WITH THE GUEST ACCOUNT

The Guest account is a convenient method of granting someone temporary access to
your MacBook. In fact, your guest doesn’t even need a password to log in. Your Guest
account has all the attributes of a standard account, so the visitor has little chance of
accidentally (or purposefully) damaging your system. Nevertheless, after the guest user
logs out, the Guest account is “flushed,” and all the data and files that person created
using the account are deleted automatically. (This allows the next guest to start with a
clean slate.)

By default, the Guest account is disabled. To turn on this feature, open System
Preferences, click Users & Groups, and then click the Guest User entry in the list. (You
may have to click the Lock icon at the lower-left corner of the Users & Groups pane and
provide your admin password before you can continue.) Click the Allow Guests to Log In
to This Computer check box to enable it.

Oh, and don't forget that you can enable specific parental controls for the Guest

account, just as you can for any other standard-level account. This feature should come
in handy if your child has a slumber party coming up this weekend.
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Setting up login items and
parental controls

Every account on your MacBook can be customized. Understandably, some set-
tings are accessible only to admin-level accounts, and others can be adjusted by
standard-level accounts. In the following sections, I introduce you to the things
that can be enabled (or disabled) in a user account.

Automating with login items

Login items are applications or documents that can be set to launch or load auto-
matically as soon as a specific user logs in — for example, Apple Mail or Contacts.
In fact, a user must be logged in to add or remove login items. Even an admin-
level account can’t change the login items for another user.

A user must have access to the Users & Groups pane in the System Preferences
window to use login items. As you can read in the following section, a user can be
locked out of System Preferences, which makes it more difficult for login items to
be deleted for that account. (Go figure.) Therefore, if the account is managed and
access to System Preferences has been turned off, an administrator must enable
the account’s access to System Preferences, allowing the managed user to delete
login items.

To set login items for your account, follow these steps:
1 . Click the System Preferences icon in the Dock, and then click the Users &
Groups icon.

2. Clickthe Login Items tab to display the settings shown in Figure 10-4.

It bears repeating: You can change the Login Items for only the account that's
currently logged in, so be sure that the desired account appears under the
Current User heading in the list at the left.

W

Click the Add button (with the plus sign) to display a file selection sheet.

4, Navigate to the application you want to launch each time you log in, click
it to select it, and then click Add.

If you're in the mood to drag and drop, just drag the applications you want to
add from a Finder window, and drop them directly into the list.

5. Ppress $8+Q to quit System Preferences and save your changes.
If the application is running at the moment, you can take an easy shortcut and

avoid these steps: Simply right-click the application icon in the Dock and choose
Options= Open at Login from the pop-up menu that appears.
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FIGURE 10-4:
Add apps to your
Login Items list.
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column next to the application.
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[l Click the lock to prevent further changes.

Login items are launched in the order in which they appear in the list, so feel free
to drag the items into any order you like.

It’s a good idea to limit the amount of login items, especially with older Mac-
Books. Login items may be automatic and convenient, but too many of them can
dramatically slow the boot process each time you start your laptop. No one wants
to wait 3 minutes before starting to work or play!

Managing an account’s access settings

A standard-level account with restrictions is a managed account. (You can read
about these accounts earlier in this chapter.) With these accounts, you can restrict
access to many different places in High Sierra and your laptop’s applications by
using parental controls. (Naturally, admin-level accounts don’t have parental con-
trols, because an admin account has no restrictions.)

In short, parental controls come in handy in preventing users — family members,
students, coworkers, friends, or the public at large — from damaging your files,
your software, or High Sierra itself. If an account has been restricted with parental
controls, the account description changes from Standard to Managed in the
Accounts list.

To display the parental controls for a standard account, start here:

1. Log in with an admin-level account.

2. Open System Preferences and click Users & Groups.
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3. Click the desired Standard account in the list and then select the Enable
Parental Controls check box.

If necessary, click the Lock icon at the lower-left corner to confirm your access.

4. Now click the Open Parental Controls button to display the six categories
(tabs) shown in Figure 10-5.

[ N ] < i Parental Controls Q
Web Stores  Time  Privacy  Other
[ ) Benjamin Franklin

‘ 2 Allow use of camera
Applies te built-in cameras in devices and connected displays.

% 7 Allow joining Game Center multiplayer games
m. Limit Mail to allowed contacts

@ Limit Applications on this Mac
Allow the user to open only the specified applications on this
Mac. An administrator passwerd is required to open other
applications.

Allowed Apps:
» Other Apps

FIGURE 10-5: "o ies
You can restrict
access to many

: : + — %
functionsin a
Managed [l Click the lock to prevent further changes. Logs... ?

account.

You can restrict access to the following functions in a Managed account:

3 Apps: These settings (which | discuss in more detail in a second) affect what
the user can do in High Sierra, as well as what the Finder itself looks like to
that user.

3 Web: High Sierra offers three levels of control for websites:

Allow Unrestricted Access to Websites: Select this radio button to allow
unfettered access for this user.

Try to Limit Access to Adult Websites: You can allow Safari to automatically
block websites it deems adult. To specify particular sites that the automatic
“adult filter” should allow or deny, click the Customize button.

Allow Access to Only These Websites: Choose this radio button to specify
which websites the user can view. To add a website, click the Add (plus
sign) button, and respond to the High Sierra prompt for a title and the
website address.
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FIGURE 10-6:
High Sierra keeps
track of your kid's

computer usage
so that you don't
have to.

¥ Stores: You can specify whether the user can use the iTunes Store and the
iBooks Store, as well as restrict access within both stores to music, movies,
TV shows, apps, and books by age or rating.

¥ Time: Parents, click the Time tab, and you'll shout with joy! Check out the
options in this pane, shown in Figure 10-6. You can limit an account to a
certain number of hours of usage per weekday (Weekday Time Limits) and per
weekend day (Weekend Time Limits). You also can set a bedtime computer
curfew time for both weekdays (called “Bedtime” here) and weekend days.

e < i Parental Controls Q

0 Benjamin Franklin

_] "), Bedtime
\ ‘| Prevents access to this computer during the specified hours.
[ school nights: B:00PM 2 to 6:00 AM T
Weekend: 8:00PM I to 6:00AM O
+ — %
#
Eﬂ Click the lock to prevent further changes. Logs... ?

Apps  Web Stores Privacy  Other

EINEE Weekday time limits

Allows acoess to this computer Monday through Friday for the
specified number of hours only.

- 3 hours a day

24 Limit weekday use to:

FEMSSSEE Weekend time limits

Allows access to this computer Saturday and Sunday for the
specified number of hours only.
_ 5 hours a day
4 Limit weekend use to: .

¥ Privacy: From this tab, you can individually configure the user’s ability to
launch apps or access social media. Use the convenient check boxes to allow
or prevent changes to the settings used by Location Services, Contacts,
Calendars, Reminders, Twitter, Facebook, and Diagnostic Apps. For even more
control, click the Manage Privacy button to jump immediately to the Privacy

tab
acc

of the Security & Privacy pane (allowing you to fine-tune which apps can
ess specific data).

¥ Other: These settings control the Dictionary and hardware devices such as
your printer and DVD burner. They include

Turn Off Siri and Dictation: Enable this check box to prevent the user from
accessing the Siri assistant and Dictation features in System Preferences.

Disable Editing of Printers and Scanners: With this check box selected, the
user cannot modify the printers and printer queues in the Print & Scan
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pane in System Preferences. If this option is enabled, the user can still print
to the default printer and switch to other assigned printers but can't add or
delete printers or manage the macOS print queue. (If the print job encoun-
ters a problem, that user has to bug you to fix things.)

Block CD and DVD Burning in the Finder: Select this check box to prevent the
user from recording CDs or DVDs via the built-in disc-recording features in
macOS. (Note, however, that if you load a third-party recording program,
such as Toast, the user can still record discs with it — unless you also
disable access to that program in the Apps section.)

Restrict Explicit Language in Dictionary: With this check box selected, profane
terms in the Dictionary are hidden for this user.

Prevent the Dock from Being Modified: Select this check box, and the user
can't remove applications, documents, and folders from the Dock in the full
Finder. (This is a great choice if you don't want the contents of the Dock
changing according to the whims of other users.)

Use Simple Finder: | discuss the Simple Finder later in this section; it's a great
idea for families and classrooms with young children.

You might want to create a single standard-level account for an entire group of
people to use. For example, maybe you want to leave the laptop in kiosk mode in
one corner of the office, or perhaps everyone in a classroom will use the same
account on the MacBook. Keep your one admin-level account close to your bosom,
and create a standard-level account for the Unwashed Horde.

High Sierra keeps a number of different types of text log files. They track where the
user goes on the Internet, the applications launched by the account, and the con-
tents of any Messages conversations in which the user participated. Click the Logs
button on any Parental Controls screen to monitor all the logs for a particular
account.

You can always tell whether an account has been assigned parental controls,
because the account description changes from Standard to Managed in the
User list.

Of particular importance are the Finder and the applications controls. Click the
Apps tab (refer to Figure 10-5) to modify these settings:

3 Allow Use of Camera: Specify whether the account has access to your MacBook's
built-in camera. (Note that an external USB Web camera is unaffected by this
setting.)
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3 Allow Joining Game Center Multiplayer Games: This check box allows or
disables the user’s access to the multiplayer games in Game Center.

¥ Limit Mail to Allowed Contacts: Select this check box to specify the email
addresses that this user can communicate with. (Note that this feature affects
only Apple Mail; other mail clients, web-based mail, instant messaging
applications, and audio/video chat applications aren’t controlled.) To add an
address to which the user can email, click the Manage button, then click the
familiar Add button bearing the plus sign. To delete an address, click the
Manage button, select the offending address, and click the Delete button
(bearing the minus sign).

If you want a notification if the user is attempting to send an email to some-
one not on the list, click the Manage button, select the Send Requests To
check box, and then type your email address in the text box.

3 Limit Applications on this Mac: When this option is selected, you can choose
which specific applications the user sees. These restrictions are in effect
whether the user has access to the full Finder or just the Simple Finder. Click
the triangle icon next to the desired group heading to expand the list. To locate
a specific application, click in the Search box and type the application name:

To allow access to all applications: Simply disable the Limit Applications
on this Mac check box.

To allow or restrict access to all the applications of a specific type:
Enable or disable the check box next to the desired group heading — for
example, clicking the Other Apps check box to disable it will prevent the
user from launching any of the applications in that group.

To allow or restrict access to an individual application: Select the check
box next to any application to select or deselect it.

To add a new application to the Allowed Apps list, drag its icon from the
Finder and drop it in the list in the Other Apps group. After you add an
application, it appears in the Other Apps group, and you can toggle access to
it just like the applications in the named groups.

These settings can work hand in hand with the High Sierra Gatekeeper feature,
which prevents anyone from launching applications that were not down-
loaded from the App Store (or are not Apple-approved).

You can restrict your standard-level users even further by assigning them the
Simple Finder set of limitations. The Simple Finder is a highly simplified version
of the regular macOS Finder. It has a basic Dock that contains only the Finder icon,
the Trash icon, and the folders for the user’s approved applications, documents,
and shared files.
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The Simple Finder is the network administrator’s idea of a foolproof interface for
macOS: A user can access only the system files and resources needed to do a job,
with no room for tinkering or goofing off.

A Simple Finder user can still make the jump to the full version of the Finder by
clicking the Finder menu, choosing Run Full Finder, and entering an admin-level
username and password.

Would you like to set up a public-access MacBook? You can also change the Auto-
matic Login account from the Users & Groups pane. Click the Login Options button
under the User list, and then click the Automatic Login pop-up menu to choose
the account that automatically logs in when macOS starts. On the confirmation
sheet that appears, enter the account password, and click OK. I’ve made it clear
elsewhere that Automatic Login is not a good security feature in many cases, such
as with a laptop on the road. However, it can be a good feature if you’re preparing
a MacBook for public use. If you set the Automatic Login to your public standard-
access account, macOS automatically uses the correct account if the Mac is
rebooted or restarted.

You can always choose Log Out from the Apple menu to log in under your own
account, or use the fast user switching feature I describe in the next section.

Mundane Chores for the Multiuser Laptop

180

After you’re hip to user accounts and the changes you can make to them, you can
turn to a number of topics that affect all users of your MacBook. These topics
include how they log in, how a user can share information with everyone else on
the computer, and how each user account can be protected from unscrupulous
outsiders with state-of-the-art encryption. (Suddenly you’re James Bond! I told
you High Sierra would open new doors for you.)

Logging in and out of High Sierra
For Dummies

Hey, how about the login screen itself? How do your users identify themselves?
Time for another of my “shortest books in the For Dummies series” special editions.
(The title is practically longer than the entire book.)

PART 3 Connecting and Communicating



MARK'S
MAXIMS

A\

WARNING

FIGURE 10-7:
The Fast User
Switching menu,
unfurled for

all to see.

Exploring your login options

High Sierra offers four methods of logging folks in to your multiuser laptop, all of
which are available from the Login Options button on any admin account:

»

»

»

The username and password login: This screen is the most secure type of
login screen you'll see in High Sierra; it requires that you type your account
username and password. (A typical hacker won't know all the usernames on
your MacBook.) Press Return to complete the process.

When you enter your password, you see bullets rather than your password
because High Sierra displays bullet characters to ensure security. Otherwise,
someone could simply look over your shoulder and see your password.

Keep your laptop secure: Use a username and password login, and
always choose a password that's tough to guess.™

The list login: This login screen offers a good middle of the road between
security and convenience. Click your account image in the list, and type your
password when the login screen displays the password prompt. Press Return
to continue.

Fast user switching: This feature allows another user to sit down and log in
while the previous user's applications are still running in the background. This
is perfect for a fast email check or a scan of your eBay bids without forcing
someone else completely off the MacBook. When you turn on Fast User
Switching, High Sierra displays the currently active user's name at the right
side of the Finder menu bar.

To switch to another account:
1. Click the current user’s name in the Finder menu (see Figure 10-7).

2. Click the name of the user who wants to log in.

High Sierra displays the login window, just as if the laptop had been rebooted.

The previous user's stuff is still running, so you definitely shouldn't reboot or
shut down the computer!

Benjamin Franklin

Mark Chambers

Window...

Users & Groups Preferences...
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To switch back to the previous user:

1. Click the username again on the Finder menu.

2. Click the previous user’s name.

For security, High Sierra prompts you for that account’s login password.

3 Auto login: This option is the most convenient method of logging in but offers
no security whatsoever. High Sierra automatically logs in the specified account
when you start or reboot your MacBook.

| strongly recommend that you use auto login only if

Your laptop is in a secure location, such as your home or a locked office. If
you're on the road, you and your data need the protection of a username
and password login!

WARNING

You can guarantee that you're the only one using your laptop. Period.

You're setting up a public-access laptop kiosk, in which case you want your
MacBook to immediately log in with the public account.

Working in a public environment? Never set an admin-level account as the auto
login account. This is the very definition of an SDI, or Supremely Dumb Idea.

Changing your login settings

To set up a username/password or list login, open System Preferences, click the
Users & Groups icon and then display the Login Options settings, as shown in
Figure 10-8. (If necessary, click the Lock icon at the lower-left corner to confirm
your access.) Here’s a rundown of key login settings:

3 Automatic Login: To set Auto Login, click the Automatic Login pop-up menu
and choose the account that High Sierra should use.

¥ Display Login Window As: Select the List of Users radio button for a list login
screen, or select the Name and Password radio button to require your users
to type their full username and password.

3 Show Fast User Switching Menu As: Select this check box to enable fast user
switching. Click the pop-up menu to specify how accounts should appear in
the Finder menu (as full names, short names, or account icons).
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Logging out

Logging out of High Sierra all the way (without fast user switching) is a cinch. Just
click the Apple menu (#) and then choose Log Out. (From the keyboard,
press 38+Shift+Q.) A confirmation dialog appears that automatically logs you off in
one minute. And that one minute is important, because if someone walks up and
clicks Cancel, he’ll be using your laptop with your account! Therefore, it’s a good
idea to bypass the confirmation dialog by pressing Option while choosing Log Out
from the menu (or by adding the Option key to the keyboard shortcut). Your Mac-
Book returns to the login screen, ready for its next victim. Heed this Mark’s
Maxim:

Always click the Log Out button in the logout confirmation dialog before you
leave your MacBook (or use the Option key to bypass the confirmation dialog),
and double-check to make sure the logout completes successfully.™

Interesting stuff about sharing stuff

You might wonder where shared documents and files reside on your MacBook.
That’s a good question. Like just about everything in High Sierra, the answer is
simple. The Users folder on your laptop has a Shared folder within it. To share a
file or folder, place it in the Shared folder.

You don’t have to turn on file sharing in the Sharing pane of System Preferences

to use Shared folders on your laptop. File sharing affects only network access to
your machine by users of other computers.
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Each user account on your MacBook also has a Public folder in that user’s Home
folder. The Public folder is a read-only folder that other users on your laptop (and
across the network) can access. They can only open and copy the files it contains.
(Sorry, no new documents or changes to existing documents from other users.)

Encrypting your Home folder can be fun

Allowing others to use your Mac laptop always incurs a risk — especially if you
store sensitive information and documents on your computer. Although your
login password should ensure that your Home folder is off-limits to everyone else,
consider an extra level of security to prevent even a dedicated hacker from access-
ing your stuff. All it takes is a forgetful moment in an airport or classroom, and
your personal and business data is suddenly within someone else’s reach. Ade-
quate security is a Supremely Good Thing!

To this end, High Sierra includes FileVault, which automatically encrypts the con-
tents of your MacBook’s drive. Without the proper key (in this case, either your
login password or the FileVault recovery key), the data stored on your drive is
impossible for just about anyone to read. (I guess the FBI or CIA would be able to
decrypt it, but they’re not likely a worry at your place!)

The nice thing about FileVault is that it’s completely transparent to you and your
users. In other words, when you log in, High Sierra automatically takes care of
decrypting your files and folders. You won’t know that FileVault is on the job
(which is how computers are supposed to work).

To turn on FileVault protection for a specific account, follow these steps:
1. click the System Preferences icon in the Dock and then click the
Security & Privacy icon.

2. Click the FileVault tab and then click the Turn On FileVault button.

. ecify whether your iCloud (Apple ID) account can be used to reset your
3. specify whether your iCloud (Appl be used y
password and unlock your disk and then click Continue.

For most MacBook owners, the Allow My iCloud Account to Unlock My Disk
option is probably just fine, but if you're security-conscious (or you've shared
your iCloud account information with others), click the Create a Recovery Key
and Do Not Use My iCloud Account radio button.

PART 3 Connecting and Communicating



TIP

WARNING

©

REMEMBER

If you decide to create a separate recovery key, write down the FileVault
recovery key displayed by High Sierra, and store it in a safe place.

To avoid mistakes, you can capture an image of your screen by pressing
98+Shift+3. The screenshot appears as an image file on your Desktop. From
there, you can open it and print a copy, or even copy the image file to a USB
flash drive or another computer on your network for safekeeping. (Naturally,
you'll delete the image once it's been printed or copied elsewhere.)

Personally, | love the FileVault feature. | use it on all my Macs running High
Sierra. Yet a risk is involved (insert ominous chord here). To wit: Do not forget
your login and iCloud account passwords (or make DOGGONE sure that
you or your Admin user have access to a copy of that all-important
FileVault recovery key)! macOS displays a dire warning for anyone who's
considering using FileVault: If you forget these safeguards, you can't retrieve
any data from your MacBook's drive. Even the smartest Apple support
technician will tell you that nothing can be done. As Jerry Reed used to say,
“It's a gone pecan” (with pecan pronounced Southern style, as “puh-kahn").

If necessary, click Enable User, provide the login password for each user
on your account, and then click Continue.

Each user on your MacBook has to be enabled to use your laptop after
FileVault has been turned on. If you don't know the login passwords for the
other user accounts on your system, you have to ask each person to provide
his or her password to continue. (If an account is not enabled, that person can
no longer access anything on the hard drive after it has been encrypted.)

Click the Restart button on the confirmation screen.

Your MacBook automatically reboots and begins the encryption process. You
can continue to use your laptop normally during the encryption.

You're done!
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» Considering the benefits of a network

» Choosing between wired and wireless
networks
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network
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» Using your network

» Protecting your MacBook with a
firewall

Chapter 11

Working Well with
Networks

n my opinion, network access ranks right up there with air conditioning and the

microwave oven. Like other “I can’t imagine life without them” kinds of tech-

nologies, it’s hard to imagine sharing data from your laptop with others around
you without a network. I guess you could still make use of a sneakernet (the old-
fashioned term for running back and forth between computers with a floppy disk),
but these days, Apple computers don’t even have floppy drives. (Even with a high-
capacity USB 3.0 flash drive, a sneakernet is still a hassle — and somewhat of a
security risk, to boot.)

Nope, networking is here to stay. Whether you use a network to share an Internet
connection, challenge your friends to a relaxing game of WWII battlefield action, or
stream your MP3 collection to other computers that use iTunes, you’ll wonder how
you ever got along without one. In this chapter, I fill you in on all the details you
need to know to get your road warrior hooked up to a new (or existing) network.
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What Exactly Is the Network Advantage?

If you have other family members with computers, or if your MacBook is in an
office with other computers (including those rascally PCs), here’s just a sample of
what you can do with a network connection:

3 Share an Internet connection: This is the major reason why many families
and most small businesses install a network. Everyone can simultaneously use
the same digital subscriber line (DSL) or cable Internet connection on every
computer on the network.

3 Share a printer: You say your fellow employee — or, even worse, your big
sister — has a great printer connected to her computer? Luckily, that printer
can be shared with anyone across your network.

3 Copy and move files of all sizes: Need to get a Keynote presentation from
one Mac to another? With a network connection, you can accomplish this task
in just seconds. Otherwise, you'd have to copy that file to a USB flash drive,
burn it to a DVD-R, or use an external hard drive. A network connection makes
copying as simple as dragging the project folder from one Finder window to
another.

3 Share documents across your network: Talk about a wonderful collabora-
tion tool! For example, you can drop a Word document or Keynote presenta-
tion file in your Public folder (or save it in your iCloud Drive) and ask for
comments and edits from others in your office (or around the planet).

3 Stream music and video: With iTunes, you can share your audio and video
media collection on your MacBook with other Macs and PCs (and even devices
such as an Apple TV or an AirPlay speaker system) on your network. Your eyes
and ears can't tell the difference! Using a network connection, you can also
watch streaming TV and movies from services like Netflix and Hulu.

3 Play multiplayer games: Invite your friends over and tell 'em you're hosting a
LAN party (the techno-nerd term for a large gathering of game players, connected
through the same network, all playing the same multiplayer game). Alternatively,
you can play most of today’s games remotely, challenging other players across
the Internet. (A great feature if you're stuck in a hotel room for the evening.)

If your laptop isn’t within shouting distance of an existing network, or you don’t
plan on buying any additional computers, you may not need to create a network.
Alone MacBook hanging out in your home with no other computers around should
need a network only for Internet access.
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If you have just your Mac laptop and an Internet connection through a high-speed
DSL/cable modem, and you have no plans to add another computer, wireless
equipment, a network printer, or a mobile device, a network probably isn’t
necessary.

Should You Go Wired or Wireless?

TABLE 111

After you decide that you indeed need a network for your home or office, you have
another decision to make: Should you install a wired network (running cables
between your computers) or a wireless network? Heck, should you throw caution
to the wind and build a combination network with both wireless and wired
hardware?

Your first instinct is probably to choose a wireless network for convenience. After
all, this option allows you to eliminate running cables behind furniture, in the
walls, or in your office ceiling. Ah, but I must show you the advantages of a wired
network as well. Table 11-1 gives you the lowdown to help you make up your mind.

Wireless versus Wired Networks

Factor Wireless Networks Wired Networks
Speed Moderate Much faster
Security Moderate Better

Convenience Better Worse

Compatibility Confusing standards Easier to understand
Cables Few (or none) Required

As I see it, here are the advantages of choosing a wired versus a wireless network
setup:

¥ Wired: Using a wired network offers two significant perks over a wireless
network:

Faster speeds: In general, wired networks that are compatible with your
MacBook are many, many times faster than the fastest 802.11ac wireless
connections.
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The performance of a wireless connection can be compromised by
interference (from impeding structures, such as concrete walls, and from
household appliances, such as some wireless phones and microwave
ovens) and by distance. A wireless network can also slow down because of
interference from other wireless networks (especially in densely populated
areas). Wired networks have no such problems (as long as you keep your
cables to lengths of 25 feet or less).

Better security: A wired network doesn't broadcast a signal that can be
picked up outside your home or office, so it's more secure.

Hackers can attack through your Internet connection, though, even if
you're using a wired network. Hence the final section of this chapter, “USE
YOUR FIREWALL!"

¥ Wireless: A wireless connection really has only one advantage, but it's a big
one: convenience (which, in this case, is another word for mobility for all your
networked devices). Laptop owners crave this independence — a freedom
that desktop computer owners can only dream about.

Accessing your network anywhere within your home or office — without
cables — is so easy. Connecting a wireless printer is a breeze. And when using
an AirPort Express mobile Base Station, even your home stereo can get
connected to your MP3 collection on your MacBook. Read more about base
stations later.

GRAFTING WIRELESS ACCESS
TO A WIRED NETWORK

Maybe you're caught in the middle when trying to choose between wired and wireless
networking. Or perhaps you're already using a wired network but are thrilled by the
idea of sitting on your deck in the sunshine, checking your email on your laptop,
untethered. By combining both technologies, you can get the faster transfers of a wired
network between all the computers in your office and the freedom you crave. In fact,
your cable or DSL Internet provider may offer a combo router that provides both wired
and wireless connections.

For example, in my home office | use a wireless base station that also includes a built-in
wired switch. My family gets all the convenience a wireless network offers, and every-
one can connect to the Internet from anywhere in our house. On the other hand, my
office computers have the faster performance and tighter security of a wired network.
Sassy indeed!
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REMEMBER

It’s time to see what’s necessary to share an Internet connection. In the following
sections, I cover two methods of connecting your network to the Internet.
(And before you open your wallet, keep in mind that you might be able to use your
laptop to share your broadband connection across your network!)

Naturally, sharing an Internet connection should only be done with those devices
and computers that you trust and consider secure (typically, only the hardware
within your home network).

Using your MacBook as a sharing device

You can use your MacBook to provide a shared Internet connection across a simple
wireless network, using a broadband DSL or cable connection.

It is possible to use a High Sierra-compatible external USB dial-up modem to
share a dial-up modem Internet connection, but I would consider it only if you
have absolutely no other option. A dial-up modem connection really can’t handle
the data transfer speeds for more than one computer to access the Internet at one
time. (In plain English, an external USB modem that you add to your MacBook
isn’t fast enough for both you and your significant other to surf the web at the
same time.) Sharing a dial-up connection just isn’t practical.

Because your MacBook has built-in AirPort Extreme wireless hardware, it’s easy
to share your cable/DSL broadband connection wirelessly with other computers in
your home or office.

When your laptop is functioning as an Internet-sharing device, your MacBook
uses High Sierra’s built-in Internet-connection-sharing feature to get the job
done, but your MacBook must remain turned on to allow Internet sharing. I show you
how to do this in the later section “Network Internet connections.”

Using a dedicated Internet-sharing device

You can also choose to use a dedicated Internet-sharing device (often called an
Internet router) to connect to your cable or DSL modem. You do have to buy this
additional hardware, but here’s the advantage: Your MacBook doesn’t have to
remain turned on just so everyone can get on the Internet.

As I mentioned, Internet routers usually include either wired or wireless network
connections, and many include both.
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Setting up an Internet router is usually a simple matter, but the configuration
depends on the device manufacturer and usually involves a number of different
settings in System Preferences that vary according to the router model. Grab a diet
cola, sit down with the router’s manual, and follow the installation instructions
you find there. (In some cases, you must set up your cable or DSL modem as a
bridge between your ISP and your router, which should be covered in your modem
and router manuals as well.)

Most Internet routers offer a DHCP server, which automatically assigns Internet
protocol (IP) addresses, and I strongly recommend that you turn on this feature!
(You can read more about DHCP later in this chapter, in the sidebar “The little
abbreviation that definitely could.”)

What Do | Need to Connect?

192
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REMEMBER

Most normal folks — whom I define as those who have never met a network
system administrator, and couldn’t care less — think that connecting to a network
probably involves all sorts of arcane chants and a mystical symbol or two. In the
following sections, I provide you with the shopping list you need to set up a
network — or connect to a network that’s already running.

Wireless connections

Today’s Mac laptops come complete with built-in AirPort Extreme wireless
hardware, so if you already have an AirPort Extreme or Express Base Station,
you’re all set. Otherwise, hold on tight while I lead you through the hardware
requirements for wireless networking.

The maximum signal range — and effectiveness — of any wireless network can
be impeded by intervening walls or electrical devices, such as microwave ovens
and some wireless phones, all of which can generate interference.

Connecting a MacBook to an existing
wireless network

Connecting a MacBook to an existing wireless network requires no extra hard-
ware, because your hardware is already built in. (Whew. That was easy!)
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Using a base station to go wireless

If you decide that you want to build your own wireless network, you eschew cables,
or you want to add wireless support to your existing wired network, you need a
base station. (If you do have an existing wired network, the base station can act as
a bridge between computers using wireless hardware and your wired network,
allowing both types of computers to talk to each other.) Such a wireless base
station will have either

3 A port that can connect to your existing wired network’s switch

3 Afull built-in switch for wired connectivity (which means you can sell your old
wired Ethernet switch to your sister in Tucson)

And, of course, a base station can simply act as a central switch for your wireless
network (with no support for a wired network).

You can use either a cool Apple Base Station or a boring 802.11ac or 802.11n generic
wireless base station; however, the Apple hardware requires less configuration
and tweaking. (Sounds like a Mark’s Maxim!)

If you don’t want the hassle of tweaking PC hardware to accommodate your
MacBook, buy Apple hardware and software.™

APPLE BASE STATION MODELS

As listed in the upcoming Table 11-2, your MacBook can work with three current
Apple Base Station models for wireless networking:

3 AirPort Extreme: | recommend using AirPort Extreme if your network needs
an enhanced antenna, which provides greater range. You can read about
connectivity ranges in Table 11-2.

3 AirPort Time Capsule: Apple’s Time Capsule unit (an external wireless backup
unit) isn't just a wireless remote hard drive. It can also act as a full AirPort
Extreme Base Station. In fact, the wireless specifications for a Time Capsule
unit and an AirPort Extreme Base Station are almost identical.

3 AirPort Express: | recommend using AirPort Express if you want to

Carry your wireless base station with you. Express is much smaller than the
other Apple Base Station models. (Think “party on the patio” or a LAN
gaming get-together at a friend's house.)

Extend the range of your existing wireless network. If your network signal
fades by the pool or potting shed, consider adding an AirPort Express at
the edge of your current range to extend the reach of your wireless
network.
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Connect your home stereo or speakers for wireless music streaming using
AirPlay. You can connect a pair of speakers to your AirPort Express and use
AirPlay to play music from your MacBook's iTunes library. (Heck, you're not
limited to playing the music on your laptop. You can also stream music
from your iPhone, iPad, or iPod touch!)

Time Capsule delivers a connection that’s several times faster than the old AirPort

Base Station’s 802.11b/802.11g/802.11n standards. 802.11ac is also compatible with
rememser  all the older standards — 802.11b/a/g/n — so I highly recommend that you stick

with 802.11ac in the future. It plays well with others, and at warp speed to boot!

@ The latest 802.11ac standard used by the AirPort Extreme Base Station and AirPort

TABLE 11-2 Apple Wireless Network Base Stations
AirPort Extreme/

Feature AirPort Time Capsule AirPort Express
Price $199/$299/$399 $99
Users (maximum) 50 50
802.11ac support Yes No
802.11n support Yes Yes
802.11g support Yes Yes
802.11b support Yes Yes
LAN Ethernet jack (high-speed Internet connection) Yes Yes
WAN Ethernet jack (wired computer network) Yes Yes
Stereo mini-jack No Yes
USB printer port Yes Yes

better job of differentiating its product names. Jot down the name of your model

The names of the Apple Base Stations are irritatingly similar; Apple usually does a
on a Post-it Note on your laptop’s desktop so you don’t get confused.

WARNING
Installing an Apple Base Station is simple. Follow these steps:
1 . Ifyou have a DSL or cable modem, connect it to the WAN (wide-area
network) port on the base station with an Ethernet cable.

2. I you have an existing wired Ethernet computer network with a switch
or router, connect it to the Ethernet LAN port on the base station with an
Ethernet cable.
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3. i you have a USB printer, connect it to the USB port on the base station.

| cover the steps to sharing a printer in the later section “Sharing a network
printer.”

4. connect the power cable.
5. switchon your base station.

6. Run the installation software provided by Apple on your laptop.

USING NON-APPLE BASE STATIONS

If any company other than Apple manufactured your wireless base station, the
installation procedure is almost certainly the same. Naturally, you should take a
gander at the manufacturer’s installation guide just to make sure, but I have
added many brands of these devices, and I used the same steps for each one.

However, I should note that Apple wireless hardware uses a slightly different
security encryption standard than most PC wireless hardware. This fact creates an
extra hurdle when you connect to a non-Apple base station or access point with
your laptop. (More on this in the next section. For now, just remember that I
recommend using Apple wireless hardware with your MacBook whenever possible
because the installation process is easier!)

Joining a wireless network

As far as I'm concerned, the only two types of base stations are Apple and non-
Apple, which includes all 802.11ac, 802.11n, and 802.11g base stations and access
points. In the following two sections, I relate what you need to know to get onboard
with either type of hardware.

APPLE AIRPORT BASE STATIONS

To join a wireless network that’s served by any flavor of Apple Base Station, follow
these steps on each Mac with wireless support:

. Click the System Preferences icon in the Dock.

Click the Network icon.

From the Connection list on the left, click Wi-Fi.

Select the Show Wi-Fi Status in Menu Bar check box.

Click the Apply button.

OUVAWN=

. Press 38+Q to quit System Preferences and save your settings.
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7. Click the Wi-Fi status icon (which looks like a fan) on the Finder menu bar,
and choose an existing network connection you'd like to join.

The network name is the same as the network name you chose when you set
up your AirPort Base Station.

8. i you set up a secure network, enter the password you assigned to the
network during setup.

By the way, security is always A Good Thing. | strongly recommend that you
enable the password encryption features of your Apple Base Station while
installing it. (Luckily, the Apple Base Station setup application leads you
through this very process.) In the words of an important Mark’s Maxim:

Keep uninvited guests out of your network! Use your base station’s
security features and encrypt your data by using WPA2 encryption!™

Some wireless networks might not appear in your Wi-Fi menu list. These are
closed networks, which can be specified when you set up your AirPort Base Station.
You can’t join a closed network unless you know the exact network name (which
is far more secure than simply broadcasting the network name). To join a closed
network, follow these steps:

1 . Click the Wi-Fi status icon (which looks like a fan) on the Finder menu bar
and choose Join Other Network.

2. Type the network’s name.

3. Ifthe network is secured with WPA, WPA2, WEP, or LEAP encryption — the
security standards for protecting your data through encryption — click
the Security pop-up menu and choose which type of encryption is being
used.

| recommend avoiding WEP and LEAP encryption whenever possible. Your best
bet is WPA2 encryption, which is the current standard for home wireless
networks — always choose it when it's available.

4. Enter the network password if required.

To disconnect from a Wi-Fi network, click the Wi-Fi menu and either choose Turn
Wi-Fi Off or connect to another wireless network. In other words, if you choose
another available wireless network from the Wi-Fi menu, your MacBook
automatically drops the previous connection. (You can be connected to only one
wireless network at a time, which makes Good Sense.)

USING NON-APPLE BASE STATIONS

If you’re using your MacBook to connect to a non-Apple base station at your
office, you might need to follow a specific procedure that takes care of the slightly
different password functionality used by standard 802.11b/g/n/ac hardware.
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High Sierra can take care of many potential wireless “language barriers” caused
by security encryption. The two most common forms are WPA2 and WEP. So
whether you need to modify your password to connect to your non-Apple base
station depends on the specific hardware and encryption system it uses.

To read or print the latest version of this procedure, fire up Safari, visit http://
kbase.info.apple.com/index.html, and type HT1126 in the search field. The
article provides the details on how to convert a standard wireless encrypted
password to a format your AirPort Extreme hardware can understand.

TRANSFERRING FILES THE EASY
AIRDROP WAY

AirDrop is the local Mac-to-Mac file transfer feature built in to macOS High Sierra, and it
couldn't be easier to use. No setup and no passwords are involved! However, it comes
with three caveats:

® AirDrop works only with Macs running Lion and later, and only with specific models:
MacBook Pro (late 2008 or newer), MacBook Air (late 2010 or newer), and MacBook
(late 2010 and newer). The 17-inch MacBook Pro (late 2008) doesn't support AirDrop.

® AirDrop uses the Wi-Fi hardware built in to today’s Mac laptops and desktops, so
don't forget to turn on Wi-Fi first. (If you're displaying the Wi-Fi status icon on your
Finder menu bar, click the icon and choose Turn Wi-Fi On.)

® You have to be within Wi-Fi signal range of another Mac to use AirDrop. Note, how-
ever, that the two computers don't have to be using the same Wi-Fi network. (For
example, my iMac uses a wired connection to my network, but because the iMac
has internal Wi-Fi hardware, | can use AirDrop to send files to my MacBook Air.)
Because AirDrop uses a Wi-Fi connection, file transfers are significantly slower (and
less secure) than they would be over a wired Ethernet network.

To use AirDrop to transfer files to another Mac, both users should click the AirDrop icon
in any Finder window sidebar to join the AirDrop group. After a short delay, you see the
account pictures for all Macs within signal range and with AirDrop open. Just drag the
files you want to transfer to the person’s picture. Both you and the recipient are
prompted for confirmation before the transfer begins. After the transfer is complete,
the files you sent are saved in the recipient's Downloads folder.

When you're done using AirDrop, just close the Finder window displaying the account
pictures (or click another location in the Finder window sidebar) to exit the AirDrop
group. (Don't forget that you have to reopen AirDrop if someone wants to send you
files. | leave my AirDrop Finder window open and minimized to the Dock.)
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Wired connections

If you own a current MacBook model, your machine doesn’t come from Apple with
a wired Ethernet port onboard. But you can add a Thunderbolt or USB-to-Ethernet
connector that allows you to use a wired network. After you add the connector to
your system, you can follow along without any problem. You just connect the
hardware and configure the connection. Don’t forget that you also need cables and
an inexpensive Ethernet switch. (If you’re using an Internet router or other hard-
ware sharing device, it almost certainly has a built-in four- or eight-port switch.)

Making a connection to a wired network

On older MacBooks, your Ethernet 10/100/1000 port (which looks like a slightly
oversized telephone/modem jack) is located on one side of your laptop. It’s ready
to accept a standard Ethernet Cat5/Cat5E/Cat6 cable with RJ-45 connectors. (If
you’ve connected a Thunderbolt- or USB-to-Gigabit-Ethernet adapter to your
MacBook, you’re also in business.)

If you’re connecting to an existing wired network, you need a standard Cats/
Cat5E/Cat6 Ethernet cable of the necessary length. I recommend a length of no
more than 25 feet, because longer cables are often subject to line interference
(which can slow or even cripple your connection). You also need a live Ethernet
port from the network near your laptop. Plug the cable into your MacBook, and
then plug the other end into the network port.

Wired network hardware

If you don’t know your switch from your NIC, don’t worry. Here I describe the
hardware you need for your wired network.

WIRED NETWORK COMPONENTS

If you’re building your own wired network, you need

¥ A switch: This gizmo's job is to provide more network ports for the other
computers in your network. Switches typically come in four- and eight-port
configurations.

As mentioned earlier in this chapter, most Internet routers (sometimes called
Internet-sharing devices) include a built-in switch. So if you've already invested
in an Internet router, make doggone sure it doesn’'t come equipped with the

ports you need before you go shopping for a switch.

PART 3 Connecting and Communicating



TIP

3 A number of Ethernet cables: Exactly how many cables you need is
determined by how many computers and other devices (such as a network
printer) you're connecting. If you're working with a Gigabit Ethernet system,
you need Cat5E or Cat6 cables. Cat6 cables provide better performance but
are more expensive.

Naturally, if you’re using a broadband Internet connection, you also have a DSL or
cable modem. These boxes always include a port for connecting to your wired
Ethernet network. If you have one of the new breed of wireless modems — which
acts as a wireless base station — don’t panic. It should also have a wired port for
connecting to your existing switch.

WIRED NETWORK CONNECTIONS

After you assemble your cables and your router or switch, connect the Ethernet
cables from each of your computers to the router or switch, and then turn on the
device. (Most need AC power to work.) Check the manual that comes with your
device to make sure that the lights you’re seeing on the front indicate normal
operation. (Colors vary by manufacturer, but green is usually A Good Color.)

Next, connect your cable or DSL modem’s Ethernet port to the WAN port on your
switch with an Ethernet cable. If your modem isn’t already on, turn it on now, and
check for normal operation.

When your router or switch is powered on and operating normally, you’re ready
to configure macOS for network operation. Just hop to the upcoming section
“Connecting to the Network.” (How about that? Now you can add network
technician to your rapidly growing computer résumé!)

Joining a wired Ethernet network

After all the cables are connected and your central connection gizmo is plugged in
and turned on, you’ve essentially created the hardware portion of your network.
Congratulations! Now you need a beard and suspenders (the common equipment
for the network guru stereotype).

With the hardware in place, it’s time to configure High Sierra. In this section,
I assume you’re connecting to a network with an Internet router or switch that
includes a DHCP server. (Jump to the later sidebar “The little abbreviation that
definitely could” for more on DHCP.)
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Follow these steps on each Mac running macOS that you want to connect to the
network:

1. click the System Preferences icon in the Dock.

2. Click the Network icon.

3. From the Connection list on the left, choose Ethernet.

The entry may also be named Ethernet 1, depending on the Mac model you're
configuring. (Make sure you select the Ethernet entry that does not carry the
Wi-Fi fan symbol.)

4. Click the Configure IPv4 pop-up menu and choose Using DHCP, as shown
in Figure 11-1.

[ X J < W Network Q
Location: | Automatic | <]
Ethernet PN
° Carmacind N7 Status: Connected
Etnemnet is currently active and has the IR
@ Bluetooth PAN address 192.168.0.104
Not Connected
Wi-Fi —
® Off = Configure 1Pv4 ’

Using DHCP with manual address

IP Address Using BootP
Subnet Mask  Manually
Routel off

DNS Server  Create PPPoE Service...

Search Domains:

FIGURE 11-1: Advanced... ?
+ [ — ~
All hail DHCP, *
the magic
networking fairy!

5. clickthe Apply button.

The Apply button is grayed out in the figure because my status (in this dialog) is
Connected.

Enjoy the automatic goodness as macOS connects to the DHCP server to
obtain an IP address, a subnet mask, a gateway router IP address, and a

OAD,
6 Domain Name System (DNS) address. (Without a DHCP server, you'd have to
TECHNICAL add all this stuff manually. Ugh.)
STUFF

A few seconds after clicking the Apply button, you should see the information.
You might also notice that the DNS Server and Search Domains fields are empty.
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Fear not. macOS is really using DNS server and domain information provided by
the DHCP server.

6. Press $8+Q to quit System Preferences and save your settings.

You're on!

Connecting to the Network

All right! The hardware is powered up, the cables (if any) are installed and
connected, and you have configured High Sierra. You’re ready to start (or join) the
party. In the following sections, I show you how to verify that you’re connected,
as well as how to share data and devices with others on your network.

THE LITTLE ABBREVIATION THAT
DEFINITELY COULD

You know, some technologies are just peachy. (So much for my tiber-tech image.)
Anyway, these well-designed technologies work instantly, you don't have to fling settings
around like wrapping paper on Christmas day, and every computer can use them: Mac,
Windows, Linux, and even the laptops used by funny-looking creatures from Roswell,
New Mexico.

Dynamic Host Configuration Protocol, or DHCP for short, is about as peachy as it gets. This
protocol enables a computer to automatically get all the technical information neces-
sary to join a network. Let me hear you say, “Oh yeah!" Virtually all network devices can
use DHCP these days, including Internet routers, switches, and (go figure) macOS.
Today's networking hardware and operating systems provide a DHCP server, which flings
the proper settings at every computer on the network all by itself. Your MacBook just
accepts the settings and relaxes in a placid networking nirvana.

In this book, you can bet the farm that | assume you want to use DHCP and that your
network hardware supports it (which is a virtual certainty with today’s hardware). That
way, | won't spend 30 pages leading you through the twisting alleyways of manual
network settings.

If you're connecting to an existing network, tell the network administrator you're taking
the easy route and using DHCP. A warning, however: Adding more than one DHCP
server on a single network will cause a civil war, and your system will lock up tight.
Therefore, before adding hardware with a DHCP server to an existing network, ask your
network administrator to ensure that you aren’'t making a mistake.
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Verifying that the contraption works

After you have at least two computers on a wired or wireless network, test whether
they’re talking to each other over the network by pinging them. (No, I didn’t make
up the term. Honest.) Essentially, pinging another computer is like yelling “Are
you there?” across a crevasse.

To ping another computer on the same network from any Mac running High
Sierra, follow these steps:

1. click the Spotlight search icon in the Finder menu bar and type Network
Utility in the Spotlight search box.

2. Click the Network Utility entry in the Spotlight list to launch the
application.

3. Clickthe Ping tab, as shown in Figure 11-2.

[ X N ] Network Utility

Info  Netstat Lookup  Traceroute Whois Finger  Port Scan

Enter the network address to ping.

_ fex. 10.0.2.1 or www.example.com)

Send an unlimited number of pings
' Sendonly 5 pings

Ping has started..

PING 192.168.0.1082 (192.168.8.102): 56 data bytes

64 bytes from 192.168.9.182: icmp_seg=0 tt1l=128 time=08.731 ms
64 bytes from 192.168.8.182: icmp_seq=1 tt1=128 time=8.475 ms
64 bytes from 192.168.9.182: icmp_seg=2 tt1=128 time=08.674 ms
64 bytes from 192.168.9.182: icmp_seg=3 tt1=128 time=08.712 ms
64 bytes from 192.168.8.182: icmp_seg=4 tt1=128 time=8.691 ms

-—— 192.168.9.182 ping statistics —-

5 packets transmitted, 5 packets received, @.0% packet loss
FIGURE 11-2: round-trip min/ava/max/stddev = @.475/8.657/0.731/08.893 ms

Look, Ma, I'm
pinging!

4. Inthe Enter the Network Address to Ping text field, enter the IP address
of the computer you want to ping:

If you're pinging another Mac running macQOS, you can get that machine’s IP
address by simply displaying its Network pane in System Preferences,

which always displays the IP address.
REMEMBER

If you're trying to ping a PC running Windows, and you don't know that
machine’s IP address, follow these steps:

1. Click Start and right-click Network (under Windows 7) and then choose Properties.
Under Windows 8, 8.1, or 10, display the Control Panel and then click Network
and Sharing Center.
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2. Click Change Adapter Settings, then right-click your Local Area Network
connection icon and choose Status from the menu that appears.

3. Click the Details button.

The IP address of that computer is proudly displayed.

n

Select the Send Only x Pings radio button, and enter 5 in the text field.
6. Cclick the Ping button:

Yay!: If everything is working, you should see results similar to those shown
in Figure 11-2, in which I'm pinging my Windows server at IP address
192.168.0.102 across my wired Ethernet network.

The addresses 192.168.0.xxx and 192.168.1.xxx are a common series of
local network IP addresses provided by Internet routers, hubs, and
switches with DHCP servers, so don't freak if you have the same local IP
address. Similarly, Apple tends to use the form 10.0.1.xxx for local
networks.

Nay: If you don't get a successful ping, check your cable connections, power
cords, and macOS settings. If you're using a wireless connection, you might
have to move closer to the network base station to connect successfully,
especially through walls.

Sharing stuff nicely with others

It works! By golly, it works! Okay, now what do you do with your all-new shiny
chrome network connection? Ah, my friend, let me be the first to congratulate you
and the first to show you around! In the following sections, I cover the most
popular network perks. (The good news is that these perks work with both wired
and wireless connections.)

Network Internet connections

If your DSL or cable modem plugs directly into your MacBook (rather than into a
dedicated Internet-sharing device or Internet router), you might ponder just how
the other computers on your network can share that spiffy high-speed broadband
connection. If you’re running a wireless network, it comes to the rescue!

Follow these steps to share your connection wirelessly:

1. click the System Preferences icon in the Dock.
2. Clickthe Sharing icon.

3. Click the Internet Sharing entry in the Services list to the left of the pane.
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REMEMBER

4. From the Share Your Connection From pop-up menu, choose Ethernet.
5. Select the Wi-Fi check box (in the To Computers Using list).

6. select the On check box next to the Internet Sharing entry in the
Services list.

High Sierra displays a warning dialog stating that connection sharing could
affect other computers on your network. If you intend to share the Internet
connection provided on an existing network at your home or office that you
didn't set up, contact your network administrator first! (It's best to avoid sowing
chaos and disorder.)

7. click Startin the warning dialog to continue.

8. Click the Close button to exit System Preferences.

Sharing an Internet connection (without an Internet router or dedicated hardware
device) through macOS requires your computer to remain on continuously.
Remind others in your office or home that the svelte laptop must remain on, or
they’ll lose their Internet connection! Naturally, when you take off on your next
trip with your road warrior, the folks left at your home or office will be without an
Internet connection until you return.

Don’t forget, you don’t need to configure Internet sharing if your DSL or cable
modem connects to a dedicated sharing device or router. That snazzy equipment
automatically connects your entire network to the Internet.

Network file sharing

You can swap all sorts of interesting files with other Macintosh computers on your
network. When you turn on file sharing, High Sierra allows all Macs on the network
to connect to your MacBook and share the files in your Public folder. (Note that
sharing across a network is different from sharing a single computer between
several people. I cover that environment in Chapter 10.)

Follow these steps to start sharing files and folders with others across your
network:

1. click the System Preferences icon in the Dock.

2. Click the Sharing icon.

3. Select the On check box next to the File Sharing service entry to enable
the connections for Mac and Windows sharing.

Other Mac users can connect to your computer by clicking Go in the Finder
menu and choosing the Network menu item. The Network window appears,
and your laptop is among the choices. If the other Macs are running High
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Sierra, your MacBook's shared files and folders appear in a Finder window, and
they're listed under the Shared heading in the sidebar.

Windows 7 users can use the Network window. Windows 8, 8.1, and 10 users
should head to the Network panel. Those lucky Windows folks also get to print
to any shared printers you've set up. (The following section covers shared
printers.)

4. Click the Close button to exit System Preferences.

High Sierra conveniently reminds you of the network name for your MacBook
at the top of the Sharing pane.

Sharing a network printer

I love describing easy procedures, and sharing a printer on a Mac network ranks
high on the list! You can share a printer that’s connected to your laptop (or your
AirPort Extreme, AirPort Time Capsule, or AirPort Express Base Station) by
following these simple steps:

1. click the System Preferences icon in the Dock.

. Click the Sharing icon.

Select the On check box next to the Printer Sharing service entry.

From the list at the right of the System Preferences window, select the
check box next to the printer you want to share.

i AWN

Click the Close button to exit System Preferences.

A printer you share automatically appears in the Print dialog on other
computers connected to your network.

USE YOUR FIREWALL!

MARK'S
MAXIMS

Yep. That’s the only heading in this entire book that’s all uppercase. It’s that
important.

The following Mark’s Maxim, good reader, isn’t a request, a strong recommenda-
tion, or even a regular Maxim. Consider it an absolute command (right up there
with Pay your taxes).

Turn on your firewall now.™

When you connect a network to the Internet, you open a door to the outside world.
As a consultant to several businesses and organizations in my hometown, I can
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tell you that the outside world is chock-full of malicious individuals who dearly
love to inflict damage on data and would like to take control of your MacBook for
their own purposes. Call ’em hackers, call ’em delinquents, or call ’em something
I can’t repeat, but don’t let them in!

High Sierra comes to the rescue again with the built-in firewall in macOS. When
you use the firewall, you essentially build a virtual “brick wall” between you and
the hackers out there (both on the Internet and within your local network). Follow
these steps:

1. click the System Preferences icon in the Dock.

2. Click the Security & Privacy icon.

3. Click the Firewall tab.

4. Click the Turn On Firewall button to activate your firewall.
5. Click the Firewall Options button.

6. select the Automatically Allow Built-In Software to Receive Incoming
Connections check box.

7. select the Automatically Allow Downloaded Signed Software to Receive
Incoming Connections check box.

8. Select the Enable Stealth Mode check box.

This important feature prevents hackers from trolling for your MacBook on the
Internet — or, in normal-speak, searching for an unprotected computer — so
it's much harder for them to attack you. (Stealth mode also prevents other
computers from pinging you, so don't be surprised if your MacBook suddenly
clams up if you try to ping it.)

9. click OK.
10. click the Close button to exit System Preferences.

High Sierra even keeps track of the Internet traffic that you do want to reach your
laptop, such as web page requests and file sharing. When you activate one of the
network features described in the section “Sharing stuff nicely with others,” High
Sierra automatically opens a tiny hole (called a port by net types) in your firewall
to allow just that type of communication with your Mac.

For example, if you decide to turn on printer sharing (as described in the preced-
ing section), High Sierra automatically allows incoming print jobs over the net-
work from other computers.
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You can also add ports for applications that aren’t on the firewall’s Allow list, such
as third-party instant messaging clients and multiplayer game servers. Depending
on the type of connection, High Sierra often displays a dialog prompting you for
confirmation before allowing certain traffic, so you probably won’t need to do
anything manually.

However, you can manually add a program to your list of allowed (or blocked)
firewall ports. Follow these steps:
1. click the System Preferences icon in the Dock.
2. Click the Security & Privacy icon.
3. Click the Firewall tab and then click the Firewall Options button.
4. Click the Add button (which carries a plus sign).
High Sierra displays a standard file-browsing sheet.

5. Browseto the application that requires access to the outside world — or
the application that you want to block from outside communication —
and click it to select it.

6. Click the Add button in the File sheet.

The application appears in the Firewall list. By default, it's set to Allow Incoming
Connections.

7. If you want to block any communications coming into the application,
click the Allow Incoming Connections pop-up menu and choose Block
Incoming Connections instead.

8. Click the Close button to exit System Preferences.
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Living the iLife



IN THIS PART ...

Build the digital media library of your dreams with
iTunes.

Create slideshows and photo books with Photos.
Put your moviemaking talents to work with iMovie.

Use GarageBand to compose and record your own
music.



IN THIS CHAPTER

» Playing music with your MacBook

» Arranging and organizing your music
collection

» Tuning into the world with Internet
radio

» Sharing your songs across a network
» Creating eye candy with Visualizer

» Buying the good stuff from the iTunes
Store

Chapter 12

The Multimedia Joy
of iTunes

ometimes, words just aren’t enough. iTunes is that kind of perfection.

To envision how iTunes changes your laptop, you have to paint the picture with
music — music that’s easy to play, search for, and transfer from device to device.
Whether it be classical, alternative, jazz, rock, hip-hop, or folk, I guarantee you
won’t find a better application than iTunes to fill your life with music. And pod-
casts. And video. And TV shows. And online education. And ringtones. And Inter-
net radio. (See how hard it is to pin down this wonderful application? Along with
your MacBook, iTunes really does form the hub of your digital lifestyle.)

In this chapter, I lead you through all the features of my absolute favorite Apple

application. (It will be pretty doggone obvious how much I appreciate this piece of
software.)

CHAPTER 12 The Multimedia Joy of iTunes 211



What Can | Play on iTunes?

Simply put, iTunes is a media player that plays audio and video files. These files
can be in any of many different formats. iTunes supports these common audio
formats:

3 MP3: The small size of MP3 files has made them popular for file trading on
the Internet. You can reduce MP3 files to a ridiculously small size (albeit at the
expense of audio fidelity), but a typical CD-quality, three-minute pop song in
MP3 format has a size of 3-5MB.

3 AAC: Advanced Audio Coding is an audio format that's similar to MP3, but offers
offer better recording quality at the same file sizes. However, this format is
somewhat less compatible with non-Apple music players and software. (Luckily,
you can still burn AAC tracks to an audio CD, just as you can MP3 tracks.) The
tracks that you download from the iTunes Store are in AAC format, and AAC
music files are becoming more popular for downloading on the Internet.

3 Apple Lossless: Another format direct from Apple, Apple Lossless format (also
known as ALAC) provides the best compromise between file size and sound
quality. These tracks are encoded without loss of quality, although Apple
Lossless tracks are somewhat larger than AAC. This format is generally the
favorite of discerning audiophiles.

3 AIFF: This standard Macintosh audio format produces sound of the absolute
highest quality. This high quality, however, also means that the files are pretty
doggone huge. AIFF recordings typically require about 10MB per minute of audio.

3 WAV: Not to be outdone, Microsoft created its own audio file format (WAV)
that works much like AIFF. It can reproduce sound at a higher quality than
MP3, but the file sizes are very large, similar in size to AIFF files.

3 CD audio: iTunes can play audio CDs. Because you don't usually store CD
audio anywhere but on an audio CD, file size is no big whoop — but again,
10MB of space per minute of music is a good approximation.

3 MP2: A close cousin of the far more popular MP3 format, MP2 is the preferred
format in radio broadcasting and is a standard audio format for HDV camcorders.
It produces file sizes similar to MP3 format.

¥ Movies and video: You can buy and download (or rent and stream) full-length
movies, TV shows, music videos, and movie trailers from the iTunes Store. .. . and,
with an Apple TV unit connected to your home theater system, you can watch
those movies and videos from the comfort of your sofa on the other side of
your living room (or even from your bedroom on the other side of your house).

¥ Podcasts: These audio downloads (typically in MP3 format) are like radio
programs for your iOS devices, but iTunes can play and organize them, too.
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Some podcasts include video and photos to boot. You can download podcasts
from the iTunes Store, and most are free.

¥ iTunes U: iTunes offers educational materials (think slideshows, presenta-
tions, and class recordings) from a wide variety of colleges and technical
institutions — and virtually all free for the download.

3 Audiobooks: You no longer need cassettes or audio CDs to enjoy your
spoken books. iTunes can play them for you, or you can send them to your
iOS device for listening on the go.

¥ Streaming Internet radio: You can listen to a continuous broadcast of songs
from one of tens of thousands of Internet radio stations, with quality levels
ranging from what you'd expect from FM radio to the full quality of an audio
CD. You can't save the music in iTunes, but streaming radio is still great fun.
(I run my own station . . . more on MLC Radio later in this chapter.) Unlike
services like Spotify, Pandora, and Apple Music, these streaming radio stations
are free and don't require a subscription!

Playing an Audio CD

FIGURE 12-1:

The main
playback controls:
Play, Previous,
and Next.

If you have an optical drive (either internal or external), playing an audio CD in
iTunes is simple. Just insert the CD in the drive, start iTunes by clicking its icon
on the Dock, and click the Play button. (Note that your MacBook might be set to
automatically launch iTunes when you insert an audio CD.) The iTunes interface
resembles that of a traditional CD player. The main playback controls of iTunes
are Play, Previous, Next, and the Volume slider, as shown in Figure 12-1.

Previous  Next Speaker Selector
Play Volume
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< 1 Music <
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TABLE 121

Click the Play button to begin listening to a song. While a song is playing, the Play
button toggles to a Pause button. As you might imagine, clicking that button again
pauses the music. If you don’t feel like messing around with a mouse or trackpad,
you can always use the keyboard. The spacebar acts as the Play and Pause buttons.
Press the spacebar to begin playback; press it again to stop.

Click the Next button to advance to the next song on the CD. The Previous button
works like the Next button but with a slight twist: If a song is currently playing
and you click the Previous button, iTunes first returns to the beginning of the
current song (just like an audio CD player). To advance to the previous song,
double-click the Previous button. To change the volume of your music, click and
drag the volume slider.

As with other Mac applications, you can control much of iTunes with the keyboard.
Table 12-1 lists some of the more common iTunes keyboard shortcuts.

Common iTunes Keyboard Shortcuts

Press This Key or Key

Combination

To Do This

Spacebar Play the currently selected song if iTunes is idle.

Spacebar Pause a playing song.

- Advance to the next song.

«— Go back to the beginning of a song. Press a second time to return to the
previous song.

38+T Increase the volume of the music.

3+l Decrease the volume of the music.

$8+Option+l Mute the audio if any is playing. Press again to play the audio.

Playing Digital Audio Files

In addition to playing audio CDs, iTunes can play the digital audio files that you
download from the Internet or obtain from other sources in the WAV, AAC, Apple
Lossless, AIFF, MP2, and MP3 file formats.

Enjoying a digital audio file is just slightly more complicated than playing a
CD. After downloading or saving your audio files to your laptop, open Finder and
navigate to wherever you stored the files. Launch iTunes and click on the Music
entry from the Media Type dropdown list at the upper left (or press 38+1), then
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click on the Songs entry in the sidebar. (If the sidebar doesn’t appear in your
iTunes window, choose View = Show Sidebar.) Now you can simply drag the music
files (or an entire folder of music) from the Finder window to the list of your songs
at the right side of the window. The added files appear in the Music section of your
iTunes Library. You can also drag a song file from a Finder window and drop it on
the iTunes icon on the Dock, which adds it to your Music Library as well.

The iTunes sidebar is a convenient beast indeed. You can drop the music file(s) on

@ top of a playlist name in the list and iTunes adds it to that particular playlist as well
as the main Library. (More about playlists in a bit.) If you drop a folder of songs

TIP on top of the Playlists header in the sidebar, iTunes creates a new playlist using
the name of the folder and adds all the songs in the folder to the new playlist. Bam!

You can customize the iTunes sidebar to display only those media types and music

@ classes that you prefer. (For example, I like my Internet Radio media type and the

Composers class visible.) To edit the entries in the sidebar, hover your pointer

TIP over the “Library” label at the very top of the sidebar and click the Edit link that
appears, then enable or disable the check boxes next to each heading as desired.

Think of the Library as a master list of your audio and video media. To view the
Music Library, select the Music entry from the Media Type dropdown list under
the Play, Previous, and Next controls, and click the Songs entry in the sidebar, as
shown in Figure 12-2. (Go figure.) In a similar manner, you can view your movies
and TV shows by choosing those types from the Media Type dropdown list. (In
classic Apple style, you can also switch your media type from the View menu, or
by pressing 38+1 through $8+5 from the keyboard. Since our current focus is on
music, I'll discuss playing video in more depth later in this section.
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To play a song, just double-click it in the Music list. Alternatively, you can use the
playback controls (Play, Previous, and Next) that I discuss earlier in this chapter
(refer to Figure 12-1).

@ The iTunes window can play media from a surprising number of possible sources:

REMEMBER »

»

»

»

»

»

»

»

Library: The Media Type dropdown list at the upper-left corner of the screen
can display Music, Movies, TV Shows, Podcasts, and Audiobooks.

Store: | discuss this music source in the final section “Buying Digital Media the
Apple Way.”

Shared: If another Mac or PC on your local network is running iTunes and is
set to share part or all of its library, you can connect to the other computer for
your music.

Devices: If an iPod is connected, it appears in the sidebar and on the toolbar
next to the Media Type dropdown list. (And yes, Virginia, other models of MP3
players from other companies also appear in the list if they are supported in
iTunes.) If you connect an iPhone or iPad to your Mag, it shows up here

as well.

Genius: Click File > New > Genius Playlist from the iTunes menu to allow
iTunes to automatically create playlists from songs in your iTunes Music
Library. You can also allow Genius to recommend music, movies, and TV
shows based on the titles you already have in your iTunes Library. (More on
this feature later in the chapter.)

Audio CD: A standard audio CD ... anything from the Byrds to Justin
Timberlake shows up in as an icon if you load the CD into your optical drive.

Home Sharing: You can turn on Home Sharing to share your Mac's media
library across your wireless network with up to five other Mac computers, as
well as iPhones, iPads, and the iPod touch. (More on Home Sharing later in
this chapter.)

Playlists: Think of playlists as folders you use to organize your music. (More
on playlists later in this chapter.)

If you’ve invested in an Apple TV, it appears in the list as well, allowing iTunes to
share media with your Apple TV, which in turn sends it to your HD-TV.

TIP

You can browse your Music Library in a number of ways: first, click the Media
Type dropdown list and choose the Music entry to display your music. By default,
the application sorts by Songs (active in Figure 12-2), but you can choose
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TIP

View= Sort By from the iTunes menu to sort by a number of different criteria
(including Album, Artist, Genre and Time).

If you’re using the Songs view mode, the Music Library may display information
for each song that you add to it, including these items:

3 Name: The title of the song
¥ Time: The length of the song
¥ Artist: The artist who performs the song

3 Album: The album on which the song appears

If any song you’re adding doesn’t display anything for the title, album, or artist
information, don’t panic; most MP3 files have embedded data that iTunes can
read. If a song doesn’t include any data, you can always add the information to
these fields manually. I show you how later, in the section “Setting or changing
the song information manually.”

If you’d rather eschew the iTunes menu, it’s easy to change your sort order by
clicking any column heading in the Music Library list — iTunes will reorder the
Library list according to that category. For example, clicking the Artist column
heading alphabetizes your Library by artist name. I often click the Time heading
to sort my Library according to the length of the songs. Oh, and you can drag
column titles to reorder them any way you like (except for the check box column
at the far left, which remains fixed).

While listening to your music, you can always display the tracks that iTunes will
play next — and even change their order. (Believe me, this is great fun for us
amateur party DJs.) Click View=> Show Up Next to display the list, and drag selected
songs to the perfect order! (You can also click the button with the list icon that
appears on the toolbar.)

Browsing the Library

After you add a few dozen songs to iTunes, viewing the Library can become a task.
Although a master list is nice for some purposes, it becomes as cumbersome as an
elephant in a subway tunnel if the list is very long. To help out, iTunes can display
your Library in another format, too: namely, browsing mode. To view the Library
in browsing mode, click View= Column Browser= Show Column Browser.
(Keyboard mavens can simply press the 38+B keyboard shortcut to switch to
browsing mode.)
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WILL | TRASH MY COUNT BASIE?

Novice iTunes users, take note: iTunes watches your back when you trash tracks.

To illustrate: Suppose you delete a song from the Library that's located only in the
iTunes music folder (which you didn’t copy into iTunes from another location on your
hard drive). That means you're about to delete the song entirely, and there'll be no copy
remaining on your MacBook. Rest assured, though, that iTunes prompts you to make
sure you really want to move the file to the Trash. (I get fearful email messages all the
time from readers who are loath to delete anything from iTunes because they're afraid
they'll trash their digital music files completely.)

Remember: If you delete a song from the Library that also exists elsewhere on your
hard drive (outside the reach of the iTunes music folder), it isn't deleted from your hard
drive. If you mistakenly remove a song that you meant to keep, just drag it back into
iTunes from Finder, or even from the Trash. 'Nuff said.

The Browse mode of iTunes displays your library in a compact fashion, organizing
your tunes into up to five sections:

¥ Genres
¥ Artists
» Albums
¥ Composers

¥ Groupings

Selecting an artist from the Artist list in Browse mode causes iTunes to display that
artist’s albums in the Album list. Select an album from the Album list, and iTunes
displays that album’s songs in the bottom section of the Browse window. (Those
Apple software designers . . . always thinking of you and me.) You can also specify
which sections you want included in Browse mode from the View <> Column Browser
menu — click a section name to toggle the display of that section on or off.

Finding songs in your Music Library

After your collection of audio files grows large, you might have trouble locating that
Swedish remix version of “I’'m Your Boogie Man.” To help you out, iTunes has a
built-in Search function. To find a song, type some text into the Search box at the top
right corner of the iTunes window. While you type, iTunes tries to find a selection
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that matches your search text. The search is thorough, showing any matching text
from the artist, album, song title, and genre fields in the results. For example, if you
type Electronic into the field, iTunes might return results for the band named
Electronic or other tunes that you classified as electronic in the Genre field. (The section
“Know Your Songs,” later in this chapter, tells you how to classify your songs by
genre, among other options.) Click the magnifying glass at the left side of the Search
field to restrict the search even more: by Artists, Albums, Composers, and Songs.

Removing old music from the Library

After you spend some time playing songs with iTunes, you might decide that you
didn’t really want to add 40 versions of “Louie Louie” to your Library. (I prefer
either the original or the cast from the movie Animal House.) To remove a song
from the Library, click the song to select it and press the Delete key on your
keyboard, or right-click the song entry and choose Delete from the menu.

You can also remove a song from the Library by dragging it to the Trash on the
Dock.

TIP

Watching Video

Watching video in iTunes is similar to listening to your music. To view your video
collection, click the Media Type dropdown list at the upper left of the iTunes
window and choose Movies or TV Shows. Music videos appear as a Smart Playlist
within the iTunes sidebar. (Read more about these in the section, “Some playlists
are smarter than others.”)

From your collection, you can do the following:

3 Double-click a video thumbnail or an entry in the list.

¥ Drag a QuickTime-compatible video clip from the Finder window to the
iTunes window. (These clips typically include video files ending in .mov,
.mv4, or .mp4.)

iTunes plays video in the box below the Source list, within the iTunes window or
in full-screen mode, depending on the settings you choose from the View=> Video
Playback menu. In full-screen mode, move your pointer to display a control strip
at the bottom of the screen, sporting the standard slider bar that you can drag to
move through the video (as well as a volume control and Fast Forward/Reverse
buttons). You can also pause the video by clicking the Pause button.
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Keeping Slim Whitman and Slim Shady
Apart: Organizing with Playlists

220

As I mention earlier, the iTunes Music Library can quickly become a fearsomely
huge beastie. Each Library can contain thousands upon thousands of songs: If
your Library grows anywhere near that large, finding all the songs in your lifelong
collection of Paul Simon albums is not a fun task. Furthermore, with the Library,
you’re stuck playing songs in the order that iTunes lists them.

To help you organize your music into groups, use the iTunes playlist feature.
Typically, a playlist is a collection of some of your favorite songs from the Library,
but playlists can also include media like movies and audiobooks. You can create as
many playlists as you want, and each playlist can contain any number of items.
Whereas the Music Library lists all available songs, a playlist displays only the
items that you add to it. Further, any changes you make to a playlist affect only
that playlist, leaving the Library untouched.

To create a playlist, you can do any of the following:

3 Choose File > New > Playlist.
3 Press 38+N.

¥ Choose File=> New > Playlist from Selection. This creates a new playlist and
automatically adds any tracks that are currently selected.

¥ Choose File > New > Genius Playlist. iTunes builds a playlist of songs that
are similar in some way (typically by matching the genre of the selection or the
beats per minute, but also based on recommendations from other iTunes
members). Note that your MacBook needs an Internet connection to create a
Genius playlist, and the larger your music library, the longer it takes iTunes to
build your playlist. You also need to turn on the Genius feature by clicking
File & Library = Turn on Genius and entering your Apple ID. (Note that
Genius playlists can sometimes mix tracks containing explicit content with less
objectionable material — especially in the comedy and rap genres.)

3 Drag a folder containing audio files from a Finder window onto the
Playlists heading in the sidebar.

To help organize your playlists, it’s a good idea to . . . well, name them. (Aren’t you
glad now that you have this book?) For example, suppose that you want to plan a
party for your polka-loving friends. Instead of running to your computer after each
song to change the music, you could create a polka-only playlist. Select and start the
playlist at the beginning of the party, and you won’t have to worry about changing
the music the whole night. (You can concentrate on playing the accordion.) To load
a playlist, select it in the sidebar list; iTunes displays the songs for that playlist.
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REMEMBER

The same items can appear in any number of playlists because the items in a
playlist are simply pointers to the media in your Music Library — not the actual
songs, movies, or TV shows themselves. Add and remove them at will to or from
any playlist, secure in the knowledge that the items remain safe in your Library.
Removing a playlist is simple: Select the playlist in the sidebar, and press Delete.

Removing a playlist does not delete any songs from your Library.

SOME PLAYLISTS ARE SMARTER
THAN OTHERS

You can create a Smart Playlist in the iTunes sidebar by choosing File > New Smart
Playlist, or by pressing Option+38+N.

The contents of a Smart Playlist are automatically created from a specific condition or
set of conditions that you set via the Smart Playlist dialog: You can limit the track selec-
tion by mundane things, such as album, genre, or artist; or you can get funky and spec-
ify songs that were played last, or by the date you added tracks, or even by the sampling
rate or total length of the song. For example, iTunes can create a playlist packed with
songs that are shorter than three minutes, so you can fill your iPod Shuffle with more
stuff! If you want to add another criterion, click the plus sign at the right side of the
dialog and you get another condition field to refine your selection even further. Smart
Playlists can even contain TV shows, movies, podcasts, and audiobooks.

You can choose the maximum songs to add to the Smart Playlist, or limit the size of the
playlist by the minutes or hours of play or the number of megabytes or gigabytes the
playlist will occupy. (Again, this is great for automatically gathering as much from your
KISS collection as will fit into a specific amount of space on a CD or your iPod.) Mark the
Live Updating check box for the ultimate in convenience. iTunes automatically main-
tains the contents of the Smart Playlist to keep it current with your conditions at all
times in the future. (If you remove tracks manually from a Smart Playlist, iTunes adds
other tracks that match your conditions.)

Now think about what all these settings mean when combined . . . whoa. Here's an exam-
ple yanked directly from my own iTunes library. | created a Smart Playlist that selects
only those songs in the Rock genre. It's limited to 25 songs, selected by least often
played, and live updating is turned on. The playlist is named Tracks I've Gotta Hear
because it finds the 25 rock songs (from my collection of more than 10,000 songs) that
I've heard least often! After | listen to a song from this Smart Playlist, iTunes automatically
“freshens” it with another song, allowing me to catch up on the tracks I've been ignoring.

CHAPTER 12 The Multimedia Joy of iTunes 221



Know Your Songs

222

Besides organizing your music into Elvis and non-Elvis playlists, iTunes gives you
the option to track your music at the song level. Each song you add to the Music
Library has a complete set of information associated with it. iTunes displays this
information (see upcoming Figure 12-3) on the Details tab:

3 Song Name: The name of the song
¥ Artist: The name of the artist who performed the song

3 Album Artist: The name of the artist responsible for a compilation or tribute
album

3 Album: The album where the song appears

3 Grouping: A group type that you assign

3 Composer: The name of the astute individual who wrote the song
3 Comments: A text field that can contain any comments on the song
¥ Year: The year the artist recorded the song

¥ Track: The position of the song on the original album

¥ Genre: The classification of the song (such as rock, jazz, or pop)

3 Disc Number: The original disc number in a multi-CD set

3 BPM: The beats per minute (indicates the song's tempo)

You can display this information by clicking a song name and pressing 38+1. The
fields appear on the Details tab.

Setting the song information automatically

Each song you add to the iTunes Music Library might have song information
included with it. If you add music from a commercial audio CD, iTunes connects
to a server on the Internet and attempts to find the information for each song on
the CD. If you download a song from the Internet, it often comes with some infor-
mation embedded in the file already; the amount of included information depends
on what the creator supplied. (And it’s often misspelled as well — think Leenard
Skeenard.) If you don’t have an Internet connection, iTunes can’t access the infor-
mation and displays generic titles instead.
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FIGURE 12-3:
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Setting or changing the song
information manually

If iTunes can’t find your CD in the online database or someone gives you an MP3
with incomplete or inaccurate information, you can change the information
yourself — believe me, you want at least the artist and song name! To view and
change the information for a song, follow these steps:

1. selectthe song in either the Song list or a playlist.
2. Press 38+l, or choose File => Get Info.
3. Click a field to edit the song's information on the Details tab, as shown in

Figure 12-3.

You can move to the next or previous tracks in the Music Library list or playlist by
clicking the Next or Previous buttons at the bottom left of the dialog.

The more work you put into setting the information of the songs in your Music
Library, the easier it is to browse and use iTunes. Incomplete song information
can make it more difficult to find your songs in a hurry. If you prefer, you don’t
have to change all information about a song (it just makes life easier later if you
do). Normally, you can get away with setting only a song’s title, artist, and genre.
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TIP

TIP

The more information you put in, however, the faster you can locate songs and the
easier they are to arrange. iTunes tries to help by automatically retrieving known
song information, but sometimes you have to roll up your sleeves and do a little
work. (Sorry, but some things just can’t be automated.)

“What about cover art, Mark?” Well, I'm overjoyed that you asked! iTunes can try
to locate artwork automatically for the tracks you select. (Note that embedding
large images can significantly increase the size of the song file.) Follow these
steps:

1. select the desired songs from the track list.

2. Choose File = Library = Get Album Artwork

You can set iTunes to automatically attempt to add album artwork every time you
rip tracks from an audio CD (as described in the next section), or when you add
songs without artwork to your Music Library. Select iTunes«> Preferences«<> Store,
and select the Automatically Download Album Artwork check box. (By the way, if
you buy tracks or an album from the iTunes Store, Apple includes album covers
automatically!)

Want to manually add album covers to your song info? Select one or more songs
in the track list, display the Info dialog and click the Artwork tab. Now launch
Safari, visit Amazon.com, and do a search on the same album (or search an online
artwork library, such as AlICDCovers.com). Drag the cover image from the web
page right into the Info dialog, and drop it on top of the “sunken square” Artwork
image well. When you click OK, the image appears in the Artwork tab of the Info
dialog.

Ripping Audio Files

224,

You don’t have to rely on Internet downloads to get audio files: You can create
your own MP3, AAC, Apple Lossless, AIFF, and WAV files from your audio CDs with
iTunes. The process of converting audio files to different formats is called ripping.
(Audiophiles with technical teeth also call this process digital extraction, but they’re
usually ignored at parties by the popular crowd.) Depending on what hardware or
software you use, each has its own unique format preferences.

The most common type of ripping is to convert CD audio to MP3 (or AAC) format.
To rip MP3s from an audio CD, follow these simple steps:

1. Launch iTunes by clicking its icon on the Dock.

Alternatively, you can locate iTunes in your Applications folder or in Launchpad.
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Choose iTunes = Preferences.

In the Preferences dialog that appears, click the General tab.

Click the Import Settings button that appears at the bottom of the
Preferences dialog.

Choose MP3 Encoder from the Import Using pop-up menu.

ol AWN

. Choose High Quality (160 Kbps) from the Setting pop-up menu, and click
OK to return to the Preferences dialog; click OK again to return to iTunes.

This bit rate setting provides the best compromise between quality (it gives you
better than CD quality, which is 128 Kbps) and file size (tracks you rip will be
significantly smaller than audiophile bit rates such as 192 Kbps or higher).
Remember, songs you buy and download from the iTunes Music Store are all
256 Kbps.

7. Load an audio CD into your Mac's optical drive.

The CD title shows up in the iTunes Source list (under the Devices heading),
which is on the left side of the iTunes window. The CD track listing appears on
the right side of the window.

If iTunes asks whether you want to import the contents of the CD into your
Music Library, you can click Yes and skip the rest of the steps; however, if
you've disabled this prompt, just continue with the remaining two steps.

TIP
8. Clear the check box of any song you don’t want to import from the CD.

All songs on the CD have a check box next to their title by default. Unmarked
songs aren't imported.

9. click the Import CD button.

Tweaking the Audio for Your Ears

Besides the standard volume controls that I mention earlier in this chapter, iTunes
offers a full equalizer. An equalizer permits you to alter the volume of various
frequencies in your music, allowing you to boost low sounds, lower high sounds,
or anything in between.

To open the Equalizer, choose Window=>Equalizer or press $8+Option+E. Use the
leftmost slider (Preamp) to set the overall level of the Equalizer. The remaining
sliders represent various frequencies that the human ear can perceive. Setting a
slider to a position in the middle of its travel causes that frequency to play back with
no change. Move the slider above the midpoint to boost that frequency; conversely,
move the slider below the midpoint to reduce the volume of that frequency.
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Continue adjusting the equalizer sliders until your music sounds the way you
like it. In case you prefer to leave frequencies to the experts, the iTunes Equalizer
has several predefined settings to match most musical styles. Open the pop-up
menu at the top of the Equalizer window to choose a genre. When you close the
Equalizer window, iTunes remembers your settings until you change them
again.

A New Kind of Radio Station

226

Besides playing back your favorite audio files, iTunes can also tune in Internet
radio stations from around the globe. You can listen to any of a large number of
preset stations, seek out lesser-known stations not recognized by iTunes, or even
add your favorite stations to your playlists. You can also subscribe to the iTunes
Radio feature to create a custom station dedicated to just the genres and artists
you prefer. This section shows you how to do it all.

Internet Radio

Although it’s not a radio tuner in the strictest sense, iTunes can locate virtual
radio stations all over the world that send audio over the Internet — a process
usually dubbed streaming. iTunes can track down hundreds of Internet radio
stations in a variety of styles with only a few mouse clicks.

To begin listening to Internet radio with iTunes, click the Internet Radio item in
the sidebar list. (If Internet Radio doesn’t appear under the Library heading in the
sidebar, it’s hidden. Hover your pointer over the “Library” label at the very top of
the sidebar and click the Edit link that appears, then click the Internet Radio check
box to enable it.) The result is a list of more than 20 types of radio stations,
organized by genre.

WHAT'S WITH THE NUMBERS NEXT TO THE
STATION NAMES?

When choosing an Internet radio station, keep your Internet connection speed in mind.
If you're using a broadband DSL or cable connection — or if you're listening at work over
your company’s high-speed network — you can listen to stations broadcasting at 128
Kbps (or even higher). The higher the bit rate, the better the music sounds. At 128 Kbps
in AAC format, for example, you're listening to sound that's as good as an audio CD.
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When you expand an Internet category by clicking its disclosure triangle, iTunes
queries a tuning server and locates the name and address of dozens of radio
stations for that category. Whether you like Elvis or not-Elvis (those passing fads,
such as new wave, classical, or alternative), something’s here for everyone. The
Internet also offers news, sports, and talk radio.

After iTunes fetches the names and descriptions of radio stations, double-click
one that you want to hear. iTunes immediately jumps into action, loads the
station, and begins to play it.

Tuning in your own stations

Although iTunes offers you a large list of popular radio stations on the web, it’s by
no means comprehensive. Eventually, you might run across a radio station that
you’d like to hear, but don’t find listed in iTunes. Luckily, iTunes permits you to
listen to other stations, too. To listen to a radio station that iTunes doesn’t list,
you need the station’s web address.

In iTunes, choose File=>Open Stream (or press 38+U). In the Open Stream dialog
that appears, enter the URL of your desired radio station and click OK. In seconds,
iTunes tunes in your station.

Radio stations in your playlists

If you find yourself visiting an online radio station more than once, you’ll be glad
to know that iTunes supports radio stations in its playlists. To add a radio station
to a playlist from the Internet Radio list, follow these steps:

HAVE AN ITCH TO HEAR “KUNG FU
FIGHTING"?

As you can probably tell from this chapter, music is very important to me. This particular
technology author has a preference for a certain hot jam spot: MLC Radio, the Internet
radio station I've been running for several years now. | call my station a '70s Time
Machine because it includes hundreds of classic hits from 1970-1979. You hear every-
thing from “Rock and Roll Hoochie Koo" by Rick Derringer to “Moonlight Feels Right” by
Starbuck. (Hey, 'm summing up a decade here, so be prepared for both Rush and the
Captain & Tennille.) The station broadcasts at 128 Kbps (audio CD quality), so you need
a broadband connection to listen. For the station’s Internet address or to ask for help
connecting to MLC Radio, visit my website at www.mlcbooks . com!
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1. Open the category that contains the station you want to add to your
playlist.

2. Locate the station you want to add to your playlist, and drag it from the
Radio list to the desired playlist on the left.

If you haven't created any playlists yet, see the section “Keeping Slim Whitman
@ and Slim Shady Apart: Organizing with Playlists” earlier in this chapter to find
out how.
TIP

You can also follow the same steps to add a radio station that doesn’t appear in the
Radio list. iTunes allows you to load a radio station URL manually by choosing
File> Open Stream, and any station that you play using the Open Stream command
is automatically added to your Songs list. Therefore, you can drag the station from
the Songs list to any playlist.

Creating a custom iTunes Radio station

The recent addition of iTunes Radio makes it possible for you to listen to the art-
ists, songs, and genres that you prefer in iTunes, without selecting a specific
Internet radio station. To use iTunes Radio, click the Radio button at the top of the
iTunes window, and type the artist name, song name, or genre in the Search field.
(Note that iTunes Radio is an Apple Music subscription service, unlike the Internet
Radio stations I described in the last section.)

As you download new music from the iTunes Store (and add new artists and
genres in iTunes Radio), the service learns more about your musical tastes and can
automatically play and recommend new music, much like the Genius feature
I discussed earlier in this chapter.

vice (described in the next section), iTunes Radio requires an Internet connection

@ Like Internet radio, the iTunes Store, and Apple’s iTunes Match subscription ser-
and an Apple ID.

REMEMBER

Your iTunes Radio station is automatically shared among all your Macs running
0S X Lion or later (as well as any devices you own running iOS 7 or later).

iTunes and iCloud Together

iTunes is connected closely with the Apple iCloud service, allowing you to share
music betwixt all your Macs and iOS devices. To download a local copy of any
iCloud item, simply click the iCloud icon next to the item. After the local copy has
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been saved to your Mac’s drive, the iCloud icon disappears and you’re ready to
listen or watch your purchase.

Apple’s iTunes Match subscription service builds on this same functionality,
allowing you to store all your music in iCloud (including the songs you’ve ripped
from audio CDs and downloaded from other sources) and listen to it on any of your
Macs, PCs, or iOS devices! When you join iTunes Match, all the songs that aren’t
available from the iTunes Store are automatically uploaded to iCloud.

At the time of this writing, the service is $25 a year and is limited to a maximum
of 10 devices and 100,000 songs (note that purchases you make from the iTunes
Store don’t count toward that 100,000-song limit).

To subscribe to iTunes Match or manage your Match storage, click the Store but-
ton to display the iTunes Store and click the iTunes Match link at the right side of
the screen.

iSending iStuff to iPod, iPhone, and iPad

©

REMEMBER

If you’re cool enough to own an iPod, you’ll be happy to know that iTunes has
features for your personal audio and video jukebox as well. The iPod Touch, Apple’s
multimedia player, will set you back $200 to $300 (depending on the storage
capacity). The iPod touch can hold literally thousands of songs, as well as pod-
casts, photos, and video. This great gadget and those like it have become known
worldwide as the preferred portable digital media players.

If you own an iPhone or iPad, you probably already know that these devices can
act as your music player as well. You can buy all sorts of applications for these
devices at the iTunes Store. iTunes even keeps track of these applications as part
of your iTunes Library.

In order to sync correctly, both your computer and the device must share the same
Apple ID.

You connect your iPod to any Macintosh or Windows PC that has USB 2.0 ports
using the included cable. After the iPod is connected, you can synchronize it with
iTunes. By default, this process is automatic: The iPod and the iTunes software
communicate with each other and figure out what items are in your iTunes Library
(as compared to the iPod Library). If they discover songs, podcasts, and video in
your iTunes Library that are missing from your iPod, the items automatically
transfer to the iPod. Conversely, if the iPod contains stuff that’s no longer in
iTunes, the iPod automatically removes those files from its drive.
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WARNING

Go back and reread that last sentence about how the iPod automatically removes
files from its drive. (I’ll wait.) Apple added this feature in an effort to be respon-
sive to copyright concerns. The reasoning is that if you connect your iPod to your
friend’s computer, you can’t transfer songs from the iPod to that computer. Of
course, you could always look at it from the marketing perspective as a feature
that makes sure your MacBook and iPod are always in total sync. Whatever the
case, pay close attention and read all warning dialogs when connecting to a com-
puter other than your own, or you might wipe out your iPod’s library.

You can change your settings on the device’s Summary pane so iTunes autosyncs
only selected playlists (click on the device icon at the upper left of the window to
display the Summary pane). Or, if you’re really nervous, you can choose to manu-
ally manage the contents of your iPod with iTunes from the Summary pane.

Sharing Your Media Across Your Network

230

TIP

Ready to share your music, podcasts, and video — legally, mind you — with other
folks on your local network? You can offer your digital media to other iTunes users
across your home or office. Follow these steps:

1. choose iTunes=> Preferences to open the Preferences dialog.

2. Cclick Sharing.

3. Select the Share My Library on My Local Network check box.

4

. Specify whether you want to share your entire library or only selected
playlists and files.

Sharing selected playlists is a good idea for those Marilyn Manson and Sex
Pistols fans who work at a cubicle farm in a big corporation.

5. you want to restrict access to just a few people, select the Require
Password check box; then type a password in the text box.

6. Cclick OK.

Note that the music you share with others can’t be imported or copied, so
everything stays legal.

Want to change that frumpy default name for your shared media library to
something more exotic, like “Dan’s Techno Beat Palace”? No problem. Display the
Preferences dialog again, click the General tab, and click in the Library Name text
box. Edit your network entertainment persona to your heart’s content.
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SENDING MUSIC ELSEWHERE WITH AIRPLAY

If you're using an AirPort Express portable wireless Base Station, you can ship your
songs right to your Base Station from iTunes, and from there to your home stereo or
boombox! Pick up an AirPlay-enabled sound system, and you can eliminate the stereo
or boombox and the AirPort Express device entirely. (I get into some serious discussion
of AirPort Express in Chapter 11.)

After your AirPort Express Base Station is plugged in and you connect your home stereo
(or a boombox or a pair of powered stereo speakers) to the stereo minijack on the Base
Station, click the Speakers button on the iTunes toolbar, and you can choose to broad-
cast the music you're playing in iTunes across your wireless network. Ain't technology
truly grand?

You can also share your media library using Home Sharing, which allows others
join in the fun — including up to five Mac computers and iOS devices (your iPad,
iPhone, and iPod touch). Home Sharing requires a network connection for all your
devices, and you have to enter the same Apple ID information on each device. To
turn on Home Sharing in iTunes, click Filec>Home Sharing and choose Turn On
Home Sharing. (Don’t forget to repeat this setup on each computer and iOS device.)
After Home Sharing is enabled, a Shared Libraries heading appears in the
sidebar.

Burning Music to Shiny Plastic Circles

Besides being a great audio player, iTunes is adept at creating CDs, too. (Of course,
your MacBook must have either an internal SuperDrive or an external optical drive
to record them.) iTunes makes the process of recording songs to a CD as simple as
a few taps on the trackpad. Making the modern version of a compilation (or mix)
tape is easier than getting a kid to eat ice cream! If you have an internal or external
optical drive, iTunes lets you burn CDs in one of three formats:

3 Audio CD: This format is the typical kind of commercial music CD you buy
at a store. Most typical music audio CDs store up to 800MB of data, which
translates into about 80 minutes of music.

3 Data CD or DVD: A standard computer CD-ROM or DVD-ROM is recorded
with the audio files. This disc can't be played in any standard audio CD player
(even if it supports MP3 CDs, which | discuss next). Therefore, you can listen to
these songs only by using your Mac and an audio player, such as iTunes or a
PC running Windows.
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WARNING

TIP

3 MP3 CD: As does the ordinary computer CD-ROM that | describe, an MP3 CD
holds MP3 files in data format. However, the files are arranged in such a way
that they can be recognized by audio CD players that support the MP3 CD
format (especially boomboxes, DVD players, personal CD players, and car
stereos). Because MP3 files are so much smaller than the digital audio tracks
found on traditional audio CDs, you can fit as many as 160 typical four-minute
songs on one disc. These discs can also be played on your Mac via iTunes.

Keep in mind that MP3 CDs aren’t the same as the standard audio CDs you buy at
the store, and you can’t play them in older audio CD players that don’t support the
MP3 CD format. Rather, this is the kind of archival disc that you burn at home for
your own collection or for use in a CD/DVD player or car audio system that supports
MP3 discs.

To begin the process, build a playlist (or select an existing playlist that you want
to record). If necessary, create a new playlist and add to it whatever songs you
would like to have on the CD. (See the earlier section, “Keeping Slim Whitman and
Slim Shady Apart: Organizing with Playlists,” if you need a refresher.) With the
songs in the correct order, right-click the playlist and choose Burn Playlist to Disc
to commence the disc-burning process. Click the desired recording format (again,
usually Audio CD) in the Burn Settings dialog that appears.

To save yourself from sonic shock, I always recommend that you enable the Use
Sound Check check box before you burn. iTunes adjusts the volume on all the
songs on your audio CD so they play at the same volume level.

WHAT THE HECK IS A PODCAST?

Today's podcasts are much like the recurring radio commentary programs of old,
covering a huge range of subjects. Most are produced by fans of a particular topic —
like a website, you can create your own — but others are offered by major news outlets
and talk radio shows (sometimes as companions to their radio broadcasts).

Podcasts are designed to entertain and inform, usually while you're doing something
else, but they can contain video as well. A typical podcast is released on a regular sched-
ule, and iTunes helps you maintain the schedule by allowing you to subscribe to a pod-
cast from within the iTunes Store. After you subscribe, iTunes automatically downloads
new episodes of the podcast.

To get started with podcasts, click Store on the iTunes toolbar, then click the Media Type
dropdown list at the left corner of the window and choose Podcasts. Remember, virtu-
ally all podcasts are free!
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Ready to go? Click Burn, and load the blank disc. iTunes lets you know when the
recording is complete.

Feasting on iTunes Visuals

TIP

By now, you know that iTunes is a feast for the ears, but did you know that it can
provide you with eye candy as well? With just a click or two, you can view
mind-bending graphics that stretch, move, and pulse with your music.

To begin viewing iTunes visuals, choose View> Show Visualizer (or press 38+T).
Immediately, most of your iTunes interface disappears and begins displaying
groovy lava lamp-style animations (like, sassy, man). To stop the visuals, choose
View = Hide Visualizer (or press §8+T again). The usual sunny aluminum face of
iTunes returns.

You can also change the viewing size of the iTunes visuals in the View menu.
Select View= Enter Full Screen (or press 38+Control+F). To escape from the Full
Screen Visuals mode, press Esc, or simply press $8+Control+F again.

You can still control iTunes with the keyboard while the visuals are zooming
around your screen. See Table 12-1 earlier in this chapter for a rundown on
common keyboard shortcuts.

Exercising Parental Authority

Do young children use your Mac? I'll be honest here: A large amount of content in
the iTunes Store, including audio, movies, and even apps, is stuff I don’t consider
suitable for kids. And what about the media that others in the family may decide
to share? Such is the world we live in today, and the good folks at Apple recognize
that you may not want to inadvertently allow your kids to have access to explicit
content.

Luckily, you can use the Restrictions settings in iTunes to build a secure fence
around content that’s for grown-ups only. Heck, you can even banish items from
the sidebar entirely. Figure 12-4 illustrates the Restrictions pane in the iTunes
Preferences dialog.
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FIGURE 12-4:

Protect your kids
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from explicit
content.
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Restrictions apply to playback, sharing, Tunes purchases,
and the iTunes Store.

ﬁj Click the lock to prevent further changes.

Cancel

You must log in with an Administrator account to change these settings, just like
with the Parental Controls in the System Preferences dialog. If the settings are
locked — the padlock icon at the bottom of the dialog is closed — click the padlock
and supply your administrator password to unlock them. (Read more about Paren-
tal Controls in Chapter 10.)

To restrict access, follow these steps:

1. choose iTunes > Preferences.
2. Click the Restrictions tab.
3. select any of the Disable check boxes to prevent access to those features.

Disabling features in iTunes applies to all user accounts — no matter who is
logged in! Notice that any features you disable disappear completely from the
sidebar after you click OK at the end of these steps.

4. Cclick the Ratings For pop-up menu, and choose your country.

Because Apple maintains separate iTunes Stores for different nations, you

can choose which country’s iTunes Store to monitor. If you like, you can disable
the display of content ratings in your iTunes library by deselecting the Show
Content Ratings in Library check box.

5. To restrict specific content in the iTunes Store, select the check box next
to the source, and make choices from the corresponding pop-up menu to
choose the restriction level.
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Note that these restrictions apply only to content in the iTunes Store, content
that can be downloaded through iCloud, and media shared with your Mac.

6. Cclick the padlock icon at the bottom of the dialog to close it and prevent
any changes.

7. Cclick OK.

Buying Digital Media the Apple Way

The hottest spot on the Internet for buying music and video is the iTunes Store,
which you can reach from the cozy confines of iTunes. (That is, as long as you
have an Internet connection. If you don’t, it’s time to turn the page to a different
chapter.)

Click the iTunes Store button near the top of the window, and after a few moments,
you’re presented with the latest offerings. Click a link in the store list to browse
according to media type; the Back and Forward buttons at the top of the iTunes
Store window operate much the same as those in Safari, moving you backward or
forward in sequence through pages you’ve already seen.

To display the details on a specific album, track, video, podcast, or audiobook
(whew), just click it. If you're interested in buying just certain tracks (for that
perfect road warrior mix), you get to listen to 90 seconds of any track — for free,
no less, and at full sound quality. When you’re ready to buy, click the Buy Now
button. (At the time of this writing, tracks are usually 99 cents a pop, and an
entire album is typically $9.99 . .. what a bargain!)

The iTunes Store uses your Apple ID to identify you, and it keeps secure track of
your payment information for future purchases. After you use the iTunes Store
once, you rarely have to log in or retype your credit card information again.

The tracks and files that you download are saved to a separate playlist called Pur-
chased. After the download is finished, you can play them, copy them to other
playlists, burn them to CD or DVD, share 'em over your network, or ship them to
your iOS devices using iCloud, just as you can any other item in your iTunes
Library.

device (including another Mac and your iPhone, iPad, or iPod touch). To set up
automatic downloading, choose iTunes Preferences to open the Preferences dia-

TIP log, and click the Downloads tab. After you’re signed in at the iTunes Store, you
can choose to download music or app purchases, and you have the option to check
for new downloads automatically. Click OK to save your changes.

‘ iTunes can automatically download the media you purchase on another iCloud
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IN THIS CHAPTER

» Importing pictures from your hard
drive or digital camera

» Organizing images with Photos

» Tweaking the appearance of
photographs

» Sharing photos with your friends

Chapter 13
Focusing on Photos

or decades now, the Mac has been the choice of professional photographers

for working with digital images — not surprising, considering the Mac’s

graphical nature. Apple continues this tradition with Photos, its photography
tool for the home user that can help you organize, edit, and even publish your
photographs. (It sports more features than a handful of Swiss army knives.) After
you shoot your photos with a smartphone or a digital camera, you can import
them into Photo, edit them, and publish them. You’re not limited to photos that
you take yourself, either; you can edit, share, and organize all kinds of digital
image files, as well as video clips. You can even create a photo album and use the
Photos interface to order a handsome soft-bound or hard-bound copy shipped to
you, or create a slideshow that you can upload to YouTube.

In this chapter, I walk you through an overview of what Photos can do. After that,
I give you a brief tour of the controls in Photos so that you can see what features
are available to you, including those for managing, printing, and publishing your
photos.

Delving into Photos

Figure 13-1 shows most of the major controls Photos offers. (Other controls appear
automatically when you enter different modes; I cover them in upcoming
sections.)
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FIGURE 13-1:
Photos greets you
with an attractive
window. Sidebar
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These controls and sections of the window are covered in more detail in the
following sections. For now, here’s a quick rundown of what you see when you
launch Photos and click the Photos mode button at the top center of the screen:

¥ Sidebar: Like iTunes and Safari, Photos sports a sidebar that displays different
locations and groupings within the application — photos you've recently
imported, for example, or specific photo albums and book projects you've
created. Switching between your photo library, your albums and your projects
involves a single click!

3 Toolbar: This group of controls determines how many images the Photos
Viewer will display, and allows you to perform a number of actions with
selected photos.

® You can display photos by moment (photos taken around the same time
and at the same location), collection (a group of related moments, like each
day of a family reunion), or year (the year the photos were taken). If the
Back button is visible, you can click it to see more images at once. To zoom
in on a specific photo, just click the desired thumbnail. To switch between
each of these groupings, click one of the four view buttons on the toolbar
(from the keyboard, press §8+1 through 38+4. The Photos view button
returns you to an overview of your entire library.)
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You can create new albumes, slideshows, and print projects (like books,
calendars, and cards) using your photos. These new thumbnails appear
when you click the Albums and Projects entries in the sidebar, which
makes it much easier to organize your photos.

You can share selected photos in a slew of different ways, including Apple
Mail, Messages, and AirDrop networking, as well as popular online sites like
Facebook, Twitter, and Flickr. If you've enabled iCloud Photo Sharing, you
can also share photos to your other Macs and iOS devices.

You can search for specific images. Just click in the box and start typing to
search by description and title, or even Faces and keywords, which | cover
later in the chapter.

¥ Viewer: This pane displays the images from your Photos Library.

You can click and drag or g8+click to select photos in the Viewer for further
tricks, such as assigning keywords and image editing.
TIP 3 Thumbnails: If you're displaying a single image from your Library, you can

press Option+S to open and close the Thumbnails pane. The Thumbnails pane
allows you to quickly switch to another image by clicking on the desired
thumbnail — a very helpful feature when you're editing a number of images
taken around the same time.

3 Full Screen: Click the Full Screen/Maximize button at the upper-left corner of
the window to switch to a full-screen display of your photos. In full screen
mode, you can double-click a thumbnail to view the image using your Mac's
entire screen real estate. (The toolbar is still available at any time: Just move
your pointer to the top of the screen to display it.) Press Esc to return to
windowed mode.

Click View = Always Show Toolbar and Sidebar in Full Screen to prevent the
toolbar and sidebar from disappearing in full screen mode.
TIP ¥ Zoom: Drag this slider to the left to reduce the size of the thumbnails in the

Viewer. This allows you to see more thumbnails at one time, which is conve-
nient for quick visual searches. Drag the slider to the right to expand the size
of the thumbnails, making it easier to differentiate details between similar
photos in the Viewer. You can also use the Zoom slider when a single image is
displayed in the Viewer.

¥ Add To Favorites: This toolbar button (which bears a heart icon) appears in
the toolbar only while you're viewing or editing a single image. Click the Add to
Favorites button to add the item that's currently displayed in the Viewer as a
Favorite. (When viewing your Library as moments or collections, you can also
hover your pointer over an item and click the heart symbol that appears at the
lower-left corner of the photo.) You can search for Favorite photos using
keywords, which are covered later in this chapter.
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¥ Info: Click this button to display information on the item that's currently
displayed in the Viewer.

¥ Share: Click this button to share the currently selected photos on Flickr,
Twitter, or Facebook. Choose iCloud Photo Sharing to send the selected
photos to your iPhone, iPad, or iPod Touch (they'll appear in the Photo Stream
albums on those devices) or to another Mac. If you use Apple’s Aperture
application to edit or organize photos, you can add the selected photos to
your Aperture library. You can also add them to a Note, attach the photos to a
text message, or email them.

3 Edit: Here's another button that's displayed in the toolbar only when you view
a single image. Click this button to switch to the editing controls within Photos
and make changes to the current image. | cover editing in depth later in the
chapter.

9 Rotate Counterclockwise: Pretty self-explanatory — a click will rotate the
currently selected image(s) in a counterclockwise direction. | find myself doing
this often, which is why Apple designers decided to park this button here.

¥ Search: Click within the familiar confines of the Search box to filter the photos
displayed in the Viewer by keyword, description, filename, or date.

Working with Images in Photos

240

Even a superbly designed image display and editing application such as Photos
would look overwhelming if everything were jammed into one window. Thus,
Apple’s developers provide different operational modes, such as editing and book
creation, that you can use in the one Photos window. Each mode allows you to
perform different tasks.

In this section, I discuss three of these modes — import, organize, and edit — and
what you can do when you’re in them.

Import images 101

In import mode, you’re ready to download images and video clips directly from
your digital camera — and you’re not limited to cameras, of course. You can also
import items from a folder on your hard drive, a memory card reader, such as
the SDXC card slot sported by many current Mac models, or even a Kodak
PhotoCD.
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TIP

Follow these steps to import images directly from your camera:

1.

Note that Photos automatically groups imported images and video into moments
and collections, which use the date, time, and location where the files were cre-
ated, if your camera stores this information with each file. For example, if you
want to see photos from your son’s graduation, they’ll appear as a separate
moment. Think about that. It’s pretty tough to arrange old-fashioned film prints
by the moment in time they document, but Photos makes it easy for you to see

Connect your digital camera to your Mac.

Plug one end of a USB cable into your camera and the other end into your
computer’'s USB port, and prepare your camera to download images.

Prepare your camera to download files.

The procedure for downloading images and video varies by camera, but the
process usually involves turning on the camera and choosing a “Download” or
“PC" mode. Check your camera’s user guide for more details.

Launch Photos.

Your Mac probably launches Photos automatically when your camera is
detected, but you can always launch Photos manually by clicking the Photos
icon on the Dock (or clicking on the Photos icon within Launchpad).

Choose File => Import from the Photos menu and click the device in the
sidebar.

Photos displays all of the images and video clips currently stored on your
camera in the Viewer.

Click the Import All New Photos button to import all new files from the
camera.

To select specific images to import, hold down the $8 key and click each desired
photo; then click Import Selected instead of Import All New Photos.

The images and clips initially appear within the Last Import album in your
Photos Library, where you can organize them as you want.

Click the Import To dropdown menu and select a destination for the
imported files.

You can choose an existing album, create a new album, or simply add them to
your library.

which photos are part of the same group.
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TIP

IMPORTING IMAGES FROM YOUR HARD
DRIVE TO PHOTOS

Adding items stored on your hard drive, a CD, a DVD, an external drive, or a USB flash
drive is easy. If the images and clips are in a folder, just drag that folder from a Finder
window and drop it into the Viewer. You can even drag items directly to the Photos icon
in the Dock. Photos automatically creates a new album using the folder name, and you
can sit back while the images are imported into that new album.

If you have individual images, you can drag them as well. Select the images in a Finder
window, and drag them into the desired album in the Albums display. To add them to
the album currently displayed in the Viewer, drag the selected photos and drop them in
the Viewer instead.

If you'd rather import images by using a standard Mac Open dialog, choose
File = Import. Simplicity strikes again!

You can also allow Photos to import images directly from your iOS devices using My
Photo Stream, which | cover later in this chapter.

Don’t be surprised if Photos automatically appears when you connect your iPhone
or iPad to your MacBook. This gives you a convenient opportunity to import photos
with a single click.

Organize mode: Organizing and sorting
your images

In the days of film prints, you could always stuff another shoebox with your latest
photos or buy another sticky album to expand your library. Your digital camera,
though, stores images as files instead, and many folks don’t print their digital
photographs. Instead, you can keep your entire collection of digital photographs
and scanned images well-ordered and easily retrieved within Photos — then you
can display them in a slideshow, email them, print them, use them as Desktop
backgrounds, or burn them to an archive disc.

A new kind of photo album

The most familiar method of organizing images in Photos is the album. Each
album can represent any designation you like, be it your pets, a vacation, your
daughter, or your daughter’s ex-boyfriends. Follow these steps:
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FIGURE 13-2:
Adding a new
album in Photos.

1 . Create a new album.

You can choose File => New Album, press $8+N. If you've selected any item
thumbnails in the Viewer, they are added to the new album automatically.

2. Type the name of your new photo album into the Album Name text box
in the sidebar (Figure 13-2).

3. Press Return.

@ My Albums D |

Untitled Album

Photos S Showing: All Photos >

? Ploces
© Imports
<75 My Bhoto Stream

7 Recently Deleted

rojocts
] My Projects
Bl summer Fun Boak
) 60's TV Stars

Photos also offers a special type of album called a Smart Album, which you can
create from the File menu. (For even faster action, press Option+38+N.) If you’re
familiar with the Smart Folders you can use within the Finder and the Smart
Playlists within iTunes (see Chapter 12), you’ve figured out this one already.

A Smart Album contains only photos that match certain criteria you choose, including
the keywords you assign your images. Other criteria include text in the photo file-
names, the dates the images were added to Photos, a specific person you’ve identi-
fied, and any description you might have added (as well as camera-specific data,
such as ISO and shutter speed).

Now here’s the really nifty angle: Photos automatically builds and maintains Smart
Albums for you. It adds new photos that match the criteria and deletes those you
remove from your Photo Library (and also removes the photos that no longer
match the Smart Album’s criteria). Smart Album icons carry a gear symbol in the
Photos sidebar.
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©

REMEMBER

TIP

You can display (or edit) information about any photo or video clip — just
right-click on the thumbnail and choose Get Info from the menu that appears.
Click the Add a Title heading in the dialog to display a text edit box, and you can
simply type a new value. You can also type a short note or description in the Add
a Description box that appears in the Info dialog.

You can copy selected items from the Viewer into any album you choose.
Right-click the desired items, then hover your pointer over the Add To menu item
and choose the destination album. You can also copy selected items to an album
by dragging them from the Viewer to the desired album entry in the sidebar.

To remove a photo or video clip that has fallen out of favor, follow these steps:

1. Click the desired album in the sidebar.
2. Inthe Viewer, click the item you want to remove to select it.

3. Press Delete.

When you remove a photo or clip from an album, you don’t remove the actual file
from your collection (represented by Photos button in the toolbar or the Photos
entry at the top of the sidebar). An album is actually just a group of links to the
images in your collection, just like how a playlist in iTunes is a group of links to
songs in your Music Library. If you want to completely remove an offending
photo from Photos, click the Photos button in the toolbar (or the Photos entry at
the top of the sidebar) to display your entire collection of photos and clips and
delete the item there. The item disappears from all albums with which it is
associated.

To remove an entire album, right-click on the offending album entry in the side-
bar and choose Delete Album.

To rename an album from the sidebar, click the entry under the Albums heading
in the list to select it, and click again to display a text box. Type the new album
name, and press Return.

Change your mind? Photos comes complete with a handy-dandy Undo feature.
Just press 38+Z, and it’s as though your last action never happened. (This is a great
trick for those moments when you realize you just deleted your only image of your
first car from your Library.) For an extra level of backup protection for your price-
less images, you can invest in an external hard drive and use the awesome High
Sierra Time Machine backup feature.
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TIP

HEY, WHAT HAPPENED TO MY EVENTS?

In iPhoto — the predecessor to Photos — an Event was a group of images you shot or
downloaded at the same time (much like a collection in Photos). Now that iPhoto has bit
the dust, you may be mourning the loss of your Events . . . don't worry, they're still
available! You'll find that Photos includes a special album named iPhoto Events (which is
available as an entry in the sidebar list). Click this iPhoto Events entry in the sidebar and
your existing Events will appear like magic!

Note that you can no longer create Events within Photos, as collections now handle the
same chorel

Working with People

Photos includes a powerful organizational tool called People, which appears as a
separate item within the sidebar.

People is a sophisticated recognition system that automatically recognizes human
faces within the photos you add to your Photos Library. (I don’t know whether it
works well with pets, but you can try.) Naturally, you have to identify — or tag —
faces before Photos can recognize them.

To tag a face, follow these steps:

1. Inthe Viewer, double-click the photo with a person you want to tag.

Note that Photos indicates each person'’s face in the photo with a circle. If a
face has already been tagged, the label (which appears when you hover your
pointer over the icon) matches the person’s face.

To set Photos to always show labels in the Viewer — so that you don’t
have to click the Add Faces link — click View =>Show Face Names.

Click the unnamed label under the person’s face to open a text box, as
shown in Figure 13-3.

2
3
4, Type the person’s name and press Return.
5

. Ifthe name appears on a Contacts contact card — or is recognized as an
existing People name, or as one of your Facebook friends — you can click
the matching entry that appears to confirm the identity. Wowzers!

6. To delete an incorrect face recognition, right-click inside the circle that
appears around the face and choose This is Not (Name) from the menu
that appears.
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FIGURE 13-3:
Adding another

mug to my
collection of
Faces. (That

doesn't sound
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right.)

Photos might not recognize the face if the person is turned at an angle to the
camera or is in a darker area of the photo. If so, display the Info pane and click the
Add Faces link to display a “floating” circular outline, then click the outline and
drag the circle over the person’s face. If necessary, you can resize the box using
the handle that appears at the right side of the circle. Now you can click the Click
to Name label and type the person’s name.
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After you tag an image, it appears in your People collection, which you can view
by clicking the People entry in the sidebar. You can double-click a portrait in your
People collection to see all the images that contain that person.

Organizing with keywords

“Okay, Mark, albums and People are great ideas, but there has to be a way to
search my Library by category!” Never fear, good Mac owner. You can also assign
descriptive keywords to items to help organize your Library and locate certain pic-
tures and video clips fast. Photos comes with a number of standard keywords, and
you can create your own as well.

To illustrate, suppose you’d like to identify your images according to special
events in your family. Birthday photos should have their own keyword, and anni-
versaries deserve another. By assigning keywords, you can search for Elsie’s
birthdays or your silver wedding anniversary (no matter what collection or album
they’re in), and all related photos with those keywords appear like magic!
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TIP

FIGURE 13-4:
Add keywords to
these selected
images.

Photos includes a number of keywords that are already available:

¥ Favorite

¥ Family

» Kids

¥ Vacation

3 Birthday

3 Photo Booth
3 Photo Stream
3 Check mark

What’s the check mark all about, you ask? It’s a special case: The check mark
keyword comes in handy for temporarily identifying specific items, because you
can search for just your check-marked photos and clips.

To assign keywords to images (or to remove keywords that have already been
assigned), select one or more photos in the Viewer. Choose Window=> Manage My
Keywords or press 38+K to display the Keyword Manager window, as shown in
Figure 13-4.
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Edit Keywords
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REMEMBER

YOU NEED YOUR OWN KEYWORDS

| bet you take photos and video clips of things other than just kids and vacations. That's
why Photos allows you to create your own keywords. Display the Photos Keyword
Manager window by pressing $8+K, click the Edit Keywords button, and then click Add
(the button with the plus sign). Photos adds a new unnamed keyword to the list as an
edit box, ready for you to type its name.

You can rename an existing keyword from this same window, too. Click a keyword to
select it, and then click Rename. Remember, however, that renaming a keyword affects
all the images that were tagged with that keyword. That might be confusing when, for
example, photos originally tagged as Family suddenly appear with the keyword
Foodstuffs. (I recommend applying a new keyword and deleting the old one if this prob-
lem crops up.)

To change the keyboard shortcut assigned to a keyword, click the Shortcut button. To
remove an existing keyword from the list, click the keyword to select it and then click the
Delete button, which bears a minus sign. After your keywords are picture-perfect (pun
grudgingly intended), click OK to save them.

Drag the keyword buttons that you use the most to the Quick Group section of the
Keyword Manager window, and Photos automatically creates a keyboard shortcut
for each keyword in the Quick Group. Now you don’t even need to display the
Keywords window to get business done!

Click the buttons for the keywords you want to attach to the selected images to
mark them. Or click the highlighted buttons for the keywords you want to remove
from the selected items.

Digging through your library with keywords

Behold the power of keywords! To sift through your entire collection of images by
using keywords, click the Search button on the toolbar at the top right of the
Photos window and type one or more keywords. For example, to see all the items
you’ve flagged as Favorites that include kids, you’d type Favorite Kids.

The images that remain in the Viewer after a search must have all the keywords
you specified. For example, if an image is identified by only three of four keywords
you chose, it isn’t a match and doesn’t appear in the Viewer. (You can create a
Smart Album with specific keywords to get around this limitation.)
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REMEMBER

To search for a photo by words in its description, just click in the Search box and
start typing. You can search through your images by date and rating as well.

Searching by locations where photos were taken

Photos can also track the location where photos were taken automatically, but this
feature requires a digital camera that includes GPS tracking information in the
image metadata for Photos to do so without your help. (Older camera models are
unlikely to support GPS tracking. Naturally, newer iPhones and iPads support this
feature.) You don’t have to turn anything on to view photos by location.

When you’re viewing photos by moments and collections, you’ll notice that Pho-
tos includes the location name to identify where the photos were taken. To search
for all images taken at a specific location, type the location name into the Search
field.

If you right-click a specific photo (that includes location information) to select it
and then click Get Info, you see a close-up map of the location where the photo
was taken.

Edit mode: Removing and fixing stuff the
right way

Not every digital image is perfect — just look at my collection if you need proof.
For shots that need a pixel massage, Photos includes a number of editing tools you
can use to correct common problems.

The first step in any editing job is to select the image you want to fix (double-click
on a thumbnail in the Viewer so that it fills the screen). Then click the Edit button
on the Photos toolbar (or simply press Return) to display the Edit mode controls
at the right side of the window, as shown in Figure 13-5. Now you’re ready to fix
problems, using the tools I discuss in the rest of this section.

If you display a video clip in the Viewer, you can play it by hovering your pointer
over the clip and pressing the Play button that appears. However, you can only
edit photographs, so the Edit button is disabled when you’re viewing a video clip.

While you’re editing, you can press the left and right arrow keys to move to the
next image (or back to the previous image). This trick works whether you were
browsing the Library or displaying the contents of an album. You can also display
the Thumbnail pane in Edit mode.
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Photos is now in
edit mode. Watch
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out, image
problems!

TIP

FWEIEE & Fiters 1 Crop

If you prefer to edit images while using more of your screen real estate, click the
Full Screen/Maximize button at the upper-left corner of the Photos window. To
switch back to the standard window arrangement, simply press the Esc key.

When you’re finished with Edit mode, click the (wait for it) Done button again to
return to the Viewer.

Rotating tipped-over shots

If an image is in the wrong orientation and needs to be turned to display correctly,
click the Rotate button to turn it once in a counterclockwise direction. Hold down
the Option key while you click the Rotate button to rotate in a clockwise
direction.

Crop 'til you drop (and a whole lot more)

Does that photo have an intruder hovering around the edges of the subject? You
can remove some of the border by cropping an image, just as folks once did with
film prints and a pair of scissors. (We’ve come a long way.) With Photos, you can
remove unwanted portions from the edges of an image; it’s a great way to get
Uncle Milton’s stray head (complete with toupee) out of an otherwise perfect
holiday snapshot.

While you’re in Editing mode, follow these steps to crop, flip and straighten an
image:

1. click the Crop button at the top of the window.

2. Select the portion of the image you want to keep.
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REMEMBER

6.

In the Viewer, click and drag the right-angle handles in the corners of the
rectangle to outline the part of the image you want. Whatever is outside this
rectangle disappears after the crop is completed.

When you drag a corner or edge of the outline, a semi-opaque grid (familiar to
amateur and professional photographers as the nine rectangles from the Rule
of Thirds) appears to help you visualize what you're claiming. (Check it out in
Figure 13-6.)

You can expand the outline to the image's full dimensions at any time by
clicking the Reset button.

See that attractive-looking Auto button that appears at the lower-right corner
of the Photos window when you're in crop mode? A single click of the Auto
button and Photos will take its best shot at producing the ideal cropping and
straightening job for you! If you don't like the results, just use the Undo feature
(88+2) to return the photo to its previous appearance.

Photos features multiple Undo levels, so you can press $8+Z several times to
travel back through your last several changes. Alternatively, you can always
return the image to its original form (before you did any editing at all) by
clicking the Reset button.

(Optional) Choose a preset aspect ratio.

You might want to force your cropped selection to a specific aspect ratio, such
as 4x3 or 16x9 for a widescreen desktop background, or 4x6 or 5x7 to match
the dimensions of photo paper. If so, click the Aspect item at the right side of
the window and select that ratio from the pop-up menu that appears. (Pick the
Square menu item for the perfect Facebook profile image, and Freeform to
allow any aspect ratio after your cropping is done.)

(Optional) Flip your photo horizontally.
A click of the Flip item gives you the mirror image of your original photo.
(Optional) Straightening what's crooked.

Was your camera slightly tilted when you took the perfect shot? Never fear!
Click on the circular angle control at the right edge of the image and drag in the
desired direction. (Besides straightening the subject, you can do some truly
wild camera angles this way, just like the 60s Batman TV series!)

Click the Done button.

Enhancing images to add pizzazz

If a photo looks washed out, click the Auto Enhance button to increase (or decrease)
the color saturation and improve the contrast. Auto Enhance is automatic, so you
don’t have to set anything — but be prepared to use Undo if you’re dissatisfied

with the changes.
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FIGURE 13-6:
Select the stuff
you want to keep
in your photo.
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Removing rampant red-eye

Unfortunately, today’s digital cameras can still produce the same “zombies with
red eyeballs” as traditional film cameras. Red-eye is caused by a camera’s flash
reflecting off the eyes’ interior surface, and it can occur with both humans and
animals. (I'm told pets get green-eye or blue-eye, but Photos can handle them, too!)

Photos can remove that red-eye and green-eye and turn frightening zombies back
into your family and friends. In Editing mode, click the Adjust button at the top of
the window, then hover your pointer over the Red-Eye item at the right side of the
screen and click the Auto button that appears. Photos automatically attempts to
remove any red-eye effect it detects in the photo, and a blue check mark appears
next to the Red-Eye item to indicate that a change was made.

Retouching like the pros

The Photos Retouch feature is perfect for removing minor flecks or lines in an image
(especially those you’ve scanned from prints). Click the disclosure triangle (which
looks like a right arrow) by the Retouch item and click the Edit button that appears
(it carries a paintbrush icon). Now hover your pointer over the photo to display the
circular retouch tool. You can drag the Size slider to change the size of the retouch
tool. Drag the pointer across the imperfection and click Done when you’re finished
touching up. Don’t forget to take a moment and marvel at your editing skill!

Using filters and adjustments to add a mood

Wondering whether a particular photo in your Library would look better as a
black-and-white (grayscale) print? Click the Filters button at the top of the screen

252  PART 4 Living the iLife



to display a list of different effects that you can apply to the photo, including
different black-and-white effects, enhanced color levels and subtle shading. Click
any thumbnail in the strip to apply the filter.

If you’d like more precise manual control over your image attributes — including
sharpness, color levels, shadows, definition and white balance — click the Adjust
button at the top of the screen and explore the lengthy array of options. Note that
most of the adjustments offer an Auto button if you hover your pointer over the
entry, and you can click the disclosure triangle at the left of each entry to display
additional controls that you can use to create a different look.

Producing Your Own Coffee-Table
Masterpiece

TIP

Projects mode unleashes what I think is probably the coolest feature of Photos: the
chance to design and print a high-quality bound photo book. First you complete
an album by editing all the images just the way you want and placing in the album
all the photos you want to include in your book. Photos can send your images as
data over the Internet to a company that prints and binds your finished book. (No,
they don’t publish For Dummies titles, but then again, I don’t get high-resolution
color plates in most of my books, either.)

At the time of this writing, you can order many different sizes and bindings. The
largest size is a 13-by-10-inch hardcover book (complete with a dust jacket) with
20 double-sided pages for about $50 — extra pages cost $1.50 each. Smaller sizes
include a 10-by-10-inch hardcover book with 20 double-sided pages for about
$40 and a softcover 8-by-8-inch album with 20 double-sided pages for about
$15. Extra pages can be added at $1.00 and $.80 a pop, respectively.

Photos can also produce and automatically order calendars and cards (both the
postal and greeting varieties) using a process similar to the one I describe in this
section for producing a book. Who needs that stationery store in the mall any-
more? (You can even order old-fashioned photo prints.)

If you decide to create a photo book, make sure the images have the highest quality
and highest resolution. The higher the resolution, the better the photos look in the
finished book. I always try to use images of more than 1,200 pixels in the shortest
dimension. You should also make sure you’ve added enough images to the album
you’ll be using, because you need to populate the entire book. (You can add extra
pages later, but each book requires a minimum number of pages.) Don’t forget to
include a good mix of landscape and portrait shots.
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To create a photo book, follow these steps:

1. Right-click the entry for the desired album in the sidebar and choose
Create > Book from the menu that appears.

Make sure no individual photos are selected in the Viewer. This way, Photos
uses all the images in the chosen location.

2. Selectthe type of book (Square, Classic, or Softcover).
Your choice determines the number of pages and the size of the book.
3. Click atheme thumbnail.

The theme you choose determines both the layout scheme and the back-
ground graphics for each page.

4. Click Create Book.

Photos adds your new book project under the Projects heading in the sidebar
(using the name of the album where the photos were located), and you see the
layout and controls shown in Figure 13-7.

In Book mode, the Viewer displays a collection of thumbnail images, each of
which represents a portion of your book — the front cover, internal pages, or
back cover. Photos automatically fills as many pages as it can with images that
best fit your layout — any extra images appear in the photo strip along the
bottom of the window. You can drag any image thumbnail into one of the
photo placeholders to add it (or replace the existing photo).

It's easy to switch to another theme at any time. Click the Change Settings
button in the toolbar (which bears a book icon), and then click the Change

Theme button that appears.

TIP
5. (Optional) Rearrange the page order to suit you by dragging the thumb-
nail of any page from one location to another.
If you prefer a book without page numbers, click the Change Settings button
and click Show Page Numbers to toggle it off.
TIP 6. (Optional) To change the look of the selected cover or page, click the

Layout Options button on the toolbar to change the color and design
layout for that element.

Clicking a design thumbnail automatically updates the page display.
7. Double-click a page to edit captions and short descriptions.

Click any of the text boxes in the page display, and begin typing to add text to
that page. (Note that some themes don't have caption or description text boxes.)
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FIGURE 13-7:
Preparing to
publish my own
coffee-table
masterpiece.

Q

TIP

After you're finished editing, click the Back button at the top of the window to
return to your full spread.

8. (Optional) To add pages to your book, click the Add Page button on the
toolbar.

As mentioned earlier, the price of additional pages varies according to the size
and type of binding you choose.

9. To view the book at any time, right-click any open spot in the Photos
Viewer and choose Preview Book.

After a short wait, the macOS Preview application opens, and you can scroll
through the contents of your book (or even print a quick copy). To close the
Preview window, choose Preview = Quit Preview.

10. when you're ready to publish your book, click the Buy Book button at the
upper-right corner of the window.

11. In a series of dialogs that appears, Photos guides you through the final
steps to order a bound book.

Note that you are asked for credit card information, so have that plastic ready.
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Drag photos here to use on another layout

Why limit yourself to paper copies of your publishing success? You can also
right-click any open spot in the Viewer and choose Save Book as PDF to create a
snazzy electronic version of your book.
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PART 4

| REALLY NEED A SLIDESHOW

You can use Photos to create slideshows by following these steps:

3.

. Right-click the desired album in the sidebar and choose Create => Slideshow

from the menu that appears.

. Type the name of the slideshow in the text box and press Return. Photos adds

a adds a new entry under Projects in the sidebar.

A scrolling thumbnail strip appears at the bottom of the Viewer, displaying the
images in the album.

Click and drag the thumbnails to appear in the desired order.

After creating your slideshow, you can customize it with the controls that appear at the
right side of the Photos window:

® Themes: Click the Theme Picker button to choose the theme for your slideshow.

The theme you choose controls the animation, transition type, and screen layout
that Photos uses — everything from the classic Ken Burns “moving photo”
animation to a nifty Sliding Panels layout.

Music: Click the Music button to display Apple’s theme music as well as the tracks
from your iTunes Library. To choose a standard theme, open the Source pop-up
menu and choose Theme Songs; click that perfect song to select it. To choose songs
from your iTunes Library, open the Source pop-up menu and click iTunes, then click
the songs you want in the order you want them.

Duration: Click the Duration Settings button, and you can choose to fit the display
of images to the length of the music you've chosen, or you can set individual tim-
ings for the slide thumbnails you've selected. If you want your slideshow to loop
after it finishes, click the Loop icon that appears at the lower-right corner of the
Viewer to toggle it on (the icon turns blue).

Preview: To display a quick preview of your slideshow without leaving the Photos
window, click the Preview button at the lower-left corner of the Viewer; this is a
handy way of determining whether the theme and music you've selected are
really what you want. When you're ready to play your slideshow, click the Play
button that appears under the Viewer, and Photos switches to full-screen mode.
To create a movie file from your completed slideshow, click Export on the Photos
toolbar.



Exploring iCloud Photo Library

Yes, Apple has decided that everything except the kitchen sink should be stored
online in iCloud: first it was your iTunes music library, then your Pages, Numbers,
and Keynote documents, and now it’s your photographs and video clips! To turn
the iCloud Photo Library feature on, click Photos= Preferences, click the iCloud
tab, and click the iCloud Photo Library check box to enable it.

With iCloud Photo Library, your entire Photos Library is actually stored online,
and everything in your Library is also accessible from other Macs and iOS devices
like your iPad and iPhone. (Think “central storage house for everything visual
that you can reach from anywhere with an Internet connection.”) If you take
a photo with your iPhone, for example, you’ll see it appear automatically within
Photos — and if you’ve recently cropped and edited a photo to perfection with
Photos, you’ll be able to retrieve that edited photo on any of your iOS devices or
another Mac.

From the same iCloud pane in the Preferences dialog, you can choose to

¥ Download copies of the full-size images and full-resolution videos on your
MacBook's local hard drive (allowing you to edit or view the originals even
when you're not connected to the Internet).

¥ Store smaller size images and smaller-resolution videos on your laptop, but
with the ability to retrieve the originals from the iCloud at any time (if you're
connected to the Internet).

Naturally, if you’re a photographer that needs constant, instant access to your
original images, the first option is preferable (choose the Download Originals to
this Mac option in the iCloud pane). However, if your MacBook’s drive is nearly
full and you’d like to conserve space, the second option is very attractive (choose
the Optimize Mac Storage option in the iCloud pane).

All this goodness is handled automatically, but there’s a catch: your entire Photos
Library needs to fit within your free 5GB of iCloud storage, or you’ll have to pay a
monthly subscription to get additional elbow room! (Storage subscriptions range
from $0.99 a month for 20GB of space to $19.99 a month for a whopping 1TB of
space.) If you have only 3GB of photos, you may be able to use iCloud Photo Library
without spending anything extra, but since my Photos Library is nearing 10GB in
size I would probably need to subscribe to take full advantage of the feature.
The choice is yours, dear reader: If you decide not to use the iCloud Photo Library,
rest assured that Photo Stream will still work as it did in iPhoto.
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Putting My Photo Stream and iCloud Photo
Sharing to Work

258

Like iPhoto before it, Photos includes the My Photo Stream feature that automati-
cally shares the photos you take among your Macs, your PCs, and iOS devices.
Unlike iCloud Photo Library, however, your images and videos are stored on your
Mac’s local hard drive and not in your iCloud storage. (The images and videos are
also always full-size and full-resolution.)

To turn on My Photo Stream, choose Photos= Preferences and click the iCloud
toolbar button, then select the My Photo Stream check box. Once the feature is
turned on, Photos should automatically import My Photo Stream photos taken
with i0S devices and other Mac computers to your Photos Library.

Once the My Photo Stream feature is turned on, it’s a cinch to share images and
videos across your Apple computers and devices — simply copy the items into
the My Photo Stream location in the sidebar. Photos automatically sends the
selected images to all compatible devices over your Internet connection. (Note
that all devices using My Photo Stream must be configured using the same
Apple ID.)

You can also choose to share specific photos by using iCloud Photo Sharing, which
can be turned on from the Photos Preferences dialog. (Yes, I agree, Apple seriously
needs to work on choosing more discrete names for these features.) Choose Pho-
tos= Preferences, click the iCloud tab on the toolbar, and select the iCloud Photo
Sharing check box.

To subscribe to a shared album invitation from another person, right-click on the
desired shared album in the sidebar, and click Accept.

To create your own shared album, select the images you want to share, click the
Share button on the toolbar and click the iCloud Photo Sharing item. Click the New
Shared Album button and Photos prompts you for the album name and the email
addresses of the folks you want to invite to your shared album. After you have
entered each email address, click the Create button at the bottom of the sheet to
start the ball rolling. You can also add or delete items from your shared album in
the same way that you would with a regular Photos album.
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IS THAT FACEBOOK, TWITTER,
AND FLICKR | SPY?

Indeed it is! Photos includes direct connections to both your Facebook and Twitter social
networking accounts (www . facebook . com and www . twitter .com) and your Flickr
online gallery account (www . f1ickr . com). You can simply select one or more photos
and send them automatically to any of these services. Click the Share button on the
toolbar to select the type of account.

The first time you select photos in the Viewer (or an album) and choose either option,
Photos prompts you for permission to set up your connection. (Of course, this requires
you to enter your Facebook, Twitter, and Flickr account information — hence the
confirmation request.) Click Set Up, and provide the data each site requires.

After you set up your accounts, simply select your photos or albumes, click the

Share toolbar button, and choose the menu item for the desired service. Apple, you
absolutely rock!
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IN THIS CHAPTER

» Taking stock of the iMovie window

» Importing and adding media content
» Using transitions in your movie

» Putting text titles to work

» Adding animated maps

» Creating a movie trailer

» Sharing your movie with others

Chapter 14

Making Film History
with iMovie

emember those home movies you used to make in high school? They were

entertaining and fun to create, and your friends were impressed. In fact,

some kids were so downright inspired that you’re not surprised when you
discover at your high school reunion that they turned out to be graphic artists, or
got involved in video or TV production.

iMovie, part of Apple’s digital lifestyle suite, makes moviemaking as easy as those
homemade movies. Apple simplifies all the technical stuff, such as importing
video and adding audio, leaving you free to concentrate on your creative ideas. In
fact, you won’t find techy terms such as codecs and keyframes in this chapter.
I guarantee you’ll understand what’s going on at all times. (How often do you get
a promise like that with video-editing software?)

With iMovie, digital video from your smartphone or your camcorder, and the other
applications that Apple provides, you can soon produce and share professional-
looking movies, with some of the same creative transitions and titles used by
Those Hollywood Types every single day. All on your MacBook, all by yourself.
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If you turn out to be a world-famous Hollywood-Type Director in a decade or so,
don’t forget the little people — like computer book authors — along the way!

Shaking Hands with the iMovie Window

262

If you've ever tried using a professional-level video-editing application, you
probably felt as though you were suddenly dropped into the cockpit of a jumbo jet.
In iMovie, though, all the controls you need are easy to use and logically placed.

To launch iMovie, click the iMovie icon on the Dock or within Launchpad. (It looks
like a star on the Hollywood Walk of Fame.) You can also click the Applications
folder in any Finder window Sidebar and then double-click the iMovie icon.

To follow the examples I show you here, take these strenuous steps and create a
new movie project:

1.

Choose File=> New Movie (or press 38+N).

Alternatively, you can click the Create New thumbnail and choose the Movie
entry from the pop-up menu. No matter how you get there, iMovie displays the
window shown in Figure 14-1.

You can also create movie trailers (short previews or teasers) within iMovie, as |
demonstrate later in this chapter. Generally, however, you should create your
trailer project after your movie is completed (unless, of course, you're specifi-
cally creating just a trailer). Why? For the same reason that studios create
trailers after the filming is finished: After you complete your movie, all the clips
will be imported already, and you'll have a better idea of what you want to
include while “teasing” your audience!

Press 38+6 to display the Theme Chooser.
Click a Theme thumbnail to select a theme to apply to your finished movie.

To preview the appearance of a theme, hover your cursor over the thumbnail
and click the Play button that appears.

iMovie automatically adds the transitions and titles that correspond to that theme.

Normally, this is what you want to do. However, you can add transitions and
titles manually, as | show you later in this chapter. So if you decide not to use a
theme out of the gate, you don't have to open the Theme Chooser at all.

Click the Change button.

iMovie adds the new project to the list in the sidebar, and you're on your way!
Check out Figure 14-2: This is the whole enchilada, in one window.
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FIGURE 14-1:
Creating a new
movie project
within iMovie.
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You’ll use these controls and displays most often:

¥ Viewer: Think of this as being just like your TV or computer monitor. Your
video clips, stillimages, and finished movie play here. You also crop and rotate
your video within the Viewer.
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TIP

©

REMEMBER

3 Content Library: This row of buttons allows you to add photos, video clips,
audio and effects such as transitions, titles, music, and sounds.

¥ Libraries List: This sidebar list allows you to display your photos from your
Photos library. (You can also display images from your Aperture library, if you
used this legacy application.) Additionally, the Libraries list displays all the video
clips you can add to your project from events you've imported. The items in the
list change, depending on the type of content you've chosen from the Content
Library. You can also select an existing iMovie project from the iMovie Library.
To hide the Libraries list and make more room for the media pane, click the
Hide button that appears at the top-right corner of the Libraries list. (To display
the Libraries list again, click the same button, which now reads Show.)

You can hide and show both the Content Library and the Libraries list with
one click on the Show or Hide the Media Library button, which appears at the
top left of the iMovie window. By hiding both, you maximize the space
available for your Viewer.

3 Event/Project Library pane: If you select an event from the All Events entry in
the Libraries list, iMovie displays a thumbnail of that event's content in the Event
pane. (Move your cursor over the Event thumbnail to see previews of the clips.)
If you decide you want to include a clip, double-click the Event to display the
clips and add the desired clip to your project. This pane also acts as the Project
Library pane, where you can display your existing iMovie projects; click the
Projects entry in the Libraries list to display your projects as thumbnails. To load
a project, just double-click the thumbnail and it appears in the Project pane.

The Event/Project Library pane displays different content, depending on the
entry you select in the Libraries list.

¥ Project pane: This pane is where most of your work gets done within iMovie,
displaying the elements you added to that specific project (such as video clips,
still photos, and audio clips). Your movie appears as a linear strip of thumb-
nails, making it easy to select, insert, and delete elements.

¥ Playhead: The white vertical line you see in the Project pane (or the red
vertical line you see in the Event/Project Library pane) is the playhead, which
indicates the current editing point while you're browsing your clips or creating
your movie. When you're playing your movie, the playhead moves to follow
your progress through the movie.

¥ Toolbar: This strip of buttons allows you to enhance and adjust photos and
video clips.

Those are the major highlights of the iMovie window. A director’s chair and
megaphone are optional, of course, but they do add to the mood.
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A Bird's-Eye View of Moviemaking

I don’t want to box in your creative skills. After all, you can attack the moviemak-
ing process from a number of angles. (Pun, unfortunately, intended.) However,
I’ve found that my movies turn out best when I follow a linear process. So before
I dive into specifics, allow me to give you an overview of moviemaking with

iMovie.

Here’s my take on the process, reduced to seven basic steps:

1.

2.

NoO v oA

has no Save item? iMovie automatically saves your project as you work, leaving

Import your video clips from your camcorder, your MacBook's FaceTime HD
camera, your Photos Library, or your hard drive.

Drag your new selection of clips from the Event pane to the Project pane, and
arrange them in the desired order.

Import or record audio clips (from iTunes, GarageBand, or external sources,
such as audio CDs or audio files you've recorded yourself), and add them to
your movie.

Import your photos (directly from Photos or Apple's legacy Aperture applica-
tion, or your hard drive), and place them where needed in your movie.

Add professional niceties, such as voiceovers, transitions, effects, and text, to
the project.

Preview your film, and edit it further if necessary.

Share your finished film with others through the web, email, your Apple TV, or
an iOS device (an iPhone, iPad, or iPod Touch), or within iMovie Theater. If you
have a MacBook with an optical drive — or an external USB optical drive — you
can also use a DVD recording application to create a DVD movie disc using your
exported movie. | use (and recommend) Toast 16 Titanium from Roxio, at www .
roxio.com.

Wondering how you save your project in iMovie — especially when the File menu

you free to concentrate on your moviemaking art.

TIP

Importing the Building Blocks

Sure, you need video clips to create a movie of your own, but don’t panic if you
have a small supply. You can certainly turn to Apple’s other digital media applica-
tions for additional raw material. (See, I told you that whole “integration” thing

would come in handy.)
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TIP

Along with video clips you import from your DV camcorder, your MacBook’s trusty
built-in FaceTime HD camera (or an external webcam), and your hard drive, you
can call on Photos (as well as the legacy applications iPhoto and Aperture) for the
still images you’ll need for your credits. On the audio side, you can call on iTunes
and GarageBand for background audio and effects. In this section, I show you how.

Pulling in video clips

Your MacBook comes equipped with extras that come in handy for video editing —
a large internal drive and ports to connect stuff. Depending on the MacBook model
you’re using and your external devices, you may use a USB, Thunderbolt or (on
older MacBooks) a FireWire connection. Today’s mass-storage camcorders, tablets,
and smartphones use a USB connection to transfer clips. I cover both older tape-
based camcorders and USB/Thunderbolt mass-storage devices in this section.

Oh, and don’t forget that your MacBook has a FaceTime HD camera on board,
ready to record clips. Heck, you’re a self-contained movie studio!

Here’s the drill if your clips are on your FireWire mini-DV camcorder or mass-
storage USB/Thunderbolt video device:

1. Plug the proper cable into your MacBook.
2. Set the camcorder to VTR (or VCR) mode.
Some video devices call this Play mode.

3. Clickthe Import button at the upper left of the iMovie window (refer to
Figure 14-2).

iMovie opens the Import window.

4, Open the Import To pop-up menu at the top of the Import window, and
choose the destination for your new video clips.

To create a new event for the imported clips, choose New Event. Alternatively,
you can import into an existing Event or iMovie project. If your family reunion
spanned more than one day, you can create a new Event for each day. (How do
they think up these things?)

5. Click the desired video source in the Source list at the left side of the
Import window.

If you're using a tape-based camcorder, playback controls appear under the
Camera Import window, mirroring the controls on your camcorder. This allows
you to control the unit from iMovie. Keen! If you're using a mass-storage
camcorder connected by USB, you instead get an Import All button beneath
the thumbnails of available clips. (Note that this button changes to Import
Selected if you select one or more of the clips.)
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If you choose your FaceTime HD camera from the list, you see a real-time
preview and a big red Record button. Click the Record button to start and stop
recording. (You can skip the rest of the steps in this section, which deal only
with USB/Thunderbolt and FireWire camcorders.)

6. To import selected clips from your FireWire DV camcorder, advance the
video to a couple of seconds before the point where you want to start
your capture; then click Import.

7. click OK, and admire your handiwork.

iMovie begins transferring the footage to your drive and automatically adds
the imported clips to the specified destination.

including those in high-definition video (HDV) format. iMovie also recognizes a

If your clips are already on your drive, rest assured that iMovie can import them,
number of other video formats, as shown in Table 14-1.

TIP
TABLE 14-1 Video Formats Supported by iMovie
File Type Description
DV Standard 4:3 digital video

DV widescreen Widescreen 16:9 digital video

MOV QuickTime movies

HDVand AVCHD  High-definition (popularly called widescreen) digital video, in 720p and 1080i

MPEG-2 Digital video format used for DVD movies

MPEG-4 A popular format for streaming Internet and wireless digital video, as well as handheld
iOS devices such as the iPad, iPhone, and iPod Touch

To import a movie file, follow this bouncing ball:

1. click the Import button on the toolbar.

2. Click the drive that stores your clips in the window's sidebar, and
navigate to their location.

3. Select the desired clips in the list.

4. Fromthe Import To pop-up menu at the top of the Import window,
choose the destination within iMovie.

5. click Import.

Alternatively, you can also drag a video clip from a Finder window and drop it in
the Project pane.
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Making use of still images

Still images come in handy as impressive-looking titles or as ending credits to
your movie. (To be truly professional, make sure you list a gaffer and a best boy. 1
have no idea what they do, but they’re always listed.) You also can use still images
to introduce scenes, close scenes, and separate clips. For example, I use stills
when delineating the days of a vacation within a movie or different Christmas
celebrations over time.

Here are two methods of adding stills to your movie:

3 Adding images and video clips from Photos, iPhoto, or Aperture: Click the
Photos, iPhoto, or Aperture Library entries in the Libraries list to access your
images, right from iMovie (as shown in Figure 14-3). When you find the image
you want to add, just drag it to the right spot in the Project pane.

3 Importing images from your hard drive: If you're a member of the International
Drag-and-Drop Society, you can drag TIFF, JPEG, GIF, PICT, PNG, and PSD images
directly from a Finder window and drop them into the Project pane.

[ ] < Projects. (28 4 Mark's Epic Winter Story

My Media
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FIGURE 14-3: IR TR TR TR TR T,
Pulling still e - - ik i i
images from
Photos is child's

play.

Importing and adding audio
from all sorts of places

You can pull in everything from Wagner to Weezer as both background music and
sound effects for your movie. In this section, I focus on how to get those notes into

iMovie and then how to add them to your movie by dragging them to the Project
pane.
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You can add audio from a number of sources:

3 Adding songs from iTunes and GarageBand: Click the Audio media button
in the Content Library and click the iTunes entry in the sidebar to display the
contents of your iTunes Library. Click the desired song in the scrolling list
(which displays all your music). To display a playlist or Smart Playlist, click the
Music dropdown list box above the waveform display. Figure 14-4 illustrates a
playlist of Frank Sinatra | selected for this project. You can add a track to your
movie by dragging any song entry from the list to the desired spot in the
Project pane.

Mark's Epic Winter Story

FIGURE 14-4:
Calling on my
iTunes Library to
add Ol Blue Eyes
to my iMovie.

L g g

You're not limited to iTunes for ear candy, however. If you exported any
original music you've composed in GarageBand to your iTunes Library, you
can use those songs in your movie. Click the GarageBand button in the
sidebar to view your GarageBand music, and then drag and drop to your
heart's content.

¥ Adding sound effects: If you need the sound of a horse galloping for your
Rocky Mountains vacation clips, click the Audio button in the Content Library,
then click Sound Effects in the sidebar. iMovie includes a number of top-shelf
audio effects you can use in the sound effects audio track in the Project pane.
This way, you can add sound effects even when you've already added a
background song. Again, to add a sound effect, drag it to the perfect spot in
the Project pane.
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If you have several gigabytes of music in your iTunes Library, it might be more
of a challenge to locate Janis Joplin's rendition of “Me and Bobby McGee,”
especially if she's included in a compilation. Let your supercomputer do the
digging for you! Click in the Search box above the track list (which carries the
familiar magnifying glass icon), and begin typing a song name. iMovie narrows
down the song titles displayed to those that match the characters you type. To
reset the search box and display all your songs in the Library or selected
playlist, click the X icon that appears to the right of the box.

3 Recording directly from a microphone: Yep, if you're thinking voiceover narra-

tion, you've hit the nail on the head. Check out the following sidebar for the scoop.

NARRATION THE EASY WAY

Ready to create that award-winning nature documentary? You can add voiceover narra-
tion to your iMovie project that would make Jacques Cousteau proud. In fact, you can
record your voice while you watch your movie playing, allowing perfect synchronization
with the action! To add narration, follow these steps:

. PressV to display the Voiceover controls under the Viewer.

. Click the Voiceover Options button, and select the input device.

Today's MacBook models sport a decent internal microphone, but you can always
add a USB microphone to your system.

3. Drag the input volume slider to a comfortable level.

. To mute the audio from your movie (which may make it easier to concentrate

on your narration), select the Mute Project check box.

. Click in the desired spot within your movie in the Project pane where the

narration should begin.

. Click the Start Recording button.

iMovie prompts you with three tones before the playhead reaches the selected spot
in your movie, so make sure you begin speaking after the third tone.

. Watch the video while you narrate so you can coordinate your narration track

with the action.

. Click the red Stop Recording button to stop recording.

iMovie adds an icon to the Project pane under the video with the voiceover.

. Click the Close button in the Voiceover controls.
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Building the Cinematic Basics

It’s time to dive in and add the building blocks to create your movie. Along with
the video clips, audio tracks, and still images you’ve imported, you can add
Hollywood-quality transitions, optical effects, and animated text titles. In this
section, I demonstrate how to elevate your collection of video clips into a real-life,
honest-to-goodness movie.

Adding clips to your movie

You can add clips to your movie via the Project pane and Event/Project Library
pane (refer to Figure 14-2). The Dynamic Duo works like this:

¥ Project pane: This displays the media you've added to your project so far,
allowing you to rearrange the clips, titles, transitions, and still images in
your movie.

3 Event/Project Library pane: This pane acts as the source repository for all
your clips, displaying them arranged by Event (the date they were shot or
imported) or by Project (media you've added to existing iMovie projects).

Typically, you add a clip to your movie from an Event. Follow these steps:

1. click the My Media button in the Content Library.

. Click the All Events entry in the Libraries list.

3. Move the cursor across clips in the Event pane to watch a preview of the
video.
4

. When you've decided what to add to your project, either add the entire
clip or a selection:

To select an entire clip: Right-click the clip’s thumbnail and choose Select
Entire Clip from the menu that appears.

To select a portion of a clip: Click and hold, and then drag the cursor across
the thumbnail. A yellow frame appears around your selection. To change
the length of the selected video, hover the cursor over either end of the
clip and drag the handle that appears on either side. If you make a mistake
while selecting video, just click any empty space within the Event pane to
remove the selection frame and try again.

5. Drag the selection from the Event pane to the spot where it belongs in
the Project pane.

Alternatively, you can press the E key.
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Preview your work — and do it often.™

iMovie includes a Play Full Screen button, which appears at the right corner of the
Viewer. (Alternatively, press 8+Shift+F or choose View«> Play Full Screen to watch
the selection.) Press the spacebar to pause, and press Esc to return to iMovie. Of
course, you can also move the cursor across the filmstrip in the Project pane to
quickly browse your project.

To play a selection from the beginning, press \ (the backslash). If you’ve ever
watched a director at work on a movie set, you may have noticed that he or she
constantly watches a monitor to see what things will look like for the audience.
You have the same option in iMovie!

Marking clips

While you’re watching video in the Event/Project Library pane, you may decide
that a certain clip has a favorite scene or that another clip has material you don’t
want, such as Uncle Ed’s shadow puppets. (Shudder.) iMovie features Favorite and
Rejected frames, allowing you to view and use your best camera work (and ignore
the worst stuff).

To mark a great video clip as a Favorite, select and right-click a range of frames
or the entire clip in the Event/Project Library pane, and then select the Favorite
menu item (or press F). To mark clips that are subpar, select the offending clip in
the Event/Project Library pane and press Delete (or right-click and choose Reject).
Clips marked as Favorites have a green line on top of the clip, and clips marked as
Rejected have a red line.

You can use the Search Filter option to specify which types of marked clips are
shown: Click the pop-up menu next to the Search field at the top of the Event/
Project Library pane. Your options include displaying all clips, displaying just
Favorite clips, hiding Rejected clips, or displaying just Rejected clips.

If you decide that a Rejected clip isn’t so bad after all or that a Favorite really isn’t

your best work, no problem. Unmark any selected Favorite or Rejected scene in the
Event/Project Library pane by choosing Mark+ Unrate (or just press U).

Removing clips from your movie

Don’t like a clip? Bah. To banish a clip from your movie, follow these steps:
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1. click the offending clip in the Project pane to select it.

Alternatively, you can select a portion of a clip by holding down the mouse
button (or maintaining pressure on the trackpad) and dragging the selection
box that appears.

2. PressDelete.
This deletes the clip from the Project pane, but the clip is still available if you

choose All Events or the iMovie Library from the Libraries list.

If you remove the wrong clip, don’t panic. Instead, use iMovie’s Undo feature
(press 38+Z) to restore it.

Reordering clips in your movie

If Day One of your vacation appears after Day Two, you can easily reorder your
clips and stills by dragging them to the proper space in the Project pane. When you
take your finger off the mouse (or trackpad), iMovie automatically moves aside
the rest of your movie with a minimum of fuss and bother.

Editing clips in iMovie

If a clip has extra seconds of footage at the beginning or end (as it should, to
ensure you get all the action), you don’t want that superfluous stuff in your mas-
terpiece. Our favorite video editor gives you the following basic functions:

¥ Crop: Removes unwanted material from a video clip or still image
¥ Rotate: Rotates a clip or image on its center axis

3 Trim: Trims frames from a video clip

Before you can edit, however, you have to select a section of a clip:

1. clicka clip or image in either the Project pane (where changes you make
are specific to this project) or the Event pane (where edits you make are
reflected in any project using that footage).

iMovie displays the clip or image in the monitor.

2. Toselect the entire clip or image, simply click it.
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3. Drag the cursor across the thumbnail to select the section of the media
you want to edit.

Some editing functions, such as Crop and Rotate, automatically apply to the
entire clip.

The selected region is surrounded by a yellow frame. You're ready to edit that
selected part of the clip.

4. When you move the cursor to the beginning or end of the selection,
handles appear. You can make fine changes to the selected section by

TIP

©

REMEMBER

dragging the handles.

To crop: Click the Crop button in the toolbar at the top of the Viewer. Drag
the edges of the frame using the handles to select the section you want to
keep. To preview your selection, click the Play button that appears when
you move the cursor into the Viewer pane. When you're ready, click the
Done button (which bears a check mark), and everything but the selected
region is removed.

To rotate: Click the Crop button. Now you can click one of the two rotation
buttons that appear at the right side of the Viewer (both of which carry a
box and curved arrow icon). Each click rotates the media 90 degrees in the
indicated direction. Click the Done button (with the check mark) when the
clip or image is properly oriented.

To trim: Right-click the selection, and choose Trim to Playhead from the
context menu. iMovie removes the frames up to the playhead position
from the selected video.

Transitions for the masses

Many iMovie owners approach transitions as visual bookends: They merely act as
placeholders that appear between video clips. Nothing could be further from the
truth, though, because judicious use of transitions can make or break a scene. For
example, which would you prefer after a wedding ceremony — an abrupt, jarring
cut to the reception, or a gradual fadeout to the reception?

Because today’s audiences are sensitive to transitions between scenes, you should
try not to overuse the same transition. Pick two or three that match the mood of
your film and the scenes between which you’re transitioning. Also carefully weigh
the visual impact of a transition. You might even decide that having no transition
is the most effective (directors call this deliberate lack of a transition a jump cut).

iMovie includes a surprising array of transitions, including old favorites (such
as Fade In and Dissolve) and some nifty stuff that you might not be familiar
with (such as Cube and Page Curl). To display your transitions collection (see
Figure 14-5), click the Transitions entry in the Content Library.
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FIGURE 14-5:
Add transitions
for flow between
clips in iMovie.
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To see what a particular transition looks like, click the thumbnail to select it and
move the cursor over the thumbnail to display the transition in the Viewer.

Adding a transition couldn’t be easier: Drag the transition from the thumbnail
list, and drop it between clips or between a clip and a still image in the Project
pane. In iMovie, transitions are applied in real time.

Even Gone with the Wind had titles

The next stop on the iMovie Hollywood Features Tour is the Titles list, shown in
Figure 14-6. You find it by clicking the Titles entry in the Content Library. You can
add a title with a still image, but iMovie also includes everything you need to add
basic animated text to your movie.

Most of the controls you can adjust are the same for each animation style. You can
change the font, the size of the text, and the color of the text. To add a title manu-
ally, follow these steps:

1. select a Title animation thumbnail from the Titles list, and drag it to the
desired spot in the Project pane.
Note that the title is previewed in the Viewer as well as in the Project pane.
2. Click the title strip in the Project pane to select it.

3. Click the Title Settings button (which bears a capital T symbol) in the
toolbar to make any changes to the fonts or text attributes.

4. Click in the text box within the Viewer to delete the default text and type
your own titles.
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Click the Done (checkmark) button to save your changes.
Click the Play button in the Viewer to preview your title.

iMovie displays a preview of the effect in the Viewer with the settings you
choose.

Adding maps and backgrounds

iMovie includes easy-to-use animated maps — think Indiana Jones traveling by
airplane from place to place — and static backgrounds that can be used with your
titles. To display them, click the Backgrounds entry in the Content Library.

To use an animated map, follow these steps:

1.
2.
3.

4.

Drag one of the globe or map thumbnails to the Project pane.
After the globe or map is created, click it in the Project pane to select it.

Click the Map Settings button (which bears a globe icon) and then click
the Start Location button (and, optionally, the End Location button) to
enter the start and stop points for the animation.

Type a city or place name to see your choices. (Heck, you can even type an
airport code or decimal coordinates to specify the spot.)

Click Done, and watch as iMovie animates your location (or your trip) in
seconds!

To add a static background from the browser, drag it to the desired spot within the
Project pane.
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HAVE A SEAT IN THE IMOVIE THEATER

After you produce a great movie, what's the easiest way to watch it? Or how can you
quickly and easily share that movie with your other iOS devices and your Apple TV? The
answer is iMovie Theater mode, where you can add completed movies, trailers, and indi-
vidual video clips — and everything is shared automatically using iCloud! (Any Mac or
iOS device with iMovie installed also includes its own iMovie Theater, and the stuff you
add appears there.)

Suppose you just want to present your content on your own MacBook — or on a projec-
tor or external monitor you've connected to your computer. Press the 3 key to display
thumbnails of the content you've shared to the Theater. You don't have to load a fin-
ished movie project in Library mode. Double-click any thumbnail to view that item. To
switch back and work on your current iMovie project, click the Projects button at the top
of the window (or press the 2 key).

To add a movie, trailer, or video clip in the Event/Project Library pane, click the item to
select it, click the Share button at the top right corner of the iMovie window and click the
Theater button.

Creating an Honest-to-Goodness
Movie Trailer

Yes, friends, you read that correctly: iMovie includes a Trailer feature that can
turn your film clips into a Hollywood-class preview, complete with genre transi-
tions and background music.

To create a trailer project, follow these steps:

1 . Click File=> New Trailer (or click the Create New button and choose
Trailer from the pop-up menu).

2. Click a Movie Trailer thumbnail to select it.

If you hover the cursor over the thumbnail and click the Play icon that appears,
iMovie displays a nifty preview of the trailer style you selected. You can click
different thumbnails to preview their look before you decide. Naturally, you
want to choose a trailer style that most closely matches the mood you want to
project with your movie.

Note that each trailer has a suggested number of cast members. This number
reflects the number of people who will appear in the clip placeholders during
the editing process. (More on this in a moment.)
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3. Click Create.

iMovie replaces the Project pane with the Trailer pane, as shown in Figure 14-7.
You can fine-tune your trailer with the Outline, Storyboard, and Shot List tabs:

Outline: On the Outline tab, you can edit the titles used in the trailer, as
well as pop-up lists of information, such as the names of the star(s) and the
logo style you want for your “studio” at the beginning of the trailer. To
change a text field, click in it and type the new text. You see the changes
you make in the Trailer display appear in the Viewer in real time.

Storyboard: After you complete your edits to the titles, click the Storyboard
tab. Now you can edit the text for each transition: Simply click the text to
display the edit box, and type. You can also drag clips from the Event pane
(or from a Finder window) to fill the storyboard's placeholders for video
clips. To delete a clip from the storyboard, click it to select it, and press

Delete.
To preserve the look and feel of the trailer storyboard, try to match your
clips with the description and suggested activity indicated by the place-
holder. (In other words, don't stick a wide-angle video clip of the family dog
TIP cavorting in the yard into a placeholder marked “Closeup.” You get the
idea.)
The Storyboard tab may not look like an editing timeline, but you can move
the cursor anywhere within the storyboard to preview your trailer. The
playhead indicator appears wherever the cursor appears, allowing you to
TIP watch the clip or transition it's resting on. You'll soon be sweeping the

cursor to the left or right to move through each section of your trailer.

Shot List: For an overall listing of each clip required for the full trailer, click
the Shot List tab. On this tab, clips are organized by type. For example, all
the action clips appear in one section, and all the landscape and close-up
clips are grouped as well. If necessary, you can also add, delete, or swap
video clips from the Shot List.

To preview your trailer in its entirety, click the Play button at the bottom of the
Viewer (or the Play Full-Screen button at the far right of the Viewer controls).
Naturally, any storyboard placeholder you haven’t filled with a clip displays just
the placeholder.

Note that iMovie displays your trailer when you click the Updated Projects entry in
the Libraries list, and it now appears in the Event/Project Library pane.

I bet all those hard-working Hollywood video editors are fuming at how easy it is
to create a trailer in iMovie!
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Sharing Your Finished Classic with Others

Your movie is complete, and iMovie has saved it automatically to your drive. Now
you’re wondering where to go from here. Select your movie in the Event/Project
Library pane, and click Share at the top right corner of the window. iMovie can
unleash your movie on your unsuspecting family and friends (and even the entire
world) in a number of ways:

¥ iTunes: Send your movie to your iTunes Library as a movie.
3 Theater: Add your movie to the iMovie Theater on your MacBook.

3 YouTube/Facebook/Vimeo: Why, certainly you can send your iMovie directly
to any of these websites! Can it get any more convenient than that? (I think
not.)

¥ File: Create a copy of your movie on your hard drive in one of four resolutions
(from Standard Definition to High Definition).

3 Email: Send your movie as an email message attachment.

When you choose a sharing option, iMovie displays the video quality for the
option and makes automatic changes to the movie attributes. (For example,
choosing Email reduces the finished movie as far as possible in file size.)

If you're worried about permanently reducing the quality of your project by
sharing it in a smaller size, fear not! When you choose a sharing option to
export your movie, your original project remains on your hard drive,

REMEMBER unchanged, so you can share a better-quality version at any time in the future.
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IN THIS CHAPTER

» Navigating the GarageBand window

» Adding tracks and loops to your song

» Repeating loops and extending your
song

» Building arrangements
» Adding effects to instruments
» Exporting your work across the globe

» Burning your song to an audio CD

Chapter 15

Recording Your Hits
with GarageBand

o you dream of making music? I've always wanted to join a band, but I

never devoted the time it takes to learn the guitar. You know the drill: Rock

stars struggle for years to master an instrument, practice for untold hours
and memorize chords. Wait a second, I almost forgot. You don’t need to do any of
that now!

Apple’s GarageBand lets a musical wannabe (like yours truly) make music
anywhere with a MacBook — complete with a driving bass line, funky horns, and
perfect drums that never miss a beat. In fact, the thousands of prerecorded loops
on tap in this awesome application allow you to design your music to match that
melody running through your head, from techno to jazz to alternative rock.

This chapter explains everything you need to know to create your first song. I also
show you how to import your hit recording into iTunes so that you can listen to it
on your iPhone with a big silly grin on your face (as I do) or add it to your next
iMovie project or Photos slideshow.
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Don’t be too smug when you think of all that practicing and hard work you missed
out on. What a shame!

Shaking Hands with Your Band

FIGURE 15-1:
The GarageBand
window.

As you can see in Figure 15-1, the GarageBand window isn’t complex, and that’s
good design. In this section, I list the most important controls so you know your
Play button from your Loop Browser button.

Forward Media Browser
Rewind Playhead View/Hide Loop Browser
New Track Button Play Time/Tempo Volume Slider

il |

Classic Electric Piano.

« 0

Controls ~ £Q

Track List Timeline

Your music-making machine includes

¥ Track list: In GarageBand, a track is a discrete instrument you set up to play
one part of your song. For example, a classical piece for string quartet would
have four tracks — one each for violin, viola, cello, and bass. The Track list
contains all the tracks in your song, arranged so you can easily see and modify
them, like the rows in a spreadsheet. A track begins in the list, stretching out
to the right all the way to the end of the song. In the upper left of Figure 15-1,
| already have one track defined — a Classic Electric Piano.
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Timeline: This scrolling area holds the loops (see the next bullet) you add,
compose, or record, allowing you to move and edit them easily. When a song
plays, the Timeline scrolls to give you a visual look at your music. (Bear with
me; you'll understand that cryptic statement in a page or two.)

Loop: Loops — prerecorded clips of an instrument being played in a specific
style and tempo — are the building blocks of your song. Most are five seconds
in length, and others are even shorter. You can drag loops from the Loop
Browser to a track and literally build a bass line or guitar solo. Loops can also
be repeated within a track, which | discuss further in a page or two. (Note that
loops have not been added yet in Figure 15-1 - you'll see them later.)

Playhead: This vertical line is a moving indicator that shows you the current
position in your song while it scrolls by in the Timeline. You can drag the
playhead to a new location at any time. The playhead also acts like the
insertion cursor in a word processing application: If you insert a section of a
song or a loop from the Clipboard, it appears at the playhead'’s current
location. (More on copying and inserting loops later, so don't panic.)

New Track button: Click this button to add a new track to your song.

View/Hide Loop Browser button: Click the button with the loop icon to
display the Loop Browser at the right side of the window (as shown in

Figure 15-1); click it again to close it. You can see more of your tracks' contents
at one time without scrolling by closing the Loop Browser.

View/Hide Media Browser button: Click this button (which bears icons of a
filmstrip, camera, and musical note) to display the Media Browser at the right
side of the window; click it again to close it (and see more of your tracks). Use
the Media Browser to add media (in this case, digital song files or movies) to
your GarageBand project for use as ringtones.

Go to Beginning button: Clicking this button returns the playhead to the
beginning of the Timeline. (Note that this button appears only when the
playhead isn't already at the beginning of the Timeline — hence, it doesn't
appear in Figure 15-1.)

Rewind/Forward One Measure buttons: To move quickly through your song
by jumping to the previous or next measure, click the corresponding button.

Play button: Hey, old friend! At last, a control you've probably used countless
times before — and it works just like the same control within iTunes or on
your audio CD player. Click Play, and GarageBand begins playing your entire
song. Notice that the Play button turns green. To pause the music, click Play
again; the button loses that sexy green sheen, and the playhead stops.

Time/Tempo display: This cool-looking LCD display shows you the current
playhead position in seconds.
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You can click the drop-down menu at the right of the display to switch
between a beats and time display.

3 Volume slider: Here's another familiar face. Just drag the slider to raise or

lower the volume.

Of course, more controls are scattered around the GarageBand window, but these
are the main controls used to compose a song — which is the next stop!

Composing Made Easy

284

In this section, I cover the basics of composition in GarageBand, working from the
very beginning. Follow along with this running example:

1.

2.

Click the GarageBand icon in the Dock; it looks like an electric guitar and
an amplifier.

If GarageBand opens a window for a previous project, close it by clicking
the Close button in each window.

GarageBand displays the top-level New Project dialog, as shown in Figure 15-2.
Click New Project from the list at the left.

Click the Empty Project icon, and click the Choose button.

GarageBand displays the Track Type dialog.

Click the Software Instrument icon.

In this chapter, | focus on using software instrument tracks, which are the
easiest for a non-musician to use (and don't require you to actually play any
notes on an instrument).

Click the Create button.

You see the window shown in Figure 15-1. Now you're ready to add tracks.

Adding tracks

Although I’m not a musician, I am a music lover. I know that many classical
composers approached a new work in the same way you approach a new song in
GarageBand — by envisioning the instruments they wanted to hear. (I imagine
Mozart and Beethoven would’ve been thrilled to use GarageBand, but I think they
did a decent job with pen and paper.)
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If you’ve followed along to this point, you’ve noticed these things:

3 A Musical Typing keyboard in your GarageBand window: You can record
the contents of a software instrument track by playing the Musical Typing
keyboard layout. (As you might imagine, this isn’t the best solution.) If you're a
musician, the best method of recording your own notes is with a MIDI
instrument, which | discuss later in the chapter. You can display the Musical
Typing keyboard window at any time by pressing $8+K. If the keyboard
window is onscreen and you don't need it, banish it by pressing $8+K or by
clicking the Close button in the keyboard window.

¥ The example song with only one empty track: If you want to write the next
classical masterpiece for Classic Electric Piano, that's fine. (I'm a big fan of this
instrument, so I'll use this track later in the example.) Note that you can always
delete a track completely, however. Click the offending track to select it, and
choose Track = Delete Track from the GarageBand menu bar.

You can use five kinds of tracks in GarageBand:

¥ Software instrument tracks: These tracks aren't audio recordings. Rather,
they're mathematically precise algorithms that your MacBook renders (builds)
to fit your needs. If you have a MIDI instrument connected to your laptop, you
can create your own software instrument tracks. (More on MIDI instruments
later in this chapter.)

¥ Real instrument tracks: These tracks are actual audio recordings, such
as your voice or a physical instrument without a MIDI connection. (Think
microphone.)
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3 Electric Guitar and Bass tracks: GarageBand includes a real instrument
track especially made for either an electric guitar or bass. This allows you to
use a number of different amplifiers and stompboxes (those effect pedals that
electric guitarists are always poking with their foot to change the sound of
their instruments).

3 Drummer track: | call this feature “Ringo in a Box” — a drum track that's
automatic, yet very configurable and easy to customize. You have presets
galore, so you can quickly jump into different drum sets and playing styles.

¥ Movie tracks: The video sound track appears if you're scoring (adding music
to) an iMovie movie — you also get a cool companion video track that shows
the clips in your movie. (More on this in the “Look, I'm John Williams!” sidebar
later in this chapter.)

It’s time to add a software instrument track of your very own:

1. Press $8+Option+N (or click the New Track button).
GarageBand displays the New Track sheet.

2. Click the Software Instrument icon and then click Create.

3. Click the new track (the second in the list) to select it.

4. Fromthe Library pane on the far left, choose the general instrument
category you want.

| chose Guitar, which prompts a second list of choices to the right, still in the
Library pane.

5. From the second list, choose your specific style of weapon, such as Classic
Clean for a simple playing style.

Figure 15-3 shows the new track that ends up in your list when you follow
these steps. Now you're ready to rock with both the original electric piano and
an electric guitar! If you like, you can hide the Library by clicking the Show/Hide
Library button at the upper-left corner of the window.

GarageBand includes a Songwriter project (also available from the top-level New

@ Project dialog; refer to Figure 15-2). When you choose a Songwriter project,

GarageBand presents you with a full set of instrument tracks, plus areal instrument

TIP track for your voice. You’re instantly ready to start adding loops and recording
your own voice!
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FIGURE 15-3:
The new track
appears, ready

to rock.
Choosing loops
After you have a new, empty track, you can add loops to build your song from the
Loop Browser. Apple gives you thousands of loops to choose from, in a mind-
boggling variety. Click the Loop Browser button (which bears a loop symbol,
somewhat like a roller coaster; refer to Figure 15-1) to display your collection, as
shown in Figure 15-4.
FIGURE 15-4:
The Loop
Browser is a great
hangout for any Bifte e
musician.
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Looking for just the right loop

The running project already includes two tracks but no loops yet. (Refer to
Figure 15-3.) Just for grins, add a Classic Electric Piano loop. Follow these steps to
search through the loop library for just the right rhythm:

1. Inthe Loop Browser, click the Instrument tab and click the button that
corresponds to the instrument you're using.

| chose the Elec Piano button.

A list of different beats appears in the pane at the bottom of the Loop Browser
window. (Refer to Figure 15-4.)

2. Click one of the loops with a green musical-note icon.

Go ahead; this is where things get fun! GarageBand begins playing the loop
nonstop, allowing you to get a feel for how that particular loop sounds.

The examples | chose for this chapter are software instruments, which are
identified by a green musical-note icon. (If you have a MIDI instrument that you

play, have at it with real instrument loops.)
REMEMBER

3. Click another entry in the list, and the application switches to that loop.

Now you're beginning to understand why GarageBand is so cool for both
musicians and the note-impaired. It's like having your own band, with mem-
bers who never get tired, never miss a beat, and play whatever you want while
you're composing. (Mozart would've loved this.)

If you want to search for a particular instrument, click in the Search box near
the top of the Loop Browser, and type the text you want to match. GarageBand
returns the search results in the list.

TIP

4. scroll down the list, and continue to sample the different loops until you
find one that fits like a glove.

For this reporter, it's Upbeat Electric Piano 01; refer to Figure 15-4.

5. Drag the entry to your Classic Electric Piano track, and drop it at the very
beginning of the Timeline (as indicated by the playhead).

Your window looks like Figure 15-5.

loops to that track. (More on extending that beat in the next section.) However, if
you want the piano’s beat to change later in the song, you add a second loop after
TP the first one in the same track. For now, leave this track as is.

‘ If you want that same beat throughout the song, you don’t need to add any more
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FIGURE 15-5:
Atrack with a
loop added.
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Whoops! Did you do something you regret? Don’t forget that you can undo most
actions in GarageBand by pressing the old standby $8+Z immediately afterward.

Second verse, same as the first

When you compose, you can add tracks for each instrument you want in your
song:

¥ Each track can have more than one loop.

3 Loops don't have to start at the beginning; you can drop a loop anywhere in
the Timeline.

For example, you might prefer to start a song with just your drum kit, with your
bass line beginning some time later (for a funkier opening).

You put loops on separate tracks so they can play simultaneously on different
instruments. If all your loops in a song are added on the same track, you hear only
one loop at a time, and all the loops use the same software instrument. By creating
multiple tracks, you give yourself the elbow room to bring in the entire band at the
same time. It’s {iber-convenient to compose your song when you can see each
instrument’s loops and where they fall in the song.

Click the Reset button in the Loop Browser (which carries an X icon) to choose
another instrument or genre category.
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LOOK, I'M JOHN WILLIAMS!

You too can be a famous composer of soundtracks . . . well, perhaps not quite as
famous as Mr. Williams, but even he had to start somewhere. To add a GarageBand
score to an iMovie, choose Track > Show Movie Track from the GarageBand menu bar
to display the Movie track. Now choose File =>Movie => Open Movie, select the movie,
and click Open.

At this point, you add and modify instrument tracks and loops just as you would with
any other GarageBand project — GarageBand displays a video preview within the Movie
track. When you click the Play button, the video is shown as well so that you can check
your work and tweak settings (as described later in the chapter).

After you finish composing, choose File &> Movie = Export Audio to Movie. You can spec-
ify the name, location and quality of the new movie file. Note that you can't edit your fin-
ished movie file using iMovie again, so scoring should always be the last step in your
filmmaking process.

Resizing, repeating, and moving loops

If you haven’t already tried listening to your entire song, try it now. You can click
Play at any time without wreaking havoc on your carefully created tracks. Sounds
pretty good, doesn’t it?

But wait: I bet the song stopped after about five seconds, right? (You can watch the
passing seconds using either the Time/Tempo display or the second rule that
appears at the very top of the Timeline.) I’'m sure you want your song to last more
than five seconds! After the playhead moves past the end of the last loop, your
song is over. Click Play again to pause the playback; then click the Go to Beginning
button (shown in Figure 15-1) to move the playhead back to the beginning of
the song.

The music stops so soon because your loops are only so long. As mentioned earlier,
most loops are five seconds in length, and others are even shorter. To keep the
groove going, you must do one of three things:

¥ Resize the loop. Hover the cursor over either the left or right edge of most
loops, and an interesting thing happens: The cursor changes to an icon
representing the left or right edge of the loop, with arrows pointing both ways.
That's your cue to click and drag — and as you drag, some loops expand to fill
the space you're making, repeating the beats in perfect time. By resizing a
loop, you can literally drag the loop's edge as long as you like.
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FIGURE 15-6:
By repeating a
loop, you can
keep the notes
flowing.

Q

TIP

REMEMBER

3 Repeat the loop. Depending on which loop you chose, you might find that
resizing it doesn't repeat the measure. Instead, the new part of the loop is
simply dead air. In fact, the length of many loops is limited to anywhere from
one to five seconds. However, if you move the cursor over the corner of a loop
you want to extend, it turns into a vertical line with a circular arrow, which tells
you that you can click and repeat the loop. GarageBand actually adds multiple
copies of the same loop automatically, for as far as you drag the loop. In
Figure 15-6, you can see how | repeated the Upbeat Electric Piano 01 loop.

¥ Add a new loop. You can switch to a different loop to change the music’s
flow. Naturally, the instrument stays the same, but there’s no reason you can't
use a horn-riff loop in your violin track (as long as it sounds good played by a
violin)! To GarageBand, a software instrument track is compatible with any
software instrument loop you add from the Loop Browser, as long as that
loop is marked with your old friend, the green musical note.

Classie Electrie Plano.
" 0 O

Classic Clean

Controls ~ EQ

You can also use the familiar Cut (38+X), Copy (38+C), and Paste (38+V) editing
keyboard shortcuts to cut, copy, and paste loops both on the Timeline and from
track to track. And you can click a loop and drag it anywhere.

A track doesn’t have to be filled for every second with one loop or another. Most

of my songs have a number of repeating loops with empty space between them as
different instruments perform solo.
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Each track can be adjusted so you can listen to the interplay between two or more
tracks or hear how your song sounds without a specific track:

3 Mute a track: Click the tiny speaker button under the track name in the list,
and the button turns blue to indicate that the track is muted. To turn off the
mute, click the speaker icon again.

3 Change the volume or balance of a track: Use the mixer that appears next
to the track name. This comes in handy if you want an instrument to sound
louder or confine that instrument to the left or right speaker.

Using the Arrangement track

GarageBand includes another method you can use to monkey with your music: Use
the Arrangement track to define (or mark) specific sections of a song, allowing you
to reorganize things by selecting, moving, and copying entire sections. For exam-
ple, you’re probably familiar with a song’s chorus (or refrain) and how often it
appears during the course of the tune. With the Arrangement track, you can repo-
sition the entire chorus within your song, carrying all the loops and settings
within the chorus along with it. If you need another chorus, just copy that
arrangement.

To use the Arrangement track, display it by choosing Track=> Show Arrangement
Track from the GarageBand menu bar. The Arrangement track then appears as a
thin strip at the top of the Track list. Click the Add Marker button (the circular
button bearing a plus sign) at the right side of the Arrangement track, and you see
a new marker appear, as shown in Figure 15-7. You can drag the right side of the
Arrangement marker to the left or right to resize it, or drag it to move it anywhere
in the song.

To rename an Arrangement marker, click the current name to display the menu of
@ existing marker names, click Rename, type a new name for the marker in the text
box, and press Return. (You can also choose one of the existing names from the

TIP menu.) In Figure 15-7, you can see the first marker is named Intro.

Now, here’s where Arrangement markers get cool:

3 To move an entire Arrangement marker: Click anywhere in the marker's
title bar (except the title itself), and drag it anywhere you like in the song. (You
can hold down Shift while clicking multiple contiguous markers to select more
than one.)
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FIGURE 15-7:

| just added a
new marker in
my song's
Arrangement
track.

Arrangement
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Track  Master

JLLLEEUNEDNNERN RN RRRN|

3 To copy an Arrangement marker: Hold down the Option key, and drag the
desired marker's title to the spot where you want the copy to appear.

3 To empty the regions in an Arrangement marker: Select it, and press
Delete. To completely delete the marker, press Delete a second time.

Tweaking the settings for a track

You don’t think that bands like Rush and U2 just “play and walk away,” do you?
No, they spend hours after their recording session is over, tweaking their music in
the studio and on the mixing board until every note sounds just as it should. You
can adjust the settings for a track, too. The tweaks you can perform include adding
effects (pull a Hendrix by adding echo and reverb to your electric guitar track) and
kicking in an equalizer (for fine-tuning the sound of your background horns).

To make adjustments to a track, follow these steps:

1 . Click the desired track in the track list to select it.

2. Click the Smart Controls button at the top left of the GarageBand window
(labeled in Figure 15-1).

You can also press B to hide or display the Smart Controls pane.
3. Click the Controls tab to show the settings shown in Figure 15-8.

Note that the settings you see will vary according to the type of instrument
track you've selected.

CHAPTER 15 Recording Your Hits with GarageBand 293



4. Click the knob control or slider for a specific effect to change the sound.

GarageBand offers a Visual Equalizer window you can use to create a custom
equalizer setting for each track. From the Smart Controls pane, click the EQ
button. To change the Bass, Low Mid, High Mid, or Treble setting for a track,
TP click and drag the equalizer waveform in the desired direction. And yep, you

can do this while your song is playing, so you can use both your eyes and ears
to define the perfect settings!

5. Click the Smart Controls button (or press B) to return to GarageBand.

Arrongement

==—  Classic Electric Piano
# 0 &

Classic Clean

d}’ 0

FIGURE 15-8:
Finesse your tune
by tweaking the
sound of a
specific track.

Time for a Mark’s Maxim:

Save your work often in GarageBand. One power blackout, and you'll never for-
give yourself. When you’re pleased with the progress you’ve made in your proj-
ect, press 38+S and enjoy the peace of mind (and use Time Machine with an

vmark's  external backup drive for good measure).™
MAXIMS

If your MacBook is equipped with a Touch Bar, you can conveniently control a
number of features within GarageBand. The shortcuts include standard controls

(like Play and Record), quick movement throughout your project and editing using

TIP Smart Controls. You can even use the Touch Bar as a simple musical keyboard, or
a set of drum pads! The GarageBand Help system contains all the specifics on
Touch Bar operation; simply click Help in the GarageBand menu and type Touch
Bar into the Search box.
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JOIN IN AND JAM ... OR TALK!

GarageBand is even more fun if you happen to play an instrument! (And yes, I'm
envious, no matter how much | enjoy the techno and jazz music | create. After all, take
away my MacBook, and I'm back to playing the kazoo — at least until | absorb all the
Learn to Play lessons for the guitar. More on Learn to Play in the next sidebar.)

Most musicians use MIDI instruments called controllers to play music on the computer.
That pleasant-sounding acronym stands for Musical Instrument Digital Interface. A wide
variety of MIDI controllers is available these days, from traditional MIDI keyboards to
more exotic fun, such as MIDI saxophones. For example, Apple sells a 37-key MIDI
keyboard from iRig for around $150. Alternatively, the highly recommended Casio
CTX-3200 offers 61 keys, and it's available online for about $130. (Both keyboards
connect to your trusty MacBook using a USB cable.)

If you have an older instrument with traditional round MIDI ports — you'll never confuse
them with USB connectors — you need a USB-to-MIDI converter. You can find this type
of converter for around $50 on websites catering to musicians.

You can also connect microphones or traditional electric instruments into your
MacBook for use with GarageBand - you'll need an audio interface, which feeds the
signal from these traditional sources into your laptop through the USB port.

After your instrument is connected, you can record tracks using any software
instrument. Create a new software instrument track as | demonstrate in this chapter,
select it, and play a few notes. Suddenly you're playing the instrument you chose! If
nothing happens, check the MIDI status light — which appears in the Time display — to
see whether it blinks with each note you play. If not, check the installation of your MIDI
connection, and make sure you've loaded any required drivers, as well as your MIDI
settings within QuickTime and the input settings in the System Preferences Sound pane.

Drag the playhead to a beat or two before the spot in the Timeline where you want your
recording to start. This gives you time to match the beat. Then click the big red Record
button and start jamming! When you're finished, click the Play button to stop recording.

Sharing Your Songs

After you finish your song, you can play it whenever you like through GarageBand.
But then again, that isn’t really what you want, is it? You want to share your music
with others on an audio CD or download it to your iPod so that you can enjoy it
yourself while walking through the mall.
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HEY, GARAGEBAND, TEACH ME HOW
TO PLAY!

In the early days of GarageBand, you were limited to creating music. And if you were a
non-musician like yours truly, GarageBand had no practical use as a tool for teaching
yourself how to actually play an instrument.

Ah, but Apple’s addition of Learn to Play actually turns GarageBand into your private
video tutor for basic piano and guitar! From the New Project dialog (refer to Figure 15-2),
click the Learn to Play entry in the list on the left to display your guitar and piano les-
sons. Right out of the box, you have a solid introduction to both instruments. You can
also download more lessons — which cover more advanced topics such as fingering
and chords — for each instrument from the Lesson Store (available from the New
Project dialog). Your onscreen instructor can even record what you play.

In fact, GarageBand includes the How Did | Play feature, which can pinpoint the portions
of a lesson you played correctly and which spots in the song you need to work on.

('m told musicians call such trouble spots flubs. Having no musical talent whatsoever,
anything | attempted to play would be one giant flub.) To try How Did | Play, open your
favorite lesson, click the Record button (with the red dot in the center), and begin
playing. To stop recording, click the Play button. Now you can see the portions of the
song you played correctly (where the notation area is green) and spots where you, um,
flubbed (the notation area turns red). Oh, and make sure your instrument is in tune,
because even correct notes played on an instrument that's out of tune produce errors
for How Did | Play!

If you find the free Learn to Play lessons valuable, you can move up to the Artist lessons,
which are taught by famous musicians (including favorites of mine such as Alex Lifeson,
John Fogerty, and Sting, who actually teaches you how to play “Roxanne”)!

iTunes to the rescue! As with the other digital lifestyle applications I cover in this
book, GarageBand can share the music you make through the digital hub that is
your MacBook. (You’ll become an iTunes power user in Chapter 12.)

Creating song files and ringtones in iTunes

You can create an AAC song file (or even a ringtone) from any project in just a few
simple steps:

1. Open the project you want to share.

2. Choose Share > Song to iTunes from the GarageBand menu bar.
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TIP

REMEMBER

FIGURE 15-9:
Tweaking
settings for
iTunes audio files.

GarageBand displays the settings you see in Figure 15-9.

To create a ringtone and send it to iTunes, choose Share > Ringtones to iTunes
from the GarageBand menu bar.

3. Cclick in each of the text boxes to type the title, artist name, composer

name, album name, and iTunes playlist for the tracks you create.

You can leave the defaults as they are if you prefer. Each track you export is
named after the song's name in GarageBand.

4. Fromthe Quality pop-up menu, choose the proper audio quality for the

finished file.

The higher the quality, the larger the file.

Click the Share button.

After a second or two of hard work, your MacBook opens the iTunes window
and highlights the new (or existing) playlist that contains your new audio,
whether it be a song or ringtone.

Exporting a project

Sometimes, you’d like to create an audio file from a GarageBand project, but you’d
rather not automatically add that song or ringtone to your iTunes Music Library.
(Perhaps you now have audio proof that a family member does indeed snore.)
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In that case, you can always export a song straight to your hard drive by following
these steps:

1. Open the project you want to export.

2. Choose Share= Export Song to Disk.

3. Type a name for the audio file.

Click the button next to the Save As text box to select a specific location where
the file should be created, or choose a preset from the Where pop-up menu.

4. Fromthe Quality pop-up menu, choose the desired audio quality.
As with sharing a song to iTunes, the higher the quality, the larger the file.
5. click Export.

Burning an audio CD

Ready to create a demo CD with your latest GarageBand creation? If your MacBook
has an internal or external optical drive, follow these steps to burn an audio disc
from within GarageBand:

1. Open the song you want to record to disc.

2. Load ablank disc into your optical drive.

If you see a dialog requesting that you choose an action, click the Ignore
button.

3. Choose Share=>Burn Song to CD.
Note that the CD you create has only one track. To include more tracks on the CD,

share the song to your iTunes Library (as described earlier), create a playlist
containing the desired songs, and burn that playlist within iTunes.
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IN THIS PART ...

Create documents with Apple’s productivity
applications.

Troubleshoot and fix problems with your MacBook.

Expand your MacBook with peripherals, external
drives, and more.

Maintain your MacBook properly for peak
performance.



IN THIS CHAPTER

» Creating a Pages document

» Entering, editing, and formatting text
» Inserting tables and graphics

» Resizing objects

» Checking your spelling

» Printing Pages documents

» Sharing your work

Chapter 16

Desktop Publishing
with Pages

hat’s the difference between word processing and desktop publishing?

In a nutshell, it’s in how you design your document. Most folks use a

word processor like an old-fashioned typewriter, much like I’m using
Microsoft Word right now. (Yawn.)

A desktop publishing application allows far more creativity in choosing where to
place text, how to align graphics, and how to edit formats. I think desktop
publishing is more visual and intuitive, allowing your imagination a free hand at
creating a document.

In this chapter, I show you how to set your inner designer free from the tedious
constraints of word processing. Whether you need a simple letter, a stunning
brochure, or a multipage newsletter, Pages can handle the job with ease — and
you’ll be surprised at how simple it is to use. Plus, Pages is a free download for any
MacBook of recent vintage (and free Apple software is always A Good Thing).
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Creating a New Pages Document

To create a new Pages document, follow these steps:

1. click the Pages icon on the Dock.

If the Pages icon doesn't appear on your Dock, click the Launchpad icon and

then click the Pages icon (which looks like a document and pen). If you haven't
installed the three Apple productivity applications yet — Pages, Numbers, and
Keynote — click the App Store icon in your Dock and download them for free!

2. Click the New Document button at the lower-left corner of the Open
dialog.

Pages displays the Template Chooser window, shown in Figure 16-1.

You can also create a new Pages document at any time from the File menu.
Just choose File => New to display the Template Chooser window.
TIP 3. Inthelist to the left, click the type of document you want to create.

The thumbnails on the right are updated with templates that match your
choice.

4. Click the template that most closely matches your needs.
To start with a blank page, choose the Blank template.

5. Cclick the Choose button to open a new document in the template
you selected.

e- e Choose a Template

Basic E FORSALE i FOUND DOG

For Rent Fiyer Lost & Found Flyer

Miscelaneaus

FIGURE 16-1:
Select a template
from the
Template
Chooser window.

Choose
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Open an Existing Pages Document

Of course, you can always open a Pages document from a Finder window. Just
double-click the document icon. (The All My Files location in the Finder window
sidebar makes it easy to track down a document.) You can also open a Pages
document from within the program. Follow these steps:

1. Launch Pages as described in the preceding section.
2. Press 38+0 to display the Open dialog.

The Open dialog operates much the same as a Finder window in Icon, List, or
Column view mode. To open a document you've already saved in your iCloud
Drive, click the Pages item under the iCloud heading in the sidebar at the left of
the dialog and double-click the desired document thumbnail in the thumbnail
display at the right side of the dialog. To open a document on your internal drive
or network, click the desired location in the Open dialog sidebar. (If you're into
convenience like | am, click one of the locations under the Favorites heading to
jump immediately to common folders like your Downloads or Documents!)

3. Click the desired drive in the Devices list at the left of the dialog, and
then click folders and subfolders until you locate the Pages document.

You can also click in the Search box at the top of the Open dialog and type in a
portion of the document name or its contents.

If you're using Icon view mode (or you're displaying the Preview column in
Column view mode), you can hover the cursor over a document thumbnail and
quickly flip through the different pages by clicking on the left and right arrows
TP that appear. This “find” feature can help you identify a particular Pages

document without even opening it.
4. Double-click the thumbnail (or filename) to load it.

If you want to open a Pages document you've edited in the recent past, things
get even easier. Just choose File => Open Recent, and you can open the docu-
ment with a single click from the submenu that appears.

Pages can open, edit, and save documents created with the Mac version of
Microsoft Word.

REMEMBER

Saving Your Work

Pages fully supports High Sierra’s Auto-Save feature, but you may feel the need to
manually save your work after you finish a significant edit (or if you need to take
a break while designing). If you’re editing a document that has already been saved
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at least once, press 38+S. A new version of the document is saved to its current
location — and you can continue with your work.

However, if you’re working on a new document that hasn’t previously been saved,
follow these steps to save it:

1.
2.
3.

4.

With the Pages document open, press 38+S.
Type a filename for your new document.

Open the Where pop-up menu, and choose a location in which to save the
document.

Note that Pages defaults to your iCloud Drive as the target location. This way,
you can open and edit your Pages document on any Mac or iOS device that
shares the same Apple ID. Alternatively, click the button sporting the down
arrow to expand the Save As sheet. This allows you to navigate to a different
location on your hard drive or network, or to create a new folder to store this
Pages project.

Click Save.

current document to an older version, choose File=> Revert To. Pages gives you the

@ You can create a version of a Pages document by choosing Filec> Save. To revert the

option of reverting to the last saved version, or you can click Browse All Versions
rememser 0 choose from multiple versions of the document.

Touring the Pages Window

304

Before you dive into any real work, let me show you around the Pages window.
You'll find the following major components and controls, as shown in Figure 16-2:

»

»

»

Pages list: This thumbnail list displays all the pages you've created within your
document. (For a single-page document, of course, the Page list contains only
a single thumbnail.) You can switch instantly between different pages in your
document by clicking the desired thumbnail in the list. If the list isn't visible,
click the View button at the left side of the Pages toolbar, and click Show Page
Thumbnails.

Layout pane: This section takes up most of the Pages window. It's where you
design and edit each page in your document.

Toolbar: Yep, Pages has its own toolbar. It keeps all the most common
application controls within easy, one-click reach.
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FIGURE 16-2:

The major points
of interest in the
Pages window.

¥ Inspector: This window extension allows you to quickly switch the appear-
ance of selected paragraphs, characters, and lists (in Format mode) or specify
settings that affect the entire document (in Document Setup mode). You can
hide and display the Inspector from the View menu, or by clicking the Format
or Document buttons on the toolbar.

Toolbar
E]
B
Text Text
» Fill
- Reflection
4321 First Street, Anytown
Curabitur leo $525,000 Opacy, el
Pages List Layout Pane Inspector

Entering and Editing Text

If you’ve used a modern word processing program, you’ll feel right at home typing
within Pages. The bar-shaped text cursor, which looks like a capital letter I, indicates
where the text you enter will appear in a Pages document. To enter text, simply
begin typing. To edit existing text in your Pages document, select and highlight the
text. As you type, Pages replaces the existing text. You can delete text by clicking
and dragging across the characters to highlight them and then pressing Delete.

Using Text, Shapes, and Graphics Boxes

Within Pages, you’ll quickly learn that text, shapes, and graphics appear in boxes,
which can be resized by clicking and dragging one of the handles that appear
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REMEMBER

around the edges of the box. (Click the box to select it and hover the cursor over
one of the square handles; you’ll see that it changes to a double-sided arrow,
indicating that Pages is ready to resize the box.)

You can also move a box, including all the stuff it contains, to another location
within the Layout pane. Click in the center of the box, and drag the box to the
desired spot. Note that Pages displays yellow alignment lines to help you align the
box with other elements around it (or with regular divisions of the page, such as
the vertical center of a poster or flyer).

To select text or graphics within a box, you must first click the box to select it and
then double-click the line of text or the graphic you want to change.

The Three Amigos: Cut, Copy, and Paste

306

REMEMBER

“Hang on, Mark. You’ve covered moving stuff, but what if you want to copy a block
of text or a photo to a second location? Or how about cutting something from a
document open in another application?” Good questions. That’s when you can call
on the power of the cut, copy, and paste features within Pages. The next few
sections explain these actions.

Cutting stuff

Cutting selected text, shapes or graphics removes them from your Pages document
and places that material on your Clipboard. (Think of the Clipboard as a holding
area for snippets of text and graphics you want to manipulate.) To cut, select some
material and choose Edit= Cut or press 38+X.

Copying text and images

When you copy text, shapes, or graphics, the original selection remains untouched,
and a copy of the selection is placed on the Clipboard. Select some material and
choose Edit=> Copy or press 38+C. To copy selected items by dragging, hold down
the Option key while you drag the items to their destination.

If you cut or copy a new selection to the Clipboard, it erases what was there. In
other words, the Clipboard holds only the latest material you cut or copied.
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Pasting from the Clipboard

Wondering what you can do with the stuff that’s stored on the Clipboard? Pasting
the contents of the Clipboard places the material at the current location of the
insertion cursor.

& You must paste the contents before you cut or copy again to avoid losing what’s
on the Clipboard.

WARNING
To paste the Clipboard contents, click the insertion cursor at the location you want
and choose Edit=> Paste or press 38+V.

Formatting Text the Easy Way

If you feel that some (or all) of the text in your Pages document needs a facelift,
you can format that text any way you like. Formatting lets you change the color,
font family, character size, and attributes as necessary.

After the text is selected, you can apply basic formatting in two ways:

¥ Use the Inspector. The Inspector appears at the right side of the Pages
window (refer to Figure 16-2). The controls it displays vary according to the
selection you've made. (Click the Format button on the right side of the
toolbar, which looks like a tiny paintbrush, to display and hide the Inspector.)
Click to select a font control to display a pop-up menu, and then click your
choice. For example, select a portion of text and open the Font Family pop-up
menu to change the font family from vanilla Arial to something more daring.
You can also select characteristics, such as the text's paragraph style, or
choose italic or bold. The Inspector also provides buttons for both vertical and
horizontal text alignment.

3 Use the Format menu. Most controls displayed within the Format section of
the Inspector are also available from the Format menu. Click Format and
hover the mouse cursor over the Font menu item, and you can then apply
bold, italic, and underlining to the selected text. You can also make the text
bigger or smaller. To change the alignment from the Format menu, click
Format, and hover the mouse cursor over the Text menu item.
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Adding a Spiffy Table

©

REMEMBER

TIP

In the world of word processing, a table is a grid that holds text, shapes, and
graphics for easy comparison. You can create a custom table layout within Pages

with a few simple clicks.

Follow these steps:

1.

2.

Here are a few pointers on how to dress up your table and make its data more

Click the insertion cursor at the location where you want the table to
appear.

Click the Table button on the Pages toolbar.

Pages displays thumbnail images of different table styles. You have a selection
of colors. Some tables also include highlighted rows and columns. Use the left
and right buttons to display different styles of thumbnails until you find the
one that's closest to the table you need.

Don't worry if the style isn't exactly right. You can always change the layout by
selecting the table and displaying the Format Inspector, where you can
fine-tune all sorts of font, color, grid, and border options.

Click the style thumbnail to insert the table.

If you need to change the number of rows or columns in your table, Pages
makes it easy. To add or delete rows or columns directly from the table, select
it and click the row and column buttons that appear. (Each bears two horizon-
tal or vertical lines, as shown in Figure 16-3.)

Click within a cell in the table to enter text.
The table cell automatically resizes and wraps the text you enter to fit.

You can paste material from the Clipboard into a table. See the earlier section
“Pasting from the Clipboard"” for details.

attractive and readable:

»

»

Change the borders on a selected cell. Click the Format icon on the toolbar
to open the Inspector, click the Cell tab, and then click the desired button in
the Border section.

Select a range of cells in a table by holding down Shift as you click. Hold down
38 and click to select multiple cells that aren’t contiguous.

Add a background color to selected cells, or fill them with an image for a
background. Click the Cell tab, and then click the Fill section in the Inspector
and choose a type of background.
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FIGURE 16-3:

Use Table
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your table.
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Adding Alluring Photos

TIP

You

can choose between two methods of adding a picture within your Pages

document:

»

»

As a floating object: You place the image in a particular spot, and it doesn’t
move even if you make changes to the text. To add a floating object, drag an
image file from a Finder window and place it at the spot you want within your
document. Alternatively, you can click the Media button on the toolbar, click
Photos, navigate to the location where the file is saved, and click the image
thumbnail. Figure 16-4 shows the Media Browser in action.

Click the magnifying glass icon to search for a specific item using keywords or
by filename.

Note that a floating object (such as a shape or image) can be sent to the
background, where text does not wrap around it. To bring back a background
object as a regular floating object, click the object to select it and choose
Arrange = Bring to Front. (More about background objects later in this
chapter.)

As an inline object: The image flows with the surrounding text as you make
layout changes. To add an inline object, hold down the 38 key as you drag an
image file from a Finder window and place it where you want within your
document. You can also click the Media toolbar button and click Photos to
display the Media Browser. Navigate to the location where the file is saved,
hold down the g8 key, and drag the image thumbnail to the spot where you
want it in the document.
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FIGURE 16-4:
Hey, isn't that the
Pages Media
Browser?
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To resize an image object, click the image to select it and drag one of the selection
handles that appear along its border. (The handles look like tiny squares.) The
side-selection handles drag only that edge of the frame. The corner-selection
handles resize both adjoining edges of the selection frame. Hold down the Shift
key to make the vertical and horizontal proportions remain fixed.

Adding a Background Shape

REMEMBER

To add a shape (such as a rectangle or circle) as a background for your text, follow
these steps:
1. Click the insertion cursor in the location you want.
2. Clickthe Shape button on the Pages toolbar, and choose a shape.
The shape appears in your document.
3. Click the center of the shape, and drag it to a new spot.
Shapes can be resized or moved in the same manner as image boxes. See the

preceding section.

You can type over a shape set as a background. Before you do, though, select the
shape, and choose Arrange+ Send to Back.
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Are You Sure about That Spelling?

©

REMEMBER

Pages can check spelling as you type (the default setting) or after you complete
your document. If you find automatic spell-checking distracting, you should pick

the latter method.

As my technical editor reminds me, spell-checking only confirms that a word
matches an entry in the Pages dictionary, not that it’s the right word for the job!

If you’ve ever “red” a document that someone else “rote,” you understand.

To check spelling as you type, follow these steps:

1.

2.

3.

Click the Edit menu, and hover the cursor over the Spelling and Grammar
menu item.

Choose Check Spelling While Typing from the submenu that appears.

If a possible misspelling is found, Pages underlines the word with a red dashed
line.

Right-click the word to choose a possible correct spelling from the list, or
choose Ignore Spelling if it's spelled correctly.

To turn off automatic spell-checking, click the Check Spelling While Typing
menu item again to deselect it.

To check spelling manually, follow these steps:

1.
2.

3.

Click within the document to place the text insertion cursor where the
spell check should begin.

Click Edit, hover the cursor over the Spelling and Grammar menu item,
and choose Check Document Now from the submenu that appears.

Right-click any possible misspellings, and choose the correct spelling, or
choose Ignore Spelling if the word is spelled correctly.

Printing Your Pages Documents

Ready to start the presses? You can print your Pages document on real paper, of
course, but don’t forget that you can also save a tree by creating an electronic PDF
instead of a printout. You’ll find the PDF dropdown menu at the bottom of the

standard High Sierra Print dialog.
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To print your Pages document on old-fashioned paper, follow these steps:

1. within Pages, choose File > Print.

Pages displays the Print sheet.

N

Click in the Copies field, and enter the number of copies you need.
3. Selectthe pages to print:
To print the entire document, select All.

To print a range of selected pages, select the From radio button and enter
the starting and ending pages.

4. Click the Print button to send the document to your printer.

Sharing That Poster with Others

Besides printing — which is, after all, so very passé these days — you can choose
to share your Pages document electronically via the Internet or your network:

3 Send a Copy: To send a copy of the actual document (which the recipient can
open using Pages on his or her own Mac or iOS device), click Share on the
Pages menu, and hover the cursor over the Send a Copy item. You can send the
document via Mail, Notes, or Messages, or you can make it available through
AirDrop (if the recipient is within range of your MacBook's Wi-Fi signal).

If you decide to send your Pages document as an email attachment, don't
forget that most ISPs have a maximum message size. If your document is too

large, your mail server probably will reject it.
REMEMBER

3 Export: You're not limited to sharing over that Internet thing! Pages can also
export your work directly to your drive in one of six different formats: a PDF
file, a Microsoft Word document, an ePub file (for use with electronic book
apps like iBooks), a document compatible with the previous version of Pages,
a Rich Text Format document, or even plain text. (Remember when everything
was in plain text?) Choose File => Export To, and pick your format; Pages
displays any options you can set for that format. When you're ready, click Next
and select the location where Pages should save the file. Click Export, and sit
back while your favorite desktop publishing application does all the work.

If the recipient of your document doesn't need to edit your work, | recom-
mend creating a PDF file, which keeps your document as close as possible to
how it appears in Pages.

TIP
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» Creating, opening, and saving
spreadsheets

» Selecting cells, entering data, and
editing data

» Formatting cells

» Adding and removing rows and
columns

» Creating simple calculations
» Adding charts to your spreadsheets

» Printing a Numbers spreadsheet

Chapter 17

Creating Spreadsheets
with Numbers

re you downright afraid of spreadsheets? Does the idea of building a budget

with charts and all sorts of fancy graphics send you running for the safety

of the hall closet? Well, good MacBook owner, Apple has again taken
something that everyone else considers super-complex and turned it into
something that normal human beings can use! (Much as Apple did with video
editing and songwriting. Is there any type of software that Apple designers can’t
make intuitive and easy to use?) And Numbers is a free download from the App
Store to boot!

In this chapter, I demonstrate how the Numbers spreadsheet program can help you

organize data and analyze important financial decisions for home and business —
everything from a household budget to your company’s sales statistics!
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Before You Launch Numbers...

In case you’re unfamiliar with applications like Numbers and Microsoft Excel —
and the documents they create — let me provide you with a little background
information.

A spreadsheet organizes and calculates numbers by using a grid system of rows and
columns. The intersection of each row and column is a cell, which can hold either
text or numeric values. Cells can also hold calculations called formulas and func-
tions, which are usually linked to the contents of surrounding cells.

Spreadsheets are wonderful tools for making decisions and comparisons, because
they let you plug in different numbers — such as interest rates or your monthly
insurance premium — and instantly see the results. These are some of my favorite
spreadsheets that I use regularly:

¥ Car and mortgage loan comparisons
¥ Acollege planner

3 My household budget (not that we pay any attention to it)

@ Numbers can open, edit, and save spreadsheets created with Microsoft Excel.

REMEMBER

Creating a New Numbers Document

Like Pages (Apple’s desktop publishing application that I cover in Chapter 16),
Numbers ships with a selection of templates you can modify quickly to create a new
spreadsheet. For example, after a few modifications, you can easily use the Budget,
Loan Comparison, and Mortgage templates to create your own spreadsheets.

To create a spreadsheet project file, follow these steps:

1. click the Launchpad icon on the Dock.
2. Click the Numbers icon.

3. Click the New Document button at the lower-left corner of the Open
dialog that appears.

Numbers displays the Choose a Template window, shown in Figure 17-1. (To
display the Choose a Template window and start a new Numbers project at
any time, just choose File => New.)
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FIGURE 17-1:
Hey, these
templates aren't
frightening at all!

Mortgage Calculator

Team Organization

Choose

4. From thelist on the left, click the type of document you want to create.

The document thumbnails in the center are updated with templates that
match your choice.

5. Cclick the template that most closely matches your needs.

6. Click the Choose button to open a new document using the template you
selected.

Opening an Existing Spreadsheet File

TIP

If you see an existing Numbers document in a Finder window or the All My Files
location (or you find it using Spotlight), just double-click the Numbers document
icon to open it. Numbers automatically loads and displays the spreadsheet.

It’s equally easy to open a Numbers document from within the program. Follow
these steps:

1. From Launchpad, click the Numbers icon to run the program.

2. Press $6+0 to display the Open dialog.

As a MacBook power user running macOS High Sierra, you can save and load
Numbers documents directly to and from your iCloud Drive. All three of
Apple’s productivity applications — Pages, Numbers, and Keynote — feature
an Open dialog that can display the contents of your iCloud Drive as well as
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your laptop's internal drive. If the spreadsheet is stored in your iCloud Drive,
click the Numbers item under the iCloud heading in the sidebar at the left of
the dialog and then double-click the desired document thumbnail.

3. Ifthe document is stored on your MacBook’s internal drive, your net-
work, or one of your Favorites locations click the desired drive or folder
in the sidebar at the left of the dialog. Drill down through folders and
subfolders until you locate the desired Numbers document.

If you're unsure where the document is, click in the Search box at the top of the
Open dialog and type a portion of the document name or even a word or two
of text it contains. Note that you can choose to search your drive, your iCloud
TP Drive, or both.

4. Double-click the spreadsheet to load it.

If you want to open a spreadsheet you’ve been working on over the last few days,
choose File=> Open Recent to display Numbers documents that you’ve worked with

recently.
TIP

Save Those Spreadsheets!

Thanks to the Auto-Save feature in High Sierra, you no longer have to fear losing
a significant chunk of work because of a waning battery or a coworker’s mistake.
However, if you’re not a huge fan of retyping data, period, you can also save your
spreadsheets manually after making a major change. Follow these steps to save
your spreadsheet to your hard drive:

1 . Press 38+S.

If you're saving a document that hasn't yet been saved, the Save As sheet
appears.

N

Type a filename for your new spreadsheet.

3. Open the Where pop-up menu, and choose a location in which to save
the file.

Common locations are your iCloud Drive, Desktop, Documents folder, and
Home folder.

If the location you want isn't listed in the Where pop-up menu, click the
down-arrow button next to the Save As text box to display the full Save As
dialog. Click the desired drive in the Devices list at the left of the dialog

TIP and then click folders and subfolders until you reach the desired location.
Alternatively, type the folder name in the Spotlight search box at the top right,
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and double-click the desired folder in the list of matching names. (As a bonus,
you can also create a new folder in the full Save As dialog.)

4. Click Save.

After you save a Numbers document for the first time, you can create a version of
that document by choosing File=> Save. To revert the current document to an older
version, choose File> Revert To. You can choose to revert to the last saved version,
or you can click Browse All Versions to look through multiple versions of the
document and choose one of those to revert to.

Exploring the Numbers Window

FIGURE 17-2:
The Numbers
window struts

its stuff.

Apple has done a great job of minimizing the complexity of the Numbers window.
Figure 17-2 illustrates these major points of interest:

3 Sheets tabs: Because a Numbers project can contain multiple spreadsheets,
they're displayed in the Sheets tabbed bar at the top of the window. To switch
among spreadsheets in a project, click the desired tab.

3 Sheet canvas: Numbers displays the rows and columns of your spreadsheet in
this section of the window; you enter and edit cell values within the sheet canvas.
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¥ Toolbar: The Numbers toolbar keeps the most common commands you'll use
within easy reach.

¥ Inspector: Located at the right side of the Numbers window, the Inspector
displays editing controls for the object that's currently selected, regardless of
whether it's a selection of text, a table, or a single cell. (If you enter an equals
sign [=] into a cell to create a formula, the Inspector displays the Function list,
where you can specify a calculation that Numbers should perform.)

Navigating and Selecting Cells in a
Spreadsheet

You can use the scrollbars to move around in your spreadsheet, but when you
enter data into cells, moving your fingers from the keyboard is a hassle. Numbers
has various handy navigation shortcut keys you can employ, as shown in
Table 17-1. After you commit these keys to memory, your productivity level will
shoot straight to the top.

TABLE 17-1 Movement Shortcut Keys in Numbers
Left arrow (<) One cell to the left
Right arrow (—) One cell to the right
Up arrow (1) One cell up
Down arrow () One cell down
Home To the beginning of the active worksheet
End To the end of the active worksheet
Page Down Down one screen
Page Up Up one screen
Return One cell down (also works within a selection)
Tab One cell to the right (also works within a selection)
Shift+Enter One cell up (also works within a selection)
Shift+Tab One cell to the left (also works within a selection)
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You can also use the mouse or trackpad to select cells in a spreadsheet:

¥ To select a single cell, click it.

¥ To select a range of adjacent cells, click a cell at any corner of the range you
want and drag in the direction you want.

¥ To select a column of cells, click the alphabetic heading button at the top of
the column.

¥ To select a row of cells, click the numeric heading button at the far left of
the row.

Entering and Editing Data
in a Spreadsheet

After you navigate to the cell in which you want to enter data, you’re ready to type
your data. Follow these steps to enter That Important Stuff:
1. Either click the cell or press the spacebar.

A cursor appears, indicating that the cell is ready to hold any data you type.

2. Enter your data.

Spreadsheets can use both numbers and alphabetic characters within a cell;
either type of information is considered data in the Spreadsheet World.

reemser 3. When you're ready to move on, press Return (to save the data and move
one cell down) or press Tab (to save the data and move one cell to the
right).

Make a mistake? No big deal:

¥ To edit data: Click within the cell that contains the data error (to select the
cell), and then click the cell again to display the insertion cursor. Drag the
insertion cursor across the characters to highlight them, and then type
the replacement data.

¥ To delete characters: Select the cell, and then highlight the characters and
press Delete.
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Selecting the Correct Number Format

After you enter your data (in a cell, row, or column), you might need to format it
so it appears correctly. For example, say you want certain cells to display a specific
type of number, such as a dollar amount, percentage, or date. Numbers gives you
a healthy selection of number-formatting possibilities.

Characters and formatting rules — such as decimal places, commas, and dollar
@ and percentage notation — are part of number formatting. If your spreadsheet
contains units of currency, such as dollars, format it as such. Then all you need to

TIP do is type the numbers, and the currency formatting is applied automatically.

To specify a number format, follow these steps:

1. selectthe cells, rows, or columns you want to format.
2. Click the Format toolbar button.
3. Click the Cell tab in the Inspector.

. From the Data Format pop-up menu, choose the type of formatting you
want to apply, as shown in Figure 17-3.
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Aligning Cell Text Just So

FIGURE 17-4:

Set text
alignment within
acell.

TIP

You can also change the alignment of text in the selected cells. The default align-
ment is flush left for text and flush right for numeric data. Follow these steps:
1. selectthe cells, rows, or columns you want to format.

See the earlier section “Navigating and Selecting Cells in a Spreadsheet” for tips
on selecting stuff.

2. Click the Format toolbar button.

3. Click the Text tab of the Inspector to display the settings shown in
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4. Click the corresponding Alignment button to choose the type of
formatting you want to apply.

You can choose left, right, center, and justified (as well as the defaults of text
left and numbers right). Text can also be aligned at the top, center, or bottom
of a cell.

Do you need to set apart the contents of some cells? For example, you might need
to create text headings for some columns and rows or to highlight the totals in a
spreadsheet. To change such formatting, select the cells, rows, or columns you
want to format, and then open the Font Family, Font Size, or Font Color buttons
on the Text tab.
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Formatting with Shading

FIGURE 17-5:
Adding shading
and colors to
cells, rows, and
columns is easy
in Numbers.

Q

TIP

322

Shading the contents of a cell, row, or column is helpful when your spreadsheet
contains subtotals or logical divisions. Follow these steps to shade cells, rows, or
columns:

1. selectthe cells, rows, or columns you want to format.

2. Click the Format toolbar button.

3. Click the Cell tab of the Inspector.
4

. Click the triangle next to the Fill heading, and choose a shading option
from the Fill pop-up menu.

Figure 17-5 shows the controls for a gradient fill.
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5. click the color box to select a color for your shading.
Numbers displays a color picker (also shown in Figure 17-5).
6. Cclick to select a color.
7. After you achieve the effect you want, click the color box again to close

the color picker.

You can also add a custom border to selected cells, rows, and columns from the
Cell tab. Click the triangle next to the Border heading to select just the right
border.
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Inserting and Deleting Rows and Columns

What’s that? You forgot to add a row, and now you’re three pages into your data
entry? No problem. You can easily add — or delete — rows and columns. First,
select the row or column adjacent to where you want to insert (or delete) a row or
column, and do one of the following:

3 For a row: Right-click and choose Add Row Above, Add Row Below, or Delete
Row from the shortcut menu that appears.

3 For a column: Right-click and choose Add Column Before, Add Column After,
or Delete Column from the shortcut menu that appears.

If you select multiple rows or columns, right-click and choose Add. Numbers
inserts the same number of new rows or columns you selected.

You can also insert rows and columns via the Table menu at the top of the Num-
bers window.

The Formula Is Your Friend

It’s time to talk about formulas, which are equations that calculate values based on
the contents of cells you specify in your spreadsheet. For example, if you desig-
nate cell A1 (the cell in column A at row 1) to hold your yearly salary and cell B1 to
hold the number 12, you can divide the contents of cell A1 by cell B1 (to calculate
your monthly salary) by typing this formula into any other cell:

=A1/B1

Formulas in Numbers always start with an equals sign, and they may include one
or more functions as well. A function is a preset mathematical, statistical, or engi-
neering calculation that will be performed, like figuring the sum or average of a
series of cells.

“So what’s the big deal, Mark? Why not use a calculator?” Sure, you could. But
maybe you want to calculate your weekly salary. Rather than grab a pencil and
paper, you can simply change the contents of cell B1 to 52, and — boom! — the
spreadsheet is updated to display your weekly salary.

That’s a simple example, of course, but it demonstrates the basics of using
formulas (and the reason why spreadsheets are often used to predict trends and
forecast budgets). It’s the what-if tool of choice for everyone who works with
numeric data.
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To add a simple formula within a spreadsheet, follow these steps:

1. select the cell that will hold the result of your calculation.
2. Type = (the equals sign).
The Formula Box appears within the confines of the cell.

3. Click the Format button on the Numbers toolbar to display the available
functions in the Inspector, as shown in Figure 17-6.
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4. Cclickthe category of calculation you want from the left column of the
Inspector.
Instead of scrolling through the entire function library, it's easier to choose a
category — such as Financial for your budget spreadsheet — to filter the
selection. (Alternatively, you can click in the Search box and type a function
name or keyword.)
To display more information about a specific function, click it in the right
@ column of the Inspector. In Figure 17-6, choosing the SUM function brings up a
- description at the bottom of the Inspector.
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5. nfter you select the perfect function in the right column, click the Insert
Function button.

The function appears in the Formula box, along with any arguments it requires.

In case you're unfamiliar with the term argument, it refers to a value specified in
a cell that a formula uses. For example, the SUM formula adds the contents of
each cell you specify to produce a total; each of those cell values is an argument.
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7.

Click an argument button in the formula, and click the cell that contains
the corresponding data.

Numbers automatically adds the cell you indicated to the formula. Repeat this
step for each argument in the formula.

After you finish, click the Accept button — the green check mark — to
add the formula to the cell.

That’s it! Your formula is now ready to work behind the scenes, doing math for
you so the correct numbers appear in the cell you specified.

Adding Visual Punch with a Chart

TIP

TIP

Sometimes, you just have to see something to believe it, so it can help to use the
data you’ve added to a spreadsheet to generate a professional-looking chart. After
you’ve entered the data you want to chart, follow these steps:

1.

Select the adjacent cells you want to chart by dragging.

To choose individual cells that aren’t adjacent, you can hold down the 8 key as
you click.

Click the Chart button on the Numbers toolbar.
The Chart button bears the symbol of a bar graph.

Numbers displays the thumbnail menu shown in Figure 17-7. Note that you
can display different categories of charts by clicking one of the three tabs at the
top (2D/3D/Interactive), and you can scroll the menu to reveal additional
thumbnails by using the left- and right-arrow buttons.

Click the thumbnail for the chart type you want.

Numbers inserts the chart as an object within your spreadsheet so you can
move the chart. You can drag using the handles that appear on the outside of
the object box to resize your chart.

With your chart selected, click the Format toolbar button to display your old
friend the Inspector, complete with the controls you can use to customize
your chart's appearance. For example, you can change the colors and add (or
remove) the title and legend.

To change the default title, click the title box to select it; click it again to
edit the text.
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Printing Your Spreadsheet

You can easily send a Numbers spreadsheet to a USB or shared network printer
— or, if you’d rather create an electronic copy of the document as an Adobe PDF,
you can click the PDF button that appears on the Numbers Print dialog and select
a location where the file will be saved.

To print a Numbers spreadsheet on your default printer, follow these steps:

1 . Choose File = Print from the Numbers menu bar.

Because a Numbers document can contain multiple spreadsheets, you can
select a specific spreadsheet to print (by clicking it in the grid and clicking the
Print This Sheet radio button at the bottom of the window), or you can print all
spreadsheets in the document (by clicking the Print All Sheets radio button).

2. Click the desired page orientation.

Spreadsheets with a large number of columns are often printed in landscape
orientation to ensure that everything fits on the page. You can also scale the
spreadsheet so it automatically fits on the page by clicking the Fit button (next
to the Content Scale slider).

3. Click Print at the bottom of the window.

Numbers displays the Print dialog. To display additional settings, click the Show
Details button at the bottom of the sheet.
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Click in the Copies field, and enter the number of copies you need.
Select the pages to print:
To print the entire spreadsheet, select All.

To print a range of selected pages, select the From radio button, and enter
the starting and ending pages.

Click the Print button to send the document to your printer.

Click the Share menu item to share your spreadsheet masterpiece with others
(as an actual copy of the document file).
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IN THIS CHAPTER

» Creating a new presentation

» Adding slides

» Using selection boxes

» Entering and editing text

» Formatting text

» Adding presenter’s notes

» Inserting media and shapes
» Running a slideshow

» Printing slides and notes

Chapter 18

Building Presentations
with Keynote

t seems like only yesterday that I was giving business presentations with a

clunky overhead projector and black-and-white acetate transparencies. Fancy

color gradients and animation were unheard of, and the only sound my
presentations made was the droning of the projector’s fan. I might as well have
been using tree bark and chalk.

Thank goodness those “cave painting” days are gone. Cutting-edge presentation
software like Keynote makes slide creation easy and — believe it or not — fun!
This is the application Steve Jobs once used for his Macworld keynotes every year.
So much visual candy is available that you’ll never need to shout to wake your
audience again. Even better, this jewel of an application is a free download from
the App Store!
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In this chapter, I first demonstrate how simple it is to build a stunning Keynote
presentation. Then you can see how to start and control your slide display from
the keyboard (or even your iPhone, iPad, or iPod touch). And don’t forget that
you can print your slides and notes so your audience can keep a copy of your
brilliant work.

Creating a New Keynote Project

Like the other applications in the iWork suite, Keynote begins the document
creation process with a Theme Chooser window. To create a new presentation
project, follow these steps:

1. click the Launchpad icon on the Dock.
2. Click the Keynote icon, which looks like a lectern.

3. Click the New Document button at the lower-left corner of the Open
dialog.

The Theme Chooser window, shown in Figure 18-1, appears. (I have to say that
these are probably the most stunning visual building blocks I've ever seenin a
presentation application.)

4. choose the aspect ratio, using either the Standard or Wide button at the
top of the window.

Although you don't necessarily need to select an exact match for your
MacBook's screen resolution, it's a good idea to select the value closest to
your projector's maximum resolution. If someone else is providing the
projector, the Standard size is the more compatible choice. If you'll present
on a typical high-resolution computer monitor, widescreen provides a better
display. (Of course, nothing's stopping you from creating two documents of
the same presentation, one in Standard ratio and one using Wide ratio. As
the Scouts say, “Be prepared!”)

n

Click the theme thumbnail that most closely matches your needs.

6. Cclick the Choose button to open a new document that uses the theme
you selected.
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FIGURE 18-1:
Select a template
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Chooser window.
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Opening a Keynote Presentation

TIP

If an existing Keynote presentation file is visible in a Finder window, you can
double-click the document icon to open the project. If Keynote is already running,
follow these steps to load a project from within the application:

1. Ppress 38+0 to display the Open dialog.

2. Click the desired drive in the Devices list at the left of the dialog; then
click folders and subfolders until you locate the Keynote project. If the
project is stored in your iCloud Drive, click the Keynote item under the
iCloud heading in the sidebar at the left of the dialog, and then double-
click the desired project thumbnail.

If the project is stored on your hard drive, the All My Files location can quickly
display all your documents. You can jump directly to any location or folder
under the Favorites heading by simply clicking on the entry. Oh, and don't
forget that you can use the Search box at the top of the Open dialog to locate
the document by name or by some of the text it contains.

3. Double-click the filename to load it.
If you want to open a Keynote document you’ve edited in the recent past, things

get even easier! Just choose File=>Open Recent, and you can open the document
with a single click from the submenu that appears.
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Saving Your Presentation

©

REMEMBER

Because Keynote provides full support for the macOS Auto-Save feature, saving
your work often isn’t as critical as it used to be. To safeguard your work in a world
of power failures, though, follow these steps:

1 . Press 38+S.

If you're saving a document that hasn't yet been saved, the familiar Save As
sheet appears.

N

Type a filename for your new document.

3. From the Where pop-up menu, choose a location in which to save the
document.

By default, Keynote saves the project directly to your iCloud Drive (iCloud
appears in the Where pop-up menu), making it available to other Macs and iOS
devices using the same Apple ID. To select a location not available from the
Where pop-up menu, click the button with the down-arrow symbol to expand
the sheet. You can also create a new folder from the expanded sheet.

4. Click Save.

You can create a version of a Keynote presentation by choosing Filew> Save. To
revert the current presentation to an older version, choose File=> Revert To. Key-
note gives you the option of reverting to the last saved version, or you can click
Browse All Versions to browse multiple versions of the presentation and revert to
any saved version.

Putting Keynote to Work

TIP

Ready for the 5-cent tour of the Keynote window? Launch the application and
create or load a project, and you see the tourist attractions shown in Figure 18-2:

¥ Slides list: Use this thumbnail list of all the slides in your project to navigate
quickly. Click a thumbnail to switch instantly to that slide.

The Slides list can also display your project in outline format, allowing you to
check all your discussion points. (This is a great way to ferret out any “holes” in
your presentation’s flow.) While in outline mode, you can still jump directly to
any slide by clicking the slide’s title in the outline. To display the outline,
choose View > Outline. You can switch back to the default Navigator Slides list
by choosing View > Navigator.
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FIGURE 18-2:

The Keynote
window is
dominated by the
Layout pane.

3 Layout pane: Your slide appears in its entirety in this pane. You can add
elements to and edit the content of the slide from the Layout pane.

3 Toolbar: As does the toolbar in Pages and Numbers, the Keynote toolbar
makes it easy to find the most common controls you'll use while designing
and editing your slides. Clicking an icon on the toolbar performs an action, jus
as selecting a menu item does.

3 Presenter Notes pane: You might decide to add notes to one or more
slides — either for your own use or to print as additional information for your
audience. Click the View icon on the toolbar, and select Show Presenter Notes
(or choose View = Show Presenter Notes) to open the Notes pane. This text
box appears under the Layout pane.

¥ Inspector: Keynote displays this pane on the right side of the window when
you click the Format button, allowing you to format selected text and images
on the fly.

Layout Pane Toolbar

t

Creating a Keynote Presentation
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Adding Slides

TIP

Keynote creates a single Title slide when you first create a project. However, not
many presentations are complete with just a single slide! To add more slides to
your project, use one of these methods:

3 Click the Add Slide button on the toolbar.
3 Choose Slide => New Slide.

¥ Press 38+Shift+N.

¥ Right-click an existing slide in the Slides list, and choose New Slide from the
menu that appears.

Keynote adds the new slide to your Slides list and automatically switches to the
new slide in the Layout pane.

Need a slide that’s very similar to an existing slide you’ve already designed?
Right-click the existing slide, and choose Duplicate to create a new slide just like
it. (Consider this cloning without the science.)

To move slides to different positions in the Slides list (that is, to change the order
in your Keynote presentation), drag each slide thumbnail to the desired spot in
the list.

Working with Text, Shapes
and Graphics Boxes

TIP

All the text, shapes, and graphics placeholders on your first Title slide appear
within boxes. Keynote uses these boxes to manipulate text, shapes, and graphics.
You can resize a box (and its contents) by clicking the box and dragging one of the
handles that appear around the edges of the box. (The cursor changes into a
double-sided arrow when you’re “in the zone.”) Side selection handles drag only
the edge of the frame, whereas corner selection handles resize both adjoining
edges of the selection frame.

To keep the proportions of a box constrained, hold down Shift while dragging its
corner handles.
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Boxes make it easy to move text, shapes and graphics together (as a single unit)
to another location within the Layout pane. Click in the center of the box, and drag
the box to the desired spot. Keynote displays alignment lines to help you align the
box with other elements around it (or with regular divisions of the slide, like
horizontal center).

To select a box, click it. To select text, shapes, or graphics within a box (see the
next section), double-click the box.

REMEMBER
When you’re resizing a photo in a box, hold down the Shift key while you drag the
frame. Doing so tells Keynote to preserve the image’s aspect ratio so that the ver-
tical and horizontal proportions remain fixed. You can also flip images horizon-
tally or vertically from the Arrange menu. To delete an image, just click it to select
it and press the Delete key.

Adding and Editing Slide Text

As with Pages, which also uses boxes for text layout, you can add or edit text in
Keynote with ease. For example, say you have a box with the placeholder text
Double-click to edit. Just double-click in that box, and the placeholder text
disappears, leaving the field ready to accept new text. Any new text you type
appears at the blinking cursor within the box.

Here are some additional ways to work with slide text:

3 Add a new text box: Just click the Text button in the Keynote toolbar, and
click one of the sample styles that appear. Your new text box appears in the
middle of the slide.

¥ Edit existing text: Click — using the bar-shaped cursor to select just the right
spot in the text — and drag the insertion cursor across the characters to
highlight them. Type the replacement text, and Keynote obligingly replaces
the old text with the new text you type.

3 Delete text: Click and drag across the characters to highlight them; then
press Delete. You can also delete an entire box and all its contents: Right-click
the offending box, and choose Delete from the menu that appears.

When a box’s contents are just right, and you’re finished entering or editing text,
click anywhere outside the box to hide it from view. You can always click the text
again to display the box later.
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Formatting Slide Text for the Perfect Look

Keynote doesn’t restrict you to the default fonts for the theme you chose. It’s easy
to format the text in your slides — a different font family, font color, text align-
ment, and text attributes (such as bolding and italicizing) — on the fly.

Select the desired text by double-clicking a box and dragging the text cursor to
highlight the characters. Now apply your formatting using one of two methods:

3 The Inspector: The font controls in the Inspector work in one of two ways:
After you've selected text, either click a font control to display a pop-up menu,
or click a button to immediately perform an action. Opening the Font Size
pop-up menu, for example, displays a range of sizes for the selected text. With
a single click of the B (bold) button, add the bold attribute to the highlighted
characters. To create bullets and lists, click the Text tab at the top of the
Inspector.

3 The Format menu: Once you've selected text, the controls on the Keynote
Format menu generally mirror those in the Inspector. To change the align-
ment from the Format menu, click Format and hover the cursor over the Text
menu item. To change text attributes, click Format and hover the cursor over
the Font menu.

Using Presenter’'s Notes in Your Project

As mentioned earlier, you can type presenter’s text notes in the Notes pane. I use
them to display related topic points while presenting my slideshow. However, you
can also print the notes for a project along with the slides, so presenter’s notes are
also great for including reminders and To Do points for your audience in
handouts.

To type your notes, just click within the Notes pane. If that pane is hidden, choose
View=> Show Presenter Notes, or click the View button at the far left of the Keynote
toolbar and choose Show Presenter Notes. When you’re finished adding notes,
click in the Slides list or the Layout pane to return to editing mode.

the Play menu at the top of the Keynote window, choose Rehearse Slideshow,
click the Tools icon at the top right, and select the Presenter Notes check box to

TIP enable it. Now you can scroll through the notes while the slideshow runs! (More
on slideshows in a second.)

‘ To display your notes while practicing, use the Keynote Rehearsal feature. Click
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Every Good Presentation Needs Media

FIGURE 18-3:

It's not just
photos. You can
add audio and
movie clips to a
slide too!

Q

TIP

Adding audio, photos, and movies to a slide is drag-and-drop easy in Keynote!
Simply drag an image, audio, or movie file from a Finder window, and place it at
the spot you want within your document.

You can also use the Media Browser. To do so, follow these steps:
1. click the Media button on the toolbar, and then click the Photos, Music,

or Movies tab to select the desired type.

Keynote displays the contents of your various media collections (such as your
Photos, iMovie, and iTunes libraries).

2. When you find the file you want to add, drag it to the spot you want in
the document.

Figure 18-3 shows the Media Browser in action.
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Having trouble finding that specific photo or movie? Click the Search icon (which
looks like a magnifying glass) at the top-right corner of the Media Browser, and
you can specify a particular filename or keyword.
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Adding a Background Shape

TIP

Text often stands out on a slide when it sits on top of a background shape. To add
a shape (such as a rectangle or circle) as a background for your text, follow these
steps:

1. click the insertion cursor in the location you want.

2. Click the Shape button on the Keynote toolbar, and choose a shape.

The shape appears in your document.

w

Click the center of the shape, and drag it to a new spot.

4. Aswith image boxes, you can resize or move shapes. You can read about
how to do just that in the earlier section “Working with Text, Shapes and
Graphics Boxes.”

5. Whenthe shape is properly positioned and sized, select it, and choose
Arrange > Send to Back.

You want to “send the shape to the back” so that any text you enter sits in front
of the shape, not hidden behind it.

Of course, you're not limited to creating shapes and graphics within Keynote;
consider using an application like Adobe Photoshop or Illustrator to create graph-
ics that you can import into your slides! As mentioned earlier, you can easily drag
and drop your new graphic into a slide from a Finder window.

Creating Your Keynote Slideshow

338

The heart of a Keynote presentation is the slideshow you build from the slides
you’ve created. A Keynote slideshow is typically presented as a full-screen pre-
sentation, with slides appearing in linear order as they are sorted in the Slides list.

You run a Keynote slideshow simply by clicking the Play button on the toolbar or
by choosing Play = Play Slideshow. You can advance to the next slide by clicking,
or by pressing the right bracket key, which looks like this: ].

Of course, other controls are available besides just the ones that advance to the
next slide. Table 18-1 lists the key shortcuts you’ll use most often during a
slideshow.
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TABLE 18-1

TIP

TIP

Keynote Slideshow Shortcut Keys

Key Action

1(right bracket) Next slide

[ (left bracket) Previous slide

Home Jump to first slide

End Jump to last slide

C Show or hide the pointer

number Jump to the corresponding slide in the Slides list
u Scroll notes up

D Scroll notes down

N Show current slide number

H Hide the slideshow and display the last application used (the

presentation appears as a minimized icon on the Dock)

B Pause the slideshow and display a black screen (press any key
to resume the slideshow)

Esc Quit

Keynote offers a number of settings you can tweak to fine-tune your slideshow.
To display these settings, choose Keynote=> Preferences, and click the Slideshow
button in the Preferences window.

If you have an iPhone, iPad, or iPod touch handy, and you’ve installed the iOS
version of Keynote on your device, choose Keynoter> Preferences to display the
Preferences window. Click the Remotes tab to link your device to your laptop and
Keynote. Now you can use your handheld device as a remote during your slide-
show. Sweet!

Printing Your Slides and Notes

I’ll be honest: I don’t print handouts for every presentation I give. However, if
you’re presenting a lengthy slideshow with plenty of information you want your
audience to remember or refer to later, nothing beats handouts that include
scaled-down images of your slides (and, optionally, your presenter’s notes).
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You're not limited to paper, though. You can also use Keynote to create an
electronic PDF (Portable Document Format) file instead of a printed handout,
which your audience members can download from your website. Or, if you’re an
educator with access to an interactive whiteboard (such as a SMART Board), you
can use this cutting-edge technology with Keynote.

To print your slides and notes, follow these steps:

1. within Keynote, choose File => Print or press 38+P.

Keynote displays the Print sheet, shown in Figure 18-4. (Note that some
printer-specific features may be different on your screen.) If necessary, expand
the Print sheet to show all the settings by clicking the Show Details button at
the bottom of the sheet.

2. Click one of the following formats (each format displays a different set of
Layout options):

Slide: Print each slide on a separate page at full size. You can optionally
choose to print the presenter notes for each slide as well.

Grid: Print multiple slides on a page at a reduced size. From the Slides
per Page pop-up menu, specify how many slides Keynote should print on
each page.

Handout: Print a handout with multiple slides per page (and, optionally,
with presenter’s notes). Again, you can choose how many slides appear on
each page.

Outline: Print the contents of your Slides list in Outline view.
3. Selectthe pages to print:
To print the entire document, select the All radio button.

To print a range of selected slides, select the From radio button, and then
enter the starting and ending pages.

4. select or deselect additional options from the Options section.

()]

. Click the Print button to send the job to your printer.

340 PART 5 Getting Productive and Maintaining Your MacBook



FIGURE 18-4:
Keynote offers a
wide range of
printing options
for your slides
and notes.
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You can also send a copy of your finished presentation as an attachment within
Mail or Messages, or you can provide others with a copy through Twitter or
Facebook. Click Share=> Send a Copy to explore your options.
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IN THIS CHAPTER

» Avoiding the blame (righteously)

» Putting basic troubleshooting
precepts to work

» Using Mark’s Troubleshooting Tree
» Getting help for your MacBook

» Running Windows — yes,
Windows — on your MacBook

Chapter 19

When Good Mac
Laptops Go Bad

wish you weren’t reading this chapter.

Because you are, I can only surmise that you’re having trouble with your MacBook,
and that it needs fixing. (The other possibility — that you just like reading about
solving computer problems — 1is more attractive but somewhat more
problematic.)

Consider this chapter a crash course in the logical puzzle that is computer
troubleshooting: the art of finding out What Needs Fixing. I tell you what to do
when you just plain can’t solve the problem yourself.

And then? I expose the BKS (Best Kept Secret) about your MacBook - the feature
that many MacBook owners have never heard of, and would never imagine. I’ll
demonstrate how you can run Windows alongside macOS High Sierra . . . both
cohabitating on your Mac laptop! (Mac purists need read no farther when you get
to this section.)
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One final word: You’re going to encounter a lot of Tips and Mark’s Maxims in this
chapter. I learned all of them the hard way, so I recommend committing them to
memory.

Repeat after Me: Yes, | Am a Tech!

MARK'S
MAXIMS

Anyone can troubleshoot. Believe it, and put these common troubleshooting myths
to rest:

»

»

»

»

»

It takes a college degree in computer science to troubleshoot. Tell that to
my troubleshooting teen. She'll think it's a hoot, because she owns a MacBook,
as well as Apple computers in the classroom, and she fixes minor problems

all the time. You can follow all the steps in this chapter without any special
training.

I'm to blame. Ever heard of viruses? Failing hardware? Buggy software? Any
of those things can cause the problem. It's Mark's Maxim time:

Don’t beat yourself up! Your laptop can be fixed.™

| need to buy expensive utility software. Nope. You can certainly invest in a
commercial testing and repair utility if you like. My favorite is Drive Genius 5
from Prosoft Engineering (www . prosofteng.com), but a third-party utility isn't
a requirement for troubleshooting. (I do, however, consider an antivirus
application a must-have; you should have one already. Hint, hint.)

There's no hope if | can’t fix it. Sure, parts fail and computers crash, but your
Apple Service Center can repair just about any problem. And (ahem) if you
backed up your laptop (as | preach throughout this book), you'll keep that
important data (even if a new hard drive or motherboard is in your future).

It takes forever. Wait until you read the number one rule in the next section;
the first step takes but 10 seconds and often solves the problem. Naturally,
not all problems can be fixed so quickly. But if you follow the procedures in
this chapter, you should fix your MacBook (or at least know that the problem
requires outside help) in an afternoon.

With those myths banished, you can get down to business and start feeling better
soon.
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Step-by-Step Laptop Troubleshooting

In the following sections, I walk you through my should-be-patented Trouble-
shooting Tree, as well as the High Sierra built-in troubleshooting application,
Disk Utility. I also introduce you to a number of keystrokes that can make your
MacBook jump through hoops.

The number one rule: Reboot!

The simple fact is that rebooting your MacBook can often solve a number of
problems. If you’re encountering these types of strange behavior with your laptop,
a reboot might be all you need:

¥ Intermittent problems communicating over a network

¥ Agarbled screen, strange colors, or screwed-up fonts

¥ The swirling Beach Ball of Doom that won't go away after several minutes
¥ An application that locks up

¥ An external device that seems to disappear or can't be opened

To put it succinctly, here’s a modest Mark’s Maxim:

Always try a reboot before beginning to worry. Always.™

MARK'S . .

maxivs  If you’re in the middle of a program, try to save all your open documents before
you reboot. That might be impossible, but try to save what you can.

WHY IS REBOOTING SO DARNED EFFECTIVE?

Rebooting fixes problems because it resets everything. Your network connection, for
example, might be acting up or might have timed out, and rebooting restores it.
Hardware connections are reset when you reboot, which can “magically” bring recalci-
trant external peripherals back to life. Rebooting also fixes problems due to brownouts
or those notorious AC power flickerings you undoubtedly have noticed from time to
time, which can even affect a laptop running on an AC adapter. Such interruptions in
constant juice might not bother you or me (or your less-intelligent toaster), but they can
play tricks on your laptop that rebooting can fix.
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As your first (and best) option for shutting down, click the Apple menu and choose
Shut Down. If you need to force a locked application (one that’s not responding) to
quit so that you can reboot, follow these steps to quash that locked application:

1 . Click the Apple (%) menu, and choose Force Quit.

The dialog shown in Figure 19-1 appears. (Note that you can also press
Option+38+Esc to display the dialog.)

2. Click the offending application and then click the Force Quit button.

eCe Force Quit Applications

If an app doesn't respond for a while, select its
name and click Force Quit.

¥ Grab
#& Photos
@ Safari
@ System Preferences
& Finder
FIGURE 19-1:
Force a
recalcitrant
. . You can open this window by pressing
appllcatlon to Command-Option-Escape. lebinld vl J
take off.

When you get everything to quit, you should be able to click the Apple menu and
choose Shut Down (not Restart) without a problem.

If your MacBook simply won’t shut down (or you can’t get the offending applica-
tion to quit), do what must be done:

1. Pressand hold your laptop’s Power button until it shuts itself off.

You have to wait about five seconds for your MacBook to turn itself off. If
you're using a MacBook Pro with a Touch ID sensor, press and hold the Touch
ID sensor for a count of 5 to 6 seconds instead.

N

Wait about ten seconds.

3. Press the Power button again to restart the computer.
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After everything is back up, check whether the problem is still apparent. If you
use your laptop for an hour or two and the problem doesn’t reoccur, you likely
fixed it!

Special keys that can come in handy

A number of keys have special powers over your MacBook. I'm not kidding! These
keys affect how your road warrior starts up, and they can really come in handy
while troubleshooting.

Using Safe mode

You can use Safe mode to force High Sierra to run a directory check of your boot
drive and disable any login items that might be interfering with your system.
Follow these steps:

1. use the Shut Down menu item from the Apple (8) menu to completely
turn off your laptop.

2. Pressthe Power button to restart the computer.

3. Immediately after you hear the start-up tone, press and hold down the
Shift key (and keep holding it down until you see the boot progress
indicator).

4. After High Sierra completely boots, you're in Safe mode, and you can
check the operation of your MacBook using Disk Utility (or a commercial
utility application).

5. once you're ready to return to normal operation, restart your MacBook
again (this time without pressing the Shift key).

Start-up keys

Table 19-1 provides the lowdown on start-up keys. Hold down the indicated key
either when you push the Power button or immediately after the screen goes blank during
arestart. (As I just mentioned, the Shift key shortcut to Safe mode is the exception;
you should press it and hold it down after you hear the start-up tone.)
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TABLE 19-1 Start-Up Keys and Their Tricks
Key Effect on Your MacBook
C Boots from the CD or DVD that's loaded in your optical drive (if you have one)
Media Eject Ejects the CD or DVD in your optical drive (if you have one)
Option Displays a system boot menu, allowing you to choose any bootable operating system on
your laptop
Shift Boots in Safe mode
T Starts your MacBook in Target Disk mode (using your Thunderbolt or FireWire port)
3B+V Shows macOS Console messages
38+R Boots from the High Sierra Recovery HD volume
38+S Starts your Mac in Single User mode
38+Option+P+R Resets Parameter RAM (PRAM)
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Some of the keys and combinations in Table 19-1 might never be necessary for
your machine, but an Apple technician might instruct you to use them.

All hail Disk Utility, the troubleshooter’s
friend

The High Sierra Disk Utility is a handy tool for troubleshooting and repairing your
MacBook’s drive. You can find it in the Utilities folder in Launchpad.

DANGER, WILL ROBINSON!

Many Disk Utility functions can actually wipe your drives clean of data instead of repairing
them! These advanced functions are unlikely to help you with troubleshooting a problem
with your existing volumes.

Remember: Don't use the following Disk Utility functions unless an Apple technician tells
you to:

® Partitioning and erasing drives

® Adding or deleting APFS volumes

® Restoring files from disk images



Fire up Disk Utility to open the rather powerful-looking window shown in

Figure 19-2.
LN Disk Utility
M~ 5 E 8
View Volume FirstAid Partition Erase Restore  Mount Info
Internal
K . ST31000528AS Media -
|l Wolfgang s ternal Physical Disk « G S .
= ) S ATA Internal Physical Disk « GUID Partition Map - @
& Ludwig
|z Johann
v [0 OM.. =
:7USB DESZTM @ wolfgang ® Ludwig Johann
) ROCKY 2 316 GB 302.13 GB 38173 GB
v [} TOSHBAExiern.. &
] Time Machins... &
Location: Internal | Capacity 178
Connection SATA Child count ]
FIGURE 19-2:
. Partition Map: GUID Partition Map  Type: Disk
The physician of
. . S.M.ART. status: Verified Deavice: disk0
drives: the High
Sierra Disk Utility.

In the left column of the Disk Utility window, you can see

¥ The physical drives in your system (the actual hardware).

¥ The volumes (the data stored on the drives, which appears as a drive icon on
your Desktop).

e You can always tell a volume, because it's indented below the physical drive entry.
6 (If you don't see physical drives and volumes, press $8+2 to show all devices.)

TECH A % Any CD or DVD loaded on your MacBook.

3 USB or Thunderbolt external drives.

For example, referring to Figure 19-2, | have one internal drive (the ST310
entry), one USB 2.0 external hard drive (the Toshiba External entry), and one
USB flash drive (The USB Disk entry). The internal drive has three volumes
(Wolfgang, Ludwig, and Johann), the external Toshiba drive has one volume
(Time Machine), and the USB flash drive has one volume (ROCKY).

The information at the bottom of the Disk Utility window is the specifications for

OLOD,

& the selected drive or volume. This info includes capacity and available space for a
tecunicar  volume, or connection type and total capacity for a drive.

STUFF

Repairing permissions and disks

Disk Utility can check the format and health of both drives and volumes (and
correct any problems it finds) with the First Aid button.
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SO EXACTLY WHAT IS A DISK
PERMISSION, ANYWAY?

Because High Sierra is built on a UNIX base, lots of permissions can apply to the files on
your drive — that is, who can open (or read or change) every application, folder, and
document on your drive. Unfortunately, these permissions sometimes get messed up
by wayward applications or power glitches, or application installers that do a subpar job
of cleaning up after themselves. And if the permissions on a file are changed, applica-
tions often lock up or refuse to run altogether.

If you're an experienced macOS user and you're looking for the old familiar Repair Disk
Permissions button in Disk Utility, let me shorten your search: It no longer exists in High
Sierra! Instead, disk permissions are now automatically checked and repaired as part of
the First Aid process. Progress marches on, but I'll miss that old codger.

(==
v Using Disk Utility to repair your hard drive carries a couple of caveats:

TECHNICAL
STUFF 3 You may not be able to immediately repair problems on your boot drive

or boot volume. This limitation actually makes sense, because you're actually
using that drive and volume right now.

If First Aid finds a problem on your boot drive but reports it can't fix that error,
boot your MacBook from the macOS Recovery HD volume. Reboot and then
hold down the $8+R keyboard shortcut immediately after you hear the
start-up chord. Then run Disk Utility from the window that appears. Because
you've booted your laptop from the Recovery HD volume, you can repair
those problems with your start-up drive. (You should be able to select your
boot hard drive or volume and click the First Aid button.)

3 You can't repair CDs and DVDs. CDs and DVDs are read-only media and thus
can't be repaired (at least by Disk Utility).

If your MacBook is having trouble reading a CD or DVD, wipe the disc with a
soft cloth to remove dust, oil, and fingerprints. Should that fail, invest in a
disc-cleaning contrivance of some sort.

To check and repair problems using First Aid, follow these steps:

1 . Click the Go menu and choose Utilities, then double-click the Disk
Utility icon.

2. In the list at the left side of the Disk Utility window, click the drive or
volume you want to check.
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FIGURE 19-3:
First Aid reports
that this drive is

error-free.

TIP

w

Click the First Aid button, and click the Run button that appears.
4. click Done to exit First Aid.

If changes were made (or if you had to boot from the macOS Recovery HD
volume), Disk Utility may prompt you to reboot after repairs have been made.

Figure 19-3 illustrates the details you’ll see if you click Show Details to expand the
display. Although some of the messages might include cryptic Linux details, you
can still tell from the figure that the operation is successful (and you get that
snazzy green check mark). All is well!

[ N ] Disk Utility

View Volume First Aid Partition Erase Restore Unmount Info

Internal

= ; ST21000528AS M. [ Running First Aid on “Wolfgang”

L First Ald process is complete, click Done to continue. E
& welfgeng — 315.35 GB
=l L J
;: Ludwig
- ¥ Hide Details
Johann _ _
b=l
Checking multi-linked files.
External Checking catalog hierarchy. _
v [T USBDISK2.0 M. |  Checking extended attrioutes fil.
= Checking volume bitmap.
| ROCKY Checking volume information.
—_ The volume Wolfgang appears to be OK
¥ ) TOSHIBAExtern.. | g gustom check exit code s 0.
] Time Machine... | Restoring the original state found as mounted
= Operation successful I
Internal Physical Volume
l ol Enabled
Avallable: 5722 GB (461 MB purgeable] | Connection SATA

Used 31017 GB = Device: disk0s2

Mark’s MacBook Troubleshooting Tree

As hip-hop artists say, “All right, kick it.” And that’s just what my MacBook
Troubleshooting Tree is here for. If rebooting your laptop didn’t solve the prob-
lem, follow these steps in order until you either find the solution or run out of
steps (more on that in the next section).

If you’re not sure quite what’s producing the error, this process is designed to be
linear — followed in order — but if you already know that you’re having a problem
with one specific peripheral or one specific application, feel free to jump to the
steps that concern only hardware or software.
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Step 1: Investigate recent changes

The first step is a simple one that many novice MacBook owners forget. Simply
retrace your steps and consider what changes you made to your system recently.
Here are the most common culprits:

3 Did you just finish installing a new application? Try uninstalling it by
removing the application directory and any support files it might have added
to your system. (And keep your applications current with the most recent
patches and updates from the developer's website.)

3 Did you just apply an update or patch to an application? Uninstall the
application, and reinstall it without applying the patch. If your MacBook
suddenly works again, check the developer's website, or contact the applica-
tion's technical support department to report the problem.

3 Did you just update High Sierra? Updating macOS can introduce problems
in your applications that depend on specific routines and system files. Contact
the developer of the application, and look for updated patches that bring your
software in line with the latest High Sierra updates.

3 Did you just make a change in System Preferences? Return the options
you changed to their original settings; then consult Chapter 5 for information
on what might have gone wrong. (If the setting in question isn't listed in
Chapter 5, consider searching the macOS online Help or the Apple support
website for more clues.)

3 Did you just connect (or reconnect) an external device? Try unplugging
the device and then rebooting to see if the problem disappears. Remember
that some peripherals need certain application software to run; without those
applications installed, they don't work correctly. Check the device's manual or
visit the company’s website to search for software you might need.

If you didn’t make any significant changes to your system before you encountered
the problem, proceed to the next step.

Step 2: Run Disk Utility

The next step is to run Disk Utility and use First Aid. The earlier section “Repair-
ing permissions and disks” shows how to complete this task on your High Sierra
boot drive.

Step 3: Check your cables

Cables can work themselves loose, and sometimes they fail. Check all the cables to
your external devices — make sure that they’re snug — and verify that
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everything’s plugged in and turned on. (Oh, and don’t forget to check for crimps
in your cables or even Fluffy’s teeth marks.)

If a Thunderbolt or USB device acts up, swap cables around to find whether you
have a bad one. A faulty cable can have you pulling your hair out in no time.

Step 4: Check your Trash

Check the contents of the Trash to see whether you recently deleted files or folders
by accident. Click the Trash icon in the Dock to display the contents. If you deleted
something by mistake, right-click the item in the Trash and choose Put Back.

I know this one from personal experience. A slight miscalculation while selecting
files to delete made an application freeze every time I launched it.

Step 5: Check your Internet and network
connections

Now that always-on DSL and cable modem connections to the Internet are the
norm, don’t forget an obvious problem: Your laptop can’t reach the Internet if
your ISP is down or your network is no longer working!

When you’re at home, a quick visual check of your DSL or cable modem usually
indicates whether a connection problem exists between your modem and your
ISP. For example, my modem has a set of informative activity lights that I always
glance at first. However, if your laptop is connected to the Internet through a
larger home or office network, and you can’t check the modem visually, you can
check your Internet connection by pinging www.apple.com:

1. Cclick the Spotlight icon at the right side of the Finder menu bar, and type
Network Utility in the search box.

2. Click the Network Utility entry.

3. Click the Ping button.

4. Enterwww. apple.com in the Address box.

5. click Ping.

You should see successful ping messages. If you don't get a successful ping and
you can still reach other computers on your network, your cable modem, DSL
modem, or ISP is likely experiencing problems. If you can't reach your network
at all, the problem lies in your network hardware or configuration. (In an office
environment, your network system administrator will be happy to help you at
this point, especially if you're blood relatives.)
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Step 6: Think virus

If you’ve made it to this point, it’s time to run a full virus scan. Make sure that
your antivirus application has the latest updated data files. My antivirus applica-
tion of choice is Mac Internet Security X9 from Intego (www.intego.com). I can
also recommend the excellent ClamXAV (www.clamxav.com).

If a virus is detected, and your antivirus application can’t remove it, try quarantin-
ing it instead. This basically disables the virus-ridden application and prevents it

from infecting other files.
TIP

Step 7: Check your login items

High Sierra might encounter problems with applications you’ve marked as login
items in System Preferences. Your account’s login items are applications that run
automatically every time you log in to your MacBook. If one of these login items is
to blame for your laptop’s problems, your MacBook will encounter some type of
trouble every time you log in. (This is usually the case when you receive an appli-
cation error message each time you start the computer.)

To check the boot process, it’s time to use that fancy Safe mode I discussed earlier
in the chapter. Restart your MacBook, and press and hold down the Shift key after
you hear the start-up tone. Login items are disabled when you’re running in Safe
mode, so if your laptop starts up without any errors, you know that one or more
login items are probably to blame.

If your computer starts without problems in Safe mode, the next step is to check
your login items. Restart your MacBook, and make a list of each of the login items
displayed for future reference. Then follow this procedure for each item in the
login list:

1. Open System Preferences, click Users & Groups, and then click the Login
Items button.

2. Select the first item from the list, and remove it.

You can delete the selected item by clicking the Delete button, which bears a
minus sign. (If a recurring error message mentions a specific application that
appears in the Login Items list, that's your likely culprit, so start by deleting that
item.)

w

Restart your MacBook.

4. your laptop is still misbehaving, repeat Steps 2 and 3, and disable a new
login item.
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5. When your MacBook starts up normally, you have discovered the
perpetrator. You'll likely need to delete that application and reinstall it.

Don't forget to add back each of the working login items to the Login Items list
using the Add button (which carries a plus sign)!

Step 8: Turn off your screen saver

The next step is to turn off your screen saver. This remedy is a long shot, but it
isn’t unheard of to discover that a faulty, bug-ridden screen saver has locked up
your MacBook. If you are running a screen saver other than one from Apple, and
your computer never wakes up from Sleep mode or hangs while displaying the
screen saver, you’ve found your prime suspect.

Reboot your MacBook (if necessary), open System Preferences, click Desktop &
Screen Saver, and click the Screen Saver button. Then do one of the following:

3 Switch to an Apple screen saver.

¥ Click the Start After pop-up menu and choose Never.

Step 9: Run System Information

Ouch. You’ve reached the final step, and you still haven’t uncovered the culprit. At
this point, you’ve narrowed the possibilities to a serious problem, such as bad
hardware or corrupted files in your macOS System folder. Fortunately, High Sierra
provides the System Information utility, which displays real-time information on
the hardware in your system. To start System Information, follow these steps:

1. Cclickthe Apple menu and choose About This Mac.
2. Cclickthe System Report button.
3. Cclick each of the Hardware categories in turn, double-checking to make

sure everything looks okay.

You don’t have to understand all the technical hieroglyphics. If a Hardware category
doesn’t return what you expect or displays an error message, though, that’s suspi-
cious. (If your MacBook doesn’t have a specific type of hardware onboard — for
example, an optical drive — you won’t see information in that category.)

The Diagnostics category shows whether your MacBook passed the Power On
self-test.
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Okay, | Kicked It, and It Still Won't Work

Don’t worry, friendly reader. Just because you’ve reached the end of my MacBook
Troubleshooting Tree doesn’t mean you’re out of luck. In the following sections,
I discuss the online help available in macOS and on the Apple website, as well as
local help in your own town.

Local service, at your service

In case you need to take in your MacBook for service, an Apple Store or Apple
Authorized Service Provider is probably in your area. To find the closest service,
launch Safari and visit the Apple website Support page (www.apple.com/support),
then click the Apple Repair link at the bottom of the page.

Always call your Apple service provider before you lug your (albeit lightweight)
laptop all the way to the shop. Make sure you know your MacBook’s serial number
(which you can display in System Information) and which version of macOS you’re
using.

The macOS Help Center

Although most macOS owners tend to blow off the Help Center when the
troubleshooting gets tough, that’s never the best course of action. Always take a
few moments to search the contents of the Help Center by choosing Finder«> Help
to see whether any mention is made of the problem you’ve encountered.

Apple Help Online

If you haven’t visited the Apple MacBook Support site yet, run, don’t walk, to
www . apple.com/support/macbook. There you will find

¥ The latest patches, updates, and tutorials for the MacBook line
3 MacBook and macOS discussion boards, moderated by Apple

¥ Tools for ordering spare parts, checking on your remaining warranty
coverage, and searching the Apple knowledge base

¥ Do-it-yourself instructions (PDF files) that you can follow to repair or
upgrade your MacBook
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And Now. . . Windows?

Okay, I know this is a chapter about what to do if your MacBook misbehaves — so
why am I suddenly talking about Windows? That’s a touch of nerd humor on my
part, because many die-hard Mac fanatics would consider the idea of running
Windows on your MacBook a big step backwards! They’d say, “Mark, why introduce
that misbegotten operating system onto a perfectly good MacBook?”

Well, ignore those naysayers! There’s no need to be furtive about your Windows
yearnings. Although I’'m an enthusiastic Mac owner, I also own two smooth-
running PCs, and all my computers cohabitate quite well in my office. I use
Windows 10 every day for a number of tasks, and some PC software is simply not
available for Macs to run. So, dear reader, what if I told you that both macOS High
Sierra and Windows 10 can live together in peace and harmony, all on the same hard
drive inside your Mac?

In this chapter, I discuss the wonder that is Boot Camp — the free utility included
with High Sierra that allows you to install and run Windows on your MacBook’s
hard drive. I explain how to switch between the two operating systems with a
simple reboot.

Hold on to your hat, MacBook owners: You’re about to take a wild trip that proves
you can indeed have the best of both worlds.

Figuring Out How Boot Camp Works

First, a bit of technobabble, but I promise it’ll be over soon, and I'll try to keep
things from getting too boring. In years past, you may have heard that a Mac
computer couldn’t run Windows out of the box (without expensive hardware or
software), and that Mac software was off-limits to PCs . . . and you’d have heard
correctly, at least for all but the recent history of the Macintosh computer. The
incompatibility was a result of Apple using a series of Motorola processors (CPUs)
that didn’t speak the same language as the Intel CPUs used in PCs. Consider a
person speaking Korean trying to read a book in Arabic, and you get the
general idea.

Then Apple began using Intel processors in Macs, and the ground rules changed.
Apple hardware was suddenly compatible with Windows. All that was needed was
a bridge to help keep both OSes separate on the same hard drive — and Apple
developed Boot Camp. Of course, that bridge works only in one direction because
you still can’t run Macintosh software on a PC. (Go figure.)
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Boot Camp accomplishes this magic by creating a separate Windows partition on
your MacBook’s hard drive. The partition holds all your Windows data, including
the OS, your Windows program files, and the documents you create while running
Windows. Consider this partition as completely separate from your macOS data
even though both partitions exist on the same physical internal drive.

Think of it this way: When you reboot your MacBook using Boot Camp, it’s similar
to changing the station on an FM radio. The hardware is the same, but you switch
to a different station (Windows instead of macOS), and you’re listening to differ-
ent music (country instead of rock). How’s that for a comparison, Dr. Science?

Naturally, you need free space on your MacBook’s hard drive to install Boot Camp.
Apple recommends having 15GB of free space, but I’d bump that up to 40GB.

ware attacks as any other Windows PC. Make sure to invest in quality antivirus

When your MacBook is running Windows, it’s just as susceptible to virus and spy-
and antispyware protection for your Windows side!

WARNING

Boot Camp without backing up your existing data on your MacBook’s internal
drive! I've personally never had a problem with Boot Camp, but there’s always a

warning  first time. In case of catastrophe, you can always use your Time Machine backup
to restore your MacBook’s operating system and all your data — yes, that’s yet
another good reason for you to pick up an external drive and use Time Machine on
your Mac laptop. Back up, brothers and sisters, back up!

‘ Remember what I said about Boot Camp modifying your hard drive? Do not install

Configuring Boot Camp

Installing Boot Camp is surprisingly easy and takes far less time than it takes to
install Windows afterward. Follow these steps:

1. Launch the Boot Camp Assistant.

You can find the Assistant in your Utilities folder, which is in your Applications
folder. I use Spotlight to reach it quickly: Click the Spotlight icon in the Finder
menu bar and type Boot Camp into the Search box, then click the Boot Camp
Assistant entry in the list.

Click the Open Boot Camp Help button on the Introduction screen for addi-
tional tips and documentation that cover the Boot Camp setup process. (You
can also print any part of the Boot Camp Help, which makes handy documen-
TP tation in case you have questions about running Windows that aren't covered

in this section.)
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2. Click Continue on the Introduction screen.
The Boot Camp Assistant Support Software screen appears.

3. Make sure the Download the Latest Windows Support Software from
Apple check box is selected, and click Continue.

Boot Camp Assistant can copy these drivers to a blank CD or DVD or an
external USB flash drive. | think an optical disc (which you can hang on to in
case you need it later) is the easiest choice, but current MacBook models no
longer have an optical drive, so the USB flash drive may be a better choice. You
load this software after your Windows installation is complete, and it provides
all the drivers that Windows needs for your Mac's hardware.

4. choose the size of your Windows partition, and click Create.

Again, you can devote more hard drive space to your Windows partition than
the amount recommended by the assistant, but don't forget this important
fact: What you reserve for use in Windows cannot be used by macOS High
Sierral Therefore, | always suggest a conservative amount. (In other words,
don't devote 300GB of your 500GB drive to your Windows partition because
you'll cramp your style in macQS.)

5. Rebootif required.
You may be prompted to launch the assistant again.
6. Cclick Start the Windows Installer, and then click Continue.

From this point on, you're running the Windows installation program, just as
you would be if you were using a PC. (Well, actually you are using a PC now -
temporarily, anyway.) Follow the onscreen prompts, which differ for each
version of Windows.

When prompted by the Windows Installer to choose the partition to format, choose
the partition named BOOTCAMP. Formatting any other partition likely results in
the loss of all your macOS files and data. (Again, this is why you should always
back up your existing system before putting Boot Camp to work.)

After Windows has been installed, load the disc or USB flash drive you created with
the drivers and support software. Windows should automatically run the Boot
Camp driver installation program for you. After the drivers are in place, you’re
ready to do the Microsoft dance.

Are you moving your stuff from Windows (running on your old PC) to . . . well,
Windows (running on your Mac)? Brings an entirely new meaning to the term
switcher, doesn’t it? If so, the files and folders on your existing PC can be copied
directly to Windows running on your Mac by using the Windows Easy Transfer
utility.
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USING THE BOOT CAMP CONTROL PANEL

Besides the capability to restart your Mac in macOS High Sierra, the Windows Boot
Camp natification icon is also your gateway to a number of other features. Right-click
the icon, and choose Boot Camp Control Panel from the contextual menu to display the
settings; these vary depending on the version of Windows you're using and the type of
Mac you're running. On the Control Panel, you will find these tabs:

® Startup Disk tab: From this tab, which is essentially a Windows version of High
Sierra's Startup Disk pane in System Preferences, you can choose to reboot in
macOS High Sierra by clicking the Mac macOS folder and then clicking Restart.

® Power tab: Specify whether your Mac should restart automatically after a power
failure.

If you make any changes in the Boot Camp Control Panel, click OK to save your changes
and return to Windows.

Switching to Windows

Here are three methods for switching back and forth between your macOS
partition and your Windows partition:

3 From macOS High Sierra: To restart your Mac in Windows, click System
Preferences on the Dock and then click the Startup Disk icon. Click the
Windows partition you created in the list to select it. (The folder icon bears the
Windows logo, and it's labeled Windows as well.) Click Restart, and then click
Restart again when asked for confirmation. Your Mac reboots and loads
Windows, and it continues to run Windows when started or rebooted until
you follow one of the next two methods of returning to macOS.

3 From Windows: Right-click the Boot Camp icon in the notification area at the
right side of your Windows taskbar — it looks like a slanted square — and
choose Restart in macOS from the menu that appears. Again, you'll be asked
to confirm your choice. After you click OK, your MacBook reboots and returns
to High Sierra.

3 During the boot process: Need a temporary fix from your other OS? You can
reboot from either High Sierra or Windows and hold down the Option key
when you see the Apple logo appear. Your MacBook displays a nifty row of
icons, each representing a bootable OS that you can use. To boot macOS, click
the High Sierra partition icon. To choose Windows, click the Windows partition
icon. Note that when you turn on or reboot your Mac, it returns to the OS you
last selected in the System Preferences Startup Disk pane.
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IN THIS CHAPTER

» Adding memory

» Upgrading your hard drive
» Adding USB and Thunderbolt devices

» Reviewing what add-ons are available

Chapter 20

Adding New Stuff
to Your Laptop

o laptop is an island.” Somebody famous wrote that, I'm sure.

Without getting too philosophical — or invoking the all-powerful Internet yet
again — the old saying really does make sense. All computer owners usually add
at least one peripheral (external device), such as a printer, trackball, backup drive,
or scanner. I talk about the ports on your MacBook in Chapter 1. These holes aren’t
there just to add visual interest to the sides of your treasured laptop. I cover your
ports (and what you can plug into them) in detail in this chapter.

But what about the stuff inside your road warrior? That’s where things get both
interesting and scary at the same time. In this chapter, I describe what you can
add to the innards of your computer, as well as how to get inside there if you work
up the courage to go exploring.

CHAPTER 20 Adding New Stuff to Your Laptop 361



More Memory Will Help

Every computer benefits from more memory — and no, there’s no however stuck
on the end of that statement! For once, I’m happy to report, there’s no exception,
no matter what type of computer you own. Hard as it is to believe, just keep in
mind this Mark’s Maxim:

More memory helps. Always.™

MARK'S Period. End of statement. No matter what type of computer you own, how old it is,
or what operating system you use, adding more memory to your system (to the
maximum it supports) significantly improves the performance of your operating
system (and practically every application you run).

Memory maximizes the power of your computer. The more memory you have, the

06“ less data your laptop has to temporarily store on its drive. Without getting into

virtual memory and other techno-junk, just consider that extra memory as extra

tecunica  elbow room for your applications and documents. Believe me, both macOS High
STUFF Sierra and Windows 10 efficiently use every kilobyte of memory you can provide.

If your MacBook is already stuffed full with the maximum amount of memory it
can hold, you can skip this section.

Unfortunately, owners of all the latest MacBook models can skip this section as
well, because these models can’t be upgraded. Because these laptops are sealed
units — literally — you must visit your local Apple hardware technician if your
laptop’s memory malfunctions and needs replacing. The same is true for the
battery in all current MacBook models.

If you’re using an older MacBook with upgradeable memory, read on.

Figuring out how much memory you have

To see how much memory your computer has, click the Apple menu (®) and
choose About This Mac. In the dialog that appears, click the Memory toolbar
button.

Click the Memory Upgrade Instructions link at the bottom of the dialog. macOS
High Sierra automatically opens a Safari browser window with online instructions
on how to upgrade the RAM in your specific MacBook model. If you’re confident
about your technical skills, you can use this documentation as a guide to removing
and installing memory modules, along with the step-by-step procedure described
in the next section.
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While you’re within the confines of the About This Mac dialog, click the Overview
toolbar button to display both the machine speed (processor speed) and the
common identifier that Apple uses to refer to your specific model. For example,
my older MacBook Air has a 1.8 GHz Intel Core i5 processor, and it’s identified as
a mid-2012 model. Write down these two figures. We’'re starting a handy list that
will help you when you order your memory!

How you plan memory upgrades depends on how much memory you want. Most
MacBook owners simply opt to install the maximum amount of memory possible.
So if your 4GB 13-inch non-Retina MacBook Pro is upgradeable to 8GB and it
currently uses the two default 2GB modules supplied by Apple, you can add 4GB of
additional RAM by replacing the existing memory modules with two 4GB memory
modules. At the time of this writing, a 4GB memory module should set you back
less than $40.

I should note that 4GB of memory is certainly acceptable for running the
applications bundled with High Sierra. With that said, these applications will run
significantly faster with 8GB or 16GB instead!

If your primary applications include video editing, game playing, audio
production, or image editing, you can use all the memory your laptop can hold.

In the past, Apple’s prices for upgrade RAM were, well, outrageous (as in, “Boy,
Howdy, I can’t afford that!”). Recently, however, Apple’s prices have become far
more competitive. If you’re interested in comparison shopping, I can heartily
recommend any of these online sources that cater to Mac owners:

¥ MacMall: www.macmall . com
¥ CDW:www.cdw.com/content/brands/apple/default.aspx

¥ Newegg: www.newegg.com

Installing memory modules

I’'m happy to report that adding extra memory to your older laptop is one of the
easiest internal upgrades you can perform. Therefore, I recommend that you add
memory yourself unless you simply don’t want to mess with your laptop’s inter-
nal organs. Your local Apple service specialist will be happy to install new RAM
modules for you (for a price).
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CLIMBING INSIDE YOUR MAC LAPTOP

This section on laptop upgrades is short for a reason: Laptops simply aren't meant to be
disassembled. As | mention several times in this book, internal expansion in older
MacBooks is severely limited. Basically, you can add extra memory and swap out your
drive. Adding memory (on a MacBook that allows it) is easy, but swapping out your hard
drive requires more work and considerable preparation. And you can't make any inter-
nal modifications to the current crop of MacBook models, which are sealed units.
(Breaking in will likely void your warranty.)

WARNING

Therefore, | always recommend that you seek professional servicing when you need to
repair your laptop. For example, if your laptop’s LED screen is cracked or broken, do not
try to fix it yourself! Sure, you might see a number of used LED panels on eBay, but
these parts aren't designed to be easily swapped out, like a desktop computer’s video
card. Besides, if you make a mistake when trying to fix something deep in the bowels of
your laptop, you might end up causing more damage than you repair.

The moral of the story? Let your local Apple dealer’s service technicians perform major
surgery on your laptop, and buy an AppleCare Protection Plan that can cover your
laptop like a blanket for up to three years!

your hardware, buy that individual the proverbial NSD (short for Nice Steak Dinner)
and enlist him or her in your cause. Even if you still do the work yourself, it’s

TIP always better to have a second pair of experienced eyes watching, especially if
you’re a little nervous.

If you have a knowledgeable friend or family member who can help you install

To add memory modules to an older MacBook model, follow these steps:

1. Get ready to operate.
a. Spread a clean towel on a stable work surface, such as your kitchen table.
The towel helps protect your screen from scratches.

b. Find a small Phillips screwdriver. (Some new models use a “star” screwdriver, so
take a second to make sure you're using the right tool!)

¢. Shut down your laptop, and wait at least ten minutes for it to cool down.
d. Unplug all cables from the computer.

2. Closethe computer, and flip it over on top of the towel.
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FIGURE 20-1:
Remove a
memory module
like a pro.

3.

n

Ground thyself!
Check out the nearby “Let's get grounded!” sidebar.
Remove the screws and bottom cover.

Depending on the model, you may have to remove up to ten screws before
you can put aside the cover. Note that some screws may be longer than
others. If so, they must be replaced in the same locations. Place the screws in a
handy plastic bowl for safekeeping. Tah-dah! That wasn't much of a challenge,
was it? Here's your chance to gaze with rapt fascination at a portion of the bare
innards of your favorite computer.

Locate the memory modules in your MacBook’s svelte chassis.
If you're replacing an existing memory module, remove it.

To remove a memory module, gently spread the two tabs at the ends of the socket,
as shown in Figure 20-1. Then lift and slide the module away from the socket.

Save the old module in the static-free packaging that held the new module. Your
old RAM (which you can now sell on eBay) will be protected from static electricity.

Position the new module in the socket.
a. Line up the module’s gold connectors toward the socket at a 25-degree angle.
b. Line up the notch in the module with the matching spacer in the socket.

See what | mean in Figure 20-2.

Press gently but firmly on both ends of the module until the module’s
tabs click into place on both ends of the socket.

Figure 20-3 shows in which direction you should press on the module. If the
module doesn’t seem to fit, make sure once again that the notch on the
module connector lines up with the spacer in the socket. Never attempt to
make it fit through sheer force!

Replace the bottom covers and screws.

To replace the bottom cover, just reverse the steps at the beginning of this list.
(It's rather like changing the oil in my Dad's 1970 Ford pickup truck.)
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inserted inserted

FIGURE 20-2:
Prepare to install
the new module.

FIGURE 20-3:
Press the new
RAM module
into place
until it locks.

Congratulations! You’ve done it. You’re now a MacBook Pro memory guru! To
verify that all is well with your road warrior, boot the computer, click the Apple
menu, choose About This Mac, and then click the Memory toolbar button. Your
laptop should report the additional memory.

LET'S GET GROUNDED!

Follow one cardinal rule when the unguarded insides of any computer are in easy reach:
Always ground yourself before you touch anything! Your body can carry enough static elec-
tricity to damage the circuitry and chips that make up the brains of your older MacBook,
and touching those parts without grounding yourself is an invitation to disaster.

Grounding yourself is easy: Just touch a conductive metal surface (preferably steel)
around your workplace for a few seconds before you dig in. (Don't use something inside
your laptop; use a metal surface outside your MacBook's case.) After you ground your-
self, you can safely handle both your laptop’s internal components and any new hard-
ware components you might be installing (such as memory modules or a hard drive).

If you walk anywhere in the room — hunting for a screwdriver, perhaps, or taking a sip
of liquid reinforcement that you've stashed a comfortable distance away — you must
ground yourself again before you get back to work. Remember: You can pick up a static
charge by simply walking.
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Considering a Hard Drive Upgrade?

TIP

REMEMBER

Asking whether you can upgrade your hard drive is a trick question. Yes, you
certainly can upgrade your hard drive. But before you start cruisin’ the Internet
for a 2TB monster, I have two suggestions:

¥ Don't upgrade your internal hard drive yourself.

3 Be sure you really need a hard drive upgrade.

Apple’s pretty generous when configuring drive storage for its base systems.
Current models run with anywhere from a 128GB solid-state drive to a 1TB
solid-state drive.

Most folks simply don’t need more than 256GB or 500GB of drive space (even with
Windows loaded in a separate partition for use with Boot Camp, which I discuss in
Chapter 19). You’re likely to find that you still have plenty of elbow room on your
drive for a typical family’s needs unless you’re heavily into

¥ Digital video (DV)
¥ Cutting-edge video games

¥ Tons of digital audio or digital photos

If you’re short on drive space, clean up your existing drive by deleting all the crud
you don’t need. This includes game and application demos, duplicate or work
copies of images and documents, archived files you downloaded from the Internet,
and the contents of the Trash. You can read how in Chapter 21.

If you decide that you do need to upgrade your MacBook’s internal drive, I strongly
recommend that you don’t install your new hard drive yourself. Call on the services
of an Apple technician to upgrade your drive!

Ponder your external options

If you find that you do need additional hard drive space, I recommend using an
external drive. Use a high-speed Thunderbolt or USB port to connect a second
hard drive the quick and easy way.

Most of today’s external peripherals don’t even require the driver software that
Mac old-timers remember with such hatred. You simply plug in a Thunderbolt or
USB device, and it works. You can move your external drive between different
Macs with a minimum of fuss and bother. A typical external USB 3.0 hard drive
that holds 1TB costs less than $80.
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An external hard drive can do anything that your internal hard drive can do. You
can boot from it, for example, or install a different version of macOS (great
for beta testers like me). External optical drives work just the same as internal
models; Apple sells an external USB SuperDrive optical drive for the MacBook for
about $80.

Apple’s AirPort Time Capsule unit is an external hard drive with a difference: It
stores the huge Time Machine backup files created by the Macs running High
Sierra on your network, and it uses a wireless connection to transfer data! (In fact,
if you’re thinking of adding a wireless base station to your wired network, your
Time Capsule actually acts as a full AirPort Extreme Base Station, complete with
USB port for connecting a USB printer.) At the time of this writing, Time Capsule
is available with either a 2TB ($299) or 3TB ($399) drive.

One problem with external drives is that data typically transfers more slowly over
a USB connection than via an internal drive. (A Thunderbolt external drive can
actually deliver transfer speeds comparable to your internal drive, but at the time
of this writing, it’s somewhat more expensive than USB hardware.) That’s why
most Mac owners use their external drives to store lesser-used documents and
applications or Time Machine backups. Their favorite applications and often-used
documents are housed on the faster internal drive.

Putting a port to work

A MacBook can carry two kinds of high-speed ports, any of which is a good match
for connecting any external device:

3 USB 2.0/3.0/C: The USB standard is popular because it's just as common in
the PC world as it is in the Mac world. (Most PCs don't have Thunderbolt
ports.) Your MacBook offers a USB-C port (which acts as a USB 3.0 port with
the proper connector, but can also charge the laptop), while older models
usually carry at least two USB 2.0 or 3.0 ports. Hardware manufacturers can
make one USB device that works on both types of computers.

Naturally, USB-C and USB 3.0 offers faster data transfer speeds than the older
USB 2.0 standard. So if your MacBook model sports USB 3.0 or USB-C ports,
you should buy only USB 3.0 external hard drives, DVD recorders, or flash
drives. 'Nuff said.

3 Thunderbolt 1/2/3: A Thunderbolt external drive offers much better perfor-
mance than a USB 3.0 drive. Today’s shiny Thunderbolt drives are getting
cheaper every day. As with USB ports, the higher the version number the
faster the port, so if your MacBook model comes with a Thunderbolt 2 or 3
port, invest in Thunderbolt 2 or 3 peripherals. The MacBook Air and MacBook
Pro proudly sport at least one Thunderbolt port on the side, but the MacBook
has only a USB-C port.
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THE MACBOOK'S MYSTERY SLOT

If you're wondering what that inch-long slot on the side of your MacBook Air is for, you'll
be pleased to hear that it's called an SDXC card slot. Why the glee? Well, this slot allows
your laptop to directly accept the storage cards used by many of today’s digital cameras
and mass-storage video camcorders, without requiring an external device or a cable
connection to your cameral!

Some MacBook owners also use SDC/SDXC cards for storage, much like a USB flash
drive. | find that a USB flash drive offers far more storage for less cost (as well as being
compatible with other Macs and PCs). If you have a large number of SDC/SDXC cards
collecting dust in your drawer, why not use them?

Connecting an external drive

With Thunderbolt or USB, you can install an external hard drive without opening
your laptop’s case. With your MacBook turned on, follow these steps:

1. connect the Thunderbolt or USB cable between the drive and your
computer.

2. Plug the external drive into a convenient surge protector or uninterrupt-
ible power supply (if necessary).

Note that some external devices are bus-powered, meaning that they don't
need a separate power supply. These devices draw their power directly from
the port (but will also drain your MacBook's battery faster).

w

Switch on the external drive.

4. If the drive is unformatted (or formatted for use in Windows), partition
and format the external drive.

The drive comes with instructions or software for you to do this. (Don't worry;
your external drive comes from the factory completely empty, and you won't
damage anything by formatting it.) Partitioning divides the new drive into one
or more volumes.

If the drive comes preformatted for use with a Windows PC, | strongly suggest
reformatting it for use with macOS. Doing so will result in faster performance
and more efficient use of space.

After the drive is formatted and partitioned, the volumes you’ve created immedi-
ately appear on the desktop. Shazam!
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Gotta have internal

If you decide that you must upgrade your existing internal drive — or if your
internal drive fails and needs to be replaced — you should always take your
MacBook to an authorized Apple service center and allow the techs there to sell
you a drive and make the swap. Here are four darned good reasons why:

3 Warranty: You're very likely to void your laptop's warranty by attempting a
drive upgrade yourself.

¥ Selection: If you're worried about choosing the proper drive, your friendly
neighborhood Apple technician can order the correct type and size of drive
for you.

¥ Difficulty: Swapping a drive in your Mac laptop is a downright pain.

3 Backup: That very same Apple service technician can back up all the data on your
existing drive, format the new drive, and move all your data to its new mansion,
so you won't lose a single document. That will save you time and possible angst.

Perhaps you won’t be truly satisfied with your life until you upgrade your MacBook’s
internal drive. I'm sure you can find a magazine article that purports to show you
how. I’ve seen many how-to articles on the web that claim to lead you down a rosy
warning  path to a hard drive upgrade. Here’s my take on those savvy instructions: You’re

walking into a minefield using someone else’s map, so you better have complete
faith in your technical skills. (And a darn good backup.)

A List of Dreamy Laptop Add-Ons

The USB toys I cover in this section might add a cable or two to your collection at
the side of your road warrior, but they’re well worth the investment. And they can
really revolutionize how you look at technologies such as television, digital audio,
and computer gaming.

Game controllers

If you’re ready to take a shot at the enemies — whether they be Nazi soldiers,
chattering aliens, or the latest jet fighters — you’ll likely find your keyboard and
mouse somewhat lacking. (And if that enemy happens to be a friend of yours play-
ing across the Internet, you’ll be ruthlessly mocked while you fumble for the right
key combination.) Instead, pick up either a USB joystick (for flying games) or a
gamepad (for arcade and first-person shooting games).
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Video controllers

For armchair directors, specialized USB digital video controllers make editing eas-
ier. The ShuttleXpress from Contour Design (www.contourdesign.com) provides a
five-button jog control that can be configured to match any DV editor. For $60,
you get the same type of editing controller as dedicated video-editing stations
costing several thousand dollars.

Music hardware

Ready to put GarageBand to the test with your favorite version of “Chopsticks”?
You’ll need a USB piano keyboard. I recommend the Keystation 49 II from M-Audio
(www .m-audio.com), which retails for a mere $100. It provides 49 keys and uses a
USB connection.
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IN THIS CHAPTER

» Cleaning unnecessary stuff off your
drive

» Backing up your data with Time
Machine

» Fixing hard drive permission errors
and catalog problems

» Automating tasks in High Sierra

» Updating OS X automatically

Chapter 21

Tackling the
Housekeeping

othing runs better than a well-oiled machine, and your laptop is no excep-

tion. (Well, you actually shouldn’t oil it, but you know what I mean.) With

a little High Sierra maintenance, you can ensure that your MacBook per-
forms as efficiently as possible (which translates into longer battery life and faster
operation overall).

In this chapter, I demonstrate how you can make good use of every byte of storage
space provided by your drive. I also show you how to back up and restore that hard
drive to an external drive, using Time Machine.

The High Sierra Automator application is a great housekeeping tool. It allows your
laptop to perform tasks automatically that used to require your attention. I show
you how you can create Automator applications and set them up to run by them-
selves. (It sounds a little spooky, but you’ll have a ball!)

And it’s important to never forget about updating macOS itself. But then again,

with Software Update configured correctly, you can live life free and easy, surfing
the web and eating ice cream (or yogurt — your pick).
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Cleaning Unseemly Data Deposits

Criminy! Where does all this stuff come from? Suddenly that spacious 512GB solid-
state drive has only 19GB left, and you’re starting to feel pinched.

Before you consider buying a new internal or external drive (which you can read
about in Chapter 20), take the smart step: Sweep your laptop’s drive clean of
unnecessary and space-hogging software and temporary files.

Getting dirty (or, cleaning things
the manual way)

If you’re willing to dig into your data a little, you have no reason to buy additional
software to help clean up your hard drive. All you really need is the willpower to
announce, “I simply don’t need this item any longer.” (And, sometimes, that’s
tougher than it might seem.)

Unnecessary files and unneeded folders

Consider all the stuff you probably don’t really need:

¥ Game demos and shareware that you no longer play or use (or even
remember)

¥ Movie trailers and other QuickTime video files that have long since passed
into obscurity

¥ Temporary files that you created and promptly forgot about

¥ Log files that chronicle application installations and errors

¥ Zip and Stufflt archives that you downloaded and no longer covet
¥ GarageBand loops and iMovie video clips you'll never use

¥ iTunes music and videos that no longer appeal to your eye and ear

How hard is it to clean this stuff off your drive? Easier than you might think! Here
are some ways to clear space on your laptop’s internal drive:

¥ You can easily delete files.

¥ You can move seldom-used files and folders to external storage (such as a
USB flash drive, an external hard drive, or a DVD).
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¥ You can uninstall applications purchased from the App Store using Launchpad.
From the Launchpad display, click and hold down the icon until it wiggles. If an
X button appears on the icon, you can click the X to remove the application
from your MacBook.

¥ You can get rid of an unnecessary application by deleting its application folder
that was created during the installation process.

Always check the application’s README file and documentation for any special
instructions before you manually delete any application’s folder! If you created
any documents in that folder that you want to keep, don’t forget to move them
before you trash the folder and its contents. In fact, some applications may come
with their own uninstall utility, so checking the README file and documentation
may save you unnecessary steps.

Removing an application or file from your drive usually involves two simple steps:

1. Display the file or application folder in a Finder window.
2. Delete the file or folder with one of these steps:

Drag the icon to the Trash.

Press 38+Delete.

Right-click the icon and choose Move to Trash.

Select the icon and click the Delete button on the Finder toolbar (if you
added one).

Truly, no big whoop.

Don’t forget to actually empty the Trash, or you’ll wonder why you aren’t regain-
ing any drive space. (High Sierra stores the contents of the Trash until you manu-
ally empty the Trash, just in case you want to undelete something.) To get rid of
that stuff permanently and reclaim the space, right-click the Trash icon in the
Dock and choose Empty Trash from the pop-up menu that appears.

Associated files in other folders

Some applications install files in different locations across your drive. (Applica-
tions in this category include Microsoft Office and Photoshop.) How can you clear
out these orphan files after you delete the application folder?
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FIGURE 21-1:
Mine your hard
drive for
additional files to
delete.

A

WARNING

The process is a little more involved than deleting a single folder, but it’s still no
big whoop. Here’s the procedure:

1. Click the Search text box in a Finder window.
You can read more about searching and the Finder window in Chapter 6.
2. Type the name of the application in the Search text box and choose
Name Matches from the pop-up menu.
Figure 21-1 shows a typical search. | wanted to remove orphan files associated
with Adobe Acrobat Reader. By searching for the word Adobe, | found both the
application and its main folder. This trick displays files created in other folders
that include your search word in their names, such as project files, PDF files,
and the font files that appear in the system Fonts folder.
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3. Decide which of these files belong to the application to be deleted.

Be sure that the files you choose to delete are part of the deleted application. If
necessary, right-click on the file and choose Get Info to display more informa-
tion In Figure 21-1, the Adobe Flash Player Install Manager is included in the
search results, but it's definitely not a part of Adobe Acrobat!
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FIGURE 21-2:
Piriform’s
CCleaner for Mac
is a great tool for
cleaning your
MacBook's drive.

Many associated files either
® Have the same icon as the parent application
® Arein the Preferences, Caches, or Application Support folders

4. Inthe Search Results window, click the associated files you want to
delete, and just drag them to the Trash.

Don’t empty the Trash immediately after you delete these associated files. Wait a
few hours or a day. That way, if you realize you deleted a file you truly need, you
can easily restore it from the Trash.

Using a commercial clean-up tool

If you’d rather use a commercial application to clean up your drive, many are
available. However, most are shareware and perform only one task. For example,
Tidy Up! 4 from Hyperbolic Software (www.hyperbolicsoftware.com) finds only
duplicate files on your drive, matching by criteria such as filename, size, content,
and extension. It’s a good tool at $30.

For keeping your MacBook’s drive slim and trim, I recommend CCleaner for Mac,
from Piriform (www.piriform.com/mac/ccleaner), as shown in Figure 21-2. This
great utility can clean everything from Internet crud (browser cookies and your
surfing history) to those macOS system caches that can grow so doggone huge.
And you can easily fine-tune whatever CCleaner for Mac wants to remove. The
utility can also uninstall many applications with a single click. Oh, and did I men-
tion that it’s free? I really like free!

/€ Piriform CCleaner

CCleaner Free 1.14.451

Mac OS X 10.13.1
MacBookAir 5.2, Intel Core i5 @ 1.80GHz, 8.0GB RAM

Mac 0S X Applications

@ safari
Internet Cache
Internet History
Cookies
Download History
Session
% System
Trash
Recent Documents
Recent Applications
Recent Servers
Recent Places
Logs
Directory Service Cache
User Downloads
Font Registry Cache

Unneeded Languages
& System Applications
Mo a0

Check for updates...

Oniine Help
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Do it. I won’t lecture you about backing up your drive. Well, perhaps for just a
moment. Imagine what it feels like to lose everything — names, numbers, letters,
reports, presentations, saved games, photographs, and music. Then ask yourself,
“Self, isn’t all that irreplaceable stuff worth just a simple backup?” It’s time for a
Mark’s Maxim:

Back up your hard drive. On a regular basis.™

You can back up your files either by saving them to external media or — as I
strongly recommend — by using the awesome Time Machine feature in El
Capitan.

Saving files

The simplest way to back up files is simply to copy the files and folders to an
external hard drive, a USB flash drive, a CD, or a DVD. Nothing fancy, but it works.

Backing up to an external hard drive
or USB flash drive

If you use an external hard drive with your MacBook, you can easily drag backup
files to it from your internal hard drive. Follow these steps:
1. Open separate Finder windows for

The external drive

The internal drive

Because you're using High Sierra, you can also open a Finder tab within a single
Finder window to accomplish the same task — from the keyboard, press $8+T.

2. From your internal drive, select the files and folders you want to back up.

3. Drag the selected files to the external drive window.

Backing up to CD and DVD

You can burn backups of your most important files to a recordable CD or
DVD. Owners of the latest MacBooks need to use an external SuperDrive or third-
party recorder, however. Saving your data is more labor-intensive this way, but
the end result is a truly “bullet-proof” backup that doesn’t rely on an external
hard drive.
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TIP

To use the Finder’s Burn feature with a CD or DVD, follow these steps:

1. Load ablank discinto your MacBook's optical drive.

If you're using the default settings in the CDs & DVDs pane in System
Preferences, a dialog asks you for a disc name.

2. Choose Open Finder from the Action pop-up menu and click OK.

3. Double-click on the Untitled optical disc icon on your Desktop to open a
Finder window showing the contents of the disc.

4, Drag the files and folders you want to back up into the disc’s Finder
window.

They can be organized any way you like. Don't forget that the total amount of
data shouldn't exceed 700MB on a CD. You should also stick within 4GB or so
(on a standard recordable DVD) or 8GB (on a dual-layer recordable DVD). You
can see how much free space remains on the disc at the bottom of the disc's
Finder window.

5. Choose File > Burn Disc.

You can also click the Action button that appears at the top of the disc's Finder
window and choose Burn Disc from the pop-up menu.

6. Choose the fastest recording speed possible.

7. Click Burn.

If you’ve invested in Toast Titanium from Roxio (www.roxio.com) or another CD/
DVD recording application, you can create a new disc layout to quickly burn the
same files to your backup disc in the future. (Think of a layout as a “road map”
that indicates which files and folders Toast should store on the backup.)

“Mark, can I back up individual files to cloud-based storage like iCloud Drive or
DropBox?” Of course! These services are fine for a handful of files (much like
backing up a handful of files to CD or DVD), but these cloud drives aren’t suitable
for backing up the entire contents of your MacBook’s internal drive. (You should
always use Time Machine with an external hard drive for that important chore.)
Also, don’t forget that you need an Internet connection to save or retrieve files
from cloud storage.

Putting things right with Time Machine

If you enable backups via the High Sierra Time Machine feature, you can literally
move backward through the contents of your MacBook’s hard drive, selecting and
restoring all sorts of data. Files and folders are ridiculously easy to restore — and
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I mean easier than any restore you've ever performed, no matter what the
operating system or backup program. Time Machine can even handle some deleted
items, such as Contacts cards!

Because Time Machine should be an important and integral part of every MacBook
owner’s existence, Time Machine has its own pane in System Preferences. (Apple
is not messing around!)

your Time Machine backup files. If you’re interested in a single Time Machine
backup location for multiple Macs across your wireless network, Time Capsule is

TIP a great addition to your home or office. Note, however, that the Time Capsule
drive isn’t meant to be mobile, so while you’re on the road, you still need an
external USB or Thunderbolt drive to safeguard your data.

‘ Apple’s AirPort Time Capsule device is designed as a wireless storage drive for

Before you can use Time Machine, it must be enabled in the Time Machine pane
in System Preferences. I cover the Time Machine configuration settings (and how
to turn on the feature) in more detail in Chapter 5.

@

REMEMBER

Here’s how you can turn back time, step by step, to restore a file or folder you
deleted or replaced:

1. FromaFinder window, open the folder that contained the item you want
to restore.

0 2 Click the Time Machine icon in the Finder menu bar and click Enter Time
O Machine.

The oh-so-ultra-cool Time Machine history appears behind your folder,
complete with its own set of buttons at the bottom of the screen, as shown in
Figure 21-3. On the right, you see a timeline that corresponds to the different
days and months included in the backups High Sierra has made.

3. Click within the timeline to jump directly to a date. The folder’s contents
on that date are displayed.

Alternatively, use the Forward and Back arrows at the right to move through
the folder's contents over time. (You should see the faces of Windows users
when you riffle through a specific folder to locate something you deleted
several weeks ago!)

The backup date of the items you're viewing appears in the button bar at the
bottom of the screen.

TIP
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4. After you locate the file or folder you want to restore, click it to select it.

5. Click the Restore button at the bottom right of the Time Machine
button bar.

If you want to restore all the contents of the current folder, click the Restore All
button instead.
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FIGURE 21-3: November 2016 —

Yes, Time ]
Machine really |
does look like this!

Time Machine returns you to the Finder, with the newly restored file now appear-
ing in the folder. Out-standing!

For robust backup-and-restore protection, Time Machine has everything a typical
Mac owner at home is likely to ever need. Therefore, this is an easy Mark’s Maxim
to predict:

Connect a high-capacity external hard drive and turn on Time Machine. Do it
now. Don’t make a humongous mistake.™

MARK'S
MAXIMS
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Maintaining Hard Drive Health

Shifty-eyed, sneaky, irritating little problems can bother your hard drive:
permissions errors. Incorrect disk and file permissions can

¥ Make your MacBook lock up
¥ Make applications act screwy (or refuse to run)

¥ Cause weird behavior in a Finder window or System Preferences

Problems with your drive’s catalog file can also result in corrupted data and files
that won’t open.

To keep High Sierra running at its best, I recommend that you check your hard
drive at least once per week.

e To fix any permissions or catalog errors on your system, follow these steps:
1. click the Launchpad icon in the Dock, and then click within the Search
i box at the top of the window.
or . Type the word disk.
ik

Click the Disk Utility icon.

At the left, click the volume or named partition you want to check.

A WN

. Click the First Aid button and click Run.

Disk Utility does the rest and then displays a message about whatever it has to
fix. (When will someone invent a car with a First Aid button?)

Automating Those Mundane Chores

One popular feature in High Sierra — Automator — can save you a tremendous
amount of time behind the keyboard. You use Automator (shown in Figure 21-4)
to create applications with a relative of AppleScript called AppleEvents. (In case
you’re unfamiliar with AppleScript, it’s the simple programming language you can
use to automate tasks and applications within High Sierra.)
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FIGURE 21-4:
Automator is a
dream come true
if you hate
repetitive tasks.
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Of course, writing an application might sound daunting — akin to single-handedly
building your own nuclear submarine over a long weekend — but Automator is
actually easy to use. Heck, you might find it downright fun!

You can also create workflows, which are sequential (and repeatable) operations
that are performed on the same files or data. Then your Automator application can
automatically launch whatever applications are necessary to get the job done.

Here’s a great example: You work with a service bureau that sends you a huge Zip
file every week with new product shots for your company’s marketing department.
Unfortunately, these images are flat-out huge — taken with a 24-megapixel
camera — and they’re always in the wrong orientation. Before you move them to
the Marketing folder on your server, you have to laboriously resize each image and
rotate it and then save the smaller version.

With help from Automator, you can build a custom application that automatically
reads each image in the folder, resizes it, rotates it, and even generates a thumb-
nail image or prints the image. Then it moves the massaged images to the proper
folder. You’d normally have to manually launch Preview to perform the image
operations and then use a Finder window to move the new files to the right
location. But now, with Automator, a single double-click of your custom applica-
tion icon does the trick.
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You find Automator in the Utilities (or Other) folder in Launchpad (or, from a
Finder window, in your Applications folder). Currently, Automator can handle
specific tasks in more than 100 applications (including the Finder). But both Apple
and third-party developers can add new Automator task support to both new and
existing applications.

To create a simple application with Automator, launch the application and follow
these steps:
1. click the New Document icon.
2. select Application and click the Choose button.
3. Click the desired application in the Library list.
Automator displays the actions available for that application.

4, Drag the desired action from the Library window to the workflow
window on the right.

5. Modify any specific settings provided for the action you chose.
6. Repeat Steps 3 through 5 until you have completed the workflow.
7. click the Run button (at the upper right) to test your script.
Use sample files while you're fine-tuning your application lest you accidentally
do something deleterious to an original (and irreplaceable) file!
WARNING 8. When the application is working as you like, press $§8+S to save it.

9. In the save dialog that appears, type a name for your new application.

10. click the Where pop-up menu and specify a location where the file should
be saved.

11. click the File Format pop-up menu and choose Application.
12. click save.

Your new Automator application icon includes the Automator robot standing
on a document. Most normal human beings would call you a programmer, so
make sure you're inscrutable from now on! If you plan to use your new
Automator application often, don't forget that you can make it more conve-
nient to use by dragging the application icon to the Dock or to the desktop.

To find all the actions of a certain type in the Library list, click in the Search box
at the top of the Library list and type a keyword, such as save or burn. You don’t

even need to press Return!
TIP
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If you want your Automator application to run every time you log in — for
example, the application tracks your time on a project — follow these steps to set
up the application as a login item:

OUVAWN==

Open System Preferences.

Display the Users & Groups pane.

Click the Login Items button.

Click the plus button at the bottom of the list.

Navigate to the location of your new Automator application.
Click Add.

Now your Automator application is really automatic. Watch your significant
other gape in amazement as your MacBook begins to work without your
touching the keyboard! (If you've added the application icon to your Dock, you
can also simply right-click the icon and choose Options = Open at Login from
the menu that appears. Either way, your MacBook gets the message.)

Updating macOS Automatically

I prefer that my MacBook clean up after itself as much as possible, so updating
High Sierra should be automatic as well. In macOS High Sierra, operating system
updates are performed in the App Store, but you configure the update process
from System Preferences.

The App Store uses the Internet, so you need an Internet connection to shake
hands with the Apple server and download any updates.

TIP

Updates can be found in two convenient spots:

3 The Apple menu: Click the Apple menu (#) and then choose App Store. Click

@

App Store

the Update icon in the App Store toolbar, which alerts you to anything new
that's available.

3 System Preferences: Click the App Store icon in the System Preferences

window.
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If you take the System Preferences route, you can set the App Store to check
for critical system updates and install them automatically:

Select the Automatically Check for Updates checkbox to enable it.
Select the Install macOS Updates checkbox to enable it.
Select the Install System Data Files and Security Updates checkbox to enable it.

You can even display any updates immediately from within the App Store
System Preferences pane (click the Check Now button).

App Store and displays any available updates with short descriptions. You can
manually click the Update button next to a specific update. High Sierra also

TIP displays a Notification window alerting you to new updates. You can choose to
continue with the update from the Notification window, or wait and update man-
ually later.

With automatic downloading disabled, macOS launches the Updates pane of the

purchased through the App Store on your other Macs can be automatically down-
loaded to this computer as well. Select the Automatically Download Apps Purchased

TP on Other Macs checkbox to enable it, and then sit back and watch convenience
happen.

‘ If you’re using the same Apple ID on more than one Mac, the applications you’ve
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The Part of Tens



IN THIS PART ...

Commit Mark's top laptop rules to memory.

Avoid the worst computing pitfalls known to man.



IN THIS CHAPTER

» Protect your laptop while you're in
transit

» Pack that MacBook with RAM
» Track your Mac with a hidden beacon
» Encrypt your MacBook’s drive

» Save energy by disabling wireless
hardware

» Use a surge protector

» Back up your laptop

Chapter 22

Ten Laptop Rules
to Follow

h, the sedentary life of a desktop Mac. It sits there, like a bump on a log,
comfortable and immobile. As long as you have a stable surface and an
uninterrupted power supply, your iMac, Mac mini, or Mac Pro is a happy

puppy.

But you, good reader, are mobile! Whether you’re on campus or attending a
convention, your Mac laptop is rarely running in the same spot, so it’s susceptible
to all sorts of road warrior pitfalls. In this chapter, I remind you of ten of the most
important rules every laptop owner should follow to prevent chaos and carnage
while traveling.
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Keep Your Laptop in a Bag

Using a laptop case or bag sounds like common sense. But MacBooks are so
doggone sexy that you’d be surprised how many people carry them around without
any protection. These Mac owners hear phrases like “unibody construction” and
“solid-state drive” and figure that their laptop can survive a construction site,
college campus, or hotel room.

Part of that is true. Mac laptops are some of the toughest ever made, but they’re
not immune to bumps, scratches, and the rare fall. The moral? If you carry around
your MacBook without any protection, soon it will look like a boxer after a bad
fight.

If you’re like me, you’re proud that your computers remain in pristine condition,
so use a laptop bag or case that offers ample padding and a convenient shoulder
strap or carry handle. (My laptop bag even converts to a backpack. It includes
plenty of extra space for power supplies, USB mouse and keyboard, and all the
assorted hoo-hah that you know you need to carry with you.) Spend an extra $30
on a laptop bag, and your $2,000 computer can weather the worst the world can
dish out.

Using a traditional laptop bag comes with a caveat, however. Some folks think a
bag draws too much attention to its expensive cargo. (And to some extent, I agree.
Few people tote an obvious 15-by-7-inch bag with a hardware manufacturer’s
logo emblazoned on it these days.) If you’re a member of this group, consider a
well-padded laptop sleeve (with corner protectors) that allows you to carry your
MacBook in your backpack, such as the BookBook cover I describe in Chapter 1.
The laptop always goes on top of those heavy books, of course. Remember, though,
that the padding is the important thing. Without that extra cushion, you might as
well just toss your unprotected laptop in with the rest of your books and must-
have equipment.

Oh, and if you’ve been using your MacBook for a longer period and it’s warm to
the touch, don’t pack it away immediately — allow it to cool for a few minutes
before stowing it safely, and you’ll help prevent damage over time to your
MacBook’s internal hardware.

Maximize Your RAM

Like any other computer running Windows or macOS, your MacBook will benefit
from all the system RAM (memory) you can squeeze onto it. (Chapter 20 describes
the benefits of extra RAM.) The virtual memory functionality built into High Sierra
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(which I also describe in Chapter 20) results in mediocre performance during
memory-intensive tasks such as video and image editing.

When your laptop has a full complement of RAM, its performance will rival the
performance of a desktop computer with the same processor — and you’ll be
using it on the go!

Current MacBook models can be configured with anywhere from 8GB to 16GB of
RAM at the time you order one from Apple, depending on the model. Unfortu-
nately, you can’t add more memory after purchase, so order your new MacBook
with the maximum amount of memory you can afford! If you own an older
MacBook model that can be upgraded, I discuss adding memory in Chapter 20.

Install a Tracker Application

Suppose the unthinkable happens: Your laptop is stolen while you’re on vacation
or on a business trip, and you know that the chances it will be returned are next
to nil. You’ve resigned yourself to replacing it (and all your data). But wait! What
if I told you that you might just be able to display your MacBook’s current loca-
tion, as well as wipe the data that’s on it (if necessary)?

If this scenario sounds a little like a James Bond movie, you’ll be surprised to
discover that several tracker applications are available for High Sierra that can run
invisibly on your laptop. A tracker application can turn your MacBook into a
transmitting beacon, broadcasting to you its current location and all the Internet
information it can get. Then you can alert the police, who will apprehend the
crook (who might be in the middle of creating a new album in Photos).

In fact, the Find My Mac feature built in to High Sierra is a tracker application in
disguise! (Note that you must set up your iCloud account in the iCloud pane in
System Preferences before you can use Find My Mac, as I cover in Chapter 5.) If
your MacBook is lost or stolen (and someone uses it to connect to the Internet),
you can visit www. icloud.com, sign in with the same Apple ID, and click Find My
iPhone; then click the All Devices menu at the top of the window and click on your
MacBook. From the display that appears, you can choose to Remote Lock or
Remote Erase your MacBook.

Keepeth Thy Drive Encrypted

In Chapter 5, I discuss a number of System Preferences panes. The Security pane is
particularly important to laptop users, because it allows you to encrypt your drive.
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REMEMBER

Encryption prevents just about anyone from accessing (or even identifying) any of
the files you’ve stored on your MacBook. The robust encryption provided by High
Sierra will certainly stymie just about anyone but the NSA. (I won’t even go there.)

In System Preferences, click Security & Privacy, click the FileVault tab, and then
click Turn On FileVault. You can use your Apple ID to unlock your MacBook’s
drive, or you can choose a unique recovery key, just in case. (Your login account
password is your primary password.) High Sierra takes care of automatically
encrypting and decrypting files as necessary. You won’t even know it’s working.

To take full advantage of an encrypted drive, you need the proper login mode (as
I discuss in Chapter 10). Think about this possible security back door: From the
Users & Groups pane, you’ve set your laptop to automatically log you in every time
you boot your MacBook Air. This scenario is the very definition of Not Secure
because your login account password automatically bypasses the FileVault
encryption! Therefore, make sure that you actually have to log in to access your account.
For the full scoop, see Chapter 10.

Brand Your MacBook

Put your brand on your laptop! Whether by using an engraving tool on the bottom
of the machine (my personal favorite) or a permanent metal tag, your MacBook
deserves some sort of identifying information. After all, most people are honest,
so you might not need to use the Find My Mac feature I mentioned earlier in this
chapter. You might have left your laptop behind by accident, and someone would
like to return it to you. (Don’t forget to offer a reward!)

Some laptop owners want to include their name, address, and other contact infor-
mation. Other road warriors feel more comfortable with just their name and email
address. Whatever information you choose to provide, branding your laptop is as
important as backing it up.

Disable Your Wireless

392

Funny how we don’t think about it, but wireless communications take juice, and that
power comes straight from your laptop’s battery! Because your Mac laptop comes
with built-in Wi-Fi and Bluetooth hardware, you’re constantly broadcasting —
sending and receiving, or at least trying to exchange data with others.
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Therein lies the rub: If you’re not connected to a wireless network or Bluetooth
device, you’re wasting precious battery power. That’s why High Sierra lets you
turn off your Wi-Fi and Bluetooth hardware to save energy. When you’re sitting in
a crowded auditorium without access to an AC socket or a wireless network, the
energy savings you reap when you disable your wireless hardware can be
significant.

cellphones are not allowed, such as on an airplane flight or in certain areas of a
hospital. And, because I'm a security-conscious kind of guy, I always disable my

warning  wireless hardware whenever I'm not using it (even if I'm in range of a wireless
network). Call me overly careful, but none of my shared files have ever been
sucked out of my MacBook without my permission!

‘ In fact, you might have to disable your wireless connectivity in situations where

— To turn off your Wi-Fi hardware from the High Sierra Finder menu bar, click the

i * Wi-Fi status icon and choose Turn Wi-Fi Off from the menu. To turn off your
Bluetooth hardware from the menu bar, click the Bluetooth icon and choose Turn
Bluetooth Off.

Take a Surge Protector with You

I’ll be honest: I usually am not a huge supporter of surge protectors, because I
think they do only half the job. That job is protecting both your hardware and your
data. And, as you probably know, a surge protector doesn’t provide backup power
in case of a brownout or total loss of power, like a UPS (uninterruptible power
supply) can.

Of course, many locales around the world offer a less-than-perfect power grid,
which translates into a sudden loss of power — usually at exactly the wrong
moment. (Think Great American Novel Takes a Nosedive.) Unlike a desktop, however,
your MacBook is smart enough to immediately switch from AC current to its
battery in case of a power failure (much like a UPS). So why am I suggesting a
surge protector for your laptop, especially seeing as how it adds bulk and weight
to your laptop bag or luggage?

3 The risk of a power spike: A surge protector is good protection from a
massive power spike, such as an overload or lightning strike.

3 Extra sockets on tap: Don't forget that you might need several more AC
sockets for external devices, such as a DVD drive, projector, and portable
printer. A surge protector can provide extra access to power, even when your
host can't.
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Naturally, if you’re traveling to a country with different AC standards (and
different socket configurations), invest in an AC plug adapter that’s compatible
with the standard used at your destination.

Use Power-Saving Features

Apple allows you considerable control over your MacBook’s sleep schedule, which
is areal boon to power-hungry laptop owners. In System Preferences, click Energy
Saver to display the Battery and Power Adapter settings.

If your laptop is running on battery power, and you need to conserve as much
power as possible, click the Battery tab. Make sure that you move the Computer
Sleep and Display Sleep sliders to 5 minutes or less. (You should also enable the
Put Hard Disks to Sleep When Possible checkbox.) Now you’re squeezing the max-
imum amount of computing time out of your remaining battery power.

If you’re running your laptop while connected to an AC outlet, click the Power
Adaptor tab. Although power isn’t a problem, I still don’t recommend that you set
the Computer Sleep and Display Sleep sliders to Never. (Sleep mode helps prolong
the life of your MacBook’s display, and a sleeping laptop generates practically no
heat.) However, you can set both sliders for a much longer delay while connected
to AC power, such as the 30 minutes I use for my display sleep when my MacBook
is charging.

Use an External Keyboard and Mouse

394

Does your laptop remain at your home, dorm room, or office for long periods of
time? If so, I recommend that you invest in an external keyboard and an external
mouse, trackball, or trackpad for two very good reasons:

¥ Adding external input devices helps lessen the wear and tear on your laptop's
keyboard and trackpad.

¥ External input devices are generally more comfortable and convenient to use
than those offered by your MacBook, especially for gaming.

If price is no obstacle, a wireless keyboard and pointing device allow you far more
freedom of movement. Note, though, that a standard USB keyboard and mouse do
just as fine a job and cost less.
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In fact, you can have two external keyboards if you like: one to work with your
laptop while you’re running High Sierra (which has all the keys unique to an Apple
keyboard), and one to use when you’re running Windows under Boot Camp (with
those gnarly Windows-specific keys). Techno-suave.

Not Again! What Is It with You
and Backing Up?

Yes, this is one of the Top Ten Laptop Rules as well. I’'m not kidding: If you think
you don’t need to back up on a regular basis, you will eventually lose every byte of
data you have. Period. It’s only a matter of time. Even if you have incredible luck
and don’t do something you regret with a Finder window, your MacBook is just a
machine, and it will wear out in the long run. (Especially with the mobile life of a
road warrior, with all the bumps and bruises of travel.) That’s why hard drive
manufacturers list MTBF (Mean Time Between Failures) figures for their hard
drives.

Backing up your drive with Time Machine isn’t difficult and doesn’t take long, and
it does indeed protect every file and folder. Chapter 21 explains everything you
need to know. After you finish your first full backup, drop me a line at mark@
mlcbooks.com with the subject I’ve Got Laptop Peace of Mind. We can celebrate
together!
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IN THIS CHAPTER

» Dodging USB 1.1 storage devices

» Shunning email and web phishing
expeditions

» Skirting those strange-sized discs
» Keeping liquids at arm’s length

» Banishing outdated disk utilities
» Eschewing pirated software

» Steering clear of the root/System
Administrator account

» Sidestepping unsecured public
wireless networks

» Spurning refurbished hardware

» Expelling dust and dirt

Chapter 23

Ten Things to Avoid Like
the Plague

f you've read other books I've written in the Dummies series, you might

recognize the title of this chapter. It’s one of my favorite Part of Tens subjects.

I don’t like to see any computer owner fall prey to pitfalls. Some pitfalls are
minor (such as not keeping your laptop clean), and others are downright cata-
strophic (such as providing valuable information over the Internet to persons
unknown).
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USB 1.1

All these potential mistakes, however, have one thing in common: They’re easy to
prevent with a little common sense — that is, as long as you’re aware of them. And
making you aware is my job. In this chapter, I fill in what you need to know.
Consider these pages valuable experience gained easily!

Storage Devices

Man, a USB 1.1 storage device is the very definition of sluggish. Only a creaking USB
1.1 external device such as a hard drive, USB hub, or CD-ROM drive could be as
slow as a turtle on narcotics.

Unfortunately, you still find countless examples of USB 1.1 hardware hanging
around, ready to ensnare unsuspecting computer owners who don’t know antiques
when they see them. eBay is stuffed to the gills with USB 1.1 equipment, and your
family and friends might try to bestow that old 4x CD-RW drive on you as a gift.
(This present, like your Aunt Harriet’s fruitcake, is one you should politely refuse.)
These drives were considered cool in the early days of the colorful iMac G3, when
USB was a new technology. Today, a USB 1.1 hard drive is simply a slow-as-maple-
syrup-in-January embarrassment.

I do admit that plenty of great USB 1.1 devices are still around these days, such as
joysticks, keyboards, mice, and other controllers, along with printers that work
just fine with slower transfer rates. However, if a peripheral’s job is to store or
move data quickly — including hard drives, network connections, USB hubs, CD-
ROM drives, and USB flash drives — give a USB 1.1 device a wide berth. Opt instead
for a Thunderbolt 1/2, USB 2.0/3.0, or even a FireWire device on older MacBooks.

Phishing Operations

Phishing is no phun. No, that’s not a misspelling. In Internet lingo, phishing refers
to an attempt by unsavory characters to illegally obtain your personal informa-
tion. If that sounds like an invitation to identity theft, it is. Thousands of sites
have defrauded individuals like you and me (along with banks and credit card
companies) out of billions of dollars. Unfortunately, the phishing industry has
been growing like a weed, and more innocent folks are being ripped off every day.
(The lowlifes running phishing operations are pond scum. I’m being polite here
because this will appear in print.)

A phishing scam works like this: You get an email purporting to be from a major
company or business, such as eBay, a government agency, or a credit card

398 PART 6 The Part of Tens



company. The message looks genuine, with all the proper graphics and company
information. It warns you that you must “update” your login or financial
information to keep it current, or that you must “validate” your information. It
even provides you with a convenient link to an official-looking web page. After
you enter your oh-so-personal information on that bogus page, the info is piped
directly to the bad guys, and they’re off to the races.

Here’s a Mark’s Maxim that every Internet user should take to heart:

No legitimate company or agency will ever solicit your personal information
through an email message!™

MARK’'S
maxims  Never respond to these messages. If you smell something phishy, open your web

browser and visit the company’s site (the real one) directly. Then contact the
company’s customer support personnel. They’ll certainly want to know about the

phishing expedition, and you can help by providing them with the email and web
warning  addresses used in the scam.

In fact, sending any valuable financial information through unencrypted
email — even to those you know and trust — is a bad idea. Email messages can be
intercepted or read from any email server that stores your messages.

Oddly Shaped Optical Discs

Your external SuperDrive (if you have one) is a marvel of precision — and it’s
doggone svelte to boot. Today’s optical drives typically don’t require a loading
tray: You just slide your CD or DVD into the drive, and the disc smoothly disappears
from sight. Right-click the disc icon on the desktop and choose Eject or drag the
disc icon to the Trash, and the disc appears like magic. No need to give the loading
and ejecting procedures a second thought, right?

Well, good reader, that’s true — but only if you’re loading a standard 1.2mm-
thick, 1220mm round CD or DVD into your drive! Note that I didn’t say

3 An 80mm minidisc: Yes, they're cute. Yes, all sorts of devices have used them,
from DV camcorders to digital cameras. But no, they're not supported by
many slot-loading drives, so there's a good chance one will refuse to eject.

¥ Acredit-card-shaped or triangular disc: Friends, these discs just aren't
natural! Of course, that's part of their pizzazz for advertisers, who give them
away in scads. A square disc works in a tray-loading drive, but a slot drive will
likely get indigestion and refuse to eject it.
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WARNING

TIP

3 Asuper-thick disc: Sure, a tray DVD drive can likely accept a disc with a thick,
printed paper label, but if that disc is more than 1.5mm thick, it can damage
your laptop’s slot-loading drive. Consider these words: “Marge, it's stuck in
there!” Now imagine how you would feel if you were the one saying that.

All three of these oddly shaped discs have one thing in common: The damage you
may cause by attempting to use one in your external SuperDrive is not covered under your
Apple warranty. A weighty statement indeed.

If you do need to read from or record to a nonstandard disc size on a regular basis,
I recommend that you pick up a USB external tray-loading drive, which can easily
handle any size disc you toss at it.

Submerged Keyboards

Do you really want a submerged keyboard? Your answer should be an unequivocal
no! And that’s why you should make it a rule to keep all beverages well out of
range of keyboards, trackpads, and external devices, such as speakers and mice —
especially when kids or cats are in close proximity to your laptop.

If soda gets spilled on your MacBook, you’re likely to be visited with intermittent
keyboard problems (or, in the worst case, a short in your laptop’s motherboard).
Suffice it to say that 12 inches of open space can make the difference between a
simple cleanup and an expensive replacement!

Antiquated Utility Software

400

Everyone’s gotta play the upgrade game. If you’re using macOS High Sierra, you
must upgrade your older utility programs — such as an older copy of TechTool Pro
from Micromat (www.micromat.com) that supports only OS X Mavericks. I know
you spent good money on ’em, but these older disk utility applications can do
more harm than good to a hard drive under macOS High Sierra. Of course, you
should avoid utility software designed for ancient versions of Mac OS X, such as
Panther and Jaguar. (In fact, those antique applications probably wouldn’t even
run with High Sierra.)

A number of things change when Apple makes the leap to a new version of
macOS. These include subtle changes to disk formats, memory management in
applications, and the support provided for different types of hard drives and
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optical drives. If you use an older utility application, you could find yourself with
corrupted data. (In fact, most utilities now refuse to run if they don’t recognize
the version of macOS you’re running.)

Now that you’re using High Sierra, make sure you diagnose and repair disk and
file errors by using only a utility application specifically designed to run in High
Sierra (including, of course, Disk Utility). Your laptop’s drive will thank you.

Software Piracy

Avoiding pirated software is a no-brainer. Don’t endorse software piracy.
Remember, Apple’s overall market share among worldwide computer users
currently weighs in at around 26 percent. Software developers know this, and they
have to expect (and receive) a return on their investment, or they’ll find something
more lucrative to do with their time. As a shareware author, I can attest to this fact
firsthand.

Pirated software might seem attractive. The price is right, no doubt about it. But
if you use an application without buying it, you’re cheating the developer, who
will eventually find doing Macintosh programming no longer worth the time and
trouble. Believe me, the MacBook is a great machine, and High Sierra is a great
operating system, but the sexiest laptop on the planet won’t make up for an
absence of good applications.

Pay for what you use, and everyone benefits.

The Forbidden Account

You may never have encountered the root, or System Administrator, account in
macOS — and that’s A Good Thing. Note that I’'m not talking about a standard
Administrator (or Admin) account. Every Mac needs at least one Admin account.
(In fact, it might be the only visible account on your computer.) Any Standard user
account can be toggled between Standard and Admin status with no trouble.

The root account, though, is a different beast altogether, and that’s why it’s
disabled by default. All UNIX systems have a root account. As you know from
earlier chapters, High Sierra is based on a UNIX foundation, so it has one too.
Anyone logging in with the root account can do anything on your system, including
deleting or modifying files in the System folder (which no other account can
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normally access). Believe me, deliberately formatting your hard drive is about the
only thing worse than screwing up the files in your System folder.

Luckily, no one can access the root/System Administrator account by accident. In
fact, you can’t assign the root account through System Preferences; you have to
use the Directory Utility application located in your Utilities folder. Unless an
Apple support technician tells you to enable and use it, you should promptly forget
that the root account even exists.

Unsecured Wireless Connections

402

©

REMEMBER

I like free Internet access as much as the next technology author. It’s cool, it’s
convenient, and public-access wireless networks are popping up all over the
world. A number of U.S. cities now offer citywide free wireless Internet access.

However, just because something is free doesn’t mean it’s safe. (Impromptu and
overly trusting bungee jumpers, take note.) Unfortunately, the free public wireless
access you’re likely to encounter is not secure. Anyone can join, and the informa-
tion you send and receive can be intercepted by any hacker worthy of the name.
A public network uses no WEP or WPA key, so no encryption is involved. There-
fore, you have no guarantee that your private email, your company’s financial
spreadsheets, and your Great American Novel aren’t being intercepted while
you’re uploading and downloading them in the airport.

If you must use your laptop on an unsecured public network, make sure that the
connection itself is secure instead. For example, don’t check your email by using
a web browser unless your ISP or email service offers an encrypted SSL (Secure
Sockets Layer) connection. (Yep, I’m talking again about that little padlock that
appears in Safari, which I discuss in Chapter 8. It’s not just for ordering things
online!) If you need to establish a secure connection with your home or office
network, use an SSL-enabled Virtual Private Network (VPN) client, which allows
you to transfer files and remotely operate a host computer with bulletproof
security.

Naturally, High Sierra includes a built-in basic VPN client, so you don’t need
additional software to connect. Open System Preferences, click the Network icon,
and then click the Add (plus sign) button. Click the Interface pop-up menu and
choose VPN. Then select the correct VPN type and click Create. (To add VPN host
capability to macOS, upgrade to macOS Server via the App Store.) If you decide to
use a VPN provider instead, use Google to shop for a provider with positive reviews
and proper customer service.
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Refurbished Hardware

Boy, do I hate refurbished stuff. Like my single-minded quest to rid the world of
floppy disks, I likewise make it a point to dispel the myth that you’re actually
“saving” money when you buy a refurbished (or remanufactured) piece of
hardware. As the saying goes, if it sounds too good to be true, it probably is.

Consider what you get when you buy a refurbished external hard drive. It’s likely
that the drive was returned as defective and then was sent back to the factory.
There the manufacturer probably performed the most cursory of repairs (just
enough to fix the known problem), perhaps tested the unit for a few seconds, and
then packed it back up again. Legally, retailers can’t resell the drive as a new item,
so they cut the price so low that you’re willing to take a chance on it.

Before you spend a dime on a so-called bargain that’s remanufactured — I can’t
get over that term — make sure you find out how long a warranty you’ll receive,
if any. Consider that the hardware is likely to have crisscrossed the country at
least once, picking up a few bumps and bruises during its travels. Also, you have
no idea how well the repairs were tested or how thoroughly everything was
inspected.

I don’t buy refurbished computers or hardware. Most of the tales I've heard about
folks who did ended badly. (The exception is the Apple online store, where you can
find a refurbished Mac with a full 1 year warranty. However, AppleCare isn’t
available with refurbished equipment.) Take my advice: Spend the extra cash on
trouble-free, new hardware that has a full warranty.

Dirty Laptops

Clean your machine. Every computer (and every piece of computer hardware)
appreciates a weekly dusting.

You should clean your screen every two or three days — unless you like peering
through a layer of dust, fingerprints, and smudges. Never spray anything directly
on your screen or your MacBook’s case. I highly recommend using pre-moistened
LCD cleaning wipes typically used for notebook computers or computer
monitors.

Your laptop’s case really doesn’t need a special cleaning agent. In fact, you

shouldn’t use any solvents on it. But a thorough wipe with a soft cloth should keep
your MacBook’s case in spotless shape.
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Index

A

AAC files, 212
access level, deciding on, 167-168
actions in notifications, 128
activation hot corners, 99
active windows, 58
administrator account
access level, deciding on, 167-168
adding accounts, 168-170
deleting accounts, 172-173
login items, setting, 174-175
modifying user accounts, 170-172
overview, 167
parental controls, managing, 175-180
advertisements on web pages, blocking, 89
aGent V6 HD webcam, Liquid Digital Solutions, 26, 28
AIFF format, 212
AirDrop, 197
AirPlay Display feature, 96
AirPort Express, 193-194, 231
AirPort Extreme, 14, 16, 191, 193-194
AirPort Time Capsule, 193-194, 368, 380
album covers, adding, 224
albums, organizing images in, 242-245
alert notifications, 128
aliases, 59-60
aligning cell text, Numbers, 321
AMD Radeon Pro 560, 14
animated maps, iMovie, 276-277
antivirus, 149, 354
Apple Base Stations, 193-197, 231
Apple file system (APFS), 86
Apple ID, 35, 159
Apple Lossless format, 212
Apple MacBook Support site, 356
Apple menu, 46, 51, 54
Apple service providers, 356
Apple support technicians, 32
Apple web-based support center, 81

AppleEvents, 382
Application menu, 46
applications. See also specific applications by name
Automator, 382-385
deleting, 375-377
Dock, adding to, 74-75
force quitting, 54
full-screen mode, 57
keyboard shortcuts, 66-67
launching, 50-54
Launchpad, removing from, 52
parental controls, setting, 175-176, 178-179
preinstalled, 25
quitting, 50-54
Arrangement track, GarageBand, 292-293
audio files. See digital audio files
audio formats, supported, 212-213
audiobooks, 213
Auto Enhance, 251
AutofFill button, Safari, 142
Automatic Login account, 180, 182
Automator application, 382-385
autoplay videos, blocking, 90, 152
Auto-Save feature, 303, 316

Back to My Mac, 162
background
Desktop, 73, 97
iMovie, 276-277
background shapes, adding, 310, 338
backups
to CD or DVD, 378-379
to external devices, 378
importance of, 395
overview, 378
preferences, setting, 106-107
Time Machine, 379-381
bags, laptop, 26, 390
Index
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banners, 128
base stations
Apple models, 193-194
installing, 194-195
joining networks, 195-197
music, sending to, 231
overview, 193
third-party, 195
battery
calibrating, 33
care of, 32-34
charging, 11
external, 33
overview, 12, 16
replacement, 34
wireless connectivity, disabling, 392-393
Bluetooth, 14, 160

BookBook hardback leather case, Twelve South,
27,28

bookmarks, adding and using, 145-147
Boolean search, 116
Boot Camp
configuring, 358-360
Control Panel, 360
general discussion, 40, 357-358
keyboards, using with, 395
overview, 25-26, 357
switching to Windows, 360
branding MacBook, 392
brightness, screen, 95-97
burning CDs and DVDs, 231-233, 298, 378-379
buying music, 235

C

cables, 22, 198-199, 352-353
calibrating battery, 33

camera, FaceTime HD, 11-12
camera, importing images from, 241
cases, laptop, 26, 390

catalog errors, fixing, 382

CCleaner for Mac, Piriform, 377

CD & DVD Sharing feature, 10, 19-20
CD audio format, 212
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CDs
backing up to, 378-379
burning, 178, 298
importing photos from, 242
optical drives, 19-20
playing, 213-214
ripping music from, 224-225
cells, in spreadsheets. See Numbers
charts, Numbers, 325-326
Chess application, 25
cleaning laptops, 403
cleaning unnecessary data from hard drive, 374-377
clearing history, 155
Clipboard, 306-307
closed networks, joining, 196
closing windows, 58
color profile, 96
commercial clean-up tools, 377
composing music. See GarageBand
Contacts, 25
Content pane, Safari, 139
cookies, 153-154
cooling pads, 20, 34
copying items, 62-63, 306
cost of MacBook models, 17
CPU, 14
cropping images, 250-251
customizing
Dock, 74-77
Launchpad, 52
Spotlight, 118-119
trackpad, 47-48
cutting content in documents, 306

D

Dashboard, 24, 71-72, 143
dead pixels, checking for, 31
dedicated Internet-sharing device, 191-192
deleting
applications, 375-377
music, 218, 219
photos from albums, 244



user accounts, 172-173

video clips from movies, 272-273
Desktop

background, 73, 97

customizing, 97

Dock, 43-44

icons, 44-45, 72-73

launching applications from, 52

menu bar, 45-46

overview, 43

personalizing, 72-74

switching with Spaces feature, 70-71

windows, 46-47
Desktop & Screen Saver pane, 97-99
desktop publishing application. See Pages
DHCP server, 192, 201
dial-up modem connections, 191
Dictionary, 9, 178
digital audio files

burning, 231-233

playing, 214-219

ripping, 224-225

sharing across network, 230-231
disk permissions, repairing, 349-350, 382
Disk Utility

overview, 348-349, 352

repairing permissions and disks, 349-351, 382
Displays pane, 95-97
Do Not Disturb mode, 110
Dock

adding items to, 74-75

customizing, 74-77

general discussion, 43-44

launching applications from, 50-51

parental controls, setting, 178

preferences, 104-105

resizing, 77

Stacks, 75-77

websites on, 141
docking station, 27
documents. See Numbers; Pages
downloading files, 148-149
Downloads button, Safari, 143
duplicating items, 64

DVD Player application, 25
DVDs
backing up to, 378-379
burning to, 178, 231
importing photos from, 242

Dynamic Host Configuration Protocol (DHCP), 192, 201

E
editing
reminders, 123-124
text, 305
video clips, iMovie, 273-274
editing photos
accessing controls, 240
cropping, 250-251
enhancing, 251-252
filters and adjustments, 252-253
new features, 87-88
overview, 249-250
red-eye removal, 252
retouching, 252
rotating, 250
email. See Mail
encryption
hard drive, 391-392
Home folder, 184-185
network, 196-197
Energy Saver pane, 103-104
enhancing images, 251-252
equalizer, iTunes, 225-226
Ethernet network, joining, 199-201
Ethernet port, 13, 22
Event pane, iMovie, 264, 271
exporting
documents from Pages, 312
GarageBand projects, 297-298
external devices
batteries, 33
cameras, 26, 28
hard drives, 242, 368-370, 378
keyboard, 394-395
mouse, 49-50, 394-395
optical drives, 10, 19

Index
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F Trash, using, 77-78
windows, managing, 54-58
Finder menu bar, 45-46
Finder search window, 116-118
Finder Tabs, 64-65
firewall, 205-207
First Aid, 349-351
Flickr, sharing photos with, 259
floating objects, adding to documents, 309
folders. See also Home folder
for bookmarks, 147
copying items, 62-63
deleting unnecessary data, 374-377
Dock, adding to, 75
duplicating items, 64
Finder tabs, using with, 64-65
Home, 67-68
in Launchpad, creating, 52
moving items, 64
for notes, 125
Public, 184
restoring, 380-381
selecting items, 61-62
Shared, 183
Stacks, 75-77
Force Click, 47-48
Force Quit, 54, 346
Force Touch trackpad, 10, 16
Format menu, 307, 336
formatting text, 307, 336
formatting with shading, in Numbers, 322
formulas, Numbers, 323-325
Forward button, Safari, 141
full-screen mode, 57, 141, 239
functions, Numbers, 323

Facebook, sharing photos with, 259
faces, tagging, 245-246
FaceTime, 16
FaceTime HD camera, 11-12
Family Sharing, 108, 162
Fast User Switching, 181
Favorite photos, 239
Favorites bar, Safari, 138, 142
file permission errors, 382
file sharing
AirDrop, 197
enabling, 117-118
with other user accounts, 183-184
over networks, 188, 204-205
files. See also iCloud
adding to Dock, 75
deleting, 374-377
downloading, 148-149
restoring, 380-381
FileVault, 184-185, 392
filters, Photos, 252-253
Find My Mac, 162, 391
Finder
copying items, 62-63
Desktop, 43-47
Dock, customizing, 74-77
duplicating items, 64
Finder Tabs, 64-65
help resources, 80-81
Home folder, 67-69
icons, 59-60
keyboard, special keys on, 65-66
keyboard shortcuts, 66-67
launching and quitting applications, 50-54
Mission Control, 69-72

moving items, 64 G

overview, 41-42 game controllers, 371
personalizing Desktop, 72-74 GarageBand

printing, 78-80 Arrangement track, 292-293
selecting items, 61-62 burning CDs, 298

Simple Finder, 178, 179-180 controls, 282-284

trackpad, navigating with, 47-50 exporting projects, 297-298
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iMovie, adding music to, 269, 290

iTunes, creating song files and ringtones in, 296-297

loops, choosing, 287-290

loops, resizing, repeating, and moving, 290-292

overview, 281-282
sharing songs, 295-298
track settings, tweaking, 293-295
tracks, adding, 284-287
tracks, types of, 285-286
Visual Equalizer, 294
General pane, 101-102
Genius Playlist, 216
Google, 140
graphics, adding, 305-306, 334-335
graphics, High Sierra improvements in, 87
grounding, 367
Guest accounts, 173

H

Handoff, 102, 160-161
hard drive
backing up, 378-381
cleaning data from, 374-377
encrypting, 391-392
external, 368-370
importing photos from, 242
permissions and catalog errors, fixing, 382
upgrading, 367-371
Hard Drive icon, 44
headphone port, 13
heat from laptops, 34
Help Center, 356
Help menu, 80
help resources, 80-81
High Efficiency Video Coding (HEVC), 86
High Sierra. See also Finder
Apple file system, 86
autoplay videos, blocking, 90

graphics and virtual reality improvements, 87

iCloud Drive sharing, 89

Intelligent Tracking Prevention, 154
overview, 16, 24, 85

Photos, adding functionality to, 87-88

Reader mode, 89

setting up, 31, 35-36

Siri improvements, 88

updating, 385-386

video improvements, 87
History list, Safari, 149-150, 155
Home button, Safari, 142
Home folder

encrypting, 184-185

general discussion, 67-69

for user accounts, 170
home page, setting up, 144-145
Home Sharing, 216, 231
hot corners, 99, 100-101
Hyperbolic Software's Tidy Up! 4 tool, 377

iCloud
accessing through web, 159
account, setting up, 35, 36
configuring, 161-162
free storage, 159
general discussion, 158-159
Handoff, 160-161
iTunes Match service, 228-229
moving documents, 159-160
opening documents, 159-160
overview, 157
preferences, 108-109, 161, 163
saving documents, 159-160
storage, managing, 163
iCloud Drive, 89
iCloud Keychain, 154-155
iCloud Photo Library, 257
iCloud Photo Sharing, 258
icons
aliases, 59-60
Desktop, 44-45, 72-73
Dock, 44
general discussion, 59-60
Hard Drive, 44
overview, 44-45
icons, used in book, 3-4
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iMovie
audio, importing, 268-270
clips, adding to movies, 271-272
controls and display, 263-264
editing clips, 273-274
GarageBand scores, adding to, 290
importing material, 265-270
maps and backgrounds, 276-277
marking clips, 272
moviemaking process, 265
narration, adding, 270
new movie project, creating, 262-264
overview, 261
removing clips, 272-273
reordering clips, 273
sharing movies, 279
sound effects, adding, 269-270
still images, importing, 268
Theater mode, 278
titles, 275-276
trailer, creating, 277-279
transitions, 274-275
video clips, importing, 266-267
video formats supported by, 267
importing
from another Mac, 37-38
images, in Photos, 240-242
movie material, to iMovie, 265-270
from Windows, 39-40
inline objects, adding to documents, 309
Inspector
Keynote, 333, 336
Numbers, 318
Pages, 305, 307
instant messaging, 24-25
Intelligent Tracking Prevention, 154
internal storage devices, 14
Internet. See also Safari
connecting to, 22, 24-25
sharing connections, 188, 191-192, 203-204
troubleshooting, 353
unsecured wireless connections, avoiding, 401-402
Internet radio, 213, 226-227
Internet router, 191-192, 198
invoice, storing, 21
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iOS devices
sending music to, 229-230
slideshow remotes, using as, 339
syncing with, 158-159
iPad. See iOS devices
iPhone. See iOS devices
iPhoto Events, 245
iPod. See iOS devices
iPod Touch, 229
iTunes
browsing Library, 217-218
burning music, 231-233
buying media, 235
deleting music, 218, 219
equalizer, 225-226
finding songs in Library, 218-219
iCloud, 228-229
iMovie, adding music to, 269
iOS devices, sending media to, 229-230
iTunes Radio station, creating, 228
keyboard shortcuts, 214
overview, 211
parental controls, 233-235
playing audio CDs, 213-214
playing digital audio files, 214-219
playlists, 220-221
radio, 226-228
ripping audio files, 224-225
sharing media across network, 230-231
sidebar, 215
song files and ringtones, creating, 296-297
song information, 222-224
supported formats, 212-213
visualizer, 233
watching video, 219
iTunes Match subscription service, 229
iTunes Radio, 228
iTunes Store, 177, 235
iTunes U, 212-213

K

keyboard shortcuts
iTunes, 214
Keynote slideshow, 339



Numbers, 318
overview, 66-67
preferences, 100
keyboards
built-in, 10, 16
checking after unpacking laptop, 32
external, 394-395
special keys on, 65-66
submerged, 400
keychains, 154-155
Keynote
background shapes, adding, 338
controls, 332-333
formatting slide text, 336
media, 337
Media Browser, 337
new project, creating, 330-331
opening presentations, 331
overview, 329-330
Presenter’s Notes, using, 336
printing slides and notes, 339-341
Rehearsal feature, 336
saving presentations, 332
slide text, adding and editing, 335
slides, adding, 334
slideshow, creating, 338-339
text, shapes and graphics boxes, 334-335
keywords, 112, 246-249

L

LAN party, 188
laptop accessories. See also external devices
bags, 390
cases, 26, 390
shelves, 21
sleeves, 26, 390
stands, 34
launching applications, 50-54
Launchpad, 51-52
LED screen, 8, 31
lifestyle applications, 24

local Mac user groups, 81
local support services, 356

location services, limiting website access to, 154
locations, searching for images by, 249

logging out, 183
login items

Automator applications, setting as, 385

launching applications, 53

setting, 174-175

troubleshooting, 354-355
login settings, 181-183
loops. See GarageBand

M

MacBook Air, 15-18
MacBook models, comparing, 15-18
MacBook Pro, 15-18
macOS High Sierra. See High Sierra
magazines, help resources in, 81
magnetic power connector, 11
MagSafe 2 connector, 11
Mail, 25, 36, 179, 398-399
Mail button, Safari, 143
managed user accounts

overview, 167-168

parental controls, setting, 175-180
manual, user, 22

manual clean-up of hard drive, 374-377

Maps, 129-133

maps, iMovie, 276-277
marking clips, 272
Mark’s Maxims icon, 4
matching text searches, 114-116
Media Browser, 337
media plug-ins, 109-110
memory. See RAM

menu bar, 45-46
Messages, 24-25
metadata, 114

Metal 2, 87

MIDI instruments, 285
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Migration Assistant, 36-39
Mission Control
Dashboard, using widgets on, 71-72
overview, 69-70
preferences, 99-101
switching desktops with Spaces feature, 70-71
MLC Radio station, 227
mouse, 49-50, 394-395
movies. See iMovie
MP2 format, 212
MP3 CDs, burning, 232
MP3 files, 212
multiplayer games, 188
multiple selection, 61
Multi-Touch gestures, 47-48
multiuser laptops. See user accounts
music. See also GarageBand; iTunes
browsing, 217-218
burning, 231-233
buying, 235
deleting, 218, 219
equalizer, 225-226
finding songs, 218-219
hardware for, 371
iOS devices, sending to, 229-230
movies, adding to, 269
parental controls, 233-235
playing audio CDs, 213-214
playing digital audio files, 214-219
playlists, 220-221
radio, 226-228
ripping audio files, 224-225
sharing across network, 230-231
song files and ringtones, creating, 296-297
song information, 222-224
supported formats, 212-213
Music Library, iTunes
album covers, adding, 224
browsing, 217-218
deleting music from, 219
finding songs in, 218-219
overview, 215
song information, 216-217, 222-224
My Photo Stream feature, 258-259
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N

navigating web, 141-144
network printers, sharing, 188, 205
networks. See also wired networks; wireless networks
advantages of, 188-189
connecting to, 201-205
file sharing, 204-205
firewall, using, 205-207
Internet connections, 191-192, 203-204
overview, 187
pinging, 202-203
printers, 205
sharing media, 230-231
troubleshooting, 353
wireless versus wired, 189-190
Night Shift feature, 96
Notes, 125-126
Notification Center, 126-128
notifications, setting in Safari, 155-156
Notifications preferences, 109-110
number format, selecting, 320
Numbers
cell text, aligning, 321
cells, navigating and selecting, 318-319
charts, 325-326
controls, 317
entering and editing data, 319
existing files, opening, 315-316
formatting with shading, 322
formulas, 323-325
general discussion, 314
new document, creating, 314-315
number format, selecting, 320
overview, 313
printing spreadsheets, 326-327
rows and columns, inserting and deleting, 323
saving work, 316-317

o)

operating system. See High Sierra

optical discs, avoiding odd shapes, 398-399
optical drives, 10, 17, 19-20

optical output port, 13



P

packing materials, keeping, 21
Pages
background shape, adding, 310
cutting, copying, and pasting, 306-307
existing documents, opening, 303
formatting text, 307
new document, creating, 302
overview, 301
photos, adding, 309-310
printing documents, 311-312
saving work, 303-304
sharing documents, 312
spell-checking, 311
tables, adding, 308-309
text, entering and editing, 304-305
text, shapes, and graphics boxes, 305-306
Pages window, 304-305
parental controls
iTunes, 233-235
overview, 167-168
setting, 175-180
passwords, 155, 169-170
pasting from Clipboard, 307
People collection, Photos, 245-246
peripherals. See external devices
permissions, fixing, 382
photo books, designing, 253-255
Photos
albums, organizing images in, 242-245
controls and display, 237-240
cropping images, 250-251
enhancing images, 251-252
filters and adjustments, 252-253
High Sierra improvements in, 87-88
iCloud Photo Library, 257
iCloud Photo Sharing, 258
iCloud preferences, 162
iMovie, adding image to, 268
importing images, 240-242
iPhoto Events, 245
keywords, assigning, 246-248
My Photo Stream feature, 258
overview, 237

People collection, 245-246
photo books, designing, 253-255
red-eye removal, 252
retouching images, 252
rotating images, 250
searching for images, 248-249
slideshows, 256
Smart Albums, 243
social media, sharing with, 258
tagging faces, 245-246
Undo feature, 244
pinging, 202-203, 353
pinned tabs, 152
pirated software, avoiding, 401
Piriform’s CCleaner for Mac, 377
placement, 20-21
playhead, 264, 283
playing
audio CDs, 213-214
digital audio files, 214-219
playlists, 220-221, 227-228
podcasts, 212-213, 232
pop-up ads, 156
ports, 12-13, 17, 369
power button, 11, 30
power cable, 11
power-saving features, 394
preferences. See System Preferences
presentations. See Keynote
Presenter Notes, 333, 336
printing
documents, 311-312
general discussion, 78-80
maps, 133
network printers, 188, 205
parental controls, setting, 177-178
from Safari, 143
slides and notes, 339-341
spreadsheets, 326-327
web pages, 152-153

privacy
cookies, 153-154
history, 155

iCloud keychain passwords, 154-155
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privacy (continued)
notifications, setting, 155-156
parental controls, setting, 177
pop-up ads, 156

Privacy tab, Spotlight preferences pane, 119

processor, 14, 16
productivity applications, 24
progress bar indicator, 30
Public folder, 184

pushing, 158

Q

Quick Look feature, 53, 113
QuickTime Player, 149

Quit command, 53

quitting applications, 50-54

R

radio, 226-228

RAM
amount of, viewing, 362-363
installing modules, 363-367
maximizing, 390-391
overview, 17, 362

Reader mode, 89, 147-148

Reading List, working with, 147-148

rebooting, 345-347

recent changes, investigating, 352

Recent Items menu, launching applications from, 53

red-eye removal, 252
refreshing web pages, 142-143
refurbished hardware, 403
registering MacBooks, 37
Rehearsal feature, Keynote, 336
reloading web pages, 142-143
Remember icon, 4

Reminders, 122-124

Remote Disc feature, 17
remote Macs, searches on, 117-118
repairing laptops, 364, 367
replacement battery, 34
resolution, screen, 96

restoring data, 379-381

414  MacBook For Dummies

Restrictions settings, iTunes, 233-234
retouching images, 252

right-click menu, 46, 50

ringtones, creating, 296-297

ripping audio files, 224-225

root account, 401-402

rotating images, 250

router, Internet, 191-192, 198

S

Safari
autoplay videos, blocking, 90
Bookmarks, adding and using, 145-147
downloading files, 148-149
full-screen mode, 141
History, using, 149-150
home page, setting up, 144-145
Intelligent Tracking Prevention, 154
navigating web, 141-144
overview, 24, 137
pinned tabs, 152
printing web pages, 152-153
privacy, 153-156
Reader mode, 89
Reading List, working with, 147-148
sections of window, 138-139
tabs, 150-152
visiting websites, 139-141
Safe mode, 347
Satellite mode, Maps, 131
saving files
in iCloud, 159-160
in Keynote, 332
in Numbers, 316-317
in Pages, 303-304
screen
cleaning, 27, 403
Displays preferences, 95-97
general discussion, 8-10
screen savers, 97-99, 355
Screen Sharing feature, 162
screen wipes, 27, 403
scrolling in windows, 54-56



SD/SDXC card slot, 13, 369
search engines, 140
searches
basic, 112-114
Boolean, 116
common search criteria, 113-114
customizing Spotlight, 118-119
Finder search window, 116-118
for images, in Photos, 248-249
matching text, 114-116
preferences, 94
security, 115
for songs, in Music Library, 218-219
in System Preferences, 94-95
secure websites, 153
security
Apple Base Station setup, 196
firewall, 205-206
hard drive encryption, 391-392
phishing, avoiding, 398-399
in Safari, 153-156
scanning files before downloading, 149
Spotlight, 115, 119
unsecured wireless connections, avoiding, 402
Security & Privacy pane, 99, 184-185, 206, 391-392
selecting items, 61-62
shading, in Numbers, 322
shapes, adding, 305-306, 310, 334-335
Share button, Safari, 144
Shared folder, 183
sharing
with AirDrop, 197
documents, 312
drives, 19-20
GarageBand projects, 295-298
Internet connections, 191-192
maps, 133
media across network, 230-231
movies, 279
network file sharing, 204-205
network Internet connections, 203-204
network printers, 205
notes, 126
with other user accounts, 183-184

preferences, 105-106
reminders, 124
shortcut menu, 46, 50
sidebar
Finder, 63
iTunes, 215
Photos, 238
Safari, 139, 143
Simple Finder, 178, 179-180
Siri, 88
sleep mode preferences, 103, 394
sleeve, laptop, 26, 390
slides. See Keynote
Slides list, Keynote, 332
slideshows, 256, 338-339
smart address, 139
Smart Albums, 243
Smart Playlist, 221
social media, 177, 258
software. See also High Sierra
applications, 25
Boot Camp, 25-26
Internet, connecting to, 24-25
older utility, 400-401
piracy, 401
preinstalled, 24
solid-state drives, 14, 18, 86
song information, iTunes, 222-224
sound, 10-11
sound effects, adding to movies, 269-270
Spaces feature, 70-71
speakers, 11
special keys, 65-66, 347-348
spell-checking, Pages, 311
Spotlight
basic searches, 112-114
Boolean searches, 116
common search criteria, 113-114
customizing, 118-119
Finder search window, 116-118
matching text searches, 114-116
preferences, 94-95
security, 115
spreadsheets. See Numbers
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Stacks, 75-77

standard level accounts, 167-168, 172, 178
Standard mode, Maps, 131

start-up keys, 347-348

Status bar, Safari, 139

storage, 14, 163

streaming Internet radio, 213, 226-227
submerged keyboards, 400

support. See tech support

support center, Apple web-based, 81

surge protectors, 26, 393-394

switchers, 40

switches, 198

switching applications, in full-screen mode, 57
switching desktops with Spaces feature, 70-71
synchronization, 157-158

System Administrator account, 401-402
System Information, running, 355

System Preferences. See also Security & Privacy pane;
Users & Groups preferences pane

applying changes, 94

Desktop & Screen Saver pane, 97-99
Displays pane, 95-97

Dock pane, 104-105

Energy Saver pane, 103-104

general discussion, 92-94

General pane, 101-102

iCloud pane, 108-109, 161, 163
media plug-ins, 109-110

Mission Control preferences, 99-101
Notifications preferences, 109-110
opening, 92

overview, 91

searching in, 94-95

Sharing pane, 105-106

Spotlight pane, 118-119

third-party application panes, 109-110
Time Machine pane, 106-107

view options, 93

T

Tab bar, Safari, 138
tabbed browsing, 150
tables, 126, 308-309
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tabs, 150-152
tagging faces on photos, 245-246
tech support
Apple MacBook Support site, 356
Help Center, 356
local Mac user groups, 81
local services, 356
overview, 32
repairing laptops, 364
Technical Stuff icon, 3
text
alignment, Numbers, 321
cutting, copying, and pasting, 306-307
entering and editing, in Pages, 304-305
formatting, 307
on slides, 335, 336
text boxes, 305-306, 334-335
text log files, 178
Theater mode, iMovie, 278
Thumbnails pane, Photos, 239
Thunderbolt Express Dock, Belkin, 27, 28
Thunderbolt port, 12, 369
Tidy Up! 4, Hyperbolic Software, 377
time limits, setting, 177
Time Machine, 106-107, 379-381
Timeline, GarageBand, 283
Tipicon, 3
titles, movie, 275-276
toolbars
iMovie, 264
Keynote, 333
Numbers, 318
overview, 57
Pages, 304
Photos, 238-239
Safari, 138
Top Sites display, 140, 142, 150
Touch Bar, 11, 16, 54, 294
Track list, GarageBand, 282
tracker application, installing, 391
trackpad
checking after unpacking laptop, 32
customizing, 47-48
Multi-Touch and Force Click features, 47-48



navigating with, 47-50
overview, 10, 16
tabbed browsing with, 151
tracks, GarageBand. See GarageBand
trailers, creating in iMovie, 262, 277-279
Transit mode, Maps, 131
transitions. iMovie, 274-275
Trash, 77-78, 352-353, 375
troubleshooting
Apple MacBook Support site, 356
cables, checking, 352-353
Disk Utility, 348-351, 352
Help Center, 356
Internet and network connections, 353
local support services, 356
login items, checking, 354-355
MacBook Troubleshooting Tree, 351-355
myths about, 344
overview, 343
rebooting, 345-347
recent changes, investigating, 352
Safe Boot mode, 347
screen saver, turning off, 355
special keys for, 347-348
start-up keys, 347-348
System Information, running, 355
Trash, checking, 352-353
viruses, 354
turning on MacBooks, 30
Twitter, 259
2 Factor Authentication, 35

U

Undo feature, Photos, 244
uninterruptible power supply (UPS), 27
UNIX, 47
unpacking MacBooks, 21-22, 31-32
unsecured wireless connections, 402
updating macOS, 385-386
upgrading

hard drive, 367-371

memory, 362-367

older utility programs, 400-401

UPS (uninterruptible power supply), 27
USB devices
backing up to flash drive, 378
game controllers, 371
keyboards, 394-395
mouse, 49-50, 394-395
music hardware, 371
printers, 78
video controllers, 371
USB port, 12-13, 369
USB SuperDrive, 19
USB-C cable, 11
USB-C port, 13, 369
user accounts
access level, deciding on, 167-168
adding, 168-170
administrator account, 167-168
deleting, 172-173
encrypting Home folder, 184-185
Fast User Switching, 181-182
Guest accounts, 173
images, changing, 171
logging out, 183
login items, setting, 174-175
login settings, 181-183
modifying, 170-172
overview, 165-167
parental controls, managing, 175-180
shared content, 183-184
user manual, 22
Users & Groups preferences pane
adding user accounts, 168-170
deleting user accounts, 172
Guest accounts, 173
login items, setting, 174-175
login settings, changing, 182-183
modifying user accounts, 170-171
parental controls, setting, 175-178
utility software, older, 400-401

\'

video card, 14
video clips. See iMovie
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video controllers, 371

videos, 87, 219. See also iMovie

Viewer, 239, 263

Virtual Private Network (VPN) client, 402
virus scans, 354

Visual Equalizer, GarageBand, 294
Visualizer, iTunes, 233

VPN (Virtual Private Network) client, 402

wW

Warning! icon, 3
warranty, 21
watching video, 219
WAV format, 212
web browser. See Safari
webcam, external, 26, 28
websites
Apple MacBook Support, 356
bookmarking, 145-147
Dock, adding to, 75
History, using, 149-150
home page, setting up, 144-145
navigating, 141-144
parental controls, setting, 175-176
printing web pages, 152-153
secure, 153
visiting, 139-141
widescreen display, 9, 16
widgets
creating from Safari, 143
Dashboard, 24, 71-72
Dictionary, 9
notification, 127
Wi-Fi. See wireless networks
Wi-Fi hardware, turning off, 393
windows
active, 58
closing, 58
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general discussion, 46-47
minimizing and restoring, 56
moving, 56-58
overview, 54
resizing, 54-56
scrolling in, 54-56
zooming, 56-58
Windows, Microsoft, 39-40. See also Boot Camp
wired networks
combo routers, 190
connecting to, 198
Ethernet network, joining, 199-201
hardware, 198-199
overview, 198
versus wireless, 189-190
wireless communication devices, 14
wireless networks
base stations, using, 193-195
combo routers, 190
connecting to existing, 192
disabling connectivity, 392-393
Ethernet, 14
joining, 195-197
overview, 192
signal range, 192
unsecured, avoiding, 402
versus wired, 189-190
wireless support, 16
workflows, 383
wrist rests, 27

Z

zooming
in Maps, 130se
in Photos, 239
in Safari, 142
windows, 56-58
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